Contents

Send Us Your Comments ........................................................................................................................................... xiii

Preface ......................................................................................................................................................................... xv
  Audience ............................................................................................................................................................... xv
  Documentation Accessibility ............................................................................................................................... xv
  Structure ............................................................................................................................................................. xv
  Related Documents ............................................................................................................................................... xviii
  Conventions ......................................................................................................................................................... xviii

What’s New in Oracle Database for Windows ............................................................................................................. xxiii
  Oracle Database 10g Release 1 (10.1) New Features............................................................................................. xxiii
  Oracle9i Release 2 (9.2.0.2) New Feature ............................................................................................................. xxiv
  Oracle9i Release 2 (9.2) New Features .................................................................................................................. xxiv
  Oracle9i Release 1 (9.0.1) New Features ............................................................................................................... xxv

1 Oracle Database Architecture on Windows
  Oracle Database on Windows Architecture ........................................................................................................ 1-1
    Thread-Based Architecture ................................................................................................................................. 1-1
    File I/O Enhancements ..................................................................................................................................... 1-3
    Raw File Support ............................................................................................................................................... 1-3
  Oracle Database Scalability on Windows ............................................................................................................. 1-4
    Support for Very Large Memory (VLM) Configurations ..................................................................................... 1-4
    4 GB RAM Tuning (4GT) ..................................................................................................................................... 1-6
    Large User Populations ..................................................................................................................................... 1-7
  Oracle Database Integration with Windows .......................................................................................................... 1-7
    Oracle PKI Integration with Windows ............................................................................................................. 1-7
    Oracle Services for Microsoft Transaction Server ........................................................................................... 1-7
    Oracle Fail Safe Integration with Windows ....................................................................................................... 1-8
    Oracle Real Application Clusters Integration with Windows ............................................................................. 1-8
  Other Sources of Information .............................................................................................................................. 1-8

2 Database Tools on Windows
  Choosing a Database Tool ............................................................................................................................................... 2-1
    Database Tools and Operating System Compatibility ...................................................................................... 2-2
Prefered Database Tools .................................................................................................................. 2-2

Starting Database Tools .................................................................................................................. 2-4
Starting Database Tools in Multiple Oracle Homes ........................................................................ 2-4
Starting Tools from Oracle8 Release 8.0.4 and Later 8.0.x Multiple Oracle Homes ............... 2-4
Starting Tools from Oracle8i Release 8.1.3 and Later Multiple Oracle Homes ......................... 2-5
Starting Database Tools from the Start Menu ............................................................................... 2-5
Starting Database Tools from the Command Line ....................................................................... 2-6
Starting Windows Tools ................................................................................................................... 2-8

Using SQL*Loader ............................................................................................................................... 2-9
Windows Processing Options ........................................................................................................... 2-9
Default (No Processing Option) or "str terminator_string" .......................................................... 2-9
"FIX n" ............................................................................................................................................. 2-10
"VAR n" ............................................................................................................................................ 2-10
Case Study Files ............................................................................................................................... 2-10
Specifying the Bad File ..................................................................................................................... 2-10
Control File Conventions .................................................................................................................. 2-10

Using Windows Tools ...................................................................................................................... 2-11
Using Event Viewer to Monitor a Database .................................................................................... 2-11
Using Microsoft Management Console to Administer a Database .............................................. 2-12
Using Oracle Counters for Windows Performance Monitor .......................................................... 2-12
Using Registry Editor to Modify Configuration Information ....................................................... 2-12
Using Task Manager to Monitor Applications and Processes ...................................................... 2-13
Using Local Users and Groups to Manage Users and Groups ...................................................... 2-13
Using User Manager to Manage Users .......................................................................................... 2-13

Optional Windows Diagnostic and Tuning Utilities ......................................................................... 2-14

3 Postinstallation Database Creation on Windows

Naming Conventions for Oracle Database ..................................................................................... 3-1
Accessing Data Files and Log Files on Remote Computers ............................................................. 3-2
Creating a Database on Windows Using Database Configuration Assistant .............................. 3-2
Creating a Database on Windows Using Command-Line Tools .................................................. 3-3
Creating Directories ......................................................................................................................... 3-4
Exporting an Existing Database ....................................................................................................... 3-4
Deleting Database Files ................................................................................................................... 3-5
Modifying the Initialization Parameter File ..................................................................................... 3-6
Starting an Oracle Database Instance ............................................................................................. 3-7
Creating and Starting an Oracle Database Service ......................................................................... 3-7
Putting the CREATE DATABASE Statement in a Script ................................................................... 3-8
Running the CREATE DATABASE Script ......................................................................................... 3-8
Importing a Database ....................................................................................................................... 3-9
Updating ORACLE_SID in the Registry ......................................................................................... 3-10
Backin Up the New Database ............................................................................................................ 3-11

Using ORADIM to Administer an Oracle Database Instance ......................................................... 3-12
Creating an Instance ....................................................................................................................... 3-13
Starting an Instance and Services ................................................................................................. 3-14
Stopping an Instance and Services ............................................................................................... 3-14
Editing an Instance ......................................................................................................................... 3-15
4 Postinstallation Configuration Tasks on Windows

Reseting Passwords for Default Accounts ................................................................. 4-1
NTFS File System and Windows Registry Permissions ................................. 4-1
    File Permissions .................................................................................. 4-2
        File Permissions Set by Oracle Universal Installer ........................... 4-2
        File Permissions Set by Database Configuration Assistant .............. 4-2
        File Permissions Set by Database Upgrade Assistant ...................... 4-3
Setting NTFS File System Security ............................................................... 4-3
Setting Windows Registry Security ............................................................. 4-4
Configuring External Job Support for the Scheduler on Windows .......... 4-4
Oracle interMedia on Windows ................................................................. 4-5
    Upgrading Oracle interMedia from an Earlier Release ....................... 4-6
    Configuring Oracle interMedia Audio, Video, Image, and Locator .......... 4-6
    Configuring Oracle interMedia Demos ................................................ 4-7
Configuring Oracle Text on Windows ......................................................... 4-8
Configuring Oracle Spatial on Windows ..................................................... 4-10
Configuring Advanced Replication on Windows ....................................... 4-11
    Checking Tablespace and Rollback Segment Requirements ................. 4-11
    Adding and Modifying Initialization Parameters .................................. 4-12
    Monitoring Data Dictionary Tables ....................................................... 4-12

5 Administering a Database on Windows

Managing Oracle Database Services ................................................................. 5-1
    Oracle Database Service Naming Conventions for Multiple Oracle Homes 5-2
    Starting Oracle Database Services ....................................................... 5-2
    Stopping Oracle Database Services ..................................................... 5-3
    Auto-starting Oracle Database Services ................................................. 5-4
Starting and Shutting Down a Database with SQL*Plus ................................. 5-5
Starting and Shutting Down a Database Using Services ............................... 5-6
Starting Multiple Instances ........................................................................ 5-9
Creating and Populating Password Files ....................................................... 5-9
    Viewing and Hiding the Password File ................................................ 5-10
    Connecting Remotely to the Database as SYS ...................................... 5-12
    Automatically Encrypted Database Passwords .................................. 5-12
    Creating Control, Data, and Log Files on Remote Computers ............... 5-12
    Archiving Redo Log Files .................................................................... 5-12
        Changing Archive Mode to ARCHIVELOG ........................................ 5-13
        Enabling Automatic Archiving ......................................................... 5-14
    Backing Up an Oracle Database on Windows ....................................... 5-15

6 Monitoring a Database on Windows

Database Monitoring Overview ........................................................................ 6-1
Using Oracle Counters for Windows Performance Monitor ......................... 6-2
    Registry Information ........................................................................... 6-2
Accessing Oracle Counters for Windows Performance Monitor ........................................ 6-3
Modifying Views .................................................................................................................. 6-3
Understanding Oracle Database Performance Objects ..................................................... 6-4
Oracle Counters for Windows Performance Monitor Troubleshooting Information .......... 6-6
Using Event Viewer ............................................................................................................. 6-6
Reading Event Viewer ....................................................................................................... 6-7
Managing Event Viewer ...................................................................................................... 6-8
Trace Files ............................................................................................................................ 6-8
Alert Files ............................................................................................................................. 6-9
Viewing Threads .................................................................................................................. 6-9

7 Tuning Windows to Optimize Oracle Database

Windows Tuning Overview .................................................................................................. 7-1
Large Page Support ............................................................................................................. 7-2
Reduce Priority of Foreground Applications on Server Console .................................... 7-2
Configure Windows Server to Be an Application Server .................................................. 7-3
Disable Unnecessary Services ............................................................................................ 7-3
Remove Unused Network Protocols .................................................................................. 7-4
Reset Network Protocol Bind Order .................................................................................. 7-4
Setting the Order of Multiple Network Interface Cards .................................................... 7-4
Apply Latest Reliable Windows Server Service Pack ......................................................... 7-5
Use Hardware or Operating System Stripping .................................................................... 7-5
  Multiple Striped Volumes for Sequential and Random Access ....................................... 7-6
Multiplex Windows Server Virtual Memory Paging File .................................................... 7-7
Close All Unnecessary Foreground Applications ............................................................... 7-7

8 Authenticating Database Users with Windows

Windows Native Authentication Overview ......................................................................... 8-1
Windows Authentication Protocols ..................................................................................... 8-2
User Authentication and Role Authorization Methods ........................................................ 8-2
  Authentication and Authorization Methods To Use ......................................................... 8-3
Operating System Authentication Enabled at Installation ............................................... 8-4

9 Administering External Users and Roles on Windows

Oracle Administration Assistant for Windows ................................................................. 9-1
  Managing a Remote Computer ......................................................................................... 9-2
  Adding a Computer and Saving Your Configuration ...................................................... 9-3
  Granting Administrator Privileges for All Databases on a Computer ......................... 9-4
  Granting Operator Privileges for All Databases on a Computer .................................... 9-5
  Connecting to a Database ............................................................................................... 9-5
    Troubleshooting Connection Problems ......................................................................... 9-7
  Viewing Database Authentication Parameter Settings ................................................. 9-8
  Creating an External Operating System User ............................................................... 9-9
  Creating a Local Database Role ...................................................................................... 9-14
  Creating an External Operating System Role ............................................................... 9-16
  Granting Administrator Privileges for a Single Database .............................................. 9-19
## 10 Storing Oracle Wallets in the Windows Registry

<table>
<thead>
<tr>
<th>Subsection</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storing Private Keys and Trust Points</td>
<td>10-1</td>
</tr>
<tr>
<td>Storing User's Profile</td>
<td>10-1</td>
</tr>
<tr>
<td>Registry Parameters for Wallet Storage</td>
<td>10-1</td>
</tr>
<tr>
<td>Oracle Wallet Manager</td>
<td>10-2</td>
</tr>
<tr>
<td>Sharing Wallets and sqlnet.ora Files Among Multiple Databases</td>
<td>10-2</td>
</tr>
</tbody>
</table>

## 11 Oracle PKI Integration with Windows

<table>
<thead>
<tr>
<th>Subsection</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Public Key Infrastructure</td>
<td>11-1</td>
</tr>
<tr>
<td>Windows Public Key Infrastructure</td>
<td>11-1</td>
</tr>
<tr>
<td>Microsoft Certificate Stores</td>
<td>11-2</td>
</tr>
<tr>
<td>Microsoft Certificate Services</td>
<td>11-2</td>
</tr>
<tr>
<td>Using Microsoft Certificate Stores with Oracle PKI Applications</td>
<td>11-2</td>
</tr>
</tbody>
</table>

## 12 Using Oracle Database with Microsoft Active Directory

<table>
<thead>
<tr>
<th>Subsection</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Active Directory Support</td>
<td>1-1</td>
</tr>
<tr>
<td>About Microsoft Active Directory</td>
<td>1-1</td>
</tr>
<tr>
<td>Accessing Active Directory</td>
<td>1-2</td>
</tr>
<tr>
<td>Oracle Components That Integrate with Active Directory</td>
<td>1-2</td>
</tr>
<tr>
<td>Directory Naming</td>
<td>1-2</td>
</tr>
<tr>
<td>Automatic Discovery of Directory Servers</td>
<td>1-3</td>
</tr>
<tr>
<td>Integration with Microsoft Tools</td>
<td>1-3</td>
</tr>
<tr>
<td>User Interface Extensions for Oracle Net Directory Naming</td>
<td>1-3</td>
</tr>
<tr>
<td>Enhancement of Directory Object Type Descriptions</td>
<td>1-3</td>
</tr>
<tr>
<td>Integration with Windows Login Credentials</td>
<td>1-4</td>
</tr>
<tr>
<td>Oracle Directory Objects in Active Directory</td>
<td>1-4</td>
</tr>
<tr>
<td>Requirements for Using Oracle Database with Active Directory</td>
<td>1-5</td>
</tr>
<tr>
<td>Directory Naming Software Requirements</td>
<td>1-5</td>
</tr>
<tr>
<td>Oracle Schema Creation</td>
<td>1-6</td>
</tr>
<tr>
<td>Oracle Context Creation</td>
<td>1-7</td>
</tr>
<tr>
<td>Configuring Oracle Database to Use Active Directory</td>
<td>1-7</td>
</tr>
<tr>
<td>Testing Connectivity</td>
<td>1-8</td>
</tr>
<tr>
<td>Testing Connectivity from Client Computers</td>
<td>1-8</td>
</tr>
</tbody>
</table>
### 13 Oracle Database Specifications for Windows

#### Initialization Parameter File Overview
- Location of the Initialization Parameter File... 2-1
- Editing The Initialization Parameter File... 2-2
- Database Configuration Assistant Renames init.ora... 2-2

**Sample File** 2-2

**SGA_MAX_SIZE Parameter** 2-3

**Initialization Parameters Without Windows-Specific Values** 2-3

**Displaying Initialization Parameter Values** 2-4

**Uneditable Database Initialization Parameters** 2-4

**Calculating Database Limits** 2-5

### 14 Configuration Parameters and the Registry

#### About Configuration Parameters
- **Registry Overview** 3-1
- **Registry Parameters** 3-1

**HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_HOME_NAME** 3-2
- **MSHELP_TOOLS** 3-3
- **NLS_LANG** 3-3
- **ORA_CWD** 3-3
- **ORA_SID_AUTOSTART** 3-3
- **ORA_SID_PFILE** 3-3
- **ORA_SID_SHUTDOWN** 3-3
- **ORA_SID_SHUTDOWN_TIMEOUT** 3-3
- **ORA_SID_SHUTDOWN_TYPE** 3-3
- **ORA_TZFILE** 3-4
- **ORACLE_AFFINITY** 3-4
- **ORACLE_BASE** 3-5
- **ORACLE_GROUP_NAME** 3-5
- **ORACLE_HOME** 3-5
- **ORACLE_HOME_KEY** 3-5
- **ORACLE_HOME_NAME** 3-5
- **ORACLE_PRIORITY** 3-5
- **ORACLE_SID** 3-5
- **OSAUTH_PREFIX_DOMAIN** 3-6
- **OSAUTH_X509_NAME** 3-6
- **RDBMS_ARCHIVE** 3-6
- **RDBMS_CONTROL** 3-6
- **SQLPATH** 3-6

**HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE** 3-6
15 Developing Applications for Windows

Finding Information on Application Development for Windows ........................................ 4-1
Java Enhancements ........................................................................................................ 4-1
XML Support ................................................................................................................ 4-1
Support for Internet Applications .................................................................................. 4-2
Application Wizards ..................................................................................................... 4-2
Oracle COM/COM+ Integration Feature ....................................................................... 4-2
Oracle Objects for OLE ................................................................................................. 4-2
ODP.NET ....................................................................................................................... 4-2
Oracle Services For Microsoft Transaction Server ..................................................... 4-3
Pro*C/C++ and Pro*COBOL Applications ................................................................... 4-3
OLE DB .......................................................................................................................... 4-3

Developing Windows Applications .................................................................................. 4-3
Developing Internet Applications .................................................................................... 4-4

Building External Procedures ........................................................................................ 4-5
External Procedures Overview ...................................................................................... 4-5
Installing and Configuring .............................................................................................. 4-6
Installing Oracle Database ............................................................................................ 4-6
Configuring Oracle Net Services .................................................................................... 4-6
Writing an External Procedure ...................................................................................... 4-7
Building a DLL ............................................................................................................... 4-8
Registering an External Procedure ............................................................................... 4-8
Executing an External Procedure .................................................................................. 4-9

Debugging External Procedures ....................................................................................... 4-10
Using Package DEBUG_EXTPROC .............................................................................. 4-10

Accessing Text Files with UTL_FILE ............................................................................. 4-11
Accessing Web Data with Intercartridge Exchange ....................................................... 4-11

Configuring Intercartridge Exchange ............................................................................ 4-11
No DNS Domain Name for Windows 2000 Computer ............................................................ E-2
Microsoft Management Console Included in Windows 2000.................................................... E-2
Raw Partitions......................................................................................................................... E-3
Services Autostart .................................................................................................................. E-3

F  Oracle Database Windows/UNIX Differences

Automatic Startup and Shutdown ............................................................................................ F-1
Background Processing and Batch Jobs .................................................................................... F-2
Diagnostic and Tuning Utilities ............................................................................................... F-2
Direct Writes to Disk ................................................................................................................ F-2
Dynamic Link Libraries (DLLs) ............................................................................................... F-3
Hot Backups ............................................................................................................................. F-3
Initialization Parameters: Multiple Database Writers .......................................................... F-3
Install Accounts and Groups .................................................................................................... F-3
Installation ............................................................................................................................... F-4
Memory Resources .................................................................................................................. F-4
Microsoft Transaction Server ............................................................................................... F-4
Multiple Oracle Homes and OFA .......................................................................................... F-4
Processes and Threads .......................................................................................................... F-5
Raw Partitions ......................................................................................................................... F-5
Services ..................................................................................................................................... F-6

G  Oracle Database for 64-Bit Windows

Unsupported Features .............................................................................................................. G-1
Oracle Database Architecture on 64-Bit Windows ............................................................... G-2
Database Tools for 64-Bit Windows ....................................................................................... G-2
Backing Up and Recovering 64-Bit Database Files .............................................................. G-2
Users and Roles for 64-Bit Windows ..................................................................................... G-2
Large Page Support for 64-bit Windows ............................................................................... G-2
Database Migration from a 32-bit Windows Computer ......................................................... G-4
  Backing Up a 32-Bit Oracle Database .................................................................................. G-4
  Migrating an Oracle Database 10g Release 1 (10.1) Database ......................................... G-5
  Migrating an Oracle9i or Older Database........................................................................... G-7
Application Migration ........................................................................................................... G-7
Oracle Database for 64-bit Windows Documentation ........................................................... G-8

Glossary

Index
Send Us Your Comments

Oracle Database Platform Guide, 10g Release 1 (10.1) for 64-Bit Windows
Part No. B13831-01

Oracle welcomes your comments and suggestions on the quality and usefulness of this publication. Your input is an important part of the information used for revision.

- Did you find any errors?
- Is the information clearly presented?
- Do you need more information? If so, where?
- Are the examples correct? Do you need more examples?
- What features did you like most about this manual?

If you find any errors or have any other suggestions for improvement, please indicate the title and part number of the documentation and the chapter, section, and page number (if available). You can send comments to us in the following ways:

- Electronic mail: ntdoc_us@oracle.com
- FAX: (650) 506-7365  Attn: Oracle Database for Windows Documentation
- Postal service:
  Oracle Corporation
  Oracle Database for Windows Documentation Manager
  500 Oracle Parkway, Mailstop 1op6
  Redwood Shores, CA 94065
  USA

If you would like a reply, please give your name, address, telephone number, and electronic mail address (optional).

If you have problems with the software, please contact your local Oracle Support Services.

This guide is your primary source of introductory and reference information for Oracle Database for Windows for both client and server. Differences between product versions are noted where appropriate.

This Preface contains these topics:

- Audience
- Documentation Accessibility
- Structure
- Related Documents
- Conventions

**Audience**

*Oracle Database Platform Guide* is intended for:

- Database administrators
- Network administrators
- Security specialists
- Developers who use Oracle Database

To use this document, you need:

- Oracle-certified Windows operating system software installed and tested
- Knowledge of object-relational database management concepts

**Documentation Accessibility**

Our goal is to make Oracle products, services, and supporting documentation accessible, with good usability, to the disabled community. To that end, our documentation includes features that make information available to users of assistive technology. This documentation is available in HTML format, and contains markup to facilitate access by the disabled community. Standards will continue to evolve over time, and Oracle is actively engaged with other market-leading technology vendors to address technical obstacles so that our documentation can be accessible to all of our
customers. For additional information, visit the Oracle Accessibility Program Web site at
http://www.oracle.com/accessibility/

Accessibility of Code Examples in Documentation
JAWS, a Windows screen reader, may not always correctly read the code examples in this document. The conventions for writing code require that closing braces should appear on an otherwise empty line; however, JAWS may not always read a line of text that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or organizations that Oracle does not own or control. Oracle neither evaluates nor makes any representations regarding the accessibility of these Web sites.

Structure

This document contains:

Chapter 1, "Oracle Database Architecture on Windows"
This chapter describes how Oracle Database architecture takes advantage of some of the more advanced services in the Windows operating system.

Chapter 2, "Database Tools on Windows"
This chapter provides a list of preferred and optional tools you can use to perform common database administration tasks. It also explains how to start these tools.

Chapter 3, "Postinstallation Database Creation on Windows"
This chapter explains how to create a database after installing Oracle Database, using either the Database Configuration Assistant or command-line tools.

Chapter 4, "Postinstallation Configuration Tasks on Windows"
This chapter describes some of the configuration tasks you must perform before using Oracle interMedia and other Oracle options.

Chapter 5, "Administering a Database on Windows"
This chapter explains how to administer Oracle Database for Windows.

Chapter 6, "Monitoring a Database on Windows"
This chapter explains how to monitor Oracle Database for Windows.

Chapter 7, "Tuning Windows to Optimize Oracle Database"
This chapter explains how to tune Windows Server operating systems to ensure that Oracle Database is running in the best possible environment.

Chapter 8, "Authenticating Database Users with Windows"
This chapter describes authentication of Oracle Database users on Windows operating systems.

Chapter 9, "Administering External Users and Roles on Windows"
This chapter describes the administration of external users and roles.
Chapter 10, "Storing Oracle Wallets in the Windows Registry"
This chapter describes storing and retrieving Oracle Wallets in the Windows registry.

Chapter 11, "Oracle PKI Integration with Windows"
This chapter describes the integration of Oracle public key infrastructure (PKI) with Windows 2000 public key infrastructure (Windows PKI) on Windows operating systems.

Chapter 12, "Using Oracle Database with Microsoft Active Directory"
This chapter describes how to configure and use Microsoft Active Directory as the LDAP directory.

Chapter 13, "Oracle Database Specifications for Windows"
This chapter discusses initialization parameters, which Oracle Database uses on Windows to enable various features of the database every time an instance is started.

Chapter 14, "Configuration Parameters and the Registry"
This chapter describes the use of the registry for various Oracle Database components. In addition, this chapter lists the recommended values and ranges for configuration parameters.

Chapter 15, "Developing Applications for Windows"
This chapter points to sources of information on developing applications for Windows and outlines a procedure for building and debugging external procedures.

Appendix A, "Getting Started with Your Documentation"
This appendix describes the contents of your Oracle Database documentation set.

Appendix B, "Storing Tablespaces on Raw Partitions"
This appendix describes how to configure your system to store datafiles for tablespaces on raw partitions.

Appendix C, "Oracle Net Services Configuration on Windows"
This appendix describes Oracle Net Services configuration for Windows. For an overview of Oracle Net Services configuration in general, see Oracle Net Services Administrator’s Guide.

Appendix D, "Error Messages on Windows"
This appendix lists error messages, causes, and corrective actions that are specific to the operation of Oracle Database for Windows.

Appendix E, "Using Oracle Database on Windows 2000"
This appendix highlights differences between Windows 2000 and Windows NT, with emphasis on procedures for common database tasks.

Appendix F, "Oracle Database Windows/UNIX Differences"
This appendix compares features of Oracle Database for Windows and UNIX. This information may be helpful to Oracle Database developers and database administrators moving from UNIX to Windows platforms.
Appendix G, "Oracle Database for 64-Bit Windows"
This appendix identifies unsupported features and special procedures for Oracle Database for 64-bit Windows.

Glossary
The Glossary contains definitions of technical terms used in this guide. The first appearance of each term in a chapter is a link to its definition in the Glossary.

Related Documents
For information on the components available in your Oracle Database installation type, see your Oracle Database Installation Guide for Windows.

For Oracle Database product information that is applicable to all operating systems, see your Oracle Database Online Documentation Library CD-ROM for Windows.

For information about Oracle Database error messages, see Oracle Database Error Messages. Oracle Database error message documentation is available only in HTML. If you only have access to the Oracle Database Documentation CD, you can browse the error messages by range. Once you find the specific range, use your browser's "find in page" feature to locate the specific message. When connected to the Internet, you can search for a specific error message using the error message search feature of the Oracle Database online documentation.

If you are not familiar with object-relational database management concepts, see Oracle Database Concepts.

Many books in the documentation set use the sample schemas, which are installed by default when you select the Basic Installation option with an Oracle Database installation. Refer to Oracle Database Sample Schemas for information on how these schemas were created and how you can use them yourself.

Printed documentation is available for sale in the Oracle Store at
http://oraclestore.oracle.com/

To download free release notes, installation documentation, white papers, or other collateral, please visit the Oracle Technology Network (OTN). You must register online before using OTN; registration is free and can be done at
http://otn.oracle.com/membership/

If you already have a username and password for OTN, then you can go directly to the documentation section of the OTN Web site at
http://otn.oracle.com/documentation/

Conventions
This section describes the conventions used in the text and code examples of this documentation set. It describes:

- Conventions in Text
- Conventions in Code Examples
- Conventions for Windows Operating Systems
Conventions in Text

We use various conventions in text to help you more quickly identify special terms. The following table describes those conventions and provides examples of their use.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Bold typeface indicates terms that are defined in the text or terms that appear in a glossary, or both.</td>
<td>When you specify this clause, you create an index-organized table.</td>
</tr>
<tr>
<td><strong>Italics</strong></td>
<td>Italic typeface indicates book titles or emphasis.</td>
<td>Oracle Database Concepts</td>
</tr>
<tr>
<td><strong>UPPERCASE</strong></td>
<td>Uppercase monospace typeface indicates elements supplied by the system. Such elements include parameters, privileges, datatypes, RMAN keywords, SQL keywords, SQL*Plus or utility commands, packages and methods, as well as system-supplied column names, database objects and structures, usernames, and roles.</td>
<td>You can specify this clause only for a NUMBER column.</td>
</tr>
<tr>
<td>monospace</td>
<td></td>
<td>You can back up the database by using the BACKUP command.</td>
</tr>
<tr>
<td><strong>font</strong></td>
<td></td>
<td>Query the TABLE_NAME column in the USER_TABLES data dictionary view.</td>
</tr>
<tr>
<td><strong>lowercase</strong></td>
<td>Lowercase monospace typeface indicates executable programs, filenames, directory names, and sample user-supplied elements. Such elements include computer and database names, net service names and connect identifiers, user-supplied database objects and structures, column names, packages and classes, usernames and roles, program units, and parameter values.</td>
<td>Enter sqlplus to start SQL*Plus.</td>
</tr>
<tr>
<td><strong>monospace</strong></td>
<td></td>
<td>The password is specified in the orapwd file.</td>
</tr>
<tr>
<td><strong>font</strong></td>
<td></td>
<td>Back up the datafiles and control files in the /disk1/oracle/dbs directory.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Some programmatic elements use a mixture of UPPERCASE and lowercase.</td>
<td>The department_id, department_name, and location_id columns are in the hr.departments table.</td>
</tr>
<tr>
<td><strong>Enter these elements as shown.</strong></td>
<td></td>
<td>Set the QUERY_REWRITE_ENABLED initialization parameter to true.</td>
</tr>
<tr>
<td><strong>lowercase</strong></td>
<td>Lowercase italic monospace font represents placeholders or variables.</td>
<td>Connect as oe user.</td>
</tr>
<tr>
<td><strong>italic</strong></td>
<td></td>
<td>The JRepUtil class implements these methods.</td>
</tr>
<tr>
<td><strong>monospace</strong></td>
<td></td>
<td>You can specify the parallel_clause.</td>
</tr>
<tr>
<td><strong>font</strong></td>
<td></td>
<td>Run old_release.SQL where old_release refers to the release you installed prior to upgrading.</td>
</tr>
</tbody>
</table>

Conventions in Code Examples

Code examples illustrate SQL, PL/SQL, SQL*Plus, or other command-line statements. They are displayed in a monospace (fixed-width) font and separated from normal text as shown in this example:

```
SELECT username FROM dba_users WHERE username = 'MIGRATE';
```

The following table describes typographic conventions used in code examples and provides examples of their use.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ ]</td>
<td>Anything enclosed in brackets is optional.</td>
<td>DECIMAL (digits [ , precision ] )</td>
</tr>
<tr>
<td>{ }</td>
<td>Braces are used for grouping items.</td>
<td>{ENABLE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A vertical bar represents a choice of two options.</td>
</tr>
</tbody>
</table>
The following table describes conventions for Windows operating systems and provides examples of their use.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose Start &gt; menu item</td>
<td>How to start a program.</td>
<td>To start the Database Configuration Assistant, choose Start &gt; Programs &gt; Oracle - HOME_NAME &gt; Configuration and Migration Tools &gt; Database Configuration Assistant.</td>
</tr>
<tr>
<td>File and directory names</td>
<td>File and directory names are not case sensitive. The following special characters are not allowed: left angle bracket (&lt;), right angle bracket (&gt;), colon (:), double quotation marks (&quot;), slash (/), pipe (</td>
<td>), and dash (-). The special character backslash () is treated as an element separator, even when it appears in quotes. If the filename begins with , then Windows assumes it uses the Universal Naming Convention.</td>
</tr>
<tr>
<td>C:&gt;</td>
<td>Represents the Windows command prompt of the current hard disk drive. The escape character in a command prompt is the caret (^). Your prompt reflects the subdirectory in which you are working. Referred to as the command prompt in this manual.</td>
<td>C:\oracle\oradata&gt;</td>
</tr>
</tbody>
</table>
### Special characters

The backslash (\) special character is sometimes required as an escape character for the double quotation mark (") special character at the Windows command prompt. Parentheses and the single quotation mark (’) do not require an escape character. Refer to your Windows operating system documentation for more information on escape and special characters.

**Example:**

```plaintext
C:\> exp HR/HR TABLES=employees
QUERY="WHERE job_id='SA_REP' and salary<8000\"
```

### HOME_NAME

Represents the Oracle home name. The home name can be up to 16 alphanumeric characters. The only special character allowed in the home name is the underscore.

**Example:**

```plaintext
C:\> net start Oracle\HOME_NAME\TNSListener
```

### ORACLE_HOME and ORACLE_BASE

In releases prior to Oracle8i release 8.1.3, when you installed Oracle components, all subdirectories were located under a top level `ORACLE_HOME` directory. The default for Windows NT was `C:\orant`.

This release complies with Optimal Flexible Architecture (OFA) guidelines. All subdirectories are not under a top level `ORACLE_HOME` directory. There is a top level directory called `ORACLE_BASE` that by default is `C:\oracle\product\10.1.0`. If you install the latest Oracle release on a computer with no other Oracle software installed, then the default setting for the first Oracle home directory is `C:\oracle\product\10.1.0\db_n`, where `n` is the latest Oracle home number. The Oracle home directory is located directly under `ORACLE_BASE`.

All directory path examples in this guide follow OFA conventions.

Refer to Oracle Database Installation Guide for Windows for additional information about OFA compliances and for information about installing Oracle products in non-OFA compliant directories.

### Table: Conventions and Examples

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
<th>Example</th>
</tr>
</thead>
</table>
| Special characters  | The backslash (\) special character is sometimes required as an escape  | C:\> exp HR/HR TABLES=employees QUERY="WHERE job_id='SA_REP' and salary<8000\"
|                     | character for the double quotation mark (") special character at the    |                                                                         |
|                     | Windows command prompt. Parentheses and the single quotation mark (’)  |                                                                         |
|                     | do not require an escape character. Refer to your Windows operating     |                                                                         |
|                     | system documentation for more information on escape and special         |                                                                         |
|                     | characters.                                                             |                                                                         |
| HOME_NAME           | Represents the Oracle home name. The home name can be up to 16           | C:\> net start Oracle\HOME_NAME\TNSListener                            |
|                     | alphanumeric characters. The only special character allowed in the     |                                                                         |
|                     | home name is the underscore.                                            |                                                                         |
| ORACLE_HOME and     | In releases prior to Oracle8i release 8.1.3, when you installed Oracle   | Go to the `ORACLE_BASE\ORACLE_HOME\rdbms\admin` directory.              |
| ORACLE_BASE         | components, all subdirectories were located under a top level `         |                                                                         |
|                     | ORACLE_HOME` directory. The default for Windows NT was `C:\orant`.       |                                                                         |
|                     | This release complies with Optimal Flexible Architecture (OFA)          |                                                                         |
|                     | guidelines. All subdirectories are not under a top level `ORACLE_HOME` |                                                                         |
|                     | directory. There is a top level directory called `ORACLE_BASE` that     |                                                                         |
|                     | by default is `C:\oracle\product\10.1.0`. If you install the latest    |                                                                         |
|                     | Oracle release on a computer with no other Oracle software installed,    |                                                                         |
|                     | then the default setting for the first Oracle home directory is        |                                                                         |
|                     | `C:\oracle\product\10.1.0\db_n`, where `n` is the latest Oracle home    |                                                                         |
|                     | number. The Oracle home directory is located directly under `           |                                                                         |
|                     | ORACLE_BASE`.                                                           |                                                                         |
|                     | All directory path examples in this guide follow OFA conventions.       |                                                                         |
|                     | Refer to Oracle Database Installation Guide for Windows for additional  |                                                                         |
|                     | information about OFA compliances and for information about installing |                                                                         |
|                     | Oracle products in non-OFA compliant directories.                       |                                                                         |
What's New in Oracle Database for Windows

This section describes new features of Oracle Database and provides pointers to additional information. New features information from previous releases is also retained to help those users migrating to the current release.

The following sections describe new features:

- Oracle Database 10g Release 1 (10.1) New Features
- Oracle9i Release 2 (9.2.0.2) New Feature
- Oracle9i Release 2 (9.2) New Features
- Oracle9i Release 1 (9.0.1) New Features

Oracle Database 10g Release 1 (10.1) New Features

This section contains these topics:

- Large Page Support
- Scheduler
- Database Password Encryption
- Data Pump Import and Export

Large Page Support

Large page support provides a performance boost for memory-intensive database servers running on Windows Server 2003. By taking advantage of newly introduced operating system support, Oracle Database 10g Release 1 (10.1) can now make more efficient use of processor memory addressing resources.

See Also: "Large Page Support" on page 7-2

Scheduler

This release includes a new database scheduler to provide enterprise scheduling functionality. External jobs performed by the user are started using the OracleJobScheduler service. This service is disabled by default. In order to use the external jobs functionality, the administrator must set the username and password for the user account under which this service must run, and enable the service.

Restricting execution of external jobs to a low-privileged user prevents any random database user from gaining operating system level privileges, but it also places restrictions on the kinds of jobs that can be run. Jobs requiring a higher level of operating system privileges cannot be run by this mechanism.
On Windows, running an external job involves the following processes:

- Job slave process (one for each job)
- extjob service (one service, with one thread for each job)
- The actual external executable or job (one for each external job)

**See Also:**

- "The Scheduler" in *Oracle Database New Features*
- "Overview of Scheduler Concepts" in *Oracle Database Administrator’s Guide*
- "Using the Scheduler" in *Oracle Database Administrator’s Guide*
- "Managing the Scheduler" in *Oracle Database Administrator’s Guide*

**Database Password Encryption**
When a user attempts a remote login to Oracle Database, the password is automatically encrypted before it is sent to the remote database. For more information, see "Automatically Encrypted Database Passwords" on page 5-12.

**Data Pump Import and Export**
Two new utilities offer faster transfer of files to and from Oracle Database. The older file transfer utilities, Import and Export, are retained for use with databases created with earlier versions of Oracle software. For more information on Data Pump Import and Export, see Chapter 2, "Database Tools on Windows".

---

**Oracle9i Release 2 (9.2.0.2) New Feature**

Beginning with Oracle9i release 2 (9.2.0.2) for 64-bit Windows, Oracle supports 64-bit processing in the following operating systems:

- Windows Server 2003 for 64-bit Itanium 2 Systems

Most of the features and functions of the 32-bit version carry over to the 64-bit version. Differences between them are noted where applicable in the text and discussed in full in Appendix G, "Oracle Database for 64-Bit Windows".

---

**Oracle9i Release 2 (9.2) New Features**

This section contains these topics:

- Very Large Memory Support
- User Migration Utility

**Very Large Memory Support**
Oracle9i release 2 (9.2) for Windows supports Very Large Memory (VLM) configurations in Windows 2000 and Windows XP, which allow Oracle9i release 2 (9.2) to access more than the 4 gigabyte (GB) of RAM traditionally available to Windows applications. For more information, see "Oracle Database Scalability on Windows" on page 1-4.
User Migration Utility
A new command-line tool, User Migration Utility, simplifies conversion of local or external database users to enterprise users. For more information, see:

- Database Tools on Windows on page 2-1
- Manually Migrating Users on page 9-30
- "Using the User Migration Utility" in Oracle Advanced Security Administrator’s Guide

Oracle9i Release 1 (9.0.1) New Features
This section contains these topics:

- Windows XP Support
- Database Configuration Assistant Improvements
- Oracle Internet Directory Administration Improvements
- Using Oracle Database on Windows 2000
- CONNECT INTERNAL Not Supported
- Server Manager Not Supported

Windows XP Support
Oracle9i release 1 (9.0.1.1.1) for Windows is certified on the 32-Bit version of Windows XP Professional Edition.

Oracle provides support information for components on various platforms, lists compatible client and database versions, and identifies patches and workaround information. Find the latest certification information at

http://metalink.oracle.com/

You must register online before using OracleMetaLink. After logging into OracleMetaLink, select Product Lifecycle from the left-hand column.

Database Configuration Assistant Improvements
Database Configuration Assistant has been redesigned to include database definitions saved as templates. The templates can generate databases. Users can define new templates, modify existing templates, or use the ones Oracle provides. When creating a database with Database Configuration Assistant, users can include new Sample Schemas provided by Oracle.

Oracle Internet Directory Administration Improvements
Administration of Oracle Internet Directory replication server has been improved with the addition of new replication queue management and reconciliation tools.

Using Oracle Database on Windows 2000
There are some differences between using Oracle Database on Windows 2000 and Windows NT 4.0. For more information, see Appendix E, "Using Oracle Database on Windows 2000".
CONNECT INTERNAL Not Supported

CONNECT INTERNAL and CONNECT INTERNAL/PASSWORD are not supported in Oracle9i. Use the following instead:

CONNECT / AS SYSDBA
CONNECT username/password AS SYSDBA

Server Manager Not Supported

Server Manager is not supported in Oracle9i. Use SQL*Plus instead. Most Server Manager scripts should work in a SQL*Plus environment, but some scripts may need to be modified.
This chapter describes how Oracle Database architecture takes advantage of some of the more advanced services in Windows operating systems.

This chapter contains these topics:

- Oracle Database on Windows Architecture
- Oracle Database Scalability on Windows
- Oracle Database Integration with Windows
- Other Sources of Information

**Oracle Database on Windows Architecture**

Oracle Database on Windows is a stable, reliable, and high performing system upon which to build applications. Each release of the database provides new platform-specific features for high performance on Windows.

Oracle Database operates the same way on Windows as it does on other platforms. The architecture offers several advantages on Windows, such as:

- Thread-Based Architecture
- File I/O Enhancements
- Raw File Support

**Thread-Based Architecture**

The internal process architecture of Oracle Database is thread-based. Threads are objects within a process that run program instructions. Threads allow concurrent operations within a process so that a process can run different parts of its program simultaneously on different processors. A thread-based architecture provides the following advantages:

- Faster context switching
- Simpler System Global Area allocation routine, because it does not require use of shared memory
- Faster spawning of new connections, because threads are created more quickly than processes
- Decreased memory usage, because threads share more data structures than processes
Internally, the code to implement the thread model is compact and separate from the main body of Oracle Database code. Exception handlers and routines track and de-allocate resources. They add robustness, with no downtime because of resource leaks or an ill-behaved program.

Oracle Database is not a typical Windows process. On Windows, an Oracle Database instance (threads and memory structures) is a Windows service: a background process registered with the operating system. The service is started by Windows and requires no user interaction to start. This enables the database to open automatically at startup.

When running multiple Oracle Database instances on Windows, each instance runs its own Windows service with multiple component threads. Each thread may be required for the database to be available, or it may be optional and specific to certain platforms. The background processes read and write from various datafiles, depending on your configuration. Oracle Database architecture on Windows is illustrated in Figure 1–1. Examples of optional and required threads on Windows are listed in Table 1–1.

Figure 1–1 Oracle Database architecture on Windows
Oracle Database for Windows is supplied as a set of executables and dynamic link libraries (DLLs). Executable images can be modified using ORASTACK to change the size of the stack used by the threads of the Oracle Database process. (Oracle recommends you use this tool only under the guidance of Oracle Support Services.)

File I/O Enhancements

Oracle Database supports 64-bit file I/O to allow use of files larger than 4 gigabytes (GB). In addition, physical and logical raw files are supported as data, log, and control files to support Oracle Real Application Clusters on Windows and for those cases where performance needs to be maximized.

All Oracle Database file I/O routines support 64-bit file offsets, meaning there are no 2 GB or 4 GB file size limitations when it comes to data, log, or control files, as there are on some other platforms. In fact, the limitations that are in place are generic Oracle Database limitations across all platforms. These limits include 4 million database blocks for each file, 16KB maximum block size, and 64K files for each database. If these values are multiplied, then maximum file size for a database file on Windows is 64 GB, and maximum total database size supported (with 16KB database blocks) is 4 petabytes.

Raw File Support

Windows supports raw files, similar to UNIX. Using raw files for database or log files can have a slight performance gain. Raw files are unformatted disk partitions that can be used as one large file. Raw files have the benefit of no file system overhead, because they are unformatted partitions. However, standard Windows commands do not support manipulating or backing up raw files. As a result, raw files are generally used only by very high-end installations and by Oracle Real Application Clusters, where they are required.

To Oracle Database, raw files are no different from other Oracle Database files. They are treated in the same way by Oracle Database as any other file and can be backed up and restored through Recovery Manager or OCOPY.
Oracle Database Scalability on Windows

Features in Oracle Database and in the Windows operating system work together to help increase scalability, throughput, and database capacity. These features include:

- Support for Very Large Memory (VLM) Configurations
- 4 GB RAM Tuning (4GT)
- Large User Populations

Support for Very Large Memory (VLM) Configurations

Oracle Database for Windows supports Very Large Memory (VLM) configurations in Windows 2000 and Windows XP, which allows Oracle Database to access more than the 4 gigabyte (GB) of RAM traditionally available to Windows applications.

Note: This feature is not supported on Windows NT, and it is available on Windows 2000 and Windows XP only with Intel Pentium II and Pentium III Xeon 32-bit processors.

Note: Oracle Database for 64-bit Windows does not support VLM. See "Oracle Database Architecture on 64-Bit Windows" on page G-2.

Specifically, Oracle Database uses Address Windowing Extensions (AWE) built into Windows 2000 and Windows XP to access more than 4 GB of RAM.

The requirements for taking advantage of this support are:

1. The computer on which Oracle Database is installed must have more than 4 GB of memory.
2. The operating system must be configured to take advantage of Physical Address Extensions (PAE) by adding the /PAE switch in boot.ini. See Microsoft Knowledge Base article Q268363 for instructions on modifying boot.ini to enable PAE.
3. It is advisable (though not necessary) to enable 4GT support by adding the /3GB parameter in boot.ini. See Microsoft Knowledge Base article Q171793 for additional requirements and instructions on modifying boot.ini to enable 4GT.
4. The user account under which Oracle Database runs (typically the LocalSystem account), must have the "Lock memory pages" Windows 2000 and Windows XP privilege.
5. USE_INDIRECT_DATA_BUFFERS=TRUE must be present in the initialization parameter file for the database instance that will use VLM support. If this parameter is not set, then Oracle Database 10g Release 1 (10.1) behaves in exactly the same way as previous releases.
6. Initialization parameters DB_BLOCK_BUFFERS and DB_BLOCK_SIZE must be set to values you have chosen for Oracle Database.
7. **Registry parameter** `AWE_WINDOW_MEMORY` **must be created and set in the appropriate key for your Oracle home.** This parameter is specified in bytes and has a default value of 1 GB. `AWE_WINDOW_MEMORY` tells Oracle Database how much of its 3 GB address space to reserve for mapping in database buffers.

This memory comes from the 3 GB virtual address space in Oracle Database, so its value must be less than 3 GB. Setting this parameter to a large value has the effect of using more of the address space for buffers and using less AWE memory for buffers. However, since accessing AWE buffers is somewhat slower than accessing virtual address space buffers, Oracle recommends that you tune these parameters to be as large as possible without adversely limiting database operations.

In general, the higher `AWE_WINDOW_MEMORY` is set, the fewer connections and memory allocations will be possible for Oracle Database. The lower `AWE_WINDOW_MEMORY` is set, the lower the performance.

8. **Once this parameter is set, Oracle Database can be started and will function exactly the same as before except that more database buffers are available to the instance.** In addition, disk I/O may be reduced because more Oracle Database data blocks can be cached in the **System Global Area (SGA).**

---

**Note:** The total number of bytes of database buffers (that is, `DB_BLOCK_BUFFERS` multiplied by `DB_BLOCK_SIZE`) is no longer limited to 3 GB.

Dynamic SGA and multiple block size are not supported with VLM. When VLM is enabled, the following new buffer cache parameters are not supported:

- `DB_CACHE_SIZE`
- `DB_2K_CACHE_SIZE`
- `DB_4K_CACHE_SIZE`
- `DB_8K_CACHE_SIZE`
- `DB_16K_CACHE_SIZE`
- `DB_32K_CACHE_SIZE`

To select the block size for the instance, use the initialization parameter `DB_BLOCK_SIZE`. The buffer cache size is set by the initialization parameter `DB_BLOCK_BUFFERS`.

---

**VLM Instance Tuning**

VLM configurations improve database performance by caching more database buffers in memory. This reduces disk I/O compared to configurations without VLM. VLM support in Oracle Database 10g Release 1 (10.1) has been re-written to integrate very closely with Windows. Compared to Oracle8i release 2 (8.1.6), VLM users should see better performance with the newer implementation.
Tuning for VLM is no different than tuning for configurations without VLM. It is an iterative task that begins by selecting appropriate `DB_BLOCK_SIZE` and `DB_BLOCK_BUFFERS` initialization parameters for the application being supported.

**Note:** Oracle Database 10g Release 1 (10.1) VLM configurations do not support multiple database block sizes.

`AWE_WINDOW_MEMORY`, a new registry parameter specific to VLM, tells Oracle Database how much of its address space to reserve for mapping in database buffers. It defaults to a value of 1 GB, which should be suitable for most installations. If `DB_BLOCK_SIZE` is large, however, the default `AWE_WINDOW_MEMORY` value of 1 GB may not be sufficient to start the database.

Increasing the value of `AWE_WINDOW_MEMORY` will improve performance, but it will also limit the amount of memory available for other Oracle Database threads (like foreground threads). Clients may see “out of memory” errors if this value is set too large. As a general guideline, increase the `AWE_WINDOW_MEMORY` registry value by 20 percent.

For example, if `DB_BLOCK_SIZE` is set to 8 KB, `AWE_WINDOW_MEMORY` is set to 1 GB, and the number of LRU latches is set to 32 (16 processor computer), then database startup fails with out of memory errors 27102 and 34. Increasing the value of `AWE_WINDOW_MEMORY` to 1.2 GB fixes the problem.

Having a large cache in a VLM configuration may also slow down database writer (DBWR) threads. Having more DBWR threads will distribute work required to identify and write buffers to disk and will distribute I/O loads among threads. Initialization parameter `DB_WRITER_PROCESSES` enables you to configure multiple database writer threads.

A large cache can also introduce contention on the LRU (least recently used) latch. On symmetric multiprocessor (SMP) systems, Oracle Database sets the number of LRU latches to a value equal to one half the number of processors on the system. You can reduce contention on such configurations by increasing the number of LRU latches to twice (or four times) the number of processors on the system.

**See Also:** Oracle Database Performance Tuning Guide for more information on instance tuning

### 4 GB RAM Tuning (4GT)

The following Windows operating systems include a feature called 4 GB RAM Tuning (4GT):

- Windows Server 2003
- Windows 2000 Advanced Server
- Windows 2000 Datacenter Server
- Windows NT 4.0 Enterprise Edition

This feature allows memory-intensive applications running on Oracle Database Enterprise Edition to access up to 3 GB of memory, as opposed to the standard 2 GB in previous operating system versions. 4GT provides a tremendous benefit: 50 percent more memory is available for database use, increasing SGA sizes or connection counts.
Large User Populations

Several features allow Oracle Database to support an increasingly large number of database connections on Windows:

- Oracle Database Shared Server Process, which limits the number of threads needed in the Oracle Database process, supports over 10,000 simultaneous connections to a single database instance.

- Oracle Net multiplexing and connection pooling features allow a large configuration to connect more users to a single database instance.

- Oracle Real Application Clusters raises connection counts dramatically by allowing multiple server computers to access the same database files, increasing the number of user connections by tens of thousands, as well as increasing throughput.

Note: Oracle Real Application Clusters is not supported on Windows XP.

Oracle Database Integration with Windows

Oracle Database is increasingly integrated with Windows, easing maintenance and improving enterprise-level deployment in security, directory, and transaction services. Integration features in Oracle Database include:

- Oracle PKI Integration with Windows
- Oracle Services for Microsoft Transaction Server
- Oracle Fail Safe Integration with Windows
- Oracle Real Application Clusters Integration with Windows

Oracle PKI Integration with Windows

Oracle Advanced Security includes Oracle PKI (public key infrastructure) integration for authentication and single sign-on. You can integrate Oracle-based applications with the PKI authentication and encryption framework, using Oracle Wallet Manager.

Oracle Services for Microsoft Transaction Server

Microsoft Transaction Server (MTS) is used in the middle tier as an application server for COM/COM+ objects and transactions in distributed environments. In Windows 2000 and Windows XP it is part of COM+. Oracle Services for Microsoft Transaction Server allows Oracle Database to be used as a resource manager in Microsoft Transaction Server-coordinated transactions, providing strong integration between Oracle solutions and Microsoft Transaction Server. Oracle Services for Microsoft Transaction Server can operate with Oracle Database running on any operating system.
Oracle Database takes advantage of a native implementation and also stores recovery information in Oracle Database itself. Oracle Services for Microsoft Transaction Server allows development in all industry-wide data access interfaces, including Oracle Objects for OLE (OO4O), Oracle Call Interface (OCI), ActiveX Data Objects (ADO), OLE DB, and Open Database Connectivity (ODBC). The Oracle APIs, OO4O and OCI, offer greatest efficiency.

**Oracle Fail Safe Integration with Windows**

Oracle Fail Safe ensures that Oracle Database (and also other Oracle and third-party applications) can be configured and managed for high availability on Windows clusters. An instance runs on only one node at a time.

A cluster is a group of independent computing systems that operates as a single virtual system, eliminating individual host systems as points of failure. Oracle Fail Safe works with Microsoft Cluster Server to ensure that if a failure occurs on one cluster system, then workloads running on that system fail over quickly and automatically to a surviving system. Oracle Database combined with Oracle Fail Safe on a Windows cluster ensures protection from both hardware and software failures.

For well-configured solutions, Oracle Fail Safe ensures a surviving system to be operational in less than a minute, even for heavily-used databases.

---

**Note:** Windows XP does not support the clustering technology found in Microsoft Cluster Server. Therefore, Oracle Fail Safe Server, which integrates with Microsoft Cluster Server, is not supported on Windows XP. Oracle Fail Safe Manager Console is supported.

---

**See Also:** Your Oracle Fail Safe documentation set, available on separate media in the Oracle CD-ROM package

**Oracle Real Application Clusters Integration with Windows**

Oracle Real Application Clusters are integrated with Microsoft Cluster Server clusters deployed on all Windows operating systems that support clustering. This enhances high availability features of Oracle Real Application Clusters by offering:

- Optional automatic restarts of a failed instance or listener in a cluster
- Detection and resolution of instance hangs
- Elimination of connect-time failover TCP/IP timeout delays for new connection requests
- Use of user-written scripts after database state (online/offline) changes

**Other Sources of Information**

**See Also:**

- Appendix F, "Oracle Database Windows/UNIX Differences"
- Chapter 2, "Database Tools on Windows", for Oracle Database integration with Windows tools
- Chapter 15, "Developing Applications for Windows", for more Oracle Database integration with Windows features
Oracle Database for Windows includes various tools to perform database functions. This chapter describes preferred tools to perform common database administration tasks and explains how tools can be started.

Unless otherwise noted, features described in this guide are common to Oracle Database Enterprise Edition, Oracle Database Standard Edition, and Oracle Database Personal Edition.

This chapter contains these topics:

- Choosing a Database Tool
- Starting Database Tools
- Using SQL*Loader
- Using Windows Tools
- Optional Windows Diagnostic and Tuning Utilities

Choosing a Database Tool

Database tools is a collective term for tools, utilities, and assistants that you can use to perform database administration tasks. Some database tools perform similar tasks, though no one database tool performs all database administration tasks. The following sections indicate which database tools can be used on particular operating systems and preferred tools to use for common database administration tasks.

---

**Note:** Oracle Server Manager is no longer shipped as of Oracle9i release 2 (9.2). All Server Manager text and examples have been replaced with SQL*Plus equivalents.

Additionally, connecting to the database as `CONNECT INTERNAL/` is no longer supported.

SQL>`CONNECT INTERNAL/password@tnsalias`

has been replaced by:

SQL>`CONNECT SYS/password@tnsalias AS SYSDBA`
Choosing a Database Tool

Database Tools and Operating System Compatibility
Almost all database tools are available on all supported versions of Windows. The exceptions are:

- Pro*COBOL, Oracle Portal, and Oracle Migration Workbench are not supported on Oracle Database for 64-bit Windows. See "Database Tools for 64-Bit Windows" on page G-2.

Note: Oracle Migration Workbench is available only at OTN. See http://otn.oracle.com/tech/migration/content.html

- Oracle Advanced Security includes Enterprise Security Manager Console and Oracle Wallet Manager. These are available only with Oracle Database Enterprise Edition and Oracle Database Personal Edition, and not Oracle Database Standard Edition. To learn whether they were installed or not, see your installActions.log at C:\Program Files\Oracle\Inventory\logs.

- Oracle Enterprise Manager and its optional management packs have additional integrated tools to assist in managing databases. See Oracle Enterprise Manager Concepts for more information.

- Microsoft Management Console must be obtained from Microsoft Corporation for use with Windows NT 4.0.

Preferred Database Tools
Table 2–1 lists various database tools you can use to perform common database administration tasks. Oracle recommends you use tools listed in the "Preferred Database Tool" column of the table. After choosing a tool to perform a task, go to Table 2–2, "Starting Database Tools from the Start Menu", on page 2-5 for instructions on how to start the tool.

Note: The VOLSIZE parameter for Export and Import utilities is not supported on Windows. If you attempt to use the utilities with the VOLSIZE parameter, then error LRM-00101 occurs. For example:

D:\> exp system/manager full=y volsize=100m;  
LRM-00101: unknown parameter name 'volsize'  
EXP-00019: failed to process parameters, type 'EXP HELP=Y' for help  
EXP-00000: Export terminated unsuccessfully

<table>
<thead>
<tr>
<th>Administration Task</th>
<th>Preferred Tool</th>
<th>Other Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a database</td>
<td>Database Configuration Assistant</td>
<td>SQL*Plus Worksheet</td>
</tr>
<tr>
<td>Delete database services</td>
<td>Database Configuration Assistant</td>
<td>ORADIM</td>
</tr>
<tr>
<td>Start a database</td>
<td>Oracle Enterprise Manager Console</td>
<td>SQL<em>Plus or SQL</em>Plus Worksheet</td>
</tr>
<tr>
<td>Shut down a database</td>
<td>Oracle Enterprise Manager Console</td>
<td>Control Panel</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SQL<em>Plus or SQL</em>Plus Worksheet</td>
</tr>
<tr>
<td>Change database passwords</td>
<td>ORAPWD</td>
<td>ORADIM</td>
</tr>
</tbody>
</table>
Choosing a Database Tool

The following points refer to tools listed in Table 2–1, "Preferred Database Tools":

- SQL*Plus Worksheet is part of Oracle Enterprise Manager.
- ORADIM can only set a password when none was previously set. If a password has been previously set, then ORADIM can change it only by deleting and re-creating Oracle Database services.
- User Migration Utility can migrate local or external users to enterprise users. For more information, see "Using the User Migration Utility" in Oracle Advanced Security Administrator’s Guide.
- Oracle Database Upgrade Assistant can upgrade the following databases to the current release: Oracle7 release 7.3.4, Oracle8 release 8.0.6, Oracle8i releases 8.1.5, 8.1.6, and 8.1.7, Oracle9i releases 1 (9.0.1) and 2 (9.2). It cannot be used to upgrade an earlier Oracle7 release to a later Oracle7 release. See your Oracle7 for Windows NT documentation for information on how to upgrade from one Oracle7 database to another.
- Data Pump Export and Data Pump Import are preferred for Oracle Database 10g Release 1 (10.1) data; Export and Import are preferred for earlier data.

<table>
<thead>
<tr>
<th>Administration Task</th>
<th>Preferred Tool</th>
<th>Other Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td>Migrate database users to a directory</td>
<td>User Migration Utility</td>
<td>None</td>
</tr>
<tr>
<td>Migrate a database</td>
<td>Oracle Database Upgrade Assistant</td>
<td>Upgrade Information Tool</td>
</tr>
<tr>
<td>Upgrade a database</td>
<td>Oracle Database Upgrade Assistant</td>
<td>Run provided scripts in SQL*Plus</td>
</tr>
<tr>
<td>Export data</td>
<td>Data Pump Export (EXPDP)</td>
<td>Export (EXP)</td>
</tr>
<tr>
<td>Import data</td>
<td>Data Pump Import (IMPDP)</td>
<td>Import (IMP)</td>
</tr>
<tr>
<td>Load data</td>
<td>Oracle Enterprise Manager Load Wizard</td>
<td>SQL*Loader (SQLLLDR)</td>
</tr>
<tr>
<td>Back up database</td>
<td>Oracle Enterprise Manager Backup Wizard</td>
<td>Recovery Manager (RMAN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OCOPY</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Legato Single Server Version</td>
</tr>
<tr>
<td>Recover database</td>
<td>Oracle Enterprise Manager Recovery Wizard</td>
<td>Recovery Manager (RMAN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OCOPY</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Legato Single Server Version</td>
</tr>
<tr>
<td>Authenticate database administrators and users</td>
<td>Oracle Enterprise Manager Console</td>
<td>SQL<em>Plus or SQL</em>Plus Worksheet</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Windows operating system</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Oracle Administration Assistant for</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Windows</td>
</tr>
<tr>
<td>Store encrypted and decrypted</td>
<td>Oracle Wallet Manager</td>
<td>None</td>
</tr>
<tr>
<td>Oracle Wallet (Oracle Advanced Security and</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oracle PKI integration)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Grant database roles</td>
<td>Oracle Enterprise Manager Console</td>
<td>Local Users and Groups</td>
</tr>
<tr>
<td></td>
<td></td>
<td>User Manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SQL*Plus</td>
</tr>
<tr>
<td>Create database objects</td>
<td>Oracle Enterprise Manager Console</td>
<td>SQL*Plus</td>
</tr>
</tbody>
</table>

Table 2–1 (Cont.) Preferred Database Tools

<table>
<thead>
<tr>
<th>Administration Task</th>
<th>Preferred Tool</th>
<th>Other Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>SQL*Plus</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows operating system</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Oracle Administration Assistant for</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SQL*Plus</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SQL*Plus</td>
<td></td>
</tr>
</tbody>
</table>

Database Tools on Windows  2-3
When upgrading a database, the provided scripts in SQL*Plus are required when upgrading Oracle Real Application Clusters systems.

If you back up files while you are shutting down the database, then your backup will be invalid. You cannot use an invalid backup to restore files at a later date.

You cannot use earlier versions of Oracle Wallet Manager to manage Oracle Database 10g Release 1 (10.1) wallets that contain password-based credentials for authentication to Oracle Internet Directory. These credentials are placed in the wallet when an Oracle Database server is registered in Oracle Internet Directory. The database wallet that Database Configuration Assistant automatically generates during database registration can only be used with an Oracle Database 10g Release 1 (10.1) server. You cannot use this database wallet for earlier versions of the database, nor can you use it for Oracle Internet Directory Release 9.0.4 or earlier.

For guidelines on creating database objects, see Oracle Database Administrator’s Guide.

Oracle Enterprise Manager Grid Control can manage a 64-bit Windows database from a remote 64-bit Solaris computer. For more information, see Appendix G, “Oracle Database for 64-Bit Windows”.

Oracle Enterprise Manager Console is not supported in Oracle Database for 64-bit Windows. For more information, see Appendix G, “Oracle Database for 64-Bit Windows”.

Starting Database Tools

This section describes how to start each of the database tools in the following categories:

- Starting Database Tools in Multiple Oracle Homes
- Starting Database Tools from the Start Menu
- Starting Database Tools from the Command Line
- Starting Windows Tools

You will be referred back to this section for database tool startup procedures as you use this guide.

Starting Database Tools in Multiple Oracle Homes

If you have multiple Oracle homes on your computer from previous releases, then see Appendix B, "Optimal Flexible Architecture", in Oracle Database Installation Guide for Windows for a description of differences between Oracle homes before and after Oracle Database 10g Release 1 (10.1).

Starting Tools from Oracle8 Release 8.0.4 and Later 8.0.x Multiple Oracle Homes

If you are using multiple Oracle homes, then the command to start a tool from any home other than the first includes a HOME_NAME, where HOME_NAME indicates the name of that Oracle home. The first Oracle home created on your computer does not have HOME_NAME appended to the group.

To start Oracle Administration Assistant for Windows from the first Oracle home, choose Start > Programs > Oracle > Configuration and Migration Tools > Administration Assistant for Windows.
To start Oracle Administration Assistant for Windows from an additional Oracle home, choose Start > Programs > Oracle - HOME_NAME > Configuration and Migration Tools > Administration Assistant for Windows.

Starting Tools from Oracle8i Release 8.1.3 and Later Multiple Oracle Homes
Beginning in Oracle8i release 8.1.3, each Oracle home, including the first Oracle home you create on your computer, has a unique HOME_NAME. To start Oracle Administration Assistant for Windows from any Oracle home, choose Start > Programs > Oracle - HOME_NAME > Configuration and Migration Tools > Administration Assistant for Windows.

Starting Database Tools from the Start Menu
Table 2–2 describes how to start assistants and other tools from the Start Menu. It also tells where to go for further information on using these products.

Note: When you use an assistant, you must have read and write access to the directory where database files will be moved or created. To create an Oracle Database, you must have an administrative privilege. If you run Database Configuration Assistant from an account that is not part of the Administrators group, then the tool exits without completing the operation.

Note: All Start Menu paths begin with choose Start > Programs > Oracle - HOME_NAME >.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Start Menu Path</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Administration Assistant for Windows</td>
<td>Configuration and Migration Tools &gt; Administration Assistant for Windows</td>
<td>Chapter 8, &quot;Authenticating Database Users with Windows&quot;</td>
</tr>
<tr>
<td>Oracle Database Upgrade Assistant</td>
<td>Configuration and Migration Tools &gt; Database Upgrade Assistant</td>
<td>Oracle Database Upgrade Guide</td>
</tr>
<tr>
<td>Database Configuration Assistant</td>
<td>Configuration and Migration Tools &gt; Database Configuration Assistant</td>
<td>&quot;Creating a Database on Windows Using Database Configuration Assistant&quot; on page 3-2</td>
</tr>
</tbody>
</table>
| Oracle Enterprise Manager Console | Enterprise Manager Console                           | Oracle Enterprise Manager Console is available from the Start Menu only with Oracle Database Client.  
Oracle Database 2 Day DBA |
| Oracle Locale Builder            | Configuration and Migration Tools > Locale Builder    | Oracle Database Globalization Support Guide            |
| Microsoft ODBC Administrator     | Configuration and Migration Tools > Microsoft ODBC Administration | Microsoft ODBC Administration online help              |
| Oracle Migration Workbench       | Configuration and Migration Tools > Migration Workbench | Oracle Migration Workbench software and documentation are available at http://otn.oracle.com/tech/migration/ |
Starting Database Tools

Table 2–2 (Cont.) Starting Database Tools from the Start Menu

<table>
<thead>
<tr>
<th>Tool</th>
<th>Start Menu Path</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Net Configuration Assistant</td>
<td>Configuration and Migration Tools &gt; Net Configuration Assistant</td>
<td>Oracle Net Services Administrator’s Guide</td>
</tr>
<tr>
<td>Oracle Net Manager</td>
<td>Configuration and Migration Tools &gt; Net Manager</td>
<td>Oracle Net Services Administrator’s Guide</td>
</tr>
<tr>
<td>SQL*Plus Worksheet</td>
<td>Application Development &gt; SQL*Plus Worksheet</td>
<td>SQL*Plus Worksheet is available from the Start Menu only with Oracle Database Client. Oracle Enterprise Manager Administrator’s Guide</td>
</tr>
<tr>
<td>Oracle Wallet Manager</td>
<td>Integrated Management Tools &gt; Wallet Manager</td>
<td>Oracle Advanced Security Administrator’s Guide</td>
</tr>
</tbody>
</table>

Note: After installing Oracle Database 10g Companion Products, Oracle Wallet Manager is not available from the Start menu. See Table 2–3, "Starting Database Tools from the Command Line" on page 2-7 for instructions on starting Oracle Wallet Manager from the command line.

Note: Oracle Enterprise Manager Console (Java-based) and Oracle Enterprise Manager Grid Control CD are not supported in Oracle Database for 64-bit Windows. Use Oracle Enterprise Manager Grid Control from your 64-bit Solaris system to manage the 64-bit computer nodes remotely. See Appendix G, "Oracle Database for 64-Bit Windows".

Starting Database Tools from the Command Line

Table 2–3 describes how to start Oracle Database tools from the command line, and where to go for further information on using these products.
### Table 2–3 Starting Database Tools from the Command Line

<table>
<thead>
<tr>
<th>Tool</th>
<th>Enter at Prompt</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Enterprise Manager Console</td>
<td>C:&gt; oemapp console</td>
<td>Oracle Enterprise Manager Console is installed only with Oracle Database Client</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>Oracle Database 2 Day DBA</em></td>
</tr>
<tr>
<td>DBVERIFY</td>
<td>C:&gt; dbv</td>
<td><em>Oracle Database Utilities</em></td>
</tr>
<tr>
<td></td>
<td>DBVERIFY starts and prompts you for a filename parameter. To obtain a list of parameters, enter:</td>
<td>C:&gt; dbv help=y</td>
</tr>
<tr>
<td>Data Pump Export</td>
<td>C:&gt; expdp username/password</td>
<td><em>Oracle Database Utilities</em> for instructions on use of Data Pump Export</td>
</tr>
<tr>
<td></td>
<td>EXPDP starts and prompts you for parameters. To obtain a list of these parameters, enter:</td>
<td>C:&gt; expdp help=y</td>
</tr>
<tr>
<td>Data Pump Import</td>
<td>C:&gt; impdp username/password</td>
<td><em>Oracle Database Utilities</em> for instructions on use of Data Pump Import</td>
</tr>
<tr>
<td></td>
<td>IMPDP starts and prompts you for parameters. To get a list of these parameters, enter:</td>
<td>C:&gt; impdp help=y</td>
</tr>
<tr>
<td>Export</td>
<td>C:&gt; exp username/password</td>
<td><em>Oracle Database Utilities</em> for instructions on use of Export</td>
</tr>
<tr>
<td></td>
<td>EXP starts and prompts you for parameters. To obtain a list of these parameters, enter:</td>
<td>C:&gt; exp help=y</td>
</tr>
<tr>
<td>Import</td>
<td>C:&gt; imp username/password</td>
<td><em>Oracle Database Utilities</em> for instructions on use of Import</td>
</tr>
<tr>
<td></td>
<td>IMP starts and prompts you for parameters. To get a list of these parameters, enter:</td>
<td>C:&gt; imp help=y</td>
</tr>
<tr>
<td>operfcfg</td>
<td>C:&gt; operfcfg</td>
<td><em>Modifying Oracle Counters for Windows Performance Monitor Parameters</em> on page 14-14</td>
</tr>
<tr>
<td>Oracle Wallet Manager</td>
<td>C:&gt; cd ORACLE_BASE\ORACLE_HOME\bin</td>
<td>Chapter 10, &quot;Storing Oracle Wallets in the Windows Registry&quot;</td>
</tr>
<tr>
<td></td>
<td>C:&gt; ORACLE_BASE\ORACLE_HOME\bin&gt;launch.exe ORACLE_HOME\bin owm.cl</td>
<td></td>
</tr>
<tr>
<td>ORADIM</td>
<td>C:&gt; oradim options</td>
<td><em>Using ORADIM to Administer an Oracle Database Instance</em> on page 3-12</td>
</tr>
<tr>
<td></td>
<td>To get a list of ORADIM options, enter either of the following:</td>
<td>C:&gt; oradim</td>
</tr>
<tr>
<td></td>
<td></td>
<td>C:&gt; oradim -?</td>
</tr>
<tr>
<td>Password Utility (ORAPWD)</td>
<td>C:&gt; orapwd</td>
<td><em>Creating and Populating Password Files</em> on page 5-9</td>
</tr>
<tr>
<td></td>
<td>Password file is hidden. Use Windows Explorer to see it in a file list. Choose View &gt; Options &gt; View &gt; Show All Files</td>
<td></td>
</tr>
<tr>
<td>Recovery Manager (RMAN)</td>
<td>C:&gt; rman parameters</td>
<td><em>Oracle Database Backup and Recovery Basics</em></td>
</tr>
<tr>
<td>SQL*Plus (SQLPLUS)</td>
<td>C:&gt; sqlplus</td>
<td><em>SQL</em>Plus User’s Guide and Reference <em>Starting and Shutting Down a Database with SQL</em>Plus* on page 5-5</td>
</tr>
</tbody>
</table>
Starting Database Tools

Table 2–4  (Cont.) Starting Database Tools from the Command Line

<table>
<thead>
<tr>
<th>Tool</th>
<th>Enter at Prompt</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL*Loader (SQLLDR)</td>
<td>C:&gt; sqlldr</td>
<td>Oracle Database Utilities</td>
</tr>
<tr>
<td></td>
<td>SQL*Loader displays a Help screen with available keywords and default values.</td>
<td>Oracle Database Error Messages</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;Starting Windows Tools&quot; on page 2-8</td>
</tr>
<tr>
<td>TKPROF</td>
<td>C:&gt; tkprof</td>
<td>Oracle Database Performance Tuning Guide</td>
</tr>
<tr>
<td>User Migration Utility</td>
<td>C:&gt; umu parameters</td>
<td>&quot;Using the User Migration Utility&quot; in Oracle Advanced Security Administrator’s Guide</td>
</tr>
<tr>
<td></td>
<td>To get a list of parameters, enter:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>C:&gt; umu help=yes</td>
<td></td>
</tr>
</tbody>
</table>

Note: Three special conditions apply when running Export or Import utilities on Windows. First, default values for BUFFER and RECORDLENGTH parameters are 4 KB and 2 KB respectively. This default RECORDLENGTH parameter does not depend on the value of BUFSIZE defined in the system header file. If you specify a value larger than USHRT_MAX (64 KB), you will get a warning message. Second, the VOLSIZE parameter is not supported. Third, to export an entire database, you must use the EXP_FULL_DATABASE role.

Note: Oracle Enterprise Manager Console is not supported in Oracle Database for 64-bit Windows. See Appendix G, "Oracle Database for 64-Bit Windows".

Starting Windows Tools

Table 2–4 describes how to start each Windows tool and where to go for more information on using these products.

Table 2–4  Starting Windows Tools

<table>
<thead>
<tr>
<th>Tool</th>
<th>Start Procedure</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Viewer</td>
<td>Choose Start &gt; Programs &gt; Administrative Tools &gt; Event Viewer</td>
<td>&quot;Using Event Viewer to Monitor a Database&quot; on page 2-11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Your operating system documentation</td>
</tr>
<tr>
<td>Microsoft Management</td>
<td>Choose Start &gt; Programs &gt; Oracle - HOME_NAME &gt; Configuration and Migration Tools &gt; Administration Assistant for Windows</td>
<td>Your operating system documentation</td>
</tr>
<tr>
<td>Console (MMC)(^1)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Your operating system documentation</td>
</tr>
<tr>
<td>Registry Editor</td>
<td>At the command prompt enter: C:&gt; regedt32</td>
<td>&quot;Using Registry Editor to Modify Configuration Information&quot; on page 2-12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chapter 14, &quot;Configuration Parameters and the Registry&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Your operating system documentation</td>
</tr>
</tbody>
</table>
This section describes Windows-specific information for using SQL*Loader (SQLLDR).

Windows Processing Options

This section discusses possible values for the operating system dependent file processing specifications string option (os_file_proc_clause), referred to in "Specifying Datafile Format and Buffering" in Chapter 8, "SQL*Loader Control File Reference", in Oracle Database Utilities.

Default (No Processing Option) or "str terminator_string"
Stream record format in which each record is terminated by a record terminator. If "str terminator_string" is not specified, then the record terminator defaults to either the Windows-style record terminator (the two-character sequence carriage return, \r, followed by line feed, \n) or the UNIX-style record terminator (single-character line feed, \n). Maximum record size is 48 KB.

When processing stream format data files, SQL*Loader can usually recognize record terminators automatically, whether they are Windows-style or UNIX-style. So you usually do not need to specify which record terminator you are using.

For external table loads, however, only Windows-style record terminators are recognized automatically. If your data file contains UNIX-style record terminators, you must specify the record terminator. If you are using SQL*Loader (with external_table option), then specify the UNIX-style record terminator by specifying "str \n" on the INFILE line in the SQL*Loader control file. For example:

INFILE mydata.dat 'str \n'

You can also specify the record terminator in hex, by specifying "str x'0a'" (assuming an ASCII-based character set). For example:

INFILE mydata.dat 'str x'0a'"
Note that the "0" (zero) before the "a" is required. If you are using SQL with an access parameter list to create the external table, then you must specify '\n' in a RECORDS DELIMITED BY clause. For example:

```sql
RECORDS DELIMITED BY '\n'
```

You can also use a hex string in this case. For example:

```sql
RECORDS DELIMITED BY 0x'0a'
```

Note that in this case, the "0" (zero) before the "x" and the "0" (zero) before the "a" are both required.

"FIX n"

Fixed record format in which each record is exactly $n$ bytes long. Record terminators are not required with fixed record format. If the record includes a record terminator, then the record terminator bytes are included in the number of bytes $n$.

"VAR n"

Variable record format in which the length of each record in a character field is included at the beginning of each record in the datafile. Record terminators are not required with the variable record format. This format provides some added flexibility over the fixed record format and a performance advantage over the stream record format. You can specify a datafile that is to be interpreted as being in variable record format as follows:

```sql
INFILE "mydata.dat" 'var n'
```

In this example, $n$ specifies the number of bytes in the record length field. If $n$ is not specified, SQL*Loader assumes a length of 5 bytes. Specifying $n$ larger than 40 will result in an error. Lengths are always interpreted in bytes, even if character-length semantics are in effect for the file. This is necessary because the file could contain a mix of fields, some processed with character-length semantics and others processed with byte-length semantics.

Case Study Files

The distribution media for SQL*Loader contains case study files for control files, datafiles, and setup files in `ulcase1,...ulcase11` in the following directory:

```
Oracle_Home\rdbms\demo
```

Specifying the Bad File

When SQL*Loader executes, it can create a file called a bad file or reject file in which it places records that were rejected because of formatting errors or because they caused Oracle Database errors. If you have specified that a bad file is to be created, it overwrites any existing file with the same name; ensure that you do not overwrite a file you wish to retain.

Control File Conventions

When preparing SQL*Loader control files (.ctl), you must follow certain syntax and notational conventions.

In full path descriptions, backslashes do not require escape characters or other special treatment. When embedding a single or double quotation mark inside a string
delimited by double quotation marks, place a backslash escape character before the embedded quotation mark.

When specifying datatypes in the SQL*Loader control file, note that the default sizes of native datatypes shown in Table 2–5 are specific to Windows. These datatypes can be loaded with correct results only between systems where they have the same length in bytes. You cannot override these defaults in the control file. If the byte order is different between the systems, you can indicate the byte order of the data with the \BYTEORDER parameter, or you can place a byte-order mark (BOM) in the file.

**Table 2–5  Default Sizes of Native Datatypes**

<table>
<thead>
<tr>
<th>Native Datatypes</th>
<th>Default Field Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOUBLE</td>
<td>8</td>
</tr>
<tr>
<td>FLOAT</td>
<td>4</td>
</tr>
<tr>
<td>INTEGER(^1)</td>
<td>4</td>
</tr>
<tr>
<td>SMALLINT</td>
<td>2</td>
</tr>
</tbody>
</table>

\(^1\) The default listed is correct if INTEGER is specified without a size. But INTEGER(n) is also allowed. In that case, n specifies the size of the INTEGER field in bytes.

See Also: Oracle Database Utilities for a complete list of options and instructions on using SQL*Loader

Using Windows Tools

You can use Windows tools in various ways to manage Oracle Database:

- Using Event Viewer to Monitor a Database
- Using Microsoft Management Console to Administer a Database
- Using Oracle Counters for Windows Performance Monitor
- Using Registry Editor to Modify Configuration Information
- Using Task Manager to Monitor Applications and Processes
- Using Local Users and Groups to Manage Users and Groups
- Using User Manager to Manage Users

Using Event Viewer to Monitor a Database

Event Viewer lets you monitor events in your system. An event is an important occurrence in the system or application (such as Oracle Database) that requires user notification. While messages for major events can appear on-screen as you work at your computer, events not requiring your immediate attention are recorded by Windows in the Event Viewer log file. You can then view this information at your convenience.

Event Viewer can be used to monitor Oracle Database events, such as:

- Initialization of **System Global Area** for active **instance**
- Initialization of Program Global Area (PGA) for background processes of active instance
- Connection to Oracle Database using **AS SYSDBA**

In addition, the operating system audit trail is logged to Event Viewer.
Using Windows Tools

Using Microsoft Management Console to Administer a Database

Microsoft Management Console provides a central location for network administration. Microsoft Management Console hosts applications (called snap-ins) that administrators can use to manage their networks. Oracle snap-ins enable database administrators to:

■ Configure Oracle Database administrators, operators, users, and roles so the Windows operating system can authenticate them
■ Configure OracleServiceSID
■ Modify registry parameters for all Oracle homes on the computer
■ Modify the computer hostname, username, and password for the database being monitored by Oracle Counters for Windows Performance Monitor
■ View and terminate an Oracle Database thread

Using Oracle Counters for Windows Performance Monitor

Oracle Counters for Windows Performance Monitor is integrated into Windows Performance Monitor. This tool enables you to view performance of processors, memory, cache, threads, and processes. Performance information provided includes device usage, queue lengths, delays, throughput measurements, and internal congestion measurements. This information is provided as charts, alerts, and reports.

You can use Oracle Counters for Windows Performance Monitor to monitor key Oracle Database information, such as:

■ Library cache
■ Buffer cache
■ Data dictionary cache
■ Redo log buffer cache
■ Thread activity

You can use your findings to improve database performance.

See Also: "Using Oracle Counters for Windows Performance Monitor" on page 6-2 for specific instructions on accessing and using Oracle Counters for Windows Performance Monitor to monitor Oracle Database performance

Using Registry Editor to Modify Configuration Information

Oracle Database stores its configuration information in a structure known as the registry. You can view and modify this configuration information through Registry Editor. The registry contains configuration information for your computer and must not be accessible for editing by inexperienced users. Only experienced administrators should view and change this information.

Registry Editor displays configuration information in a format similar to Windows Explorer. In the left-hand window is a tree-like format consisting of keys (or folders).
When one of these keys is highlighted, parameters and values assigned to that key are displayed in the right-hand window.

When you install products from your CD-ROM, configuration parameters are automatically entered in the registry. These parameters are read each time your Windows computer is started and whenever an Oracle Database product is started. These parameters include settings for:

- Oracle home directory
- Language
- Company name
- Oracle home subdirectories for individual products
- Individual products such as SQL*Plus
- Services

See Also: Chapter 14, "Configuration Parameters and the Registry" for definitions of Oracle Database configuration parameters and specific instructions on using the registry to modify Oracle Database configuration parameters.

Using Task Manager to Monitor Applications and Processes

Task Manager has three tabs:

- Applications tab displays what applications are running. This is useful for identifying and ending unresponsive tasks. (Oracle Database does not appear as an application because it runs as a service.)
- Processes tab displays details of currently running processes and their resource usage. Columns are customizable.
- Performance tab graphically displays real-time CPU and memory usage, which is useful for spotting sudden changes.

Using Local Users and Groups to Manage Users and Groups

Local Users and Groups enables you to manage users and groups on Windows 2000 and Windows XP. Specifically, you can:

- Create and modify local user accounts
- Create and modify user profiles
- Create, add, and delete local groups

Using User Manager to Manage Users

User Manager enables you to manage Windows computer security and create user accounts on Windows NT. With User Manager, you can:

- Grant Oracle Database roles
- Use operating system authentication for user accounts (For example, you can grant DBA access to a Windows user.)
- Create a Windows user account that enables you to make secure client connections to Oracle Database without a password
Optional Windows Diagnostic and Tuning Utilities

Windows 2000 Resource Kit includes several diagnostic and tuning utilities.

QuickSlice provides a quick overview of what is occurring on the system, using a graphical user interface.
- Distinguishes between time spent in user mode and kernel mode
- Imposes low overhead on the system (unlike Performance Monitor)
- Shows a continuous display, rather than just a snapshot
- Opens a window with more details when you double-click a process

Process Viewer summarizes resource usage by a process.

Process Explode provides a detailed display of resource usage by a process.

Task List displays resource usage and other details of a process when its processor identifier or process name is given as an argument. This tool also displays a list of executables and DLLs associated with a process.

See Also:
- Appendix E, "Using Oracle Database on Windows 2000"
- Chapter 5, "Administering a Database on Windows" for OracleServiceSID configuration tasks
- Chapter 6, "Monitoring a Database on Windows" for thread management tasks
- Chapter 8, "Authenticating Database Users with Windows" for authentication tasks
- Chapter 14, "Configuration Parameters and the Registry" and Chapter 6, "Monitoring a Database on Windows" for Oracle Counters for Windows Performance Monitor tasks
- Oracle Database Installation Guide for Windows for components available for installation
This chapter describes how to create a database after installing Oracle Database, using either Database Configuration Assistant or command-line tools.

This chapter contains these topics:

- Naming Conventions for Oracle Database
- Accessing Data Files and Log Files on Remote Computers
- Creating a Database on Windows Using Database Configuration Assistant
- Creating a Database on Windows Using Command-Line Tools
- Using ORADIM to Administer an Oracle Database Instance

### Naming Conventions for Oracle Database

All mounted Oracle Database servers in a network must have unique database names. When a database is created, a name is associated with it and stored in its control files. If you provide the database keyword, either in the CREATE DATABASE statement or when prompted by Database Configuration Assistant, then that value becomes the name for that database.

If you attempt to mount two Oracle Database servers with the same database name, then you receive the following error during mounting of the second server:

```
ORA-01102: cannot mount database in EXCLUSIVE mode
```

If there are two or more Oracle Database servers on the same computer, but located in different Oracle homes, then the following rules apply:

- Each database name must be unique
- Each SID must be unique

To change the name of an existing database, you must use the CREATE CONTROLFILE statement to re-create your control files and specify a new database name. This restriction exists only for Oracle8i and later versions. Any Oracle7 release 7 servers running simultaneously with an Oracle Database 10g Release 1 (10.1) server are not subject to this restriction.
Accessing Data Files and Log Files on Remote Computers

Oracle Database can access database files on a remote computer using Universal Naming Convention (UNC), but it may degrade database performance and network reliability. UNC is a PC format for specifying locations of resources on a local area network. UNC uses the following format:

`\server-name\shared-resource-path-name`

For example, UNC specification for file `system01.dbf` in directory `C:\oracle\product\10.1.0\oradata\orcl` on shared server `argon` would be:

`\argon\oracle\product\10.1.0\oradata\orcl\system01.dbf`

Locations of archive log files cannot be specified using UNC. Always set initialization parameter `LOG_ARCHIVE_DEST_n` to a mapped drive. If you set it to a UNC specification, then Oracle Database does not start and you receive the following errors:

ORA-00256: error occurred in translating archive text string '\meldell\rmdrive'
ORA-09291: sksachk: invalid device specified for archive destination
OSD-04018: Unable to access the specified directory or device
OS/ERROR: (OS 2) The system cannot find the file specified

An ORA-00256 error also occurs if you enter `\\meldell\rmdrive` or `\\meldell\rmdrive`. Control files required the additional backslashes for Oracle8 release 8.0.4, but redo log files and datafiles did not.

Creating a Database on Windows Using Database Configuration Assistant

Oracle recommends you use Database Configuration Assistant to create a database, because it is easier. It offers the same interface and operates the same way on all supported platforms, so no step-by-step procedures or screen shots are included here.

**See Also:** Oracle Database 2 Day DBA for instructions on using Database Configuration Assistant

Database Configuration Assistant enables you to:

- Create a Database
- Configure Database Options in a database
- Delete a Database
- Manage Templates

An initialization parameter file is an ASCII text file containing parameters. It can be used to create and modify a database using command-line tools. When you create a database using Database Configuration Assistant, a server parameter file (SPFILE) is created from the initialization parameter file, and the initialization parameter file is renamed. Oracle does not recognize the renamed file as an initialization parameter file, and it is not used after the instance is started.
If you want to modify an instance created with Database Configuration Assistant after it starts up, you must use `ALTER SYSTEM` statements. You cannot change the SPFILE itself, because it is a binary file that cannot be browsed or edited using a text editor. The location of the newly-created SPFILE is `ORACLE_BASE\ORACLE_HOME\database`. The SPFILE filename is `spfileSID.ora`.

**See Also:** "Managing Initialization Parameters Using a Server Parameter File" in *Oracle Database Administrator’s Guide*

**Creating a Database on Windows Using Command-Line Tools**

This section describes how to create a new database manually. As part of its database software files, Oracle Database provides a sample database creation script and a sample initialization parameter file, both of which can be edited to suit your needs. Alternatively, if you have an existing script you can use it as-is to create a database manually or edit it using the sample database creation script as a guide.

Database creations are of three types:
- Copy an existing database and delete the old database.
- Copy an existing database and keep the old database.
- Create a new database when no database exists on your system.

Table 3–1 summarizes tasks involved in creating a new database for each of these database creation categories. Each step is explained in detail in the following subsections.

<table>
<thead>
<tr>
<th>Task</th>
<th>Copy existing database and delete old database</th>
<th>Copy existing database and keep old database</th>
<th>Create new database when no database exists on system</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating Directories</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Exporting an Existing Database</td>
<td>Yes</td>
<td>Maybe(^1)</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Deleting Database Files</td>
<td>Yes</td>
<td>No</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Modifying the Initialization Parameter File</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Starting an Oracle Database Instance</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Creating and Starting an Oracle Database Service</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Putting the CREATE DATABASE Statement in a Script</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Running the CREATE DATABASE Script</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Importing a Database</td>
<td>Yes</td>
<td>Maybe(^2)</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Updating ORACLE_SID in the Registry</td>
<td>No</td>
<td>Only if you change the default SID</td>
<td>Yes</td>
</tr>
<tr>
<td>Backing Up the New Database</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

\(^1\) Yes if you copy data from the existing database to the new database; no otherwise.

\(^2\) Yes if you import tables and other objects exported from the existing database; no otherwise.
We use an example in the following sections to demonstrate how to create a database. In this example, the existing database is the starter database with a SID of orcl located in directory C:\oracle\product\10.1.0\oradata\orcl. You will copy orcl to a new database with a database name and SID of prod located in directory C:\oracle\product\10.1.0\oradata\prod. You will then delete starter database orcl.

---

**Note:** In this example, ORACLE_BASE is C:\ oracle \ product \ 10.1.0. See "Conventions" on page xviii for more information on ORACLE_BASE.

---

**Creating Directories**

Create the following directories in which to put administration and database files for new database prod:

- C:\oracle\product\10.1.0\admin\prod
- C:\oracle\product\10.1.0\admin\prod\bdump
- C:\oracle\product\10.1.0\admin\prod\pfile
- C:\oracle\product\10.1.0\admin\prod\udump
- C:\oracle\product\10.1.0\oradata\prod

**Exporting an Existing Database**

You are required to export an existing database only if you intend to copy its contents to a new database. If you are working with data from an earlier Oracle release, then you can use Export for this task. If you are using Oracle Database 10g Release 1 (10.1) data, then Oracle recommends that you use Data Pump Export because it supports new Oracle Database 10g Release 1 (10.1) features, such as floating points.

Although you can start Data Pump Export or Export in either parameter mode or interactive mode, Oracle recommends parameter mode. Interactive mode provides less functionality than parameter mode and exists for backward compatibility only.

The syntax for Data Pump Export parameter mode is:

C:\> expdp SYSTEM/password DUMPFILE=myexp.dmp FULL=y LOGFILE=myexp.log

The syntax for Data Pump Export interactive mode is:

C:\> expdp SYSTEM/password

Enter only the command expdp SYSTEM/password to begin an interactive session and let Data Pump Export prompt you for information it needs.

---

**Note:** If you use parameter mode, then Data Pump Export considers filenames and directory names to be invalid if they contain one or more blank spaces. The workaround is to enclose the full path in the DUMPFILE= parameter in triple quotation marks. For example:

DUMPFILE="""C:\program files\export.dmp"""

If Data Pump Export is used in interactive mode, then the filename or directory name can contain a space without quotation marks.
Creating a Database on Windows Using Command-Line Tools

Postinstallation Database Creation on Windows

3-5

The syntax for Export parameter mode is:

C:\> exp SYSTEM/password FILE=myexp.dmp FULL=y LOG=myexp.log

The syntax for Export interactive mode is:

C:\> exp SYSTEM/password

Enter only the command exp SYSTEM/password to begin an interactive session and let Export prompt you for information it needs.

---

**Note:** If you use parameter mode, Export considers filenames and directory names to be invalid if they contain one or more blank spaces. The workaround is to enclose the full path in the FILE= parameter in triple quotation marks. For example:

FILE=""C:\program files\export.dmp"

If Export is used in interactive mode, then the filename or directory name can contain a space without quotation marks.

---

**See Also:** Oracle Database Utilities for more information on using Data Pump Export or Export

To export all data from an existing database to a new database:

1. Set ORACLE_SID to the database service of the database whose contents you intend to export. For example, if the database you intend to export is starter database orcl, then enter the following at the command prompt. Note that there are no spaces around the equal sign (=) character.

C:\> set ORACLE_SID=orcl

2. If the existing database is Oracle Database 10g Release 1 (10.1), then start Data Pump Export from the command prompt:

C:\> expdp SYSTEM/password DUMPFILE=myexp.dmp FULL=y LOG=myexp.log

You now have a full database export of starter database orcl in file myexp.dmp. All messages from Data Pump Export are logged in file myexp.log.

3. If the existing database is before Oracle Database 10g Release 1 (10.1), then start Export from the command prompt:

C:\> exp SYSTEM/password FILE=myexp.dmp FULL=y LOG=myexp.log

You now have a full database export of starter database orcl in file myexp.dmp. All messages from Export are logged in file myexp.log.

---

**Deleting Database Files**

Deleting database files is required only when you copy an existing database to a new database to replace the old database. In the following example, you delete the database files of starter database orcl.

To delete database files:

1. Shut down starter database orcl at the command prompt:

C:\> oradim -SHUTDOWN -SID orcl -SHUTTYPE inst -SHUTMODE immediate
2. Delete the following files from directory
   C:\oracle\product\10.1.0\oradata\orcl:

<table>
<thead>
<tr>
<th>File Name</th>
<th>File Name</th>
<th>File Name</th>
<th>File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>control01.ctl</td>
<td>dsys01.dbf</td>
<td>temp01.dbf</td>
<td>xdb01.dbf</td>
</tr>
<tr>
<td>control02.ctl</td>
<td>cwlite01.dbf</td>
<td>tools01.dbf</td>
<td>redo01.log</td>
</tr>
<tr>
<td>control03.ctl</td>
<td>example01.dbf</td>
<td>undotbs01.dbf</td>
<td>redo02.log</td>
</tr>
<tr>
<td>index01.dbf</td>
<td>system01.dbf</td>
<td>user01.dbf</td>
<td>redo03.log</td>
</tr>
</tbody>
</table>

Modifying the Initialization Parameter File

To use starter database orcl as the basis for your new database, first copy ORACLE_BASE\admin\orcl\pfile\init.ora. Second, put the copy in ORACLE_BASE\admin\prod\pfile\init.ora. Third, modify the file as described in this section.

**Note:** Beginning with Oracle9i release 2 (9.2), nesting of quotation marks using the backslash (\) escape character is no longer supported. This may affect how Oracle Database interprets parameter values in your initialization parameter file. For example, if you specified CONTROL_FILES = "ctlfile\'1.ora" in releases prior to release 9.2, the filename would be interpreted as ctlfile'1.ora. Starting with release 9.2, the filename would be interpreted as ctlfile\'1.ora.

Oracle highly recommends modifying your parameter files to remove such references. See Oracle Database Reference for other methods of nesting quotation marks in initialization parameter values.

If you do not have an existing database on your system, then you cannot copy an existing initialization parameter file to use as the basis for your new initialization parameter file. However, you can use the sample initialization parameter file initsmpl.ora provided in

ORACLE_BASE\ORACLE_HOME\admin\sample\pfile

as the basis for the initialization parameter file for database prod.

If you use initsmpl.ora as the basis for the initialization parameter file, then you must set the following parameters to the indicated values, or you will not be able to start database prod:

- **DB_NAME=prod.domain**

  Parameter DB_NAME indicates the database name and must match the name used in the CREATE DATABASE statement in "Putting the CREATE DATABASE Statement in a Script" on page 3-8. You give a unique database name to each database. You can use up to eight characters for a database name. The name is not required to match the SID of the database service.

- **INSTANCE_NAME=prod.domain**

- **SERVICE_NAMES=prod.domain**
Creating a Database on Windows Using Command-Line Tools

Postinstallation Database Creation on Windows

- **CONTROL_FILES** = 
  "C:\oracle\product\10.1.0\oradata\prod\control01.ctl",
  "C:\oracle\product\10.1.0\oradata\prod\control02.ctl",
  "C:\oracle\product\10.1.0\oradata\prod\control03.ctl")

Parameter **CONTROL_FILES** lists database control files. You do not have control files on your file system at this point, because control files are created when you run the **CREATE DATABASE** statement. Ensure that you specify the complete path and filename, including drive letter.

- **BACKGROUND_DUMP_DEST** = 
  C:\oracle\product\10.1.0\admin\prod\bdump

- **USER_DUMP_DEST** = C:\oracle\product\10.1.0\admin\prod\udump

- **DB_FILES=100**

Modifying initialization parameter **DB_FILES** is not required, but it is recommended to optimize performance. Set this parameter to the same number as the value of the **MAXDATAFILES** option of the **CREATE DATABASE** statement. The value of 100 is used for this example.

**See Also:** *Oracle Database Reference* for information on other initialization parameters that you can add or modify

**Starting an Oracle Database Instance**

Start an instance without mounting a database.

**STARTUP NOMOUNT**

You are not required to specify the **PFILE** clause in this example, because the initialization parameter file is stored in the default location. At this point, there is no database. Only the SGA is created and background processes are started in preparation for the creation of a new database.

**Creating and Starting an Oracle Database Service**

You are required to create and start an Oracle Database service only if you do one of the following:

- Copy an existing database to a new database and keep the old database
- Create a new database when you have no other database to copy

Before you create the database, first create a Windows service to run the database. This service is the Oracle Database **process**, `oracle.exe`, installed in the form of a Windows service.

Use ORADIM to create the service. After it has been created, the service starts automatically. See “Using ORADIM to Administer an Oracle Database Instance” on page 3-12 for information on how to use ORADIM.

To create and start an Oracle Database service:

1. Run ORADIM from the command prompt:

   C:\> oradim -NEW -SID prod -STARTMODE manual
   -PFILE 'C:\oracle\product\10.1.0\admin\prod\pfile\init.ora'

   Note that the previously created initialization parameter file is specified, with complete path, including drive name. You can check if the service is started in the Services window of the Control Panel.
2. Set ORACLE_SID to equal prod. Note that there are no spaces around the equal sign (=) character:

C:\> set ORACLE_SID=prod

Putting the CREATE DATABASE Statement in a Script

The CREATE DATABASE statement is a SQL statement that creates the database. A script containing this statement can be used anytime you create a database.

The CREATE DATABASE statement may have the following parameters:

- MAXDATAFILES - default value: 32, maximum value: 65534
- MAXLOGFILES - default value: 32, maximum value: 255

When you run a CREATE DATABASE statement, Oracle Database performs several operations depending upon clauses that you specified in the CREATE DATABASE statement or initialization parameters that you have set.

Note: Oracle-managed files is a feature that works with the CREATE DATABASE statement to simplify administration of Oracle Database. Oracle-managed files eliminates the requirement to directly manage operating system files comprising an Oracle Database server, because you specify operations in terms of database objects rather than filenames. For more information on using Oracle-managed files see Oracle Database Administrator’s Guide.

To create database prod, copy and save the following statement in a file named script_name.sql:

CREATE DATABASE prod
MAXLOGFILES 5
MAXDATAFILES 100
DATAFILE 'oracle\product\10.1.0\oradata\prod\system01.dbf' SIZE 325M REUSE
AUTOEXTEND ON NEXT 10240K MAXSIZE UNLIMITED
UNDO TABLESPACE "UNDOTBS" DATAFILE
'oracle\product\10.1.0\oradata\prod\undotbs01.dbf'
SIZE 200M REUSE AUTOEXTEND ON NEXT 5120K MAXSIZE UNLIMITED
CHARACTER SET WE8MSWIN1252
logfile 'C:\oracle\product\10.1.0\oradata\prod\redo01.log' size 100M reuse,
'C:\oracle\product\10.1.0\oradata\prod\redo02.log' size 100M reuse,
'C:\oracle\product\10.1.0\oradata\prod\redo03.log' size 100M reuse;

Running the CREATE DATABASE Script

To use the SQL script to create a database:

1. Verify that the service is started in the Control Panel. In this example, the service name is OracleServicePROD, and its status column must display Started. If not, then select the service name and choose Start.

You can also check the status of the service by entering the following at the command prompt:

C:\> net START
A list of all Windows services currently running on the system appears. If OracleServicePROD is missing from the list, then enter:

C:\> net START OracleServicePROD

2. Make PROD the current SID:

C:\> set ORACLE_SID=PROD

3. Start SQL*Plus from the command prompt, and connect to the database as SYSDBA:

C:\> sqlplus /NOLOG
SQL> CONNECT / AS SYSDBA

The message connected appears.

4. Turn on spooling to save messages:

SQL> SPOOL script_name.log

5. Run script script_name.sql that you created in "Putting the CREATE DATABASE Statement in a Script" on page 3-8:

SQL> @C:\oracle\product\10.1.0\db_1\rdbms\admin\script_name.sql;

If the database is successfully created, then the instance is started and the following message appears numerous times: Statement processed

Importing a Database

You can use Data Pump Import (for Oracle Database 10g Release 1 (10.1) data) or Import (for earlier data) to import the full export created in "Exporting an Existing Database" on page 3-4 into the new database. Although you can start Data Pump Import or Import using either parameter mode or interactive mode, Oracle recommends parameter mode because it provides more functionality. Interactive mode exists solely for backward compatibility.

The syntax for Data Pump Import parameter mode is:

C:\> impdp SYSTEM/password DUMPFILE=myexp.dmp FULL=y LOG=myexp.log

The syntax for Data Pump Import interactive mode is:

C:\> impdp SYSTEM/password

Enter only impdp SYSTEM/password to begin an interactive session and let Data Pump Import prompt you for information it needs.

---

**Note:** If you use parameter mode, then Data Pump Import considers filenames and directory names to be invalid if they contain one or more blank spaces. The workaround is to enclose the full path in the DUMPFILE= parameter in triple quotation marks. For example:

DUMPFILE="**C:\program files\export.dmp**"

If you use Data Pump Import in interactive mode, then the filename or directory name can contain a space without quotation marks.
The syntax for Import parameter mode is:

```
C:\> imp SYSTEM/password FILE=myexp.dmp FULL=y LOG=myexp.log
```

The syntax for Import interactive mode is:

```
C:\> imp SYSTEM/password
```

Enter only `imp SYSTEM/password` to begin an interactive session and let Import prompt you for information it needs.

---

**Note:** If you use parameter mode, then Import considers filenames and directory names to be invalid if they contain one or more blank spaces. The workaround is to enclose the full path in the `FILE=` parameter in triple quotation marks. For example:

```
FILE="""C:\\program files\\export.dmp""
```

If you use Import in interactive mode, then the filename or directory name can contain a space without quotation marks.

---

**Note:** If the original database from which the export file was generated contains a **tablespace** that is not in the new database, then Import tries to create that tablespace with associated datafiles.

The easy solution is to ensure that both databases contain the same tablespaces. Datafiles are not required to be identical. Only tablespace names are important.

---

**See Also:** *Oracle Database Utilities* for more information on using Data Pump Import or Import.

---

**Updating ORACLE_SID in the Registry**

If this is the first database on the system or if you intend to make the new database the default database, then you must make a change in the registry.

1. Start Registry Editor at the command prompt:

```
C:\> regedit32
```

The Registry Editor window appears.

2. Choose subkey `HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME0` for the first Oracle home on your computer. For subsequent installations to different Oracle homes on the same computer, the path is `HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID` where ID is the unique number identifying the Oracle home.

**See Also:** Chapter 14, "Configuration Parameters and the Registry" for more information on subkey locations for multiple Oracle homes

3. Locate parameter `ORACLE_SID` on the right side of the Registry Editor window.

4. Double-click the parameter name and change the data to the new SID, which is `prod` in this example.
If you do not yet have parameter `ORACLE_SID`, because this is the first database on your system, then you must create it.

To create parameter `ORACLE_SID`:

1. Choose Add Value from the Edit menu.
   
The Add Value dialog appears:

   ![Add Value dialog](image)

2. Enter `ORACLE_SID` in the Value Name field.
3. Select `REG_EXPAND_SZ` (for an expandable string) in the Data Type list.
4. Click OK.
   
   A string editor dialog appropriate for the data type appears:

   ![String Editor dialog](image)

5. Enter `prod` in the String field.
6. Click OK.
   
   Registry Editor adds parameter `ORACLE_SID`.
7. Choose Exit from the Registry menu.
   
   Registry Editor exits.

**Backing Up the New Database**

**Caution:** If anything goes wrong while operating the new database without a backup, then you must repeat the database creation procedure. Back up your database now to prevent loss of data.

To back up the new database:

1. Shut down the database instance and stop the service:

   ```
   C:\> oradim -SHUTDOWN -SID prod -SHUTTYPE srvc,inst -SHUTMODE immediate
   ```
2. Using the tool of your choice, back up database files.

Database files consist of the initialization parameter file, control files, online redo log files, and datafiles.

When the backup is complete, you can start the database again, create users and objects, if necessary, make any other changes, and use the database.

Be sure to back up the database after making any significant changes, such as switching archiving mode or adding a tablespace or datafile.

See Also: For more information on archiving, backup, and recovery

- Oracle Database Concepts
- Oracle Database Backup and Recovery Basics
- Oracle Database 2 Day DBA

Caution: Do not store database files on a compressed drive. This can result in write errors and decreased performance.

Using ORADIM to Administer an Oracle Database Instance

ORADIM is a command-line tool that is available with Oracle Database. You are required to use ORADIM only if you are manually creating, deleting, or modifying databases. Database Configuration Assistant is an easier tool to use for this purpose.

The following sections describe ORADIM commands and parameters. Note that each command is preceded by a dash (-). To get a list of ORADIM parameters, enter:

```
oracle -?
```

Note: Specifying `oradim` without any options also returns a list of ORADIM parameters and descriptions.

When you use ORADIM, a log file called `oradim.log` opens in `ORACLE_BASE\ORACLE_HOME\database`, or in the directory specified by registry parameter ORA_CWD. All operations, whether successful or failed, are logged in this file. You must check this file to verify success of an operation.

If you have installed an Oracle Database service on Windows 2000, then when logging in as SYSTEM user (LocalSystem), with startup mode set to Automatic, it is possible that the Oracle Database service starts but the database does not start automatically. The following error message is written to file `ORADIM.LOG` in directory `ORACLE_BASE\ORACLE_HOME\database`:

```
ORA-12640: Authentication adapter initialization failed
```
Oracle Enterprise Management Agent, Oracle Enterprise Manager Management Server and Oracle Internet Directory may also fail, because they cannot connect to the database for the same reason. The workarounds are:

- **Modify SQLNET.ORA**
  
  You can modify `SQLNET.ORA`, either by removing the line
  
  `sqlnet.authentication_services= (NTS)`
  
  or by changing it to
  
  `sqlnet.authentication_services= (NONE)`

- **Start the database after the service starts**
  
  You can start the database manually after the Oracle Database service has started, using SQL*Plus and connecting as `SYSDBA`.

- **Start the service as a specific user**

  See Also: Your operating system documentation for instructions on starting services

### Creating an Instance

To use ORADIM to create an instance, enter:

```
oradim -NEW -SID SID | -SRVC service_name | -ASMSID SID | -ASMSRVC service_name
[-SYSPWD password] [-STARTMODE auto | manual] [-SRVCSTART system | demand]
[-PFILE filename | -SPFILE] [-SHUTMODE normal | immediate | abort] [-TIMEOUT secs] [-RUNAS osusr/ospass]
```

where

- `-NEW` indicates that you are creating a new instance. This is a mandatory parameter.
- `-SID SID` is the name of the instance to create.
- `-SRVC service_name` is the name of the service to create (`OracleServiceSID`).
- `-ASMSID SID` is the name of the Automatic Storage Management (ASM) instance to create.
- `-ASMSRVC service_name` is the name of the ASM service to create.
- `-STARTMODE auto | manual` indicates whether to start the instance when the Oracle Database service is started. Default is `manual`.
- `-SRVCSTART system | demand` indicates whether to start the Oracle Database service on computer restart.
- `-PFILE filename` is the initialization parameter file to be used with this instance. Ensure that you specify the complete path name of this file, including drive letter.
- `-SPFILE` indicates that a server parameter file (SPFILE) be used during startup instead of a PFILE.
- `-TIMEOUT secs` sets the maximum time to wait (in seconds) before the service for a particular SID stops.
To create an instance called PROD, for example, you can enter:

```
C:\> oradim -NEW -SID prod -STARTMODE auto -PFILE
C:\oracle\product\10.1.0\admin\prod\pfile\init.ora
```

### Starting an Instance and Services

To use ORADIM to start an instance and services, enter

```
oradim -STARTUP -SID SID | -ASMSID SID [-SYSPWD password] [-STARTTYPE srvc | inst | srvc,inst] [-PFILE filename | -SPFILE]
```

where

- `-STARTUP` indicates that you are starting an instance that already exists. This is a mandatory parameter.
- `-SID SID` is the name of the instance to start.
- `-ASMSID SID` is the name of the ASM instance to start.
- `-STARTTYPE srvc, inst` indicates whether to start the service or the instance. One or both values can be specified. If it is not specified, then the registry is checked for the current setting.
  
  -`-STARTTYPE srvc` is equivalent to running `net start` `oracleservice<sid>` from the command line.
  
  -`-STARTTYPE inst` is equivalent of running `startup` within SQL*Plus.
- `-PFILE filename` is the initialization parameter file to be used with this instance. Ensure that you specify the complete path name of this file, including drive letter.
- `-SPFILE` indicates that a server parameter file (SPFILE) be used during startup instead of a PFILE.

To start an instance called puma, for example, you can enter:

```
C:\> oradim -STARTUP -SID puma -STARTTYPE inst -PFILE
C:\oracle\product\10.1.0\admin\prod\pfile\init.ora
```

### Stopping an Instance and Services

The Enterprise Database Control service (`OracleDBConsole SID`) is dependent on the Oracle Database service (`OracleService SID`). You must stop the dependent Enterprise Database Control service (if installed) before running ORADIM to stop the database instance service.

To use ORADIM to stop an instance, enter:

```
oradim -SHUTDOWN -SID SID | -ASMSID SID [-SYSPWD password] [-SHUTTYPE srvc | inst | srvc,inst] [-SHUTMODE normal | immediate | abort]
```

where

- `-SHUTDOWN` indicates that you are stopping an instance. This is a mandatory parameter.
- `-SID SID` specifies the name of the instance to stop.
- `-ASMSID SID` is the name of the ASM instance to stop.
- `-SHUTTYPE srvc, inst` indicates whether to stop the service or the instance. One or both values can be specified. If it is not specified, then the registry is checked for the current setting.
■ -SHUTMODE specifies how to stop an instance. This is an optional parameter. If you do not specify how to stop an instance, then normal is the default mode.

To stop an instance called puma, for example, you can enter:

```
C:\> oradim -SHUTDOWN -SID puma -SHUTTYPE srvc,inst
```

**Editing an Instance**

You can edit an existing instance to change such values as instance name, startup mode, shutdown mode, and shutdown type. To use ORADIM to modify an instance, enter:

```
oradim -EDIT -SID SID | -ASMSID SID [-SYSPWD password] [-STARTMODE auto | manual] [-SRVCSTART system | demand] [-PFILE filename | -SPFILE] [SHUTMODE normal | immediate | abort] [SHUTTYPE srvc | inst | srvc,inst]
```

where

■ -EDIT indicates that you are modifying an instance. This is a mandatory parameter.

■ -SID SID specifies the name of the instance to modify. This is a mandatory parameter.

■ -ASMSID SID is the name of the ASM instance to modify.

■ -STARTMODE indicates whether to start the instance when the Oracle Database service is started. Default is manual.

■ -SRVCSTART system | demand indicates whether to start the Oracle Database service on computer restart.

■ -PFILE filename specifies the initialization parameter file to be used with this instance. Ensure that you specify the complete path name of this file, including drive letter.

■ -SPFILE indicates that a server parameter file (SPFILE) be used during startup instead of a PFILE.

■ -SHUTMODE specifies how to stop an instance. This is an optional parameter. If you do not specify how to stop an instance, then normal is the default mode.

■ -SHUTTYPE indicates whether to stop the service or the instance. One or both values can be specified. If it is not specified, then the registry is checked for the current setting.

To specify a new initialization parameter file for the instance prod, for example, you can enter:

```
C:\> oradim -EDIT -SID prod -PFILE
C:\oracle\product\10.1.0\admin\lynx\pfile\init.ora
```

**Deleting an Instance**

The Enterprise Database Control service (OracleDBConsoleSID) is dependent on the Oracle Database service (OracleServiceSID). You must stop the dependent Enterprise Database Control service (if installed) before running ORADIM to delete the database instance.

To use ORADIM to delete an instance, enter:

```
oradim -DELETE -SID SID | -ASMSID SID | -SRVC service_name | -ASMSRVC service_name
```
where

- `-DELETE` indicates that you are deleting an instance or service. This is a mandatory parameter.
- `-SID SID` specifies the name of the SID to delete.
- `-SRVC service_name` specifies the name of the service to delete.
- `-ASMSID SID` is the name of the ASM instance to delete.
- `-ASMSRVC service_name` is the name of the ASM service to delete.

To delete an instance called `prod`, for example, you can enter:

```
C:\> oradim -DELETE -SID prod
```
This chapter describes configuration tasks you can perform to increase security and other configuration tasks you must perform before using Oracle interMedia and other Oracle options. Where appropriate, the chapter provides references to other guides for those configuration tasks.

This chapter contains these topics:

- Resetting Passwords for Default Accounts
- NTFS File System and Windows Registry Permissions
- Configuring External Job Support for the Scheduler on Windows
- Oracle interMedia on Windows
- Configuring Oracle Text on Windows
- Configuring Oracle Spatial on Windows
- Configuring Advanced Replication on Windows

**Note:** Directory path examples in this chapter follow Optimal Flexible Architecture (OFA) guidelines (for example, ORACLE_BASE\ORACLE_HOME\rdbms\admin). If you specified non-OFA compliant directories during installation, then your directory paths will differ. See Appendix B, "Optimal Flexible Architecture", in Oracle Database Installation Guide for Windows for more information.

**Resetting Passwords for Default Accounts**

Oracle Database installs with a number of default accounts. Database Configuration Assistant locks and expires most default database accounts upon successful installation. Oracle recommends changing all user passwords *immediately* after installation.

**See Also:** Oracle Database Administrator’s Guide for more information on default database accounts and passwords

**NTFS File System and Windows Registry Permissions**

Oracle recommends that you configure Oracle Database files, directories, and registry settings to allow only authorized database administrators (DBAs) to have full control.
If you created a database using Database Configuration Assistant or upgraded a
database using Oracle Database Upgrade Assistant, then no further action is required.
This section describes the permissions automatically set by Oracle Universal Installer,
Database Configuration Assistant, and Oracle Database Upgrade Assistant and the
steps to set these permissions manually.
This section contains these topics:

- File Permissions
- Setting NTFS File System Security
- Setting Windows Registry Security

**See Also:** Your operating system documentation for more
information about modifying NTFS file system and Windows registry
settings

### File Permissions

Beginning with Oracle9i release 2 (9.2), Oracle Universal Installer, Database
Configuration Assistant, and Database Upgrade Assistant set file permissions when
Oracle Database software is installed or upgraded.
This section contains these topics:

- File Permissions Set by Oracle Universal Installer
- File Permissions Set by Database Configuration Assistant
- File Permissions Set by Database Upgrade Assistant

#### File Permissions Set by Oracle Universal Installer

During Oracle Database installation, by default Oracle Universal Installer installs
software in `ORACLE_BASE\ORACLE_HOME`. Oracle Universal Installer sets the
following permissions to this directory, and all files and directories under this
directory:

- **Administrators** - Full Control
- **System** - Full Control
- **Authenticated Users** - Read, Execute and List Contents

**Important:** If these accounts already exist and possess more
restrictive permissions, then the most restrictive permissions are
retained. If accounts other than **Administrators**, **System**, and
**Authenticated Users** already exist, then the permissions for these
accounts are removed.

#### File Permissions Set by Database Configuration Assistant

During database configuration, Database Configuration Assistant installs files and
directories in the following default locations, where `database_name` is the database
name or SID:

- `ORACLE_BASE\admin\database_name` (administration file directories)
- `ORACLE_BASE\oradata\database_name` (database file directories)
- `ORACLE_BASE\oradata\database_name` (redo log files and control files)
Database Configuration Assistant sets the following permissions to these directories, and all files and directories under these directories:

- **Administrators** - Full Control
- **System** - Full Control

**Important:** If these accounts already exist and possess more restrictive permissions, then the most restrictive permissions are retained. If accounts other than Administrators and System already exist, then the permissions for these accounts are removed.

**File Permissions Set by Database Upgrade Assistant**

When an older version of the database is upgraded to Oracle Database 10g Release 1 (10.1), Database Upgrade Assistant installs software in the following directories, where database_name is the database name or SID:

- **ORACLE_BASE\admin\database_name** (administration files)
- **ORACLE_BASE\oradata\database_name** (database file directories)
- **ORACLE_BASE\oradata\database_name** (redo log files and control files)
- **ORACLE_BASE\ORACLE_HOME\database (SPFILESID.ORA)**

Database Upgrade Assistant sets the following permissions to these directories, and all files and directories under these directories:

- **Administrators** - Full Control
- **System** - Full Control

**Important:** If these accounts already exist and possess more restrictive permissions, then the most restrictive permissions are retained. If accounts other than Administrators and System already exist, then the permissions for these accounts are removed.

Beginning with Oracle Database 10g Release 1 (10.1), Database Upgrade Assistant can also configure Enterprise Manager. If the "Enable daily backup" option is selected while configuring Enterprise Manager, then Database Upgrade Assistant shows a separate screen asking for Flash Recovery Area. Database Upgrade Assistant will try to create the directory structure in whatever file system location is specified if it does not exist. It will put the same set of file permissions to this location. The default location shown by DBUA for flash recovery area is:

- **ORACLE_BASE\flash_recovery_area**

**Setting NTFS File System Security**

To ensure that only authorized users have full file system permissions:

1. Go to Windows Explorer.
2. Set the following permissions for each directory or file:
Configuring External Job Support for the Scheduler on Windows

Oracle recommends that you remove write permissions from users who are not Oracle Database DBAs or system administrators in HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE of the Windows registry.

To remove write permissions:
1. Open the registry.
2. Go to HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE.
3. Select Permissions from the Security main menu.
   The Registry Key Permissions dialog appears.
4. Remove write permissions from any users who are not Oracle Database DBAs or system administrators. Note that the SYSTEM account must have Full Control, since this is the account with which Oracle Database runs.
5. Ensure that user accounts that must run Oracle applications have read privileges.
6. Choose OK.
7. Exit the registry.

Configuring External Job Support for the Scheduler on Windows

This release includes a new database scheduler to provide enterprise scheduling functionality. External jobs performed by the user are started using the OracleJobScheduler service. This service is disabled by default. In order to use the external jobs functionality, the administrator must set the username and password for the user account under which this service must run and enable the service.
Restricting execution of external jobs to a low-privileged user prevents unauthorized database users from gaining operating system level privileges, but it also places restrictions on the kinds of jobs that can be run. Jobs requiring a higher level of operating system privileges cannot be run by this mechanism.

**Oracle interMedia on Windows**

Performance related components of Oracle interMedia are now packaged on the Companion CD. Although interMedia functions properly without the Companion CD, the following components must be installed from the Companion CD in order to achieve acceptable performance of image processing:

- JAccelerator (NCOMP)
- Oracle interMedia Image Accelerator

Oracle interMedia includes the following components.

**Client**

Oracle interMedia Client provides an Oracle Database interMedia Audio, Image, and Video Java interface that lets you use local (client-side) applications to manipulate or modify multimedia data stored in a network-accessible (server-side) database. To use the Java library, set environment variable `CLASSPATH` so that it contains the Oracle interMedia library.

Client also provides a simple interMedia Image sample (`SimpImg.exe`) that was developed using Microsoft Visual C++. `SimpImg.exe` locates and updates images, using interMedia Image in Oracle Database.

**Audio**

Oracle interMedia Audio manages audio data in multiple file formats in Oracle Database. Types of audio data supported include conversations, songs, and other sounds in popular audio file formats. This makes it possible to integrate audio data with other application-specific object-relational data.

**Video**

Oracle interMedia Video manages video data in multiple video file formats. This makes it possible to integrate video data with other application-specific object-relational data.

**Image**

Oracle interMedia Image provides image storage, retrieval, and format conversion capabilities through an object data type (ODT). It also supports image storage, using Binary Large Objects (BLOBs), and references to image data residing in external files (BFILEs).

The Image component of Oracle interMedia also comes with a sample demonstration that shows how an image is extracted from Oracle Database.

**Locator**

Oracle interMedia Locator enables Oracle Database to support online internet-based geocoding facilities for locator applications and proximity queries.
Upgrading Oracle interMedia from an Earlier Release

If you upgrade from an earlier Oracle release to the current release, Oracle interMedia will be upgraded automatically if it is detected. If for some reason you want to upgrade interMedia manually, follow this procedure:

1. Upgrade the database.
2. Start SQL*Plus:
   ```
   C:\> sqlplus /NOLOG
   ```
3. Connect to Oracle Database with account SYSDBA:
   ```
   SQL> CONNECT / AS SYSDBA
   ```
4. Run script imdbma.sql:
   ```
   SQL> @ORACLE_BASE\ORACLE_HOME\ord\im\admin\imdbma.sql
   ```
5. If the script displays NOT_INSTALLED, then no prior release of Oracle interMedia was installed on your computer. You must install rather than upgrade Oracle interMedia.
6. If the script displays INSTALLED, then the current Oracle interMedia release is already installed on your computer.
7. If the script displays u0nnnnn0.sql, then Oracle interMedia release nnnnn is currently installed. For example, u0800060.sql means that Oracle Image Cartridge release 8.0.6.0.0 is currently installed.
8. Upgrade Oracle interMedia common files:
   ```
   SQL> @ORACLE_BASE\ORACLE_HOME\ord\admin\u0nnnnn0.sql
   ```
9. Upgrade Oracle interMedia:
   ```
   SQL> @ORACLE_BASE\ORACLE_HOME\ord\im\admin\u0nnnnn0.sql
   ```
10. Verify the upgrade:
    ```
        SQL> CONNECT / AS ORDSYS
        SQL> @ORACLE_BASE\ORACLE_HOME\ord\im\admin\imchk.sql
    ```

Configuring Oracle interMedia Audio, Video, Image, and Locator

If you install Enterprise Edition, then Database Configuration Assistant starts automatically at the end of installation. If you choose any Database Configuration Assistant installation type other than Customized, then interMedia does not require manual configuration. All tasks described in this section are performed automatically.

If you select Customized installation, then Database Configuration Assistant will guide you through configuration of Oracle interMedia.

If you are creating and configuring a database manually, then you can configure Oracle interMedia Audio, Video, Image, and Locator as follows:

1. Start SQL*Plus:
   ```
   C:\> sqlplus /NOLOG
   ```
2. Connect to Oracle Database with account SYSDBA:
   ```
   SQL> CONNECT / AS SYSDBA
   ```
3. Start the database (if necessary):
   SQL> STARTUP

4. Run script ordinst.sql:
   SQL> @ORACLE_BASE\ORACLE_HOME\ord\admin\ordinst.sql

5. Run script iminst.sql:
   SQL> @ORACLE_BASE\ORACLE_HOME\ord\im\admin\iminst.sql

6. Exit SQL*Plus:
   SQL> EXIT

---

**Note:** If you manually copy your Oracle8i listener.ora and tnsnames.ora files into your Oracle Database network directory, then you must modify network configuration files tnsnames.ora and listener.ora on your server to enable external routine calls to work and interMedia to function properly. Follow the procedure in Oracle Net Services Administrator’s Guide.

---

**Configuring Oracle interMedia Demos**

To configure Oracle interMedia Audio, Video, and Image demos, follow instructions in readme.txt files at locations shown in Table 4–1.

<table>
<thead>
<tr>
<th>Demo</th>
<th>File Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>ORACLE_BASE\ORACLE_HOME\ord\aud\demo</td>
</tr>
<tr>
<td>Video</td>
<td>ORACLE_BASE\ORACLE_HOME\ord\vid\demo</td>
</tr>
<tr>
<td>Image</td>
<td>ORACLE_BASE\ORACLE_HOME\ord\img\demo</td>
</tr>
</tbody>
</table>

**Note:** These readme.txt files contain UNIX line breaks. If you simply double-click them, they will open in Notepad by default, and Notepad does not recognize UNIX line breaks. Use write.exe or edit.com instead.

Directory \img\demo also contains demo_ordimg.mk, the makefile to make interMedia Image demos for a Microsoft C compiler. But before you can build and run the demonstration, you must first modify it to adapt it to your environment.

To configure Oracle interMedia Locator demonstrations, go to the following directory:

ORACLE_BASE\ORACLE_HOME\md\demo\geocoder

Sample data that can be loaded into Oracle Database is in nh_cs.sql. Examples that show use of Locator functionality are in geohttp.sql and geolocate.sql. Examples of data indexes created by using Locator are in geoindex.sql.
Configuring Oracle Text on Windows

Oracle Text enables text queries through SQL and PL/SQL from most Oracle interfaces. By installing Oracle Text with an Oracle Database server, client tools such as SQL*Plus, Oracle Forms, and Pro*C/C++ are able to retrieve and manipulate text in Oracle Database.

Oracle Text manages textual data in concert with traditional data types in Oracle Database. When text is inserted, updated, or deleted, Oracle Text automatically manages the change.

Your Oracle Text postinstallation tasks depend on your situation.

If you install Oracle Text from the CD-ROM and have a previous release of Oracle Text (formerly called interMedia Text) already installed, then see Oracle Text Application Developer’s Guide.

If you upgrade your database, then you may be required to configure Oracle Net for external procedures. Otherwise, Oracle Text may not work. In any case other than upgrade, Oracle Net will be configured correctly by default to work with Oracle Text. See Oracle Text Application Developer’s Guide and Oracle Text Reference.

If you are indexing formatted documents such as Microsoft Word, then you must set your environment to use the Inso filter before you can index your documentation set. For more information on setting up your environment for Inso filtering, see Oracle Text Reference.

---

**Note:** The Inso filter is not supported on Windows XP 64-bit Edition Version 2003 or Windows Server 2003 Datacenter Edition for 64-bit Itanium 2 Systems. See Appendix G, "Oracle Database for 64-Bit Windows".

---

Finally, if you install Oracle Text from the CD-ROM and do not have a previous release of Oracle Text installed, then Oracle Database is already configured for use with Oracle Text if one of the following is true:

- You created the database by using Database Configuration Assistant in standalone mode, and selected Typical database creation type.

- The database is a **starter database** that you created by performing the following sequence of steps:
  1. Select Oracle Database in the **Available Products** window.
  3. Select General Purpose in the **Database Configuration** window.

**See Also:** For more information about creating a starter database

- Chapter 3, "Postinstallation Database Creation on Windows"
- *Oracle Database Installation Guide for Windows*
If none of these is true, then you must configure Oracle Database for use with Oracle Text by doing one of the following:

- Configuring Oracle Text Using Database Configuration Assistant
- Configuring Oracle Text Using Command-Line Tools

**Configuring Oracle Text Using Database Configuration Assistant**

To use Database Configuration Assistant to configure Oracle Database for use with Oracle Text at the time you create the database, simply select Oracle Text as the option to configure when prompted.

To configure the database at a later time:

1. Start Database Configuration Assistant.
   - Choose `Start > Programs > Oracle - HOME_NAME > Configuration and Migration Tools > Database Configuration Assistant`.
2. Select `Configure database options in a database`.
3. Select the database to modify when prompted.
4. Select Oracle Text as the option to configure when prompted.

**Configuring Oracle Text Using Command-Line Tools**

Manually configuring Oracle Database for use with Oracle Text consists of creating a tablespace for Oracle Text data dictionary tables and then creating username `ctxsys` and Oracle Text data dictionary tables.

1. Start SQL*Plus:
   - `C:\> sqlplus /NOLOG`
2. Connect to Oracle Database with account SYSDBA:
   - SQL: `CONNECT / AS SYSDBA`
3. Create a tablespace for Oracle Text data dictionary tables:
   - SQL> `CREATE TABLESPACE tablespace_name DATAFILE 'ORACLE_BASE\oradata\dbname\drlsys01.dbf' SIZE 80m;`
4. Connect AS SYSDBA:
   - SQL> `CONNECT USERNAME/PASSWORD AS SYSDBA`
5. Run script `dr0csys.sql` to create username `ctxsys`:
   - SQL> `@ORACLE_BASE\ORACLE_HOME\ctx\admin\dr0csys.sql password default_tablespace_name temporary_tablespace_name;`

Where:

- `password` is the password that you intend to use for username `ctxsys`.
- `default_tablespace_name` is the default tablespace for Oracle Text data dictionary tables. Set the default tablespace to the value of `tablespace_name` in step 3.
- `temporary_tablespace_name` is the temporary tablespace for Oracle Text data dictionary tables. Set the temporary tablespace to the value of `tablespace_name` in step 3.
6. Connect as ctxsys:
   SQL> CONNECT ctxsys/password

7. Run script dr0inst.sql to create and populate Oracle Text data dictionary tables:
   SQL> @ORACLE_BASE\ORACLE_HOME\bin\dr0inst.sql;

8. Run the language-specific default script, where xx is the language code (for example, us):
   SQL> @ORACLE_BASE\ORACLE_HOME\ctx\admin\defaults\drdefxx.sql;

9. Exit SQL*Plus:
   SQL> EXIT

Configuring Oracle Spatial on Windows

Oracle Spatial makes storage, retrieval, and manipulation of spatial data easier and more intuitive to users.

One example of spatial data is a road map. A road map is a two-dimensional object that contains points, lines, and polygons representing cities, roads, and political boundaries such as states. A road map represents geographic information. Locations of cities, roads, and political boundaries are projected onto a two-dimensional display or piece of paper, preserving relative positions and relative distances of objects.

If you install Oracle Spatial through Enterprise Edition, then no manual configuration is required. All Oracle Spatial configuration tasks are performed automatically.

If you install both Oracle Spatial and Oracle Database together through Enterprise Edition or Standard Edition Custom installation, then Database Configuration Assistant starts automatically at the end of installation. If you choose Custom installation and select Create new database, then the assistant asks if Oracle Spatial is to be configured automatically.

If you install Oracle Spatial during a separate installation from Enterprise Edition, then you must either start Database Configuration Assistant and select Configure database options in a database or configure Oracle Spatial manually.

To configure Oracle Spatial manually:
1. Start SQL*Plus at the command prompt:
   C:\> sqlplus /NOLOG

2. Connect to Oracle Database with account SYSDBA:
   SQL> CONNECT / AS SYSDBA

3. Start the database (if necessary):
   SQL> STARTUP

4. Run script ordinst.sql:
   SQL> @ORACLE_BASE\ORACLE_HOME\ord\admin\ordinst.sql

5. Connect to the database as user SYSTEM:
   SQL> CONNECT SYSTEM/password
6. Run script `mdinst.sql`:
   
   ```sql
   SQL> @ORACLE_BASE\ORACLE_HOME\md\admin\mdinst.sql
   ```

7. Exit SQL*Plus:
   
   ```sql
   SQL> EXIT
   ```

---

**Note:** Script `mdinst.sql` has a variable `%MD_SYS_PASSWORD%` that Oracle Universal Installer will instantiate at installation time. Therefore, if you have changed the `mdsys` user's password, then be sure during a manual installation to remember also to update script `mdinst.sql` with that password.

---

### Configuring Advanced Replication on Windows

Oracle Database installs replication packages and procedures automatically rather than as a separate manual process. There are many configuration and usage possibilities with Advanced Replication.

This section describes how to manually configure Advanced Replication in Oracle Database. Follow the instructions only if you add Advanced Replication to an installation of Oracle Database that was not previously configured with this feature.

**See Also:** Oracle Database Advanced Replication for more information about Advanced Replication and for definitions of master sites and materialized view sites.

Configuring Advanced Replication consists of the following steps:

- Checking Tablespace and Rollback Segment Requirements
- Adding and Modifying Initialization Parameters
- Monitoring Data Dictionary Tables

### Checking Tablespace and Rollback Segment Requirements

Recommended tablespace and rollback segment requirements for Advanced Replication are shown in Table 4–2.

<table>
<thead>
<tr>
<th>Tablespace/Rollback Segment</th>
<th>Minimum Free Space</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYSTEM1</td>
<td>20 MB</td>
</tr>
<tr>
<td>UNDO TABLESPACE</td>
<td>10 MB</td>
</tr>
<tr>
<td>RBS</td>
<td>5 MB</td>
</tr>
<tr>
<td>TEMP</td>
<td>10 MB</td>
</tr>
<tr>
<td>USERS</td>
<td>No specific requirement</td>
</tr>
</tbody>
</table>

1 Replication triggers and procedures are stored here.
Adding and Modifying Initialization Parameters

If you use Advanced Replication, then certain parameter values must be added to the initialization parameter file, and others must be set to recommended values. Parameter names and values for the master site and materialized view sites are shown in Table 4–3.

### Table 4–3  Advanced Replication Initialization Parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Recommended Value</th>
<th>Site</th>
</tr>
</thead>
<tbody>
<tr>
<td>JAVA_POOL_SIZE</td>
<td>50 MB</td>
<td>master</td>
</tr>
<tr>
<td>DISTRIBUTED_LOCK_TIMEOUT</td>
<td>300 seconds</td>
<td>master</td>
</tr>
<tr>
<td>GLOBAL_NAMES</td>
<td>TRUE</td>
<td>master</td>
</tr>
<tr>
<td>OPEN_LINKS</td>
<td>4</td>
<td>master</td>
</tr>
<tr>
<td>PROCESSES</td>
<td>Add 9 to current value</td>
<td>master</td>
</tr>
<tr>
<td>JOB_QUEUE_PROCESSES</td>
<td>2&lt;sup&gt;1&lt;/sup&gt;</td>
<td>master</td>
</tr>
<tr>
<td>JOB_QUEUE_PROCESSES</td>
<td>2</td>
<td>materialized view</td>
</tr>
</tbody>
</table>

<sup>1</sup> Depends on number of n-way sites.

Monitoring Data Dictionary Tables

If you use Advanced Replication and intend to set up a large number of replicated objects, then you are required to monitor the following data dictionary tables with the `SQL SELECT` command:

- ARGUMENT$  
- IDL_CHAR$  
- IDL_UB1$  
- IDL_UB2$  
- IDL_SB4$  
- I_ARGUMENT1  
- I_SOURCE1I$  
- SOURCE$  
- TRIGGER

If necessary, increase storage parameters to accommodate storage requirements of large numbers of replicated objects.
This chapter describes how to administer Oracle Database for Windows.

This chapter contains these topics:

- Managing Oracle Database Services
- Starting and Shutting Down a Database with SQL*Plus
- Starting and Shutting Down a Database Using Services
- Starting Multiple Instances
- Creating and Populating Password Files
- Connecting Remotely to the Database as SYS
- Automatically Encrypted Database Passwords
- Creating Control, Data, and Log Files on Remote Computers
- Archiving Redo Log Files
- Backing Up an Oracle Database on Windows

### Managing Oracle Database Services

This section tells you how to manage the services that Oracle Database installs on your computer.

This section provides information on the following:

- Oracle Database Service Naming Conventions for Multiple Oracle Homes
- Starting Oracle Database Services
- Stopping Oracle Database Services
- Auto-starting Oracle Database Services
Oracle Database Service Naming Conventions for Multiple Oracle Homes

Oracle Database for Windows lets you have multiple Oracle homes on a single computer. This feature, described in Appendix B, "Optimal Flexible Architecture", in Oracle Database Installation Guide for Windows, affects Oracle services naming conventions. As you perform installations into Oracle home directories:

- You must accept default Oracle home name provided or specify a different name for each Oracle home directory.
- You are prompted to give a system identifier and global database name for each database installation.

Starting Oracle Database Services

Oracle Database services must be started for you to use Oracle Database and its products. You can start Oracle Database services from three different locations:

- Control Panel
- Command Prompt
- Oracle Administration Assistant for Windows

Note: You can start Oracle Database when you start OracleServiceSID. See "Starting and Shutting Down a Database Using Services" on page 5-6 for information on registry parameters that enable you to do this.

Control Panel
To start Oracle Database services from the Control Panel:

1. Access your Windows Services dialog.

   See Also: Your operating system documentation for instructions

2. Find the service to start in the list, select it, and click Start.

   If you cannot find OracleServiceSID in the list, then use ORADIM to create it.

3. Click Close to exit the Services dialog.

Command Prompt
To start Oracle Database services from the command prompt, enter:

C:\> NET START service

where service is a specific service name, such as OracleServiceORCL.

Oracle Administration Assistant for Windows
To start Oracle Database services from Oracle Administration Assistant for Windows:

1. Choose Start > Programs > Oracle - HOME_NAME > Configuration and Migration Tools > Administration Assistant for Windows

2. Right-click the SID.

   where SID is a specific instance name, such as orcl.
3. Click **Start Service**.

   This starts service `OracleServiceORCL`.

### Stopping Oracle Database Services

On occasion (for example, when re-installing Oracle Database), you must stop Oracle Database services. You can stop Oracle Database services from three different locations:

- **Control Panel**
- **Command Prompt**
- **Oracle Administration Assistant for Windows**

---

**Note:** You can stop Oracle Database in normal, immediate, or abort mode when you stop `OracleServiceSID`. See "Starting and Shutting Down a Database Using Services" on page 5-6 for information on registry parameters that enable you to do this.

---

**Control Panel**

To stop Oracle Database services from the Control Panel:

1. Access your Windows Services dialog.

   **See Also:** Your operating system documentation for instructions

2. Select `Oracle_HOME_NAME_TNSListener` and click **Stop**.

   `Oracle_HOME_NAME_TNSListener` is stopped.

3. Select `OracleServiceSID` and click **Stop**.

4. Click **OK**.

   `OracleServiceSID` is stopped.

**Command Prompt**

To stop Oracle Database services from the command prompt, enter:

```
C:\> net STOP service
```

where `service` is a specific service name, such as `OracleServiceORCL`.

**Oracle Administration Assistant for Windows**

To stop Oracle Database services from Oracle Administration Assistant for Windows:

1. Choose **Start** > **Programs** > **Oracle - HOME_NAME** > **Configuration and Migration Tools** > **Administration Assistant for Windows**.

2. Right-click the **SID**.

   where `SID` is a specific instance name, such as `orcl`.

3. Click **Stop Service**.

   This stops service `OracleServiceORCL`. 
Auto-starting Oracle Database Services

Oracle Database services can be set to start automatically whenever the Windows computer is restarted. You can turn auto-start on or off from two different locations:

- Control Panel
- Oracle Administration Assistant for Windows

Control Panel
To use the Control Panel to configure when and how Oracle Database is started:
1. Access your Windows Services dialog.

   **See Also:** Your operating system documentation for instructions

2. Select service OracleServiceSID and click Startup.
3. Choose Automatic from the Startup Type field.
4. Click OK.
5. Click Close to exit the Services dialog.

Oracle Administration Assistant for Windows
To automatically start Oracle Database services from Oracle Administration Assistant for Windows:
1. Choose Start > Programs > Oracle - HOME_NAME > Configuration and Migration Tools > Administration Assistant for Windows.
2. Right-click the SID.
   
   where **SID** is a specific instance name, such as **orcl**.
3. Choose Startup/Shutdown Options.
4. Choose the Oracle Service tab.
5. Choose Automatic in Oracle Service Startup Type.
6. Click Apply.
7. Click OK.
Starting and Shutting Down a Database with SQL*Plus

These instructions assume that a database instance has been created.

**Note:** Directory path examples in this chapter follow **Optimal Flexible Architecture** (OFA) guidelines (for example, `ORACLE_BASE\ORACLE_HOME\rdbms\admin`). If you specified non-OFA compliant directories during installation, then your directory paths will differ. See Appendix B, "Optimal Flexible Architecture", in *Oracle Database Installation Guide for Windows* for more information.

To start or shut down Oracle Database:

1. Go to your Oracle Database server.
2. Start SQL*Plus at the command prompt:
   
   ```
   C:\> sqlplus /NOLOG
   ```
3. Connect to Oracle Database with *username* **SYSDBA**:
   
   ```
   SQL> CONNECT / AS SYSDBA
   ```
4. To start a database, enter:
   
   ```
   SQL> STARTUP [PFILE=path\filename]
   ```

   This command uses the **initialization parameter file** specified in `path\filename`. To start a database using a file named `init2.ora` located in `C:oracle\product\10.1.0\admin\orcl\pfile`

   you would enter:

   ```
   SQL> STARTUP PFILE=C:oracle\product\10.1.0\admin\orcl\pfile\init2.ora
   ```
If no PFILE is specified, then the command looks for an SPFILE in ORACLE_HOME\database. If the command finds one, then the command uses it to start the database. If it does not find an SPFILE, then it uses the default initialization parameter file located in ORACLE_BASE\ADMIN\db_name\pfile.

5. To stop a database, enter:

```sql
SQL> SHUTDOWN [mode]
```

where mode is normal, immediate, or abort.

In a normal shutdown, Oracle Database waits for all currently-connected users to disconnect and disallows any new connections before shutting down. This is the default mode.

In an immediate shutdown, Oracle Database terminates and rolls back active transactions, disconnects clients, and shuts down.

In an abort shutdown, Oracle Database terminates active transactions and disconnects users; it does not roll back transactions. The database performs automatic recovery and rollback the next time it is started. Use this mode only in emergencies.

**See Also:** Chapter 2, "Database Tools on Windows" for a list of other tools that can start Oracle Database and this guide for information on options you can specify when starting your database.

---

**Starting and Shutting Down a Database Using Services**

You can start or shut down Oracle Database by starting or stopping service OracleServiceSID in the Control Panel. Starting OracleServiceSID is equivalent to using the STARTUP command or manually entering:

```command
C:\> oradim -STARTUP -SID SID [-STARTTYPE srvc | inst | srvc,inst] [-PFILE filename | -SPFILE]
```

Stopping OracleServiceSID is equivalent to using the SHUTDOWN command or manually entering:

```command
C:\> oradim -SHUTDOWN -SID SID [-SHUTTYPE srvc | inst | srvc,inst] [-SHUTMODE normal | immediate | abort]
```

You can enable starting and stopping Oracle Database through OracleServiceSID two different ways:

- Oracle Administration Assistant for Windows
- Setting Registry Parameters

**Oracle Administration Assistant for Windows**

To start or stop a database using Oracle Database services from Oracle Administration Assistant for Windows:

1. Choose Start > Programs > Oracle - HOME_NAME > Configuration and Migration Tools > Administration Assistant for Windows.
2. Right-click the SID.
   where SID is a specific instance name, such as ORCL.
3. Choose Startup/Shutdown Options.
4. Choose the **Oracle Instance** tab.

5. Select **Start up instance when service is started**, **Shut down instance when service is stopped**, or both.

![Startup/Shutdown Configuration for ORCL](image)

**Setting Registry Parameters**

To start or stop Oracle Database through Oracle Database Services, set the following registry parameters to the indicated values:

- **ORA_SID_AUTOSTART**
  
  When set to `true`, the default value, this parameter causes Oracle Database to start when `OracleServiceSID` is started.

- **ORA_SID_PFILE**
  
  This parameter sets the full path to the initialization parameter file. If this entry is not present, then `oradim` will try to start the database with an SPFILE or PFILE from `ORACLE_HOME\database`.

- **ORA_SHUTDOWN**
  
  When set to `true`, this parameter enables the selected instance of Oracle Database to be shut down when `OracleServiceSID` is stopped. This includes any database in the current Oracle home. Default value is `false`.

- **ORA_SID_SHUTDOWN**
  
  When set to `true`, the default value, this parameter causes the instance of Oracle Database identified by the `SID` value to shut down when `OracleServiceSID` is stopped manually—using either the Control Panel or Net stop command.
The following two registry parameters are optional:

- **ORA_SID_SHUTDOWNTYPE**
  
  This parameter controls database shutdown mode. Set it to a (abort), i (immediate), or n (normal). Default mode is i (immediate) if you do not set this parameter.

- **ORA_SID_SHUTDOWN_TIMEOUT**
  
  This parameter sets maximum time to wait before the service for a particular SID stops.

The registry location of these required and optional parameters is determined by the number of Oracle home directories on your computer. If you have only one Oracle home directory, then these parameters belong in:

```
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME0
```

If you have multiple Oracle home directories, then these parameters belong in:

```
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME0\HOMEID
```

where **ID** is incremented for each additional Oracle home directory on your computer.

---

**Note:** If you use ORADIM to create or edit instances, then it automatically sets the relevant registry parameters to their appropriate values.

---

**See Also:** Chapter 14, “Configuration Parameters and the Registry” for instructions on adding and editing registry parameters

---

**Starting or Stopping OracleServiceSID from the Control Panel**

1. **To start the database, start OracleServiceSID.**
   
   This automatically starts ORADIM and issues the -STARTUP command using the initialization parameter file identified by **ORA_SID_PFILE**.

2. **To stop the database, stop OracleServiceSID.**
   
   This automatically starts ORADIM, which issues the -SHUTDOWN command in the mode indicated by **ORA_SID_SHUTDOWNTYPE**, and shuts down Oracle Database.

**See Also:** Your operating system documentation for instructions on starting and stopping services.
Starting Multiple Instances

1. Start the service for each instance using ORADIM or the Services dialog of the Control Panel.

2. At the command prompt set the ORACLE_SID configuration parameter to the SID for the first instance to run:
   ```
   C:\> SET ORACLE_SID=SID
   ```
   where SID is the name of the Oracle Database instance.

3. Start SQL*Plus:
   ```
   C:\> sqlplus /NOLOG
   ```

4. Connect AS SYSDBA:
   ```
   SQL> CONNECT / AS SYSDBA
   ```

5. Start up the first instance:
   ```
   SQL> STARTUP PFILE=ORACLE_BASE\admin\db_name\pfile\init.ora
   ```
   where ORACLE_BASE is c:\oracle\product\10.1.0 (unless you changed it during installation) and db_name is the name of the instance.

6. Repeat Steps 2-5 for the other instances to run.

Creating and Populating Password Files

Use Password Utility to create password files. Password Utility is automatically installed with Oracle Database utilities. Password files are located in directory ORACLE_BASE\ORACLE_HOME\DATABASE and are named PWDsid.ORA, where SID identifies the Oracle Database instance. Password files can be used for local or remote connections to Oracle Database.

To create and populate a password file:

1. Create a password file with the Password Utility:
   ```
   C:\> orapwd FILE=PWDsid.ora PASSWORD=password ENTRIES=max_users
   ```
   where
   - FILE specifies the password filename.
   - SID identifies the database instance.
   - PASSWORD sets the password for account SYS.
   - ENTRIES sets maximum number of entries in password file. This corresponds to maximum number of distinct users allowed to connect to the database simultaneously with either the SYSDBA or the SYSOPER DBA privilege.

2. Set initialization parameter file parameter REMOTE_LOGIN_PASSWORDFILE to exclusive, shared, or none.

   The value exclusive specifies that only one instance can use the password file and that the password file contains names other than SYS. In search of the password file, Oracle Database looks in the registry for the value of parameter ORA_SID_PWFILE. If no value is specified, then it looks in the registry for the value of parameter ORA_PWFILE, which points to a file containing usernames, passwords, and privileges. If that is not set, then it uses the default:
The default value is shared. It specifies that multiple instances (for example, a Real Application Clusters environment) can use the password file. However, the only user recognized by the password file is SYS. Other users cannot log in with SYSOPER or SYSDBA privileges even if those privileges are granted in the password file. The shared value of this parameter affords backward compatibility with earlier Oracle releases. Oracle Database looks for the same files as it does when the value is exclusive.

none specifies that Oracle Database ignores the password file and that authentication of privileged users is handled by the Windows operating system. This is the default setting.

3. Start SQL*Plus:
   
   \[ C:\> sqlplus / NOLOG \]

4. Connect AS SYSDBA:
   
   \[ SQL> CONNECT / AS SYSDBA \]

5. Start Oracle Database:
   
   \[ SQL> STARTUP \]

6. Grant appropriate privileges to each user. Users who must perform database administration, for example, would be granted privilege SYSDBA:
   
   \[ SQL> GRANT SYSDBA TO scott; \]

   If the grant is successful, then the following message displays:

   Statement Processed.

   This adds scott to the password file and enables scott to connect to the database with SYSDBA privileges. Use SQL*Plus to add or delete usernames, user passwords, and user privileges in password files.

---

Caution: Copying or manually moving password files may result in ORADIM being unable to find a password to start an instance.

---

### Viewing and Hiding the Password File

The password file is not automatically hidden. It can be made invisible and visible again from two different locations:

- Command Prompt
- Windows Explorer

---

Note: The password file must be visible before it can be moved, copied, or deleted.
Command Prompt
1. To see the password file, enter:

   ORACLE_BASE\ORACLE_HOME\database> attrib

   The password file is displayed as PWDsid.ora:
   A ORACLE_BASE\ORACLE_HOME\database\oradb.exe
   A ORACLE_BASE\ORACLE_HOME\database\oraDim.Log
   A ORACLE_BASE\ORACLE_HOME\database\PWDsid.ora
   A ORACLE_BASE\ORACLE_HOME\database\SPFILEsid.ora

2. To make the password file invisible, enter:

   ORACLE_BASE\ORACLE_HOME\database> attrib +H PWDsid.

3. To see the effect of the change, enter:

   ORACLE_BASE\ORACLE_HOME\database> attrib

   The password file is now hidden:
   A ORACLE_BASE\ORACLE_HOME\database\oradb.exe
   A ORACLE_BASE\ORACLE_HOME\database\oraDim.Log
   A H ORACLE_BASE\ORACLE_HOME\database\PWDsid.ora
   A ORACLE_BASE\ORACLE_HOME\database\SPFILEsid.ora

4. To make the password file visible again, enter:

   ORACLE_BASE\ORACLE_HOME\database> attrib -H PWDsid.

Windows Explorer
To make the password file invisible or visible again:
1. Navigate to directory ORACLE_BASE\ORACLE_HOME\database.
2. Right-click PWDsid.ora.
3. Choose Properties.
   The PWDsid.ora Properties dialog opens.
4. In Attributes, check or clear the checkbox next to Hidden.
5. Click OK.

To view or hide an invisible password file:
1. Navigate to directory ORACLE_BASE\ORACLE_HOME\database.
2. Choose Folder Options from the View main menu.
3. Choose the View tab.
4. To view an invisible password file, choose Show hidden files and folders.
5. To hide a visible password file, choose Do not show hidden files and folders.
6. Click OK.
Connecting Remotely to the Database as SYS

When connecting to the starter database from a remote computer as SYS, you must use a different password from the one described in Oracle Database Installation Guide for Windows when logging on with SYSDBA privileges. This is because the password file enables database access in this situation and it requires the password oracle for this purpose.

Automatically Encrypted Database Passwords

With Oracle Database, the password used to verify a remote database connection is automatically encrypted. Whenever a user attempts a remote login, Oracle Database encrypts the password before sending it to the remote database. If the connection fails, then the failure is noted in the operating system audit log.

Note: Configuration parameter ORA_ENCRYPT_LOGIN is retained for backward compatibility and is set to true by default. See Chapter 14, “Configuration Parameters and the Registry” for instructions on adding and setting configuration parameters in the registry.

Creating Control, Data, and Log Files on Remote Computers

Oracle Database can access database files on a remote computer using Universal Naming Convention (UNC), but it may degrade database performance and network reliability. UNC is a PC format for specifying locations of resources on a local area network. UNC uses the following format:

\server-name\shared-resource-path-name

For example, UNC specification for file system01.dbf in directory C:\oracle\product\10.1.0\oradata\orcl on shared server argon would be:

\argon\oracle\product\10.1.0\oradata\orcl\system01.dbf

Locations of archive log files cannot be specified using UNC. Always set initialization parameter LOG_ARCHIVE_DEST_n to a mapped drive. If you set it to a UNC specification, then Oracle Database does not start and you receive the following errors:

ORA-00256: error occurred in translating archive text string '\meldell\rmdrive'
ORA-09291: sksachk: invalid device specified for archive destination
OSD-04018: Unable to access the specified directory or device
O/S-Error: (OS 2) The system cannot find the file specified

An ORA-00256 error also occurs if you enter \\meldell\rmdrive or \\meldell\rmdrive. Control files required the additional backslashes for Oracle8 release 8.0.4, but redo log files and datafiles did not.

Archiving Redo Log Files

If you installed Oracle Database through the Typical installation, then it is created in NOARCHIVELOG mode. If you created your database through the Custom option of Database Configuration Assistant, then you had the choice of either ARCHIVELOG or NOARCHIVELOG.
In NOARCHIVELOG mode, redo logs are not archived. Setting your archive mode to ARCHIVELOG and enabling automatic archiving causes redo log files to be archived. This protects Oracle Database from both instance and disk failure.

This section describes how to change archive mode to ARCHIVELOG and enable automatic archiving.

See Also: For complete descriptions of ARCHIVELOG and NOARCHIVELOG modes, see "Managing Archived Redo Logs" in Oracle Database Administrator’s Guide

Changing Archive Mode to ARCHIVELOG

1. Start SQL*Plus at the command prompt:
   
   C:\> sqlplus /NOLOG

2. Connect to Oracle Database as SYSDBA:
   
   SQL> CONNECT / AS SYSDBA

3. If the database is open, then shut it down:
   
   SQL> SHUTDOWN

4. Next, mount the database:
   
   SQL> STARTUP MOUNT

5. Enter the following command:
   
   SQL> ARCHIVE LOG LIST

   The following output indicates the database is not in archive mode:

   Database log mode  No Archive Mode
   Automatic archival   Disabled
   Archive destination  %RDBMS%
   Oldest online log sequence 34
   Current log sequence 37

6. Change archive mode to ARCHIVELOG:
   
   SQL> ALTER DATABASE ARCHIVELOG;

7. Enter the following command:
   
   SQL> ARCHIVE LOG LIST

   The following output indicates the database is now in archive mode:

   Database log mode  Archive Mode
   Automatic archival   Disabled
   Archive destination  %RDBMS%
   Oldest online log sequence 34
   Current log sequence 37

8. Open the database:
   
   SQL> ALTER DATABASE OPEN;
Enabling Automatic Archiving

1. Open file `ORACLE_BASE\ADMIN\db_name\pfile\init.ora`.

2. Find the following three initialization parameters:
   
   ```
   # LOG_ARCHIVE_START = true
   # LOG_ARCHIVE_DEST_1 = %ORACLE_HOME%\database\archive
   # LOG_ARCHIVE_FORMAT = "%%ORACLE_SID%%T%TS%S.ARC"
   ```

3. Remove the `#` sign from in front of each.

4. Edit the `LOG_ARCHIVE_DEST_n` value to identify an existing drive and directory in which to archive your filled redo logs.

   **Note:** Double quotation marks around `LOG_ARCHIVE_FORMAT`

5. Edit the `LOG_ARCHIVE_FORMAT` value to indicate the appropriate archiving format:

   - `%%ORACLE_SID%%T.ARC` specifies the thread number. This number is padded to the left by zeroes. The default value is one with a range of up to three characters. Example: `SID0001.ARC`
   - `%%ORACLE_SID%%S.ARC` specifies the log sequence number. This number is padded to the left by zeroes. The default value is one with a range of up to five characters. Example: `SID0001.ARC`
   - `%%ORACLE_SID%%t.ARC` specifies the thread number. The number is not padded. The default value is one with no range limit on characters. Example: `SID1.ARC`
   - `%%ORACLE_SID%%s.ARC` specifies the log sequence number. The number is not padded. The default value is one with no range limit on characters. Example: `SID1.ARC`

6. Save your changes.

7. Exit the file.

8. Shut down the database:

   ```
   SQL> SHUTDOWN
   ```

9. Restart the database

   ```
   SQL> STARTUP
   ```

10. Enter the following command:

    ```
    SQL> ARCHIVE LOG LIST
    ```
The following output indicates that automatic archiving of redo log files is enabled and an archiving destination is specified:

<table>
<thead>
<tr>
<th>Database log mode</th>
<th>Archive Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic archival</td>
<td>Enabled</td>
</tr>
<tr>
<td>Archive destination</td>
<td>C:\BACKUP</td>
</tr>
<tr>
<td>Oldest online log sequence</td>
<td>34</td>
</tr>
<tr>
<td>Current log sequence</td>
<td>37</td>
</tr>
</tbody>
</table>

**Backing Up an Oracle Database on Windows**

As noted in Table 2–1, ”Preferred Database Tools” on page 2-2, Oracle recommends Oracle Enterprise Manager Backup Wizard for backup and recovery. Oracle Database 10g Release 1 (10.1) also bundles Legato Single Server Version (LSSV) software to provide tape backups of your Oracle Database. It is fully integrated with Recovery Manager (RMAN) to back up your database on a single host. Legato NetWorker updates and documentation can be obtained directly from Legato and can be found at the following Web site:

http://www.legato.com/lssv/

If you have previously installed and used Legato Storage Manager (LSM) on your Oracle Database server, then you can uninstall it and install this new version of Legato NetWorker. Any backups made by LSM can still be used by the new Legato NetWorker software.
This chapter describes how to monitor Oracle Database for Windows.

This chapter contains these topics:

- Database Monitoring Overview
- Using Oracle Counters for Windows Performance Monitor
- Using Event Viewer
- Trace Files
- Alert Files
- Viewing Threads

Database Monitoring Overview

Table 6–1 describes tools that enable you to monitor Oracle Database.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Functionality</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Counters for Windows Performance Monitor</td>
<td>Monitor database objects, such as CPU usage, buffer cache, or a background process.</td>
</tr>
<tr>
<td>Event Viewer</td>
<td>Monitor database events.</td>
</tr>
<tr>
<td>Trace Files</td>
<td>Record occurrences and exceptions of database operations</td>
</tr>
<tr>
<td>Alert Files</td>
<td>Record important information about error messages and exceptions during database operations.</td>
</tr>
<tr>
<td>Oracle Enterprise Manager Database Management Packs</td>
<td>Monitor and tune using tools with real-time graphical performance information. <strong>See Also:</strong> Your Oracle Enterprise Manager documentation set for more information</td>
</tr>
<tr>
<td>Oracle Administration Assistant for Windows</td>
<td>View information on or terminate any Oracle thread.</td>
</tr>
</tbody>
</table>
Oracle Counters for Windows Performance Monitor is a graphical tool for measuring the performance of Oracle Database for Windows objects on a local server or other servers on a network. This tool is the same in appearance and operation as Windows Performance Monitor, except it has been preloaded with Oracle Database performance elements.

On each computer, you can view behavior of objects, such as buffer cache, data dictionary cache, datafiles, threads, and processes. An object is a graphical representation of an element in your system. Every element, resource, and device in your system can be represented as an object.

A set of counters is associated with each object. A counter is a unit of measurement used by Performance Monitor to display activity. The type of activity the counter measures is dependent upon type of object.

Certain types of objects and their respective counters are present on all systems. Other counters, such as application-specific counters, appear only if the computer is running the associated software.

Each of these objects has an associated set of counters that provide information about device usage, queue lengths, delays, and information used to measure throughput and internal congestion.

Registry Information

When you install Oracle Counters for Windows Performance Monitor, values are automatically set in the registry as described in Chapter 14, "Configuration Parameters and the Registry".

Oracle Counters for Windows Performance Monitor lets you monitor only one database instance at a time. For this reason, the registry contains the following values:

- Hostname
- Username
- Password

Note: A 64-bit version of Oracle Enterprise Manager Grid Control is not available in this release. Oracle Enterprise Manager Grid Control can manage a 64-bit Windows database from a remote 64-bit Solaris computer. For more information, see Appendix G, "Oracle Database for 64-Bit Windows".

See Also: Oracle Database Performance Tuning Guide for general tuning information

Note: Before using Oracle Counters for Windows Performance Monitor to view Oracle-specific counters, you must specify the SYSTEM password using operfcfg.exe or Oracle Administration Assistant for Windows. See "Using operfcfg" on page 14-14 or "Using Oracle Administration Assistant for Windows" on page 14-15 for instructions.
Use operfcfg to change these values. Oracle recommends setting the security level on each of these registry values.

See Also: Chapter 14, "Configuration Parameters and the Registry" for instructions on how to use operfcfg.

To use Oracle Counters for Windows Performance Monitor for another database instance on the same computer or a UNIX computer, change the values appropriately in the registry. You can also monitor non-Windows installations of Oracle Database by changing Hostname registry value so it points to another computer specified in file tnsnames.ora.

**Accessing Oracle Counters for Windows Performance Monitor**

To access Oracle Counters for Windows Performance Monitor:

Choose Start > Programs > Oracle - HOME_NAME > Configuration and Migration Tools > Oracle Counters for Windows Performance Monitor.

Oracle Counters for Windows Performance Monitor has four views you can choose from the View menu:

- Chart view displays database activity as it occurs.
- Alert view lets you know when certain minimum performance criteria are not being met, or maximum criteria are being exceeded.
- Log view maintains continuous records on performance.
- Report view saves information about specific criteria.

See Also: Your operating system documentation for complete information about the four views.

**Modifying Views**

For each view you can decide objects to monitor, what counters to use for each object, and graphical attributes of the view. When an object is chosen, it is assigned a counter, a color, and added to the status bar at the bottom of Oracle Counters for Windows Performance Monitor.

To add objects to a view:

1. Choose Add To (Chart, Alert, Log, Report) from the Edit menu. (This example uses Add to Chart, but other dialogs are similar.)
   
   The Add to Chart dialog appears.

2. In the Computer list, select the computer to monitor.

3. In the Object list, select the object or objects to monitor, then click Add.
   
   If no data or Oracle Database objects appear, then either Oracle Database is not running or an invalid host string or password has been entered. If the database is not started, then exit Oracle Counters for Windows Performance Monitor, start the database, and restart Oracle Counters for Windows Performance Monitor.

4. In the Counter list, select one or more counters for each object you have selected. Note that the contents of the Counter list change depending upon your selection in the Object list. For details on how a counter works, highlight the counter and click Explain.

5. In the Instance list, select an instance for this counter.
6. In the Color list, choose a color for the display of the selected counter.
7. In the Scale list, choose the scale at which to display the counter.
8. In the Width list, specify the width of the line on the graph.
9. In the Style list, choose a style for your graph line.
10. Click Done when you are finished.

The selections you have chosen to monitor are displayed.

Understanding Oracle Database Performance Objects

All Oracle Database system resources that can be monitored through Oracle Counters for Windows Performance Monitor begin with ‘Oracle Database’. This section lists Oracle Database objects and describes their associated counters. These measures are defined in

`ORACLE_BASE\ORACLE_HOME\dbs\PERF\ver.ora`

See Also: Oracle Database Performance Tuning Guide for additional information on these objects

Note: You can monitor only one instance at a time using Oracle Counters for Windows Performance Monitor on a given computer.

Oracle Database Buffer Cache
The counter is phyrds/gets %. The percentage of phyrds/gets is calculated as a Miss ratio. The lower the Miss counter, the better. To improve performance, increase the number of buffers in the buffer cache, if memory is available on the computer. This value is not time-derived.

Oracle Database Redo Log Buffer
The counter is redo log space requests. The value of this counter must be near zero. If this value increments consistently, then processes have had to wait for space in the redo log buffer. In this case, it may be necessary to increase the size of the redo log buffer.

Oracle Database Data Dictionary Cache
The counter is getmisses/gets %. The value of this counter must be less than 10 or 15% for frequently accessed data dictionary caches. If the ratio continues to increase over this threshold while your application is running, then increase the amount of memory available to the data dictionary cache.

To increase the memory available to the cache, increase the value of initialization parameter `SHARED_POOL_SIZE`. This value is not time-derived.

See Also: Oracle Database Performance Tuning Guide for more detailed information on tuning memory allocation in Oracle Database

Oracle Database Library Cache
The counter is reloads/pins %. This is the percentage of SQL statements, PL/SQL blocks, and object definitions that required reparsing. Total Reloads must be near zero.
Using Oracle Counters for Windows Performance Monitor

If the ratio of Reloads to Pins is greater than 1%, then reduce the library cache misses. This value is not time-derived.

**Oracle Database Data Files**
The counters are phyrs/sec and phywrts/sec. These values are time-derived. Disk contention occurs when multiple processes try to access the same disk simultaneously. Depending on results from monitoring disk activity, corrective actions could include:

- Distributing I/O
- Separating datafiles and **redo log files**
- Separating tables and indexes
- Stripping table data

**Oracle Database DBWR stats1**
The two counters available, buffers scanned/sec and LRU scans/sec, are helpful in tuning Buffer Cache. Buffers scanned/sec is the number of buffers DBWR scanned in each second. The buffers scanned are on the LRU (Least Recently Used) list. LRU scans/sec is the number of times DBWR scanned the (Least Recently Used) buffer list in each second.

**Oracle Database DBWR stats2**
The two counters available, timeouts/sec and checkpoints/sec, are helpful in determining how much work DBWR has been requested to perform. Timeouts/sec is the number of times DBWR timed-out in each second. DBWR is on a three second timeout interval. If DBWR has not been posted within a three second interval, then it times out.

Checkpoints/sec is the number of checkpoint messages processed by database writer in each second. Whenever a checkpoint occurs, DBWR must be messaged (posted) to "write dirty buffers to disk".

**Oracle Database Dynamic Space Management**
The counter is recursive calls/sec. Dynamic extension causes Oracle Database to execute SQL statements in addition to those SQL statements issued by user processes. These SQL statements are called recursive calls.

If Oracle Database makes excessive recursive calls while an application is running, then it may be necessary to determine the cause. Examine the recursive calls statistic through dynamic performance table **V$SYSSTAT**.

**Oracle Database Free List**
The counter is free list waits/requests %. Contention for free lists is reflected by contention for free data blocks in buffer cache. You can determine if contention for free lists is reducing performance by querying **V$WAITSTAT**.

If the number of free list waits for free blocks is greater than 1% of the total number of requests, then consider adding more free lists to reduce contention.

**Oracle Database Sorts**
The available counters are sorts in memory/sec and sorts on disk/sec. The default sort area size is adequate to hold all data for most sorts. However, if your application often performs large sorts on data that does not fit into the sort area, then you may increase sort area size.
Oracle Counters for Windows Performance Monitor Troubleshooting Information

If no data or Oracle Database objects appear in the Objects list of the Add to (Chart, Alert, Log, Report) dialog, then:

1. Ensure that Oracle Database is running. If it is not running, then exit Oracle Counters for Windows Performance Monitor, and start the database.
2. If the database is running but no data or Oracle Database objects appear, then check the error file for Oracle Counters for Windows Performance Monitor:

   \ORACLE_BASE\ORACLE_HOME\dbs\OPERF\ver.log

   If the log file indicates an invalid host string or password, then check the registry for correct values for Hostname, Password, and Username. See "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services" on page 14-6 for further information about these values.

Using Event Viewer

Oracle Database for Windows problems and other significant occurrences are recorded as events in an application event log. View and manage these recorded events in Event Viewer.

To access Event Viewer:

   
   The Event Viewer window appears.
2. Choose Application from the Log menu.
   
   Figure 6–1 displays the Application view window, Table 6–2 shows what is recorded in each column, and Table 6–3 interprets icons that appear at the left edge of the viewer.

   **Figure 6–1 Application View Window**
Oracle Database for Windows events display with a source of Oracle.SID.

Event number 34 specifies an audit trail event. These events are recorded if parameter 
`AUDIT_TRAIL` is set to `db(true)` or `os` in the initialization parameter file. Option `os` 
enables system wide auditing and causes audited records to be written to Event 
Viewer. Option `db` enables system wide auditing and causes audited records to be 
written to the database audit trail (table `SYS.AUD$`). Some records, however, are 
written to Event Viewer.

Event numbers other than 34 specify general database activities, such as an instance 
being started or stopped.

When you double-click an icon in Event Viewer, the Event Detail dialog appears with 
more information about the selected event. Figure 6–2, for example, shows details 
about EventID 1011. In the Description field you will find a text description of the 
event. In the Data field you can choose Bytes to see the information in hexadecimal 
format or Words to see DWORDS for the same data.
Managing Event Viewer

Setting AUDIT_TRAIL to db or os causes more records to be written to Event Viewer. This can fill up the Event Viewer log file. Follow these procedures to increase log file size:

1. Choose Log Settings from the Log menu.
   The Event Log Settings dialog appears.
2. Adjust the setting in the Maximum Log Size field to an appropriate level.
3. Click OK.
   You are returned to Event Viewer.

| Caution: | Audit information cannot be spooled to a file. Parameter AUDIT_FILE_DEST is not supported in Windows and should not be added to the initialization parameter file. |

Trace Files

Oracle Database for Windows background threads use trace files to record occurrences and exceptions of database operations, as well as errors. Background thread trace files are created regardless of whether parameter BACKGROUND_DUMP_DEST is set in the initialization parameter file. If BACKGROUND_DUMP_DEST is set, then trace files are stored in the directory specified. If the parameter is not set, then trace files are stored in directory $ORACLE_BASE\ADMIN\db_name\bdump.$
Oracle Database creates a different trace file for each background thread. The name of the trace file contains the name of the background thread, followed by the extension ".TRC". Sample trace file syntax includes:

- SIDDBWR.TRC
- SIDSMON.TRC

where SID is the name of the instance.

Trace files are also created for user threads if parameter USER_DUMP_DEST is set in the initialization parameter file. Trace files for user threads have the form oraxxxxx.trc, where xxxxx is a 5-digit number indicating the Windows thread ID.

Alert Files

Alert files contain important information about error messages and exceptions that occur during database operations. Each Oracle Database for Windows instance has one alert file; information is appended to the file each time you start the instance. All threads can write to the alert file.

For example, when automatic archiving of redo logs is halted because no disk space is available, a message is placed in the alert file. The alert file is the first place to check if something goes wrong with the database and the cause is not immediately obvious.

The alert file is named alert_SID.log and is found in the directory specified by parameter BACKGROUND_DUMP_DEST in the initialization parameter file. If parameter BACKGROUND_DUMP_DEST is not set, then file alert_SID.log is generated in ORACLE_BASE\admin\db_name\bdump. Alert files should be deleted or archived periodically.

Viewing Threads

To view information on Oracle Database threads using Oracle Administration Assistant for Windows, you must either enable Windows native authentication for the database or run utility ocfgutil.exe with arguments username and password. The utility stores the username and password in the following registry location:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\OracleOraConfig

When Windows native authentication is not enabled, Oracle Remote Configuration Agent retrieves the username and password from this registry key to log in to the database.

To view information on Oracle Database threads using Oracle Administration Assistant for Windows:

1. Choose Start > Programs > Oracle - HOME_NAME > Configuration and Migration Tools > Administration Assistant for Windows.
2. Right-click the SID, where SID is a specific instance name, such as orcl.
3. Choose Process Information.
   The Process Information dialog appears, listing name, type, user, thread ID, and CPU usage for each Oracle Database thread.
4. To terminate a thread, select it and click Kill Thread.
The list displays information about Oracle threads.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>User</th>
<th>Thread ID</th>
<th>CPU</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td>PMON</td>
<td>Background</td>
<td>SYS</td>
<td>1596</td>
<td>0.00</td>
<td>0%</td>
</tr>
<tr>
<td>DBW0</td>
<td>Background</td>
<td>SYS</td>
<td>1512</td>
<td>0.00</td>
<td>0%</td>
</tr>
<tr>
<td>LGWR</td>
<td>Background</td>
<td>SYS</td>
<td>1556</td>
<td>0.01</td>
<td>0%</td>
</tr>
<tr>
<td>CKPT</td>
<td>Background</td>
<td>SYS</td>
<td>1552</td>
<td>0.00</td>
<td>0%</td>
</tr>
<tr>
<td>SMON</td>
<td>Background</td>
<td>SYS</td>
<td>1520</td>
<td>0.00</td>
<td>0%</td>
</tr>
<tr>
<td>RECO</td>
<td>Background</td>
<td>SYS</td>
<td>1516</td>
<td>0.00</td>
<td>0%</td>
</tr>
<tr>
<td>CIQ0</td>
<td>Foreground</td>
<td>SYS</td>
<td>1572</td>
<td>0.00</td>
<td>0%</td>
</tr>
</tbody>
</table>
This chapter describes how to tune the Windows Server operating system to ensure that Oracle Database is running in the best possible environment.

This chapter contains these topics:

- Windows Tuning Overview
- Large Page Support
- Reduce Priority of Foreground Applications on Server Console
- Configure Windows Server to Be an Application Server
- Disable Unnecessary Services
- Remove Unused Network Protocols
- Reset Network Protocol Bind Order
- Setting the Order of Multiple Network Interface Cards
- Apply Latest Reliable Windows Server Service Pack
- Use Hardware or Operating System Striping
- Multiplex Windows Server Virtual Memory Paging File
- Close All Unnecessary Foreground Applications

Note: For the sake of brevity, this discussion uses the collective term Windows Server when a statement applies to Windows 2000 Server and Windows NT Server.

Windows Tuning Overview

Windows Server operating systems offer considerably fewer tuning adjustments than UNIX. This difference constrains systems administrators when they try to optimize Windows Server performance, but it also makes Windows Server easier to use.

There are still ways, however, to make Windows Server a better application server environment for Oracle Database. Most of the operating system specific procedures described in this chapter enable Oracle Database to reserve more system resources, such as CPU, memory, and disk I/O.
In addition, because Oracle Database is a high-performance database management system that effectively uses resources of your Windows computer, it should not also serve as any of the following:

- Primary or backup domain controller
- File or print server
- Remote access server
- Router

These configurations consume network, memory, and CPU resources. In addition, the Windows computer that is running Oracle Database should not be locally accessed with a high frequency or intensively used for local user processing, unless it has enough resources to accommodate all this activity.

---

**Note:** Information presented in this chapter does not apply to Oracle Database installations on Windows NT Workstation. It does apply to Oracle Database installations on Windows NT Server and Windows NT Server 4.0, Enterprise Edition. Windows NT Server 4.0, Enterprise Edition includes capability for using additional products. One such product is Microsoft Cluster Server, which is required to implement Oracle Fail Safe.

---

**Large Page Support**

Large page support is a new feature of Oracle Database 10g Release 1 (10.1). It provides a performance boost for memory-intensive database instances running on Windows Server 2003. By taking advantage of newly introduced operating system support, Oracle Database 10g Release 1 (10.1) can now make more efficient use of processor memory addressing resources. Specifically, when large page support is enabled, the CPUs in the system will be able to access the Oracle Database buffers in RAM more quickly. Instead of addressing the buffers in 4KB increments, the CPUs are told to use 4MB page sizes when addressing the database buffers.

This feature is particularly useful when the Oracle buffer cache is several gigabytes. Smaller-sized configurations will still see a gain when using large pages, but the gain will not be as great as when the database is accessing large amounts of memory.

To enable large page support, set `ORA_LPENABLE` to 1 in the Oracle key of the Windows Server 2003 registry.

---

**Note:** Large pages are supported in Oracle Database for 64-bit Windows. For more information, see "Large Page Support for 64-bit Windows" on page G-2.

---

**Reduce Priority of Foreground Applications on Server Console**

One of the settings provided by default during installation of Windows Server gives interactive foreground applications priority over every background process. To prevent foreground applications on the server console from taking excessive processor time away from Oracle Database, you can reduce priority for foreground applications.

**See Also:** Your operating system documentation for instructions on reducing priority of foreground applications
Configure Windows Server to Be an Application Server

Windows memory manager divides up system memory into three different pools described in Table 7–1.

<table>
<thead>
<tr>
<th>Pool</th>
<th>Percent of Total Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kernel and other system services</td>
<td>9%</td>
</tr>
<tr>
<td>File Cache</td>
<td>41%</td>
</tr>
<tr>
<td>Paged Memory</td>
<td>50%</td>
</tr>
</tbody>
</table>

Windows Server memory manager tries to balance each application’s usage of memory by dynamically paging memory between physical RAM and a virtual memory paging file. If an application is particularly memory-intensive (like Oracle Database) or if a large number of applications are running concurrently, then combined memory requirements of the applications may exceed physical memory capacity.

The large proportion of memory reserved for file caching (41%) can be quite beneficial to file and print servers. But it may not be advantageous to application servers that often run memory-intensive network applications. A Windows Server file cache is particularly unnecessary for Oracle Database, which performs its own caching through System Global Area.

You can reset the Windows Server memory model from the default file and print server, with its large file cache, to a network applications model, with a reduced file cache and more physical memory available for Oracle Database.

See Also: Your operating system documentation for instructions

Disable Unnecessary Services

After you have significantly reduced the file cache as described in "Configure Windows Server to Be an Application Server" on page 7-3, you can retrieve additional physical memory for Oracle Database by disabling services not needed for core operating system functionality. Unnecessary services include:

- License Logging Service
- Plug and Play
- Remote Access Autodial Manager
- Remote Access Connection Manager
- Remote Access Server
- Telephony Service

Consult with your systems administrator to identify other unnecessary services.

Do not disable any of the following services:

- Alerter
- Computer Browser
- EventLog
- Messenger
- OracleServiceSID
Remove Unused Network Protocols

Remove all unnecessary network protocols on Windows so that processing time can be concentrated on servicing only critical protocols.

See Also: Your operating system documentation for instructions on removing unnecessary network protocols

Reset Network Protocol Bind Order

If multiple protocols must be installed on the server, you can give the protocol most frequently used by Oracle Database highest priority by resetting the network protocol bind order.

See Also: Your operating system documentation for instructions on resetting network protocol bind order

Setting the Order of Multiple Network Interface Cards

If you have public and private network interface cards (NICs) on a single Windows computer and they are not in the correct order, then you might experience problems with any configuration (Oracle Enterprise Manager, for example) that uses gethostname.

If the private NIC is seen first by Windows, then a gethostname call will return the hostname of the private interconnect. Whichever tool is calling gethostname will have configuration or connectivity problems stemming from this non-public network information.

On a Windows 2000 computer, you can determine the current order of your NICs, and change it if necessary, as follows:

1. Choose Start > Settings > Network and Dial-up Connections.
2. Choose Advanced > Advanced Settings.
3. The Connections: field lists your public and private Local Area Connections. To change the order in which Windows accesses them, select one of them and click on the Arrow buttons to move it up or down.
4. When the public and private NICs are in the order you want, click OK.
5. The change in priority takes effect immediately. Restarting your computer is not necessary.
**Apply Latest Reliable Windows Server Service Pack**

Microsoft releases operating system patches, called Service Packs, on a quarterly basis. Service Packs are collections of bug fixes and product enhancements to the basic Windows Server release. In general, apply Service Packs as soon as it is safe to do so, since they fix bugs and can improve Windows Server performance or functionality.

While Service Packs are supposed to fix bugs, there have been reports (for example, the initial release of Windows NT Server 4.0 Service Pack 2) of bugs within the patch updates themselves. In general, it is safest to wait a few weeks after a Service Pack is released before implementing it. This allows time for other field sites to report any problems with the SP release.

The latest Windows Server Service Packs may be downloaded as self-extracting archives from [http://support.microsoft.com](http://support.microsoft.com)

Unless there are assurances that the Service Pack works without flaws on Windows Server, choose to create an `Uninstall` directory. This enables the Service Pack to be removed and the original configuration to be restored.

Service Pack files overwrite similarly-named files in the previous Windows Server configuration. However, Service Pack files can be overwritten in turn by setup programs that copy files from the original installation media.

For example, installing a new network protocol or printer driver usually requires copying files from original Windows Server installation media. When Service Pack files are comprehensively or selectively overwritten, the Service Pack must be re-applied.

**Use Hardware or Operating System Striping**

Compared to CPU and memory speeds, hard disk drives are extremely slow. Now that hard disk drives are relatively inexpensive, Oracle recommends that Windows Server use logical volumes comprised of striped physical disks. Data striping is an effective means of reducing the impact of relatively slow hard drives by distributing file I/O across a number of hard drives simultaneously.

Striping data across a number of disks is one example of a redundant array of inexpensive disks (RAID). There are several different types of RAID, also referred to as RAID levels, ranging from high performance to high reliability. The three most common RAID levels in Oracle Database installations are RAID-0, RAID-1, and RAID-5. Descriptions of each RAID level follow Table 7–2, which shows each level's read and write penalties.

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>Read Penalty</th>
<th>Write Penalty</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (Disk Striping)</td>
<td>1:1</td>
<td>1:1</td>
</tr>
<tr>
<td>1 (Disk Mirroring)</td>
<td>1:1</td>
<td>2:1</td>
</tr>
<tr>
<td>0 + 1</td>
<td>1:1</td>
<td>2:1</td>
</tr>
<tr>
<td>5 (Distributed Data Gathering)</td>
<td>1:1</td>
<td>4:1</td>
</tr>
</tbody>
</table>

1  Read penalty is ratio of I/O operations to read requests.
2  Write penalty is ratio of I/O operations to write requests.

---

Tuning Windows to Optimize Oracle Database 7-5
**Disk Stripping**

RAID level 0 enables high-performance, fault-intolerant disk striping. Multiple physical hard disks are aggregated into a logical whole, either by a disk controller or through the operating system (for example, Windows 2000 Server striped volumes). Data operations against the logical volume are broken down into as many chunks as there are physical drives in the array, making simultaneous use of all disks. Given identical hard disks, if one hard disk has a throughput rate of DISKRATE operations/second, then a RAID 0 logical volume has a rate of:

\[(DISKRATE \times \text{[number of physical drives in array]}) \text{ operations/second}\]

The downside of RAID 0 is its lack of fault tolerance. If one disk in the logical volume fails, the whole volume fails and must be restored from a backup.

**Disk Mirroring**

RAID level 1 enables fault tolerant disk mirroring with some chance of a performance penalty. Essentially, every write to a mirrored disk is duplicated on another drive dedicated to this purpose (the mirror drive). If the mirrored disk fails, the mirror drive is brought online in real time. After the faulted drive is replaced, the mirror configuration can be reestablished.

The read penalty for RAID level 1 is nominally 1:1, but it may benefit from split reads on some controllers. When the controller knows which mirror can be accessed fastest, for example, it can lower seek times by directing I/O operations to that disk.

**Disk Stripping + Mirroring**

RAID level 0+1 enables mirroring of an array of striped hard disks. This is a blend of RAID 0 and RAID 1, offering high-performing fault tolerance.

**Distributed Data Guarding**

RAID level 5, also known as disk striping with parity, eliminates the costly requirement to mirror. In RAID 5, multiple hard disks are aggregated into a striped logical volume, similar to RAID 0, but each drive contains parity information such that any single drive failure is tolerated. With one failed drive, a RAID-5 system can allow continued access to data, although access times are greatly reduced due to on-the-fly rebuilding of bytes from parity information. RAID-5 solutions usually allow hot-swapping of faulty drives with replacements, triggering a rebuild of the failed drive’s data onto the replacement from parity information.

The write penalty of 4:1 results from 2 reads and 2 writes during parity calculation.

**Multiple Striped Volumes for Sequential and Random Access**

If there are enough physical disks in Windows Server, create at least two striped volumes (in addition to a standalone hard disk or striped volume for the operating system). One striped volume can be used for sequential data access, and the other can be used for random data access.

Oracle Database redo logs and archived redo logs, for example, are written in sequential order. Because of reduced head movement, hard disks perform best when reading or writing sequential data.

Oracle Database data files, however, are usually accessed in random order. Random access in a hard disk results in significant head movement, translating to slower data access.
Unless redo logs are separated from datafiles (at physical device level), undo file I/O contention may result, increasing access times for both types of files.

**Multiplex Windows Server Virtual Memory Paging File**

Some virtual memory paging is likely even if Oracle Database is the only network application running on Windows Server, because Windows Server memory manager will attempt to move seldom-used pages to disk to free up more physical memory for hot pages.

Multiplexing the Windows Server virtual memory paging file is a good strategy to boost overall system performance. Splitting the paging file onto at least two different physical volumes (or logical volumes as long as underlying physical volumes do not overlap) provides a significant performance boost to virtual memory swapping operations.

Even though this is a good technique to increase speed of virtual memory paging, too much paging activity is still a performance hit and should be corrected by adding more RAM to the server.

**General Page File Sizing Tip**

Oracle recommends that total combined size of your page files be at least equal to physical RAM on your computer. Configurations where combined size is two to four times the size of physical RAM are not uncommon. Minimize paging as much as possible. But situations in which the operating system runs out of or low on paging space are to be avoided at all costs. Adequately-sized paging files spaced across physical disks spread out I/O most efficiently, because the operating system spreads paging evenly across page files.

---

**Note:** Internal read/write batch size for Windows is 4K.

---

**Close All Unnecessary Foreground Applications**

Once procedures in previous sections have been applied, remember to close any unnecessary foreground applications. First, remove all applications from Startup folders of Windows Server console operators. Second, minimize the window when executing long-running scripts from a command prompt, so that Windows Server can focus on the operation and not on a flood of window repaint messages. Third, disable screen savers, which can quickly saturate the CPU. If a screen saver must be run, choose Blank Screen, which uses the least amount of processing time.
This chapter describes authentication of Oracle Database users with Windows operating systems.

This chapter contains these topics:

- Windows Native Authentication Overview
- Windows Authentication Protocols
- User Authentication and Role Authorization Methods
- Operating System Authentication Enabled at Installation

**Windows Native Authentication Overview**

Oracle Database can use Windows user login credentials to authenticate database users. Benefits include:

- Enabling users to connect to Oracle Database without supplying a username or password
- Centralizing Oracle Database user authentication and role authorization information in Windows NT or Windows 2000, which frees Oracle Database from storing or managing user passwords or role information

The Windows native authentication adapter (automatically installed with Oracle Net Services) enables database user authentication through Windows. This enables client computers to make secure connections to Oracle Database on a Windows server. The server then permits the user to perform database actions on the server.

---

**Note:** Current user database links are not supported with Windows native authentication.

---

**Note:** This chapter describes using Windows native authentication methods with Windows 2000 and Windows NT 4.0. For information on Secure Sockets Layer (SSL) protocol and Oracle Internet Directory, see Oracle Advanced Security Administrator’s Guide and Oracle Internet Directory Administrator’s Guide.
Windows Authentication Protocols

The Windows native authentication adapter works with Windows authentication protocols to enable access to Oracle Database.

- Kerberos is the default authentication protocol for Windows 2000.
- NT LAN Manager (NTLM) is the default protocol for Windows NT 4.0.

If the user is logged on as a Windows 2000 domain user from a Windows 2000 computer, then Kerberos is the authentication mechanism used by the NTS adapter. For all other users, NTLM is the authentication mechanism used by the NTS adapter.

If authentication is set to NTS on a standalone Windows 2000 or Windows NT 4.0 computer, ensure that Windows service NT LM Security Support Provider is started. If this service is not started on a standalone Windows 2000 or Windows NT 4.0 computer, then NTS authentication fails. This issue is applicable only if you are running Windows 2000 or Windows NT 4.0 in standalone mode.

Client computers do not need to specify an authentication protocol when attempting a connection to Oracle Database. Instead, Oracle Database determines the protocol to use, completely transparent to the user. The only Oracle Database requirement is to ensure that parameter `SQLNET.AUTHENTICATION_SERVICES` contains `nts` in the following file on both the client and database server:

```
ORACLE_BASE\ORACLE_HOME\network\admin\sqlnet.ora
```

This is the default setting for both after installation. For Oracle8 release 8.0.x releases, you must manually set this value.

If typical, your Oracle Database network includes client computers and database servers, and computers on this network may use different Oracle Database software releases on different Windows operating systems on different domains. This combination of different releases means that the authentication protocol being used can vary.

Table 8–1 lists Oracle Database software and Windows operating system releases required to enable Kerberos as the default authentication protocol:

**Table 8–1 Software Requirements to Enable Kerberos Authentication Protocol**

<table>
<thead>
<tr>
<th>Location</th>
<th>Windows Software</th>
<th>Oracle Database Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client Computer</td>
<td>Windows NT 4.0 or Windows 2000</td>
<td>Oracle8i Client or later</td>
</tr>
<tr>
<td>Database Computer</td>
<td>Windows NT 4.0 or Windows 2000</td>
<td>Oracle8i Database or later</td>
</tr>
<tr>
<td>Domain</td>
<td>Windows 2000</td>
<td>None</td>
</tr>
</tbody>
</table>

For all other combinations of Windows operating system and Oracle Database software releases used in your network, the authentication protocol used is NTLM.

**See Also:** Your operating system documentation for more information on each authentication protocol

User Authentication and Role Authorization Methods

This section describes how user login credentials are authenticated and database roles are authorized in Windows NT 4.0 or Windows 2000 domains. User authentication and role authorization are defined in Table 8–2.
Oracle Database supports user authentication and role authorization in Windows NT 4.0 domains. Table 8–3 provides descriptions of these basic features.

### Table 8–2 User Authentication and Role Authorization Defined

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>User authentication</td>
<td>Process by which the database uses the user’s Windows login credentials to authenticate the user.</td>
<td>Oracle Database 2 Day DBA</td>
</tr>
<tr>
<td>Role authorization</td>
<td>Process of granting an assigned set of roles to authenticated users.</td>
<td>Oracle Database 2 Day DBA</td>
</tr>
</tbody>
</table>

### Table 8–3 Basic Features of User Authentication and Role Authorization

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication of external users</td>
<td>Users are authenticated by the database using the user’s Windows login credentials enabling them to access Oracle Database without being prompted for additional login credentials.</td>
</tr>
<tr>
<td>Authorization of external roles</td>
<td>Roles are authorized using Windows local groups. Once an external role is created, you can grant or revoke that role to a database user. Initialization parameter OS_ROLES is set to false by default. You must set OS_ROLES to true to authorize external roles.</td>
</tr>
</tbody>
</table>

### Authentication and Authorization Methods To Use

Table 12–4 describes user authentication and role authorization methods to use based on your Oracle Database environment:

### Table 8–4 User Authentication and Role Authorization Methods

<table>
<thead>
<tr>
<th>Method</th>
<th>Database Environment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enterprise users and roles</td>
<td>You have many users connecting to multiple databases. Enterprise users have the same identity across multiple databases. Enterprise users require use of a directory server. Use enterprise roles in environments where enterprise users assigned to these roles are located in many geographic regions and must access multiple databases. Each enterprise role can be assigned to more than one enterprise user in the directory. If you do not use enterprise roles, then you have to assign database roles manually to each database user. Enterprise roles require use of a directory server.</td>
</tr>
<tr>
<td>External users and roles</td>
<td>You have a smaller number of users accessing a limited number of databases. External users must be created individually in each database and do not require use of a directory server. External roles must also be created individually in each database, and do not require use of a directory server. External roles are authorized using group membership of the users in local groups on the system.</td>
</tr>
</tbody>
</table>

**See Also:** Oracle Advanced Security Administrator’s Guide for more information on Enterprise users and roles
Operating System Authentication Enabled at Installation

When you install Oracle Database, a special Windows local group called ORA_DBA is created (if it does not already exist from an earlier Oracle Database installation), and your Windows username is automatically added to it. Members of local group ORA_DBA automatically receive the SYSDBA privilege.

Membership in ORA_DBA enables you to:

■ Connect to local Oracle Database servers without a password with the command
  
  CONNECT / AS SYSDBA
  
■ Connect to remote Oracle Database servers without a password with the command
  
  CONNECT /@net_service_name AS SYSDBA
  
  where net_service_name is the net service name of the remote Oracle Database server

■ Perform database administration procedures such as starting and shutting down local databases

■ Add additional Windows users to ORA_DBA, enabling them to have the SYSDBA privilege
External users and roles are in general defined by something external to Oracle Database. In a Windows environment, they are defined by the operating system.

This chapter describes external user and external role creation and management using either Oracle Administration Assistant for Windows or by a combination of Oracle Database command line tools, Registry Editor, and other Windows tools.

---

**Note:** Both methods can also administer external users and roles in Windows 2000 domains, but cannot be used to administer an enterprise user or an enterprise role. See Oracle Advanced Security Administrator’s Guide for more information on tools available for administering enterprise users and roles.

---

This chapter contains these topics:
- Oracle Administration Assistant for Windows
- Manually Administering External Users and Roles

### Oracle Administration Assistant for Windows

Oracle Administration Assistant for Windows runs from Microsoft Management Console and enables you to configure the following Oracle Database users and roles so that the Windows operating system can authenticate them, and they can access Oracle Database without a password:
- Regular Windows domain users and global groups as external users
- Windows database administrators (with the SYSDBA privilege)
- Windows database operators (with the SYSOPER privilege)

In addition, Oracle Administration Assistant for Windows can create and grant local and external database roles to Windows domain users and global groups.

With Oracle Administration Assistant for Windows, none of the following need be done manually:
- Create local groups that match the database system identifier and role
- Assign domain users to these local groups
Authenticate users in SQL*Plus with

\[\text{CREATE USER username IDENTIFIED EXTERNALLY}\]

This section describes how to perform the following tasks with Oracle Administration Assistant for Windows:

- Adding a Computer and Saving Your Configuration
- Granting Administrator Privileges for All Databases on a Computer
- Granting Operator Privileges for All Databases on a Computer
- Connecting to a Database
- Viewing Database Authentication Parameter Settings
- Creating an External Operating System User
- Creating a Local Database Role
- Creating an External Operating System Role
- Granting Administrator Privileges for a Single Database
- Granting Operator Privileges for a Single Database

**Note:** Oracle Administration Assistant for Windows runs from Microsoft Management Console, which is automatically included in Windows 2000. If you are using Windows NT 4.0, you must do one of the following:

- Install Microsoft Windows NT 4.0 Option Pack, which includes Microsoft Management Console
- Download Microsoft Management Console from the Microsoft Web site: [http://www.microsoft.com](http://www.microsoft.com)

**Managing a Remote Computer**

If you want to use Oracle Administration Assistant for Windows to manage a **remote computer**, you must have administrator privileges for the remote computer. Oracle Administration Assistant for Windows always creates users in Oracle Database with the domain name as the prefix. If you are managing Oracle7 release 7.x or later databases remotely, you must set registry parameter `OSAUTH_PREFIX_DOMAIN` to true on the remote computer. This parameter is located in

\[HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_HOME_NAME\]

If a Windows 2000 computer is not identified with a Domain Name System (DNS) domain name, you will receive the following error message:

Calling query w32RegQueries1.7.0.17.0 RegGetValue
Key = HKEY_LOCAL_MACHINE
SubKey = SYSTEM\CurrentControlSet\Services\Tcpip\Parameters
Value = Domain
Query Exception: GetValueKeyNotFoundException
Query Exception Class: class oracle.sysman.oii.oii.OiilQueryException
...
To assign a DNS name:

1. Choose Start > Settings > Control Panel > System > Network Identification > Property > More > Primary DNS.
2. Enter a domain name, such as US.ORACLE.COM.

Adding a Computer and Saving Your Configuration

When you use Oracle Administration Assistant for Windows for the first time, it adds the local computer to its navigation tree. You can then add other computers.

To add a computer to the Microsoft Management Console tree:

1. Choose Start > Programs > Oracle - HOME_NAME > Configuration and Migration Tools > Administration Assistant for Windows.

   Microsoft Management Console starts.

2. Double-click Oracle Managed Objects.

   The Computer icon appears.

3. Right-click Computers.


   The Add Computer dialog appears.

5. Specify the domain and computer name for the computer on which Oracle Database is installed.

6. Click OK.

7. Double-click Computers to display the computer you added.

8. Double-click the computer you added. Several nodes for authenticating database administrators and operators appear.

   The **OS Database Administrators - Computer** node creates an operating system-authenticated database administrator with **SYSDBA** privileges for every database instance on the computer. The **OS Database Operators - Computer** node creates an operating system-authenticated database operator with **SYSOPER** privileges for every database instance on the computer.

9. Save your configuration in a console file by choosing Save in the Console main menu. You can now authenticate database administrators and operators for all instances on the computer.
Granting Administrator Privileges for All Databases on a Computer

To grant database administrator (SYSDBA) privileges to database administrators (DBAs) for all databases on a computer:

1. Choose Start > Programs > Oracle - HOME_NAME > Configuration and Migration Tools > Administration Assistant for Windows.

Oracle Administration Assistant for Windows starts.

2. Right-click OS Database Administrators - Computer.

3. Click Add/Remove.

   The OS Database Administrators - Computer for hostname dialog appears.

   4. Select the domain of the user to which to grant SYSDBA privileges from the Domain list.

   5. Select the user.

   6. Click Add.

      The user now appears in the OS Database Administrators - Computer window.

   7. Click OK.
Granting Operator Privileges for All Databases on a Computer

To grant database operator (SYSOPER) privileges to DBAs for all databases on a computer:

1. Choose Start > Programs > Oracle - HOME_NAME > Configuration and Migration Tools > Administration Assistant for Windows.

   Oracle Administration Assistant for Windows starts.

2. Right-click OS Database Operators - Computer.

3. Click Add/Remove.

   The OS Database Operators - Computer for hostname dialog appears.

4. Select the domain of the user to which to grant SYSOPER privileges from the Domain list.

5. Select the user.

6. Click Add.

   The user now appears in the OS Database Operators - Computer window.

7. Click OK.

Connecting to a Database

To enable Secure Sockets Layer (SSL) when connecting to Oracle Database, start the Oracle Database service and the listener service in the same user account as the wallet created in Oracle Wallet Manager. Do not use the default user account in the Windows Services dialog. If the Oracle Database service and the listener service are started in the
default user accounts, then SSL does not work, and the listener does not start. Support for SSL is an Oracle Advanced Security feature. Oracle Wallet Manager is also an Oracle Advanced Security feature.

**See Also:** *Oracle Advanced Security Administrator’s Guide* for more information on SSL support

To connect to a database:

1. Right-click the database instance you want to access in the Microsoft Management Console scope pane. In the example here, a connection is to be made to ORCL:

2. Choose **Connect Database**.

   If you connect to Oracle Database, the following Windows nodes appear beneath the instance. If these nodes do not appear, double-click the instance.

   - External OS Users
   - Local Roles
   - External OS Roles
   - OS Database Administrators
   - OS Database Operators
Troubleshooting Connection Problems

When connecting to a local computer, Oracle Administration Assistant for Windows first tries to connect to the database as a SYSDBA, using the Bequeath networking protocol. When connecting to a remote computer, Oracle Administration Assistant for Windows first tries to connect to the database using Windows native authentication as a SYSDBA, using the TCP/IP networking protocol (port 1521 or the deprecated 1526). If it is unsuccessful, one or more dialogs appear and prompt you to enter information to connect to the database.

The dialog shown here appears because the Windows domain user with which you are attempting to connect to Oracle Database is not recognized as an authenticated user with SYSDBA privileges. Enter an Oracle Database username and password to access the database. To avoid being prompted with this dialog again, configure your domain user to be a database administrator authenticated by the Windows operating system.

The next dialog appears either because you are not using the TCP/IP networking protocol to connect to a remote installation of Oracle Database or because Oracle Database is not running. Using a protocol other than TCP/IP (Named Pipes for example) causes this dialog to appear each time you attempt a remote connection.
If you do not want this dialog to appear each time, then change to the TCP/IP protocol and make sure the **Oracle Net Services** listener for the database is listening on the default port 1521 (or the deprecated default port 1526). Otherwise, this dialog appears every time. Ensure also that Oracle Database is started.

1. Enter the **net service name** with which to connect to Oracle Database. You must enter a net service name regardless of the authentication method you select.

2. If you want to access the database with an Oracle Database username and password, select the Database Authenticated option. This username and password must exist in Oracle Database and have the **SYSDBA** privilege.

3. If you want to access the database with the Windows domain user with which you are currently logged in, select the OS Authenticated Connection as SYSDBA option. This domain user must already be recognized by Windows as an authenticated user with **SYSDBA** privileges. Otherwise, your logon fails.

---

**Note:** Oracle Net Services provides a Trace Assistant tool that helps diagnose connection problems by converting existing trace file text into a more readable format. See "Using the Trace Assistant to Examine Trace Files" in **Oracle Net Services Administrator’s Guide**.

---

**Viewing Database Authentication Parameter Settings**

To view database authentication parameter settings:

1. Right-click the database.

2. Choose **Properties**.

3. The Properties dialog appears displaying the following parameter values:

   - **OS_AUTHENT_PREFIX**
   - **OS_ROLES**
OS_AUTHENT_PREFIX is an init.ora file parameter that authenticates external users attempting to connect to Oracle Database with the user’s Windows username and password. The value of this parameter is attached to the beginning of every user’s Windows username.

By default, the parameter is set to none ("") during Oracle Database creation. Therefore, a Windows domain username of frank is authenticated as username frank. If you set this parameter to xyz, then Windows domain user frank is authenticated as user xyzfrank.

OS_ROLES is an init.ora file parameter that, if set to true, enables the Windows operating system to manage authorization of an external role for a database user. By default, OS_ROLES is set to false. You must set OS_ROLES to true and restart Oracle Database before you can create external roles. If OS_ROLES is set to false, Oracle Database manages granting and revoking of roles for database users.

If OS_ROLES is set to true, and you assign an external role to a Windows global group, then it is granted only at the Windows global group level, and not at the level of the individual user in this global group. This means that you cannot revoke or edit the external role assigned to an individual user in this global group through the Roles tab of the User Name Properties dialog at a later time. Instead, you must use the field in the Assign External OS Roles to a Global Group dialog to revoke the external role from this global group (and therefore all its individual users).

External roles assigned to an individual domain user or local roles (with OS_ROLES set to false) assigned to an individual domain user or Windows global group are not affected by this issue. They can be edited or revoked.

If OS_ROLES is set to true, you cannot grant local roles in the database to any database user. You must grant roles through Windows. See “Creating a Local Database Role” on page 9-14 and “Creating an External Operating System Role” on page 9-16 for more information.

Creating an External Operating System User

The External OS Users node of Oracle Administration Assistant for Windows enables you to authenticate a Windows user to access Oracle Database as an external user without being prompted for a password. External users are typically regular database users (not database administrators) to which you assign standard database roles (such as CONNECT and RESOURCE), but do not want to assign SYSDBA (database administrator) or SYSOPER (database operator) privileges.

To create an external operating system user:

1. Follow the steps in "Connecting to a Database" on page 9-5 to connect to a database.

3. Choose **Create**.

Create External OS User Wizard starts, and the first of three wizard dialogs appears. The first dialog is for Windows Users and Groups.
4. In **Domain Users and Groups** select the domain in which your Windows domain users and global groups are located.

5. Select the Windows domain users and global groups to which to grant access to the database.

6. Click **Add**. The selected users and groups now appear in the New External OS Users list.

7. Click **Next**. The Profile and Tablespace dialog appears.
8. In the **Assigned Profile** list, select a profile for the new external users. A profile is a named set of resource limits. If resource limits are enabled, Oracle Database limits database usage and instance resources to whatever is defined in the user’s profile. You can assign a profile to each user and a default profile to all users who do not have specific profiles.

9. In **Tablespace Quota** double-click the **tablespace** to assign a tablespace **quota**.

10. Click **Next**. The Roles dialog appears.
11. In **Available Roles** select the database roles to grant to the new external users.

12. Click **Grant**.

13. Click **Finish**.

14. Right-click the external user for which you want to view information and select **Properties**.

   The assigned properties appear.

---

**Note:** If you select a Windows global group for authentication when using Oracle Administration Assistant for Windows, all users currently in the group are added to Oracle Database. If at a later time, you use a Windows tool to add or remove users in this Windows global group, these updates are not reflected in Oracle Database. The newly added or removed users must be explicitly added or removed in Oracle Database with Oracle Administration Assistant for Windows.
Creating a Local Database Role

The Local Roles node of Oracle Administration Assistant for Windows enables you to create a role and have it managed by the database. Once a local role is created, you can grant or revoke that role to a database user. To create a local database role:

1. Follow the steps in "Connecting to a Database" on page 9-5 to connect to a database.
2. Right-click **Local Roles** for the database for which you want to create a local role.
3. Choose **Create**.

Create Local Role Wizard starts, and the first of three wizard dialogs appears. The first dialog is for Name and Authentication.

4. Enter a local role name to use.
5. In **Authentication** select **None** if you want a user to use this local role without being required to enter a password.

Select **Password** if you want use of this role to be protected by a password. These roles can only be used by supplying an associated password with the `SET ROLE` command. See *Oracle Database 2 Day DBA* for additional information.

Enter the password to use with this role.
Confirm the password by entering it a second time.

6. Click Next. The System Privileges dialog appears.

7. In **Available System Privileges** select the system privileges you want to assign to the local role.

8. Click **Grant** to grant the selected system privileges to the local role.

   The Granted System Privileges field displays the list of system privileges granted to the local role. To revoke a system privilege, make an appropriate selection, then choose **Revoke**.

9. If you want to grant Admin Option to this role, click the value in the **Admin Option** column to display a list. This enables you to select Yes.

10. Click Next. The Roles dialog appears.
11. In **Available Roles** select the roles you want to assign to the local role. Both local roles and external roles appear in this list.

12. Click **Grant** to grant the selected roles to the role.

   The Granted Roles field displays the list of roles granted to the role. Both local roles and external roles can appear in this list. To revoke roles, make appropriate selections, then choose **Revoke**.

13. Click **Finish**.

### Creating an External Operating System Role

The External OS Roles node of Oracle Administration Assistant for Windows enables you to create an external role and have it managed by the Windows operating system. Once an external role is created, you can grant or revoke that role to a database user. To create an external role:

1. Follow the steps in "Connecting to a Database" on page 9-5 to connect to a database.

2. Right-click **External OS Roles** for the database for which to create an external role.

3. Choose **Create**.
Create External OS Role Wizard starts, and the first of three wizard dialogs appears. The first dialog is for Name. Authentication: External appears in this dialog to indicate that only external roles can be created.

**Note:** Create External OS Role Wizard is available only if `init.ora` parameter `OS_ROLES` is set to `true`. If it is set to `false`, then you must first change it to `true` and then restart Oracle Database.

4. Enter an external role name to use. An external role is a role that is managed by the Windows operating system.

5. Click **Next**.

   The System Privileges dialog appears.
6. In **Available System Privileges** select the system privileges you want to assign to the external role.

7. Choose **Grant** to grant the selected system privileges to the external role.

8. The **Granted System Privileges** field displays the list of system privileges granted to the external role. To revoke a system privilege, make an appropriate selection, then click **Revoke**.

9. If you want to grant Admin Option to this role, choose the value in the **Admin Option** column to display a list. This enables you to select Yes.

10. Click **Next**.

    The Roles dialog appears.
11. In Available Roles select the roles you want to assign to the external role. Both local roles and external roles appear in this list.

12. Click Grant to grant the selected roles to the external role.
   The Granted Roles field displays the list of roles granted to the external role.

13. Click Finish.

Granting Administrator Privileges for a Single Database

The OS Database Administrators node of Oracle Administration Assistant for Windows enables you to authorize a Windows user with SYSDBA privileges for a specific instance on a computer. To grant administrator (SYSDBA) privileges for a single database:

1. Follow the steps in "Connecting to a Database" on page 9-5 to connect to a database.

2. Right-click OS Database Administrators.

3. Choose Add/Remove.
   The OS Database Administrators for instance dialog appears. In the example shown here, the instance is MARK:
4. In **Domain Users and Groups** select the domain of the user to which to grant **SYSDBA** privileges from the **Domain** list.

5. Select the user.
   
   The user now appears in OS Database Administrators.

6. Click **OK**.

**Granting Operator Privileges for a Single Database**

The OS Database Operators node of Oracle Administration Assistant for Windows enables you to authorize a Windows user with **SYSOPER** privileges for a specific instance on a computer. To grant operator (**SYSOPER**) privileges for a single database:

1. Follow the steps in "Connecting to a Database" on page 9-5 to connect to a database.

2. Right-click **OS Database Operators**.

3. Choose **Add/Remove**.
   
   The OS Database Operators for **instance** dialog appears. In the example shown here, the instance is **MARK**:
4. In Domain Users and Groups select the domain of the user to which to grant SYSOPER privileges from the Domain list.

5. Select the user.

6. Click Add.

   The user now appears in OS Database Operators.

7. Click OK.

Manually Administering External Users and Roles

Instead of using Oracle Administration Assistant for Windows, you can manually configure administrators, operators, users, and roles to be authenticated by the operating system. Manual configuration involves using Oracle Database command line tools, editing the registry, and creating local groups in Active Directory Users and Computers.

Note: In Windows NT you create local groups in User Manager.

All of the following can be manually configured to access Oracle Database without a password:

- External operating system users
- Windows database administrators (with SYSDBA privilege)
Manually Administering External Users and Roles

- Windows database operators (with **SYSOPER** privilege)

In addition, you can manually create and grant local and external database roles to Windows domain users and global groups.

This section describes:

- Manually Creating an External Operating System User
- Manually Granting Administrator and Operator Privileges for Databases
- Manually Creating an External Role
- Manually Migrating Users

---

**Note:** Use extreme care when manually configuring administrators, operators, users, and roles to be authenticated by the operating system. If possible, use Oracle Administration Assistant for Windows to perform configuration procedures.

---

**Manually Creating an External Operating System User**

This section describes how to authenticate external operating system users (not database administrators) using Windows, so that a password is not required when accessing the database. When you use Windows to authenticate external operating system users, your database relies solely on the operating system to restrict access to database usernames.

In the following procedure, two Windows usernames are authenticated:

- Local user **frank**
- Domain user **frank on domain sales**

Local user **frank** logs into its local Windows client computer to access an Oracle Database server, which can be on a different computer. To access other databases and resources on other computers, the local user must provide a username and password each time.

Domain user **frank on domain sales** logs into a **sales** domain that includes many other Windows computers and resources, one of which contains an Oracle Database server. The domain user can access all the resources the domain provides with a single username and password.

The procedure is divided into two sets of tasks performed on different computers:

- **External User Authentication Tasks on the Oracle Database Server**
- **External User Authentication Tasks on the Client Computer**

**External User Authentication Tasks on the Oracle Database Server**

1. Add parameter **OS_AUTHENT_PREFIX** to your *init.ora* file.

The **OS_AUTHENT_PREFIX** value is prefixed to local or domain usernames attempting to connect to the server with the user’s operating system name and password. The prefixed username is compared with Oracle Database usernames in the database when a connection request is attempted. Using parameter **OS_AUTHENT_PREFIX** with Windows native authentication methods is the recommended method for performing secure, trusted client connections to your server.
2. Set a value for \texttt{OS\_AUTHENT\_PREFIX}. Your choices are:

- Any character string
  
  If you specify \texttt{xzy}, as in this procedure's example, then \texttt{xzy} is prefixed to the beginning of the Windows username (for example, \texttt{xzyfrank} for local user \texttt{frank} or \texttt{xzysales\frank} for domain user \texttt{frank} on domain \texttt{sales}). String values are case insensitive.

- " " (two double quotes with no space between)
  
  This option is recommended, because it eliminates the need for any prefix to Windows usernames (for example, \texttt{frank} for local user \texttt{frank} or \texttt{sales\frank} for domain user \texttt{frank} on domain \texttt{sales}).

- No value specified
  
  If you do not specify a value for \texttt{OS\_AUTHENT\_PREFIX}, it defaults to \texttt{OPS\$} (for example, \texttt{OPS\$frank} for local user \texttt{frank} or \texttt{OPS\$sales\frank} for domain user \texttt{frank} on domain \texttt{sales}).

3. Create a Windows local username for \texttt{frank} with the Computer Management tool, or create a domain username for \texttt{frank} with Active Directory Users and Computers (if the appropriate name does not currently exist). See your operating system documentation for detailed instructions.

\begin{quote}
\textbf{Note:} In Windows NT you can create both local and domain usernames in User Manager.
\end{quote}

4. Do this step \textit{only} if you are \textit{not} authenticating a domain name with a user (for example, just \texttt{frank} instead of \texttt{frank} on domain \texttt{sales}). Otherwise, go to step 8.

\begin{enumerate}
\item Start Registry Editor from the command prompt:
\begin{verbatim}
C:\> regedt32
\end{verbatim}
\item Go to \texttt{HKEY\_LOCAL\_MACHINE\SOFTWARE\ORACLE\HOME\ID}, where \texttt{ID} is the Oracle home directory you want to edit.
\item Choose \texttt{Edit \textgreater Add Value}.  
  
  The Add Value dialog appears:

\begin{figure}[h]
\centering
\includegraphics[width=0.5\textwidth]{Add_Value_Dialog.png}
\caption{Add Value Dialog}
\end{figure}

\begin{enumerate}
\item Enter \texttt{OSAUTH\_PREFIX\_DOMAIN} in the \textbf{Value Name} field.
\item Choose \texttt{REG\_EXPAND\_SZ} from the \textbf{Data Type} list.
\item Click \texttt{OK}.
\end{enumerate}
The String Editor dialog appears:

5. Enter true in the String field to enable authentication at the domain level.
   There may be multiple frank usernames on your network, including local user
   frank, domain user frank on sales, and possibly several domain users frank
   on other domains. Entering true enables the server to differentiate among them.
   Entering false causes the domain to be ignored and local user frank to become
   the default value of the operating system user returned to the server.

6. Click OK.
   Registry Editor adds the parameter.

7. Choose Exit from the Registry menu.
   Registry Editor exits.

8. Ensure that parameter SQLNET.AUTHENTICATION_SERVICES in file
   sqlnet.ora contains nts.

9. Start SQL*Plus:
   C:\> sqlplus /NOLOG

10. Connect to the database with the SYSTEM database administrator (DBA) name:
    SQL> CONNECT
    Enter user-name: SYSTEM/password
    Unless you have changed it, the SYSTEM password is MANAGER by default.

11. Create a local external user by entering:
    SQL> CREATE USER xyzfrank IDENTIFIED EXTERNALLY;
    where xyz is the value you chose for initialization parameter OS_AUTHENT_{
    PREFIX, and frank is the Windows local username.

12. Grant a local external user database roles by entering:
    SQL> GRANT RESOURCE TO xyzfrank;
    SQL> GRANT CONNECT TO xyzfrank;

13. Create a domain external user by entering:
    SQL> CREATE USER "XYZSALES\FRANK" IDENTIFIED EXTERNALLY;
    where XYZ is the value you chose for initialization parameter OS_AUTHENT_{
    PREFIX, and SALES\FRANK is the domain name and Windows domain username.
    Double quotes are required and the entire syntax must be in uppercase.
14. Grant a domain external user database roles by entering:

   SQL> GRANT RESOURCE TO "XYZSALES\FRANK";
   SQL> GRANT CONNECT TO "XYZSALES\FRANK";

   Double quotes are required and the entire syntax must be in uppercase.

15. Connect to the database with the SYSDBA name:

   SQL> CONNECT / AS SYSDBA

16. Shut down the database:

   SQL> SHUTDOWN

17. Restart the database:

   SQL> STARTUP

   This causes the change to parameter OS_AUTHENT_PREFIX to take effect.

External User Authentication Tasks on the Client Computer

1. Create Windows local or domain username frank with the same username and password that exist on the Windows server (if the appropriate name does not currently exist).

2. Ensure that parameter SQLNET.AUTHENTICATION_SERVICES in file sqlnet.ora contains nts.

3. Use Oracle Net Configuration Assistant to configure a network connection from your client computer to the Windows server on which Oracle Database is installed. See Oracle Net Services Administrator’s Guide for instructions.

4. Start SQL*Plus:

   C:\> sqlplus /NOLOG

5. Connect to your Windows server:

   SQL> CONNECT /@connect_identifier

   where connect_identifier is the net service name for Oracle Database.

   Oracle Database searches the data dictionary for an automatic login username corresponding to the Windows local or domain username, verifies it, and enables connection as xyzfrank or xyzsales\frank.

6. Verify that you have connected to Oracle Database as local or domain user frank by viewing the roles assigned in steps 12 or 14 of “External User Authentication Tasks on the Oracle Database Server”.

   SQL> SELECT * FROM USER_ROLE_PRIVS;

   which outputs for local user frank:

<table>
<thead>
<tr>
<th>USERNAME</th>
<th>GRANTED_ROLE</th>
<th>ADM</th>
<th>DEF</th>
<th>OS_</th>
</tr>
</thead>
<tbody>
<tr>
<td>XYZFRANK</td>
<td>CONNECT</td>
<td>NO</td>
<td>YES</td>
<td>NO</td>
</tr>
<tr>
<td>XYZFRANK</td>
<td>RESOURCE</td>
<td>NO</td>
<td>YES</td>
<td>NO</td>
</tr>
</tbody>
</table>

   2 rows selected.
Manually Administering External Users and Roles

or, for domain user frank:

| USERNAME           | GRANTED_ROLE | ADM | DEF | OS_
|--------------------|--------------|-----|-----|-----
| XYZSALES\FRANK    | CONNECT      | NO  | YES | NO  
| XYZSALES\FRANK    | RESOURCE     | NO  | YES | NO  

2 rows selected.

Because the Oracle Database username is the whole name xyzfrank or
xyzsales\frank, each object created by xyzfrank or xyzsales\frank (that
is, table, view, index, and so on) is prefixed by this name. For another user to
reference the table shark owned by xyzfrank, for example, the user must enter:

SQL> SELECT * FROM xyzfrank.shark

---

Note: Automatic authorization is supported for all Oracle Net
protocols.

Manually Granting Administrator and Operator Privileges for Databases

This section describes how to enable Windows to grant the database administrator
(SYSDBA) and database operator (SYSOPER) privileges to database administrators.
With this privilege, database administrators can issue the following commands from a
client computer and connect to Oracle Database without entering a password:

CONNECT / AS SYSOPER
CONNECT / AS SYSDBA

To enable this feature, the Windows local or domain username of the database
administrator must belong to one of the Windows local groups listed in Table 9–1.

Table 9–1 Windows Local Groups with SYSDBA and SYSOPER Privileges

<table>
<thead>
<tr>
<th>Local Group</th>
<th>Privileges</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORA_OPER</td>
<td>SYSOPER privileges for all databases on a computer</td>
</tr>
<tr>
<td>ORA_DBA\1</td>
<td>SYSDBA privileges for all databases on a computer</td>
</tr>
<tr>
<td>ORA_SID_OPER</td>
<td>SYSOPER privileges for a single database (identified by SID)</td>
</tr>
<tr>
<td>ORA_SID_DBA</td>
<td>SYSDBA privileges for a single database (identified by SID)</td>
</tr>
</tbody>
</table>

\1 ORA_DBA is automatically created during installation. See section "Operating System Authentication Enabled at Installation" on page 8-4 for information.

The manual procedure for enabling database administrators to connect as SYSOPER or
SYSDBA without a password is divided into two sets of tasks performed on different
computers:

- SYSDBA/SYSOPER Authentication Tasks on the Oracle Database Server
- SYSDBA/SYSOPER Authentication Tasks on the Client Computer

SYSDBA/SYSOPER Authentication Tasks on the Oracle Database Server

1. Create a Windows local group corresponding to the privileges you want Windows
to grant (see Table 9–1).
2. Add your database administrator usernames to this group.
3. Ensure that parameter `SQLNET.AUTHENTICATION_SERVICES` in file `sqlnet.ora` contains `nts`.
4. Start Registry Editor from the command prompt:
   ```
   C:\> regedt32
   ```
5. Go to `HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME\ID` where `ID` is the Oracle home that you want to edit.
6. Set parameter `OSAUTH_PREFIX_DOMAIN` to `true`.

**SYSDBA/SYSOPER Authentication Tasks on the Client Computer**

1. Create a Windows local or domain username with the same username and password that exist on the Windows server (if the appropriate username does not currently exist).
2. Ensure that parameter `SQLNET.AUTHENTICATION_SERVICES` in file `sqlnet.ora` contains `nts`.
3. Use Oracle Net Configuration Assistant to configure a network connection from your client computer to the Windows server on which Oracle Database is installed. See *Oracle Net Services Administrator’s Guide* for instructions.
4. Start SQL*Plus:
   ```
   C:\> sqlplus /NOLOG
   ```
5. Connect to Oracle Database:
   ```
   SQL> SET INSTANCE net_service_name
   ```
   where `net_service_name` is the Oracle Net net service name for Oracle Database.
6. If you specified `ORA_DBA` or `ORA_SID_DBA` in step 1 of "SYSDBA/SYSOPER Authentication Tasks on the Oracle Database Server", then enter either of the following:
   ```
   SQL> CONNECT / AS SYSOPER
   SQL> CONNECT / AS SYSDBA
   ```
   If you specified `ORA_OPER` or `ORA_SID_OPER` in step 1, then enter:
   ```
   SQL> CONNECT / AS SYSOPER
   ```
   You are now connected to the Windows server. If you connect with `SYSDBA`, you are given DBA privileges.

**Manually Creating an External Role**

This section describes how to grant Oracle Database roles to users directly through Windows (known as external roles). When you use Windows to authenticate users, Windows local groups can grant these users external roles.

All privileges for these roles are active when the user connects. When using external roles, all roles are granted and managed through the operating system. You cannot use both external roles and Oracle Database roles at the same time.
Consider the following example. With external roles enabled, you log on to a Windows domain with domain username `sales\frank` (sales is the domain name and frank is the domain username). You then connect to Oracle Database as Oracle Database user `scott`. In this case, you receive the roles granted to `sales\frank` but not the roles granted to `scott`.

The procedure for manually creating an external role is divided into two sets of authorization tasks performed on different computers:

- **External Role Authorization Tasks on the Oracle Database Server**
- **External Role Authorization Tasks on the Client Computer**

### External Role Authorization Tasks on the Oracle Database Server

1. Add initialization parameter `OS_ROLES` to the `init.ora` file.
2. Set `OS_ROLES` to `true`.
   
   The default setting for this parameter is `false`.
3. Ensure that parameter `SQLNET.AUTHENTICATION_SERVICES` in file `sqlnet.ora` contains `nts`.
4. Start SQL*Plus:
   
   ```
   C:> sqlplus /NOLOG
   ```
5. Connect to your Windows server:
   
   ```
   SQL> CONNECT / AS SYSDBA
   ```
6. Create a new database role. You can give this new role whatever name you want. In this example the role is named `DBSALES3`:
   
   ```
   SQL> CREATE ROLE DBSALES3 IDENTIFIED EXTERNALLY;
   ```
7. Grant to `DBSALES3` whatever Oracle Database roles are appropriate to your database environment:
   
   ```
   SQL> GRANT DBA TO DBSALES3 WITH ADMIN OPTION;
   SQL> GRANT RESOURCE TO DBSALES3 WITH ADMIN OPTION;
   SQL> GRANT CONNECT TO DBSALES3 WITH ADMIN OPTION;
   ```
8. Connect to the database as `SYSDBA`:
   
   ```
   SQL> CONNECT / AS SYSDBA
   ```
9. Shut down the database:
   
   ```
   SQL> SHUTDOWN
   ```
10. Restart the database:
    
    ```
    SQL> STARTUP
    ```
11. Create a Windows local group with the following syntax:
    
    ```
    ORA_sid_rolename[_D][_A]
    ```
    
    where
    
    - `sid` identifies the database instance
    - `rolename` identifies the database role granted
■ D indicates that this database role is to be a default role of the database user
■ A indicates that this database role includes ADMIN OPTION

Characters D and A are optional. If specified, they must be preceded by an underscore.

For this example, ORA_orcl_dbsales3_D is created.

12. Add one or more Windows local or domain usernames to this group.

See Also: Your operating system documentation for instructions on managing users and groups

You can create multiple database roles and grant them to several possible Windows groups with differing options, as shown in the following table. Users connecting to the ORCL instance and authenticated by Windows as members of all four of these Windows local groups will have the privileges associated with dbsales3 and dbsales4 by default (because of option _D). If these users first connect as members of dbsales3 or dbsales4 and use the SET ROLE command, then they can also gain access to database roles dbsales1 and dbsales2. But if these users try to connect with dbsales1 or dbsales2 without first connecting with a default role, they are unable to connect. Finally, these users can grant dbsales2 and dbsales4 to other roles (because of option _A).

<table>
<thead>
<tr>
<th>Database Roles</th>
<th>Windows Groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>dbsales1</td>
<td>ORA_ORCL_dbsales1</td>
</tr>
<tr>
<td>dbsales2</td>
<td>ORA_ORCL_dbsales2_a</td>
</tr>
<tr>
<td>dbsales3</td>
<td>ORA_ORCL_dbsales3_d</td>
</tr>
<tr>
<td>dbsales4</td>
<td>ORA_ORCL_dbsales4_da</td>
</tr>
</tbody>
</table>

Note: When Oracle Database converts the group name to a role name, it changes the name to uppercase.

External Role Authorization Tasks on the Client Computer

1. Create a Windows local or domain username with the same username and password that exist on the Windows server (if the appropriate username does not currently exist).

2. Ensure that parameter SQLNET.AUTHENTICATION_SERVICES in file sqlnet.ora contains nts.

3. Use Oracle Net Configuration Assistant to configure a network connection from your client computer to Oracle Database. See Oracle Net Services Administrator’s Guide for instructions.

4. Start SQL*Plus:
   
   C:\> sqlplus /NOLOG

5. Connect to the correct instance:

   SQL> SET INSTANCE connect_identifier

   where connect_identifier is the net service name for the Oracle Database connection that you created in Step 3.
6. Connect to Oracle Database:

```
SQL> CONNECT scott/tiger AS SYSDBA
```

You are connected to the Windows server over net service with Oracle Database username `scott/tiger`. Roles applied to Oracle Database username `scott` consist of all roles defined for the Windows username that were previously mapped to the database roles (in this case, `ORA_DBSALES3_D`). All roles available under an authenticated connection are determined by the Windows username and the Oracle-specific Windows local groups to which the user belongs (for example, `ORA_SID_DBSALES1` or `ORA_SID_DBSALES4_DA`).

---

**Note:** OSDBA and OSOPER are generic names for two special operating system groups that control database administrator logins when using operating system authentication. Windows-specific names for OSDBA and OSOPER are described in "Manually Granting Administrator and Operator Privileges for Databases" on page 9-26. See *Oracle Database Administrator’s Guide* for more information on OSDBA and OSOPER.

---

**Manually Migrating Users**

You can migrate local or external users to enterprise users with User Migration Utility. Migrating from a database user model to an enterprise user model provides solutions to administrative, security, and usability challenges in an enterprise environment. In an enterprise user model, all user information is moved to an LDAP directory service, which provides the following benefits:

- Centralized storage and management of user information
- Centralized user authentication
- Enhanced security

User Migration Utility is a command-line tool. Its syntax is of the form:

```
C:\ umu parameters
```

To get a list of User Migration Utility parameters, enter:

```
C:\ umu help=yes
```

**See Also:** "Using the User Migration Utility" in *Oracle Advanced Security Administrator’s Guide*
This chapter describes storing and retrieving of Oracle Wallets in the Windows registry.

This chapter contains these topics:
- Storing Private Keys and Trust Points
- Storing User's Profile
- Registry Parameters for Wallet Storage

**Storing Private Keys and Trust Points**
Oracle Wallets store **private keys, trust points**, and **digital certificates** used in public key applications for authentication and **encryption**. Oracle Wallet Manager creates and manages Oracle Wallets. Oracle public key applications use obfuscated Oracle Wallets for authentication and encryption.

---

**Note:** Oracle Wallet Manager is a feature of Oracle Advanced Security, a separately licensable option to Oracle Database.

---

**Storing User's Profile**
In a Windows 2000 or Windows NT 4.0 domain, a user's profile is stored on the local computer. When a local user logs on to that computer, that user's profile on the local computer is uploaded into the user profile in that computer's registry. When a user logs out, that user's profile stored on the local file system is updated, ensuring that the domain user or local user always has the most recent user profile version.

**Registry Parameters for Wallet Storage**
Parameter **WALLET_LOCATION** in file *sqlnet.ora* specifies the location of the obfuscated Oracle Wallet for use by Oracle PKI applications. For example, the **WALLET_LOCATION** parameter for storing an Oracle Wallet in the registry in:

```
\\HKEY_CURRENT_USER\SOFTWARE\ORACLE\WALLETS\SALESAPP
```

would be:

```
WALLET_LOCATION = (SOURCE= (METHOD=REG) (METHOD_DATA= (KEY=SALESAPP)))
```
Continuing the example, the encrypted Oracle Wallet would be stored in the registry in:
\\HKEY_CURRENT_USER\SOFTWARE\ORACLE\WALLETS\SALESAPP\EWALLET.P12

and the obfuscated Oracle Wallet would be stored in:
\\HKEY_CURRENT_USER\SOFTWARE\ORACLE\WALLETS\SALESAPP\CWALLET.SSO

On Windows operating systems, if there is no value specified for parameter \WALLET\_LOCATION, then Oracle PKI applications first look for the obfuscated wallet in registry key:
\\HKEY_CURRENT_USER\SOFTWARE\ORACLE\WALLETS\DEFAULT

If no obfuscated wallet is found there, Oracle PKI applications look for it in the file system of the local computer at location:
%USERPROFILE%\ORACLE\WALLETS

Regardless of location, wallets are always stored in the same format. All functionality is the same except for the location of the wallets.

**Oracle Wallet Manager**

Oracle Wallet Manager creates and manages Oracle Wallets. If you want to use the Windows registry for Oracle Wallets, then you must select the Use Windows System Registry check box. If Windows System Registry is selected, then the tool shows a list of existing keys when it opens a wallet or saves a new wallet. The list appears in:
\\HKEY_CURRENT_USER\SOFTWARE\ORACLE\WALLETS

You can select one of the existing locations or enter the name for a new location (registry key). If you enter a new key called \Key1, for example, then the tool creates the following registry key:
\\HKEY_CURRENT_USER\SOFTWARE\ORACLE\WALLETS\KEY1

The encrypted wallet will be stored in:
\\HKEY_CURRENT_USER\SOFTWARE\ORACLE\WALLETS\KEY1\EWALLET.P12

The obfuscated wallet will be stored in:
\\HKEY_CURRENT_USER\SOFTWARE\ORACLE\WALLETS\KEY1\CWALLET.SSO

If you do not select the Use Windows System Registry check box, then the tool displays all the available drives and directories on the local computer. You can select one of the existing directories or enter a new directory. The tool stores the encrypted or obfuscated wallet in the selected directory or creates the directory if it does not exist.

**Sharing Wallets and sqlnet.ora Files Among Multiple Databases**

Multiple nonreplicated databases cannot share wallets. If sqlnet.ora files contain wallet location information, then databases also cannot share sqlnet.ora files.

The only exception to this rule is password-authenticated or Kerberos-authenticated enterprise user security with default database-to-directory connection configuration that uses passwords. This configuration keeps database wallets in the default location, where Database Configuration Assistant creates them. In this situation, no wallet location information is stored in the sqlnet.ora file, and the wallet can be shared among multiple databases.
Note: If SSL is used for enterprise user authentication, then the wallet location must be specified in the sqlnet.ora file. So sqlnet.ora files cannot be shared by multiple databases for SSL-authenticated enterprise users.
Oracle PKI Integration with Windows

This chapter describes integration of Oracle public key infrastructure (PKI) with Windows 2000 public key infrastructure (Windows PKI) on Windows operating systems.

This chapter contains these topics:

- Oracle Public Key Infrastructure
- Windows Public Key Infrastructure

Oracle Public Key Infrastructure

Oracle public key infrastructure (PKI) is used by Oracle Enterprise Security Manager, LDAP-enabled Oracle Enterprise Manager, Oracle's Secure Socket Layer (SSL) authentication, Oracle Database, and Oracle Application Server.

Oracle PKI includes the following components:

- Oracle Wallets
- Oracle Wallet Manager (OWM)

Oracle Wallets store digital certificates, trust points, and private keys used in public key applications for encryption, decryption, digital signature, and verification.

Windows Public Key Infrastructure

This section describes Windows public key infrastructure.

This section contains these topics:

- Microsoft Certificate Stores
- Microsoft Certificate Services
- Using Microsoft Certificate Stores with Oracle PKI Applications

---

**Note:** Microsoft Certificate Store integration works only with digital certificates that use Microsoft Enhanced Cryptographic Provider. To create these certificates, you need to install Windows High Encryption Pack and select Microsoft Enhanced Cryptographic Provider. Also, when there are more than one of these certificates available for the same key usage (signature/key exchange), the first certificate retrieved will be used for Oracle SSL.
Microsoft Certificate Stores

Microsoft Certificate Stores are repositories for storing digital certificates and their associated properties. Windows 2000 stores digital certificates and certificate revocation lists in logical and physical stores. Logical stores contain pointers to public key objects in physical stores. Logical stores enable public key objects to be shared between users, computers, and services without requiring storage of duplicates of objects for each user, computer, or services. Public key objects are physically stored in the registry of the local computer or, for some user certificates, in Active Directory. Standard system certificate stores defined by Microsoft include:

- MY or Personal
- CA
- ROOT

MY or Personal holds a user's certificates for which the associated private key is available. The MY certificate store maintains certificate properties that indicate the Cryptographic Service Provider (CSP) associated with the private key. An application uses this information to obtain the private key from the CSP for the associated certificate. CA holds issuing or intermediate certificate authority (CA) certificates. ROOT holds only self-signed CA certificates for trusted root CAs.

Microsoft Certificate Services

Microsoft Certificate Services (MCS) consists of the following modules:

- Server Engine
- Intermediary
- Policy

Server Engine handles all certificate requests. It interacts with other modules at each processing stage to ensure that the proper action is taken based on the state of the request. The Intermediary module receives requests for new certificate from clients and then submits them to Server Engine. The Policy module contains the set of rules controlling the issuance of certificates. This module may be upgraded or customized as needed.

Using Microsoft Certificate Stores with Oracle PKI Applications

Wallet Resource Locator (WRL) specifies that parameter WALLET_LOCATION in file sqlnet.ora identifies a particular PKI. You can choose between using Oracle Wallet or Microsoft Certificate Stores by setting parameter WALLET_LOCATION in sqlnet.ora. To use credentials from Microsoft Certificate Stores, set parameter WALLET_LOCATION in sqlnet.ora to:

```
WALLET_LOCATION = (SOURCE = (METHOD=MCS))
```

The Oracle application uses Oracle's TCP/IP with SSL protocol (TCPS) to connect to Oracle Server. The SSL protocol uses X.509 certificates and trust points from the user's Microsoft Certificate Store for SSL authentication.
This chapter describes how to configure and use Microsoft Active Directory as the LDAP directory.

This chapter contains these topics:

- Microsoft Active Directory Support
- Oracle Components That Integrate with Active Directory
- Requirements for Using Oracle Database with Active Directory
- Configuring Oracle Database to Use Active Directory
- Testing Connectivity
- Access Control List Management for Oracle Directory Objects

Microsoft Active Directory Support

This section describes how Microsoft Active Directory is used as an LDAP directory server by Oracle Database.

This section contains these topics:

- About Microsoft Active Directory
- Accessing Active Directory

About Microsoft Active Directory

Active Directory is the LDAP-compliant directory server included with Windows 2000. Active Directory stores all Windows 2000 information, including users, groups, and policies. Active Directory also stores information about network resources (such as databases) and makes this information available to application users and network administrators. Active Directory enables users to access network resources with a single login. The scope of Active Directory can range from storing all the resources of a small computer network to storing all the resources of several wide areas networks (WANs).
When using Oracle features that support Active Directory, ensure that the Active Directory computer can be successfully reached using all possible TCP/IP hostname forms to reach the domain controller. For example, if the hostname of the domain controller is `server1` in the domain `acme.com`, then ensure that you can ping that computer using all of the following:

- `server1.acme.com`
- `acme.com`
- `server1`

Active Directory often issues referrals back to itself in one or more of these forms, depending upon the operation being performed. If any of the forms cannot reach the Active Directory computer, then some LDAP operations may fail.

Oracle Components That Integrate with Active Directory

The following Oracle Database features support or have been specifically designed to integrate with Active Directory:

- Directory Naming
- Automatic Discovery of Directory Servers
- Integration with Microsoft Tools
- User Interface Extensions for Oracle Net Directory Naming
- Enhancement of Directory Object Type Descriptions
- Integration with Windows Login Credentials
- Oracle Directory Objects in Active Directory

Directory Naming

Oracle Database provides the Directory Naming feature which makes use of a directory server. This feature has been enabled to work with Microsoft Active Directory. Directory Naming enables clients to connect to the database making use of information stored centrally in an LDAP-compliant directory server such as Active Directory. For example, any net service name previously stored in the `tnsnames.ora` file can now be stored in Active Directory.
Automatic Discovery of Directory Servers

Oracle Net Configuration Assistant provides automatic discovery of directory servers. When you select Active Directory as the directory server type, Oracle Net Configuration Assistant automatically discovers the directory server location and performs related tasks.

See Also: “Configuring Oracle Database to Use Active Directory” on page 12-7 for more information on Active Directory configuration

Integration with Microsoft Tools

Oracle Database services, net service names, and enterprise role entries in Active Directory can be displayed and tested in two Windows 2000 tools:

- Windows Explorer
- Active Directory Users and Computers

Windows Explorer displays the hierarchical structure of files, directories, and local and network drives on your computer. It can display and test Oracle Database service and net service name objects.

Active Directory Users and Computers is an administrative tool installed on Windows servers configured as domain controllers. This tool enables you to add, modify, delete, and organize Windows 2000 accounts and groups, and publish resources in the directory of your organization. Like Windows Explorer, it can display and test Oracle Database service and net service name objects. Additionally, it can manage access control.

See Also:

- "Testing Connectivity from Microsoft Tools" on page 12-9
- "Access Control List Management for Oracle Directory Objects” on page 12-11

User Interface Extensions for Oracle Net Directory Naming

The property menus of Oracle Database service and net service name objects in Windows Explorer and Active Directory Users and Computers have been enhanced. When you right-click these Oracle directory objects, you now see two new options for testing connectivity:

- Test
- Connect with SQL*Plus

The Test option tests whether the username, password, and net service name you initially entered can actually connect to Oracle Database. The Connect with SQL*Plus option starts SQL*Plus, which enables you to perform database administration, run scripts, and so on.

See Also: "Testing Connectivity from Microsoft Tools" on page 12-9

Enhancement of Directory Object Type Descriptions

Oracle directory object type descriptions in Active Directory have been enhanced to make them easier to understand. In the right pane of Figure 12–1 on page 12-4, for example, the Type column reveals that sales is an Oracle Net Service name.
Integration with Windows Login Credentials

Oracle database and configuration tools can use the login credentials of the Windows user currently logged on to connect to Active Directory without having to re-enter the login credentials. This feature has two benefits:

- Oracle clients and databases can securely connect to Active Directory and retrieve the net service name.
- Oracle configuration tools can connect automatically to Active Directory and configure Oracle Database and net service name objects. The enabled tools include Oracle Net Configuration Assistant and Database Configuration Assistant.

Oracle Directory Objects in Active Directory

If Oracle Database and Oracle Net Services are installed and configured to access Active Directory, then Active Directory Users and Computers displays Oracle directory objects, as illustrated in Figure 12–1:

![Figure 12–1 Oracle Directory Objects in Active Directory Users and Computers](image)

Table 12–1 describes the Oracle directory objects appearing in Figure 12–1.

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>oranet.dev</td>
<td>The domain in which you created your Oracle Context. This domain (also known as the administrative context) contains various Oracle entries to support directory naming. Oracle Net Configuration Assistant automatically discovers this information during Oracle Database integration with Active Directory.</td>
</tr>
<tr>
<td>OracleContext</td>
<td>The top-level Oracle entry in the Active Directory tree. It contains Oracle Database service and net service name object information. All Oracle software information is placed in this folder.</td>
</tr>
<tr>
<td>orcl</td>
<td>The Oracle Database service name used in this example.</td>
</tr>
<tr>
<td>Products</td>
<td>Folder for Oracle product information.</td>
</tr>
</tbody>
</table>
To use Net Directory Naming with Active Directory, you must have certain Microsoft and Oracle software releases, and you must create an Oracle Schema and an Oracle Context. These requirements are discussed in the following sections:

- **Directory Naming Software Requirements**
- **Oracle Schema Creation**
- **Oracle Context Creation**

**Note:**
- The Oracle schema and Oracle Context can both be created by running Oracle Net Configuration Assistant.
- Regardless of the Oracle Database Client and Oracle Database releases you are using, you must be running in a Windows 2000 domain to integrate Net Directory Naming with Active Directory.

If you are using Active Directory with Oracle Database, then ping the DNS domain name of your Windows 2000 domain. If this does not work, then perform either of the following tasks:

- Set your Windows 2000 primary domain controller IP address as your DNS.
  For example, if your Windows 2000 domain is sales, then the DNS domain name for this domain is sales.acme.com. The IP address is of the form 001.002.003.0.
- Add the DNS domain name of your Windows 2000 domain and your domain controller IP address to your hosts or lmhosts file.

On the Windows 2000 computer, you can either set 001.002.003.0 as the DNS, or you can add 001.002.003.0 acme.com to the hosts or lmhosts file.

If this step is not performed, then errors such as the following are returned when using Active Directory:

```plaintext
Cannot Chase Referrals
```

### Directory Naming Software Requirements

For client computers from which you want to manage Oracle Database enterprise users, roles and domains, you must have Oracle8i Client release 8.1.6 or later and one of the following Microsoft products:

- Windows XP, Windows 2000, or Windows Server 2003
- Windows NT 4.0 with Active Directory Service Interfaces (ADSI)
For the database, you must have Oracle8i Database release 8.1.6 or later. This is required for registering the database service as an object in Active Directory. The database can use any of the following Microsoft products:

- Windows 2000 or Windows Server 2003
- Windows NT 4.0 with ADSI

Both the client computers and the database must be members of a Windows 2000 domain.

Oracle Schema Creation

You must create an Oracle schema to use net directory naming features with Active Directory. A schema is a set of rules for Oracle Net Services and Oracle Database entries and their attributes stored in Active Directory. The following restrictions apply to creating an Oracle schema to use with Active Directory:

- Only one Oracle schema can be created for each forest.
- Schema creation is performed on a Windows 2000 domain controller.
- The Windows 2000 domain controller must be the operations master that allows schema updates. See your operating system documentation for instructions.

To create an Oracle schema:

1. Log in as a member of the Schema Administrator group. Domain administrators are in the Schema Administrator group by default.
2. Use Oracle Net Configuration Assistant to create the Oracle schema. You can create your schema during or after database installation.

If the Active Directory display is not configured to accept all 24 default languages, then Oracle schema creation can fail while Oracle Net Configuration Assistant is configuring Active Directory as the directory server. Before running Oracle Net Configuration Assistant to complete directory access configuration, verify that the display specifiers for all 24 languages are populated by entering the following at the command prompt:

```
ldifde -p OneLevel -d cn=DisplaySpecifiers,cn=Configuration,dn=domain context -f temp file
```

where:

- **domain context** is the domain context for this Active Directory server.
  
  For example, `dc=acme,dc=com`.
- **temp file** is a file where you want to put the output.

If the command reports that fewer than 24 entries were found, then you can still use Oracle Net Configuration Assistant. However, the report will indicate that Oracle schema creation failed, rather than simply reporting that display specifiers for some languages were not created.

Display Specifiers Not Created

When Net Configuration Assistant creates the Oracle Schema in Active Directory, the display specifiers for Oracle entries are not created. This means you cannot view Oracle database entries in Active Directory interfaces.
You can manually add these entries into Active Directory after the Oracle Schema has been created by doing the following, using the same Windows userid you used when creating the Oracle Schema with Net Configuration Assistant:

1. Open a command shell.
2. Change directory to `ORACLE_HOME\ldap\schema\ad`.
3. Copy `adDisplaySpecifiers_us.sbs` to `adDisplaySpecifiers_us.ldif`.
4. Copy `adDisplaySpecifiers_other.sbs` to `adDisplaySpecifiers_other.ldif`.
5. Edit each of these `.ldif` files, replacing all occurrences of `%s_AdDomainDN%` with the domain DN for the specific Active Directory into which you want to load the display specifiers (for example, `dc=acme,dc=com`).
6. Run the following commands:

   ```
   ldapmodify -h <ad hostname> -Z -f adDisplaySpecifiers_us.ldif
   ldapmodify -h <ad hostname> -Z -f adDisplaySpecifiers_other.ldif
   ```

   where `<ad hostname>` is the hostname of the Active Directory domain controller to which you want to load the display specifiers.

   **See Also:** "Automatic Discovery of Directory Servers" on page 12-3

### Oracle Context Creation

You must create an Oracle Context to use net directory naming features with Active Directory. Oracle Context is the top-level Oracle entry in the Active Directory tree. It contains Oracle Database service and Oracle Net service name object information.

- You can create only one Oracle Context for each Windows 2000 domain (administrative context).
- You must have the right to create domain and enterprise objects in order to create the Oracle Context in Active Directory with Oracle Net Configuration Assistant.
- Use Oracle Net Configuration Assistant to create your Oracle Context. You can create the Oracle Context during or after Oracle Database Custom installation.

   **See Also:**

   - *Oracle Database Installation Guide for Windows* for installation procedures
   - *Oracle Net Services Administrator’s Guide* for configuration procedures

### Configuring Oracle Database to Use Active Directory

Oracle Net Configuration Assistant enables you to configure client computers and Oracle Database to access a directory server. When you choose directory access configuration from Oracle Net Configuration Assistant, it then prompts you to specify a directory server type to use. When you select Active Directory as the directory server type, the Automatic Discovery of Directory Servers feature of Oracle Net Configuration Assistant automatically:

- Discovers the Active Directory server location
- Configures access to the Active Directory server
Testing Connectivity

- Creates the Oracle context (also known as your domain)

If the Active Directory server is shut down while client connections are accessing an Oracle Database server, another Active Directory server is automatically discovered and begins providing connection information. This minimizes client connection downtime.

If the Active Directory server already has an Oracle Context, then select the following non-default radio button:

- Select the directory server you want to use, and configure the directory server for Oracle usage. (Create or upgrade Oracle Schema and Oracle Context as necessary.)

Oracle Net Configuration Assistant will report that the Oracle Context does not exist. Ignore this and choose to create the Oracle Context anyway. Directory access configuration will complete without trying to re-create the existing Oracle Context.

---

**Note:** Regardless of the Oracle Database Client and Oracle Database releases you are using, you must be running in a Windows 2000 domain to take advantage of the automatic directory server discovery features of Oracle Net Configuration Assistant. If you are not running in a Windows 2000 domain, then Oracle Net Configuration Assistant does not automatically discover your directory server, and instead prompts you for additional information, such as the Active Directory location.

---

**See Also:**

- "Oracle Schema Creation" on page 12-6 for information about possible failures during configuration
- "Requirements for Using Oracle Database with Active Directory" on page 12-5
- "Automatic Discovery of Directory Servers" on page 12-3
- Oracle Net Services Administrator’s Guide for configuration procedures

---

**Testing Connectivity**

This section describes how to connect to an Oracle Database server through Active Directory.

This section contains these topics:

- Testing Connectivity from Client Computers
- Testing Connectivity from Microsoft Tools

**Testing Connectivity from Client Computers**

When using Oracle Net directory naming, client computers connect to a database by specifying the database or net service name entry that appears in the Oracle Context. For example, if the database entry under the Oracle Context in Active Directory is `orcl`, and the client and the database are in the same domain, then a user connects to the database through SQL*Plus by entering the following connect string:

```
SQL> CONNECT username/password@orcl
```
If the client and the database are in different domains, then a user connects to the database through SQL*Plus by entering:

```
SQL> CONNECT username/password@orcl.domain
```

where `domain` is the domain in which the Oracle Database server is located.

These connect strings follow DNS-style conventions. While Active Directory also supports connections using X.500 naming conventions, Oracle recommends DNS-style conventions because they are easier to use.

DNS-style conventions enable client users to access an Oracle Database server through a directory server by entering minimal connection information, even when the client computer and Oracle Database server are in separate domains. Names following the X.500 convention are longer, especially when the client and Oracle Database server are located in different domains (also known as administrative contexts).

**See Also:**
- "Configuration Management Concepts" in *Oracle Net Services Administrator’s Guide* for more information about X.500 naming conventions
- "Unlocking and Changing Passwords" in *Oracle Database Installation Guide for Windows*

### Testing Connectivity from Microsoft Tools

Oracle directory objects in Active Directory are integrated with two Microsoft tools:

- Windows Explorer
- Active Directory Users and Computers

You can test connectivity to an Oracle Database server from within these Microsoft tools by actually connecting to it, or you can just test the connection with actually connecting. To test connectivity:

1. Start Windows Explorer or Active Directory Users and Computers.
   
   To start Windows Explorer:
   
   a. Choose **Start > Programs > Accessories > Windows Explorer**.
   
   b. Expand **My Network Places**.
   
   c. Expand **Entire Network**.
   
   d. Expand **Directory**.

   To start Active Directory Users and Computers:

   Choose **Start > Programs > Administrative Tools > Active Directory Users and Computers**.

   **Note:** All clients accessing an Oracle Database server through Active Directory require read access on all net service name objects in the Oracle Context and must be able to authenticate anonymously with Active Directory. Oracle Net Configuration Assistant automatically sets this up.

2. Expand the domain in which your Oracle Context is located.
3. Expand your Oracle Context.

4. Right-click a database service or Oracle Net Service name object.

   A menu appears with several options. This section covers only the Test and Connect with SQL*Plus options.

5. If you want to test the database connection without actually connecting to it, then choose Test. A status message appears describing the status of your connection attempt.

6. If you want to test the database connection by actually connecting to it, then choose Connect with SQL*Plus. The Oracle SQL*Plus Logon dialog appears.
7. Enter your username and password, then click **OK**. A status message appears describing the status of your connection attempt.

**Access Control List Management for Oracle Directory Objects**

This section identifies security groups specific to Oracle directory objects within Active Directory and explains how to add and delete security group members.

This section contains these topics:
- Security Groups
- Adding and Deleting Security Group Members

**Security Groups**

Security groups are automatically created when the Oracle Context is created in Active Directory. The user configuring access (and thus creating the Oracle Context) is automatically added to each group. The relevant groups are:
- **OracleDBCreators**
- **OracleNetAdmins**

**OracleDBCreators**
The **OracleDBCreators** group is for the person registering the Oracle Database server. The domain administrator is automatically a member of this group. Users in this group can:
- Create new Oracle Database objects in the Oracle Context.
- Modify the Oracle Database objects that they create.
- Read, but not modify, the membership for this group.

**OracleNetAdmins**
Users in the **OracleNetAdmins** group can:
- Create, modify, and read Oracle Net Services objects and attributes.
- Read the group membership of this group.
Adding and Deleting Security Group Members

You can add or remove users in the security groups with Active Directory Users and Computers.

**Note:** Use Active Directory Users and Computers to perform the procedures described in this section. Windows Explorer does not provide the necessary functionality.

To add or remove users:

1. Choose **Start > Programs > Administrative Tools > Active Directory Users and Computers**.

2. Choose **Advanced Features** from the **View** main menu.
   
   This enables you to view and edit information that is normally hidden.

3. Expand the domain (administrative context) in which your Oracle Context is located.

4. Expand **Users**.
   
   The security groups appear in the right window pane.

5. Right-click the Oracle security group that you want to view or modify.
   
   A menu appears with several options.

6. Choose **Properties**.

7. Choose the **Members** tab.

   The Properties dialog for the group you selected appears (in this example, **OracleDBCreators**).
8. To add users, click Add.
   The Select Users, Contacts, Computers, or Groups dialog appears.

9. Select the users or groups you want to add and click Add.
   Your selections appear in the Select Users, Contacts, Computers, or Groups dialog.

10. To remove a user, select the user name from the Members list and click Remove.

11. When you are finished adding and removing users, click OK.
Oracle Database for Windows uses initialization parameters to enable various features of the database every time an instance is started.

This chapter contains these topics:

- Initialization Parameter File Overview
- Sample File
- SGA_MAX_SIZE Parameter
- Initialization Parameters Without Windows-Specific Values
- Displaying Initialization Parameter Values
- Uneditable Database Initialization Parameters
- Calculating Database Limits

Initialization Parameter File Overview

An initialization parameter file is an ASCII text file containing parameters. By changing parameters and values in an initialization parameter file, you can specify, for example:

- Amount of memory Oracle Database uses
- Whether to archive filled online redo logs
- Which control files currently exist

Every database instance has a corresponding initialization parameter file and an ORACLE_SID registry parameter that points to the system identifier for the instance.

The initialization parameter filename takes the form init.ora. A single instance might have several initialization parameter files, each having some differences that affect system performance.

---

**Note:** Your init.ora file for initialization parameters is set by Oracle Universal Installer during database installation. These parameter settings may vary depending on your hardware configuration. For descriptions of all initialization parameters and instructions for setting and displaying their values, see Oracle Database Reference.
Location of the Initialization Parameter File

If you do not specify a different initialization file with option PFILE at database startup, then by default Oracle Database uses initialization parameter files located in

ORACLE_HOME\admin\db_name\pfile\init.ora

---

**Note:** If you create a database manually using a SQL script, you are required to create an initialization parameter file or copy an existing initialization parameter file and modify the contents. If you use Database Configuration Assistant to create a database, the initialization parameter file is automatically created for you.

---

Editing The Initialization Parameter File

To customize Oracle Database functions, you may be required to edit the initialization parameter file. Use only an ASCII text editor to modify the file.

Database Configuration Assistant Renames init.ora

When you create a database using Database Configuration Assistant, a server parameter file (SPFILE) is created from the initialization parameter file, and the initialization parameter file is renamed. Oracle does not recognize the renamed file as an initialization parameter file, and it is not used after the instance is started.

If you want to modify an instance created with Database Configuration Assistant after it starts up, you must use ALTER SYSTEM statements. You cannot change the SPFILE itself, because it is a binary file that cannot be browsed or edited using a text editor. The location of the newly-created SPFILE is ORACLE_BASE\ORACLE_HOME\database. The SPFILE filename is spfileSID.ora.

See Also:  "Managing Initialization Parameters Using a Server Parameter File" in Oracle Database Administrator’s Guide

Sample File

Oracle Database provides an annotated sample initialization parameter file with alternative values for initialization parameters. These values and annotations are preceded by comment signs (#), which prevent them from being processed. To activate a particular parameter, remove the preceding # sign. To de-activate a particular parameter, edit the initialization parameter file to add a comment sign. The sample file is called initsmpl.ora and is located in

ORACLE_BASE\ORACLE_HOME\admin\sample\pfile.

If you installed a starter database, the initialization parameter file used by the starter database is located in the same directory. You can use either initsmpl.ora or the starter database init.ora as a basis for creating a new Oracle Database initialization parameter file.

To use sample file initsmpl.ora as part of database creation:

1. Rename the sample file init.ora.
2. Edit this file to reflect the correct location of your database control files and the name of your database, as a minimum.
Here are two examples of activation and de-activation of alternative parameters. Several initialization parameters are specified with three different values to create a small, medium, or large System Global Area, respectively. The parameter that creates a small SGA is active in this first example:

```
  db_block_buffers = 200  # SMALL
# db_block_buffers = 550  # MEDIUM
# db_block_buffers = 3200 # LARGE
```

To create a medium-sized SGA, comment out the small parameter definition and activate the medium parameter definition. Edit the initialization parameter file as in this second example:

```
# db_block_buffers = 200  # SMALL
  db_block_buffers = 550  # MEDIUM
# db_block_buffers = 3200 # LARGE
```

**SGA_MAX_SIZE Parameter**

Parameter SGA_MAX_SIZE holds the maximum size that System Global Area (SGA) can reach for a particular instance. Beginning with Oracle9i release 1 (9.0.1), Oracle Database can change its SGA configuration while the instance is running. This allows sizes of buffer cache, shared pool, and large pool to be changed without instance shutdown.

Oracle Database can start instances underconfigured and allow the instance to use more memory by growing SGA up to a maximum of SGA_MAX_SIZE. If no SGA_MAX_SIZE value is specified, then Oracle Database selects a default value that is the sum of all components specified or defaulted at initialization time. If SGA_MAX_SIZE specified in the initialization parameter file is less than the sum of all components specified or defaulted to at initialization time, then the setting of SGA_MAX_SIZE in the initialization parameter file is ignored.

**See Also:**

- Oracle Database Performance Tuning Guide for more information about SGA initialization parameters.
- Oracle Database Concepts for more information about SGA and its components

Memory allocated for the SGA of an instance is displayed on instance startup when using Oracle Enterprise Manager (or SQL*Plus). You can also display the SGA size of the current instance by using the SQL*Plus SHOW statement with the SGA clause.

**Initialization Parameters Without Windows-Specific Values**

*Oracle Database Reference* describes default values for many initialization parameters as being operating system-specific. However, not all parameters that it describes as having operating system-specific values affect Windows. In these cases, Windows uses either the default value set in the Oracle Database kernel or does not use the parameter. Table 13–1 describes these initialization parameters:
Displaying Initialization Parameter Values

Windows-specific parameter values can be viewed by using an ASCII editor to open the initialization parameter file:

```
ORACLE_BASE\ORACLE_HOME\admin\db_name\pfile\init.ora
```

To display any parameter value (whether set in the initialization parameter file or the Oracle Database kernel), enter the following command at the SQL*Plus command prompt:

```
SQL> SHOW PARAMETER parameter_name
```

where `parameter_name` is the name of a specific initialization parameter.

Uneditable Database Initialization Parameters

Check the initialization parameters in Table 13–2 when creating a new database. They cannot be modified after you have created the database. See Chapter 3, "Postinstallation Database Creation on Windows" for details on creating a new database, including the part of the procedure where you modify these parameters.
Calculating Database Limits

Use size guidelines in this section to calculate Oracle Database limits.

Table 13–2  Uneditable Database Initialization Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHARACTER SET</td>
<td>Specifies database Globalization Support character set to use. This parameter can be set only when you create the database.</td>
</tr>
<tr>
<td>DB_BLOCK_SIZE</td>
<td>Specifies size in bytes of standard Oracle Database blocks.</td>
</tr>
<tr>
<td>DB_NAME</td>
<td>Specifies name of the database to be created. Database name is a string of eight characters or less. You cannot change the name of a database.</td>
</tr>
</tbody>
</table>

1 Not an initialization parameter, but rather a clause in the CREATE DATABASE statement. See Chapter 3, "Postinstallation Database Creation on Windows" for an example of using this clause.

Calculating Database Limits

Table 13–3  Block Size Guidelines

<table>
<thead>
<tr>
<th>Type</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum block size</td>
<td>16,384 bytes or 16 kilobytes (KB)</td>
</tr>
<tr>
<td>Minimum block size</td>
<td>2 kilobytes (KB)</td>
</tr>
<tr>
<td>Maximum blocks for each file</td>
<td>4,194,304 blocks</td>
</tr>
</tbody>
</table>
| Maximum possible file size with 16 K sized blocks | 64 Gigabytes (GB)  
  (4,194,304 * 16,384) = 64 gigabytes (GB) |

Table 13–4  Maximum Number of Files for Each Database

<table>
<thead>
<tr>
<th>Block Size</th>
<th>Number of Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 KB</td>
<td>20,000</td>
</tr>
<tr>
<td>4 KB</td>
<td>40,000</td>
</tr>
<tr>
<td>8 KB</td>
<td>65,536</td>
</tr>
<tr>
<td>16 KB</td>
<td>65,536</td>
</tr>
</tbody>
</table>

Table 13–5  Maximum File Sizes

<table>
<thead>
<tr>
<th>Type</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum file size for a FAT file</td>
<td>4 GB</td>
</tr>
<tr>
<td>Maximum file size in NTFS</td>
<td>16 Exabytes (EB)</td>
</tr>
<tr>
<td>Maximum database size</td>
<td>65,536 * 64 GB equals approximately 4 Petabytes (PB)</td>
</tr>
<tr>
<td>Maximum control file size</td>
<td>20,000 blocks</td>
</tr>
</tbody>
</table>
### Table 13-6  Shadow Process Memory

<table>
<thead>
<tr>
<th>Release Number</th>
<th>Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle9i release 2 (9.2)</td>
<td>444 KB</td>
</tr>
<tr>
<td>Oracle9i release 1 (9.0.1)</td>
<td>444 KB</td>
</tr>
<tr>
<td>Oracle8i release 8.1.7</td>
<td>335 KB</td>
</tr>
<tr>
<td>Oracle8i release 8.1.6</td>
<td>335 KB</td>
</tr>
<tr>
<td>Oracle8 release 8.1.3</td>
<td>265 KB</td>
</tr>
<tr>
<td>Oracle8 release 8.0.5</td>
<td>254 KB</td>
</tr>
<tr>
<td>Oracle8 release 8.0.4</td>
<td>254 KB</td>
</tr>
</tbody>
</table>
This chapter describes use of the registry for various Oracle Database for Windows components. It also lists recommended values and ranges for configuration parameters.

This chapter contains these topics:

- About Configuration Parameters
- Registry Overview
- Registry Parameters
- Oracle Real Application Clusters Registry Parameters
- Modifying a Registry Value with regedt32
- Adding a Registry Parameter with regedt32
- Adding or Modifying Registry Parameters with Oracle Administration Assistant for Windows
- Modifying Oracle Counters for Windows Performance Monitor Parameters

About Configuration Parameters

Oracle Database for Windows uses configuration parameters to locate files and specify runtime parameters common to all Oracle products. When an Oracle program or application requires a translation for a particular configuration variable, Oracle Database for Windows uses the associated parameter. All Oracle parameters are stored in the registry.

Registry Overview

Oracle Database for Windows stores its configuration information in a repository (the registry) that is organized in a tree format. The tree format consists of keys in the registry and parameter values for the keys. Keys and parameter values can be viewed and modified in Registry Editor.

Keys are folders that appear in the left pane of a Registry Editor window. A key contains subkeys or parameters.
Parameters in Registry Editor appear as a string, consisting of three components:

- Parameter name
- Value class or type of entry
- Value itself

For example, parameter ORACLE_SID can have the following entry in the registry:

```
ORACLE_SID:reg_sz:orcl1
```

Value classes for Oracle Database for Windows parameters are:

- String value with a REG_SZ, REG_EXPAND_SZ (for an expandable string), or a REG_MULTI_SZ (for multiple strings) prefix to identify a parameter value entry as a data string
- Binary value with a REG_DWORD prefix to identify a value entry as a dword (hexadecimal data) entry

Most Oracle Database for Windows parameter values are string types. Use Oracle Universal Installer defaults when a type is not given.

### Registry Parameters

This section describes Oracle Database for Windows registry parameters for the following keys. Other products, such as Oracle Enterprise Manager, have additional keys and parameters that are not described in this chapter.

- HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_HOME_NAME
- HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE
- HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services

**Note:** Oracle Database for 64-bit Windows has additional configuration parameters that enable and control large page support. See "Large Page Support for 64-bit Windows" on page G-2.

To modify these registry values, see "Modifying a Registry Value with regedt32" on page 14-9.

**HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_HOME_NAME**

Each time you install Oracle products into a new Oracle home on your computer, **HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_HOME_NAME** is created. This subkey contains parameter values for most Oracle products.
Registry Parameters

**Note:** See Appendix B, "Optimal Flexible Architecture", in Oracle Database Installation Guide for Windows for details on the PATH variable and registry values when you are working with multiple Oracle homes.

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_HOME_NAME includes the following parameters for an Oracle home directory. Depending on products you install, additional parameters can also be created. See your Windows development manuals.

**MSHELP_TOOLS**
Specifies the location of Windows help files. The default value is ORACLE_BASE\ORACLE_HOME\mshelp

**NLS_LANG**
Specifies supported language, territory, and character set. This parameter specifies the language in which messages appear, the territory and its conventions for calculating week and day numbers, and the character set displayed. Oracle Universal Installer sets this value during installation based on the language setting of the operating system. See Oracle Database Globalization Support Guide for a list of values.

**ORA_CWD**
Specifies current working directory. For example, if you set this parameter and then use ORADIM, a log file called oradim.log is created in this directory. This parameter must be manually set.

**ORA_SID_AUTOSTART**
Starts Oracle Database when OracleServiceSID service is started. The default value is true.

**ORA_SID_PFILE**
Specifies full path to initialization parameter file. The default value is ORACLE_BASE\admin\DB_NAME\pfile\init.ora

**ORA_SID_SHUTDOWN**
When set to true, the default value, this parameter shuts down the instance of Oracle Database identified by SID when OracleServiceSID is stopped manually—using either the Control Panel or Net stop command.

**ORA_SID_SHUTDOWN_TIMEOUT**
Sets maximum time (in seconds) to wait for shutdown to complete before the service for a particular SID stops. The default value is 30.

**ORA_SID_SHUTDOWNTYPE**
Specifies mode in which Oracle Database is shut down when you stop OracleServiceSID. Valid values are a (abort), i (immediate), and n (normal). The default value is i.
ORA_TZFILE
Specifies location of time zone file. Each file contains:

- Valid time zone names
- Offset from UTC
- Abbreviation for standard time
- Abbreviation for daylight savings time

In previous releases, the default value for ORA_TZFILE was

```
ORACLE_BASE\ORACLE_HOME\oracore\zoneinfo\timezone.dat
```

Beginning with Oracle Database 10g Release 1 (10.1), the default value is

```
ORACLE_BASE\ORACLE_HOME\oracore\zoneinfo\timezlrg.dat
```

The former default, timezone.dat, contains most commonly used time zones and is smaller for better database performance. The new default, timezlrg.dat, includes time zones not defined in the smaller file. To enable use of the smaller file, the database administrator must:

1. Shut down Oracle Database.
2. Set ORA_TZFILE to the full path name of the location of timezone.dat file.
3. Restart Oracle Database.

To view time zone names, use SQL*Plus to make the following query:

```
SELECT * from v$timezone_names
```

If the larger timezlrg.dat file is used, then it must stay in use unless the user is sure that no data uses one of the added time zones. Also, all databases that share information must use the same time zone file.

See Also: Oracle Database Globalization Support Guide for lists of time zone names for both time zone files

ORACLE_AFFINITY
Specifies Windows processor affinity of each thread within the Oracle Database process. This parameter must be manually added. Oracle recommends consulting Oracle Support Services before changing this parameter. The format is:

```
name1:cpumask1;name2:cpumask2
```

Each name setting must be the name of a background thread, user for non-background (shadow) threads, or def for any thread type not handled specifically.

The name mask sets the affinity mask of the Oracle Database process. Valid background thread names include DBW0, LGWR, PMON, SMON, ARCH, RECO, CKPT, TRWR, SNP0 through SNP9, P000 through P481, and any other name found in the NAME column of the v$bgprocess data dictionary view.

Each affinity setting must be a valid affinity mask (or its numeric equivalent) for the corresponding name. Process affinity masks are used only when Oracle services are first started. Each thread's affinity is set only when the individual thread is started (for example, at database startup time for the background threads).
**ORACLE_BASE**
Specifies the top-level Oracle directory (for example, C:\oracle\product\10.1.0) that contains ORACLE_HOME, admin, and oradata. The default is ORACLE_BASE.

**ORACLE_GROUP_NAME**
Specifies the name of the group containing icons of the Oracle products installed. The parameter is added to your registry when you first install Oracle products, even if Oracle Universal Installer does not create a program group for Oracle products you have installed (for example, if you have installed only Oracle Net software). The default value is Oracle - HOME_NAME.

**ORACLE_HOME**
Specifies Oracle home directory in which Oracle products are installed. This directory is immediately beneath the Oracle base directory in the Oracle directory hierarchy. The default value is the drive letter and name that you specify during installation.

**ORACLE_HOME_KEY**
The HKEY_LOCAL_MACHINE location of Oracle parameters. The default value is software\oracle\HOMEID.

**ORACLE_HOME_NAME**
Specifies home name of Oracle home directory in which Oracle products are installed. The default value is the name that you specify during installation.

**ORACLE_PRIORITY**
Determines Windows scheduling priorities of threads within the Oracle Database management system process. The format is:

name1:priority1;name2:priority2 . . .

The name class sets the priority class of the Oracle Database process. Threads can be assigned priority either collectively or individually. The collective name user designates non-background (shadow) threads; the collective name def designates any thread type not handled specifically. Valid individual background thread names include DBW0, LGWR, PMON, SMON, ARCH0, RECO, CKPT, TRWR, SNP0 through SNP9, and any other name found in the NAME column of the v$bgprocess data dictionary view.

The default value is class:normal; def:normal.

**Note:** ORACLE_PRIORITY is not automatically created for you in the registry. When it is not defined in the registry, Windows default values are used for thread priorities.

**ORACLE_SID**
Specifies the name of the Oracle Database instance on the host computer. The value of this parameter is the SID for the instance. The default value is specified by the entry in the Database Identification window of Oracle Universal Installer.
**OSAUTH_PREFIX_DOMAIN**
Enables user authentication. When it is set to `true`, it enables the server to differentiate between one *username* and another, whether they are local users, domain users, or domain users on another domain in your network. When it is set to `false`, the domain is ignored, and the local user becomes the default value of the operating system user returned to the server. The default value is `false`.

**OSAUTH_X509_NAME**
Enables client users to access Oracle Database as X.509-compliant enterprise users. This parameter is required only if you want to use enterprise users and roles in an Oracle Database computer running in a Windows 2000 domain. The default value is `false`.

**RDBMS_ARCHIVE**
Specifies the location of backup database files. The default value is `ORACLE_BASE\ORACLE_HOME\database\archive`.

**RDBMS_CONTROL**
Specifies the location of backup database control files. The default value is `ORACLE_BASE\ORACLE_HOME\database`.

**SQLPATH**
Specifies the location of SQL scripts. The default value is `ORACLE_BASE\ORACLE_HOME\dbs`.

**HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE**
This subkey contains the following parameters:

**INST_LOC**
Specifies the location of Oracle Universal Installer files. The default value is `System Drive:\program files\oracle\inventory`.

**OO4O**
Specifies the location of Oracle Objects for OLE message files. The default value is `ORACLE_BASE\ORACLE_HOME\oo4o\mesg`.

**HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services**
`HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet` contains four keys:

- Control
- Enum
- HardwareProfiles
- Services

The first three are used by the operating system. You can edit only the `Services` subkey, which contains:

- Parameters for Oracle Counters for Windows Performance Monitor
- Parameters for Oracle Database Services
Parameters for Oracle Counters for Windows Performance Monitor

Oracle Counters for Windows Performance Monitor parameters appear in:

HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES\ORACLE\PERFORMANCE

where ORACLE\ver refers to whatever version of Oracle Database is installed.

For multiple Oracle homes compliance starting with release 10.1, parameters Hostname, Username, Password, LOGFILE, and PERF_FILE_NAME have been moved to

HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES\ORACLE\ver\PERFORMANCE\KEY_HOME_NAME.

**Note:** Modify only the Hostname, Password, and Username values to point to any database. Oracle recommends that you use operfcfg. See “Using operfcfg” on page 14-14.

For Oracle Counters for Windows Performance Monitor to display information for Oracle Database performance objects, it must log in to the database. Modify the following parameters if the default information is not applicable or if you want to access another database:

- **Hostname** displays the SID of the database that Oracle Counters for Windows Performance Monitor will connect to. The default value is blank, causing Oracle Counters for Windows Performance Monitor to connect to the default database on the computer.

  If you specify a different SID, you must also add a connect descriptor for that SID to your tnsnames.ora file. Oracle recommends that you use Oracle Net Configuration Assistant, but you can also copy, paste, and modify the following example:

  ```
  SERVICE_NAME =
  (DESCRIPTION =
   (ADDRESS_LIST =
    (ADDRESS = (PROTOCOL = TCP)(HOST = HOST_NAME)(PORT = 1521))
   )
   (CONNECT_DATA =
    (SERVER = DEDICATED)
    (SERVICE_NAME = SERVICE_NAME)
   )
  )
  ```

- **Password** displays the encrypted password for the username to access the database. The default value is MANAGER (encrypted).

- **Username** displays the username to access the database. The default value is SYSTEM.

Oracle Counters for Windows Performance Monitor requires the following parameters as entry points:

- **Close** specifies the close entry point for the DLL. The default value is CloseOracle\verPerformanceData.

- **Collect** specifies the collect entry point for the DLL. The default value is CollectOracle\verPerformanceData.
Oracle Real Application Clusters Registry Parameters

- **Library** specifies the name of the Oracle Counters for Windows Performance Monitor DLL. The default value is ORAPERFver.dll.

- **Open** specifies the open entry point for the DLL. The default value is OpenOracleverPerformanceData.

The following parameters specify Oracle Counters for Windows Performance Monitor log file and object configuration files:

- **LOGFILE** specifies the name of the Oracle Counters for Windows Performance Monitor log file. This log file reports any errors, such as Oracle Database objects not appearing or database access problems. The default value is ORACLE_BASE\ORACLE_HOME\dbs\operfver.log.

- **PERF_FILE_NAME** specifies the location of the PERFver.ora file, which contains all performance objects displayed by Oracle Counters for Windows Performance Monitor. The default value is ORACLE_BASE\ORACLE_HOME\dbs\perfver.ora.

### Parameters for Oracle Database Services

- **HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES** subkey contains additional subkeys that correspond to each Oracle Database service. Each service subkey contains the following parameters:

  - **DisplayName** specifies the service name of the instance whose SID is SID. The default value is the name of the service. For example, OracleServiceORCL1, where ORCL1 is the SID.

  - **ImagePath** specifies the fully qualified path name of the executable started by the service and any command-line arguments passed into the executable at runtime. The default value is the path to the executable file of the product.

  - **ObjectName** specifies the logon user account and computer to which the service should log on. The default value is LocalSystem.

### Oracle Real Application Clusters Registry Parameters

Oracle Real Application Clusters registry values are based on the clusterware. If you are not using the clusterware, then some of this information may not be applicable to your particular cluster environment.

---

**Note:** Oracle Real Application Clusters is not supported on Windows XP.

---

**HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\OCR**

This subkey contains the following values:

- **OCRROOT** points to the location of the Oracle Cluster Registry file.

- **LOCAL_ONLY** which is set to False for a cluster installation and True for a single-instance database installation.
Modifying a Registry Value with regedt32

**Caution:** Do not edit your registry unless absolutely necessary. If an error occurs in your registry, then Oracle Database for 64-Bit Windows can stop functioning, and the registry itself can become unusable.

To edit Oracle-related settings:

1. Start Registry Editor in one of two ways:
   - From the command prompt, enter:
     ```
     C:\> regedt32
     ```
   - Choose **Start > Run**, enter `regedt32` in the **Open** field, and click **OK**.

   The Registry Editor window appears.

2. Navigate to the values you want to view or modify by double-clicking appropriate keys.

   The left-hand side of the window shows the hierarchy of registry keys, and the right-hand side of the window shows various values associated with a key.

3. Double-click the parameter to edit.

   The String Editor dialog appears:

   ![String Editor](image)

4. Make any necessary edits.

5. Click **OK**.

6. Choose **Exit** from the **Registry** menu.

Adding a Registry Parameter with regedt32

To add a parameter to the registry:

1. Start Registry Editor in one of two ways:
   - From the command prompt, enter:
     ```
     C:\> regedt32
     ```
   - Choose **Start > Run**, enter `regedt32` in the **Open** field, and click **OK**.

   The Registry Editor window appears.

2. Navigate to the key to which you want to add the new value.

3. Choose **Add Value** from the **Edit** menu.

   The Add Value dialog appears:
4. In the **Value Name** field, type the name of the value that you want to add to the currently selected key.

5. In the **Data Type** list, select the data type that you want to assign to the added value:
   - `REG_SZ`, `REG_EXPAND_SZ` (for an expandable string), or `REG_MULTI_SZ` (for multiple strings) for a data string
   - Binary value with a `REG_DWORD` prefix to identify a value entry as a DWORD (hexadecimal data) entry

6. Click **OK**.

   The String Editor dialog appears:

7. Type the value for the parameter.

8. Click **OK**.

   Registry Editor adds the parameter.

9. Choose **Exit** from the **Registry** menu.

**Adding or Modifying Registry Parameters with Oracle Administration Assistant for Windows**

Instead of using `regedit32` to add, edit, and delete parameters for an Oracle home, you can use the Oracle Home Configuration snap-in, one of several **snap-ins** included as part of Oracle Administration Assistant for Windows. You must have **Microsoft Management Console** on your computer to use this product.

See "HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_HOME_NAME" on page 14-2 for more information about Oracle home parameters.
Starting Oracle Administration Assistant for Windows

To start Oracle Administration Assistant for Windows:


2. Expand Oracle Homes.

3. Right-click the Oracle home that you want to modify.

Adding Oracle Home Parameters

To add an Oracle home parameter:

1. Click **Add** in the Properties dialog.
   
   The Add Value dialog appears.

2. Enter the name in the **Parameter Name** field.
3. Enter the value in the **Parameter Value** field.
4. Click **OK**.
5. Click **Apply**.
Adding or Modifying Registry Parameters with Oracle Administration Assistant for Windows

**Note:** With Oracle Administration Assistant for Windows, you can add parameters only with a datatype of REG_SZ. Use `regedit32` to add parameters with a datatype of REG_EXPAND_SZ, REG_MULTI_SZ, or REG_DWORD.

### Editing Oracle Home Parameters

To change the default SID, select the SID from the Default SID list in the Properties dialog. To edit one of the other parameters:

1. Select the parameter in the **Other Settings** list in the Properties dialog.
2. Click **Edit**.

The Edit Value dialog appears.

3. Modify the value.
4. Click OK.
5. Click Apply.

Deleting Oracle Home Parameters
To delete an Oracle home parameter:
1. Select the parameter in the Other Settings list in the Properties dialog.
2. Click Delete.

Modifying Oracle Counters for Windows Performance Monitor Parameters
Instead of using regedt32 to modify Oracle Counters for Windows Performance Monitor's Hostname, Password, and Username parameters, you can use operfcfg or Oracle Administration Assistant for Windows.

See Also: "Parameters for Oracle Counters for Windows Performance Monitor" on page 14-7 for more information about Hostname, Password, and Username parameters

Using operfcfg
operfcfg is an Oracle Database tool that you run from the command prompt. Use this syntax:
operfcfg [-U username] [-P password] [-D TNS_Alias_for_database]

where:
- *username* is the username registry parameter value that Oracle Counters for Windows Performance Monitor uses to log in to the database. You must have a DBA privilege on this database.
- *password* is the password registry parameter value for *username*.
- *TNS_Alias_for_database* is the net service name that Oracle Counters for Windows Performance Monitor uses to connect to the database. It affects the Hostname registry parameter. The net service name corresponds to the SID of the database that you want to monitor. The -D command can be specified without providing a database name value.

The -U, -P, and -D commands are all optional.

The following examples illustrate use of operfcfg. First, to change username to dba_admin, password to frank, and leave database name at its current value, you would enter:
C:\> operfcfg -U dba_admin -P frank

To change username to dba_admin, password to frank, and database name to prod, you would enter:
C:\> operfcfg -U dba_admin -P frank -D prod

To change password to frank for the current username and database name, you would enter:
C:\> operfcfg -P frank
In the final example, you change *Hostname* to a blank value, causing Oracle Counters for Windows Performance Monitor to connect to the default database on the computer. The current username and password must be valid user accounts on this database.

Enter:

```
C:\> operfcfg -D
```

### Using Oracle Administration Assistant for Windows

Oracle Counters for Windows Performance Monitor snap-in is part of Oracle Administration Assistant for Windows. You must have Microsoft Management Console on your computer in order to use this product.

To use Oracle Counters for Windows Performance Monitor snap-in:

1. Choose **Start** > **Programs** > **Oracle - HOME_NAME** > **Configuration and Migration Tools** > **Administration Assistant for Windows**.
   
   Oracle Administration Assistant for Windows starts.

2. Right-click **Performance Monitor**.

3. Click **Properties**.

   The Performance Monitor Properties dialog appears.

4. Modify the text in the **Username**, **Password**, or **Database** fields.

5. Click **Apply**.
This chapter points to sources of information on developing applications for Windows and outlines a procedure for building and debugging external procedures.

This chapter contains these topics:

- Finding Information on Application Development for Windows
- Developing Windows Applications
- Building External Procedures
- Debugging External Procedures
- Accessing Text Files with UTL_FILE
- Accessing Web Data with Intercartridge Exchange

**Finding Information on Application Development for Windows**

This section describes where to find information on developing applications specifically for Windows. These products are included on your Oracle Database Server CD-ROM.

**Java Enhancements**

Oracle Database includes an integrated Java Virtual Machine and JServer Accelerator. Oracle Database also provides Oracle Java Database Connectivity (JDBC) Drivers. For more information, see *Oracle Database Java Developer’s Guide*.

**XML Support**

Oracle XML products include XML Developer's Kit (XDK) and Oracle XML SQL Utility. For more information:

- *Oracle XML Developer’s Kit Programmer’s Guide*
- *Oracle XML API Reference*
Support for Internet Applications

Oracle Database support for internet applications includes Oracle Portal, which enables you to publish your data to the Web, Oracle HTTP Server, and PL/SQL Embedded Gateway, which offers PL/SQL procedures stored in Oracle Database that can be started through browsers. For more information:

- Oracle Portal Installation Guide and Tutorial
- Oracle Enterprise Manager Grid Control Installation and Basic Configuration

Note: Oracle Portal is available on a separate CD-ROM and included with Oracle Database for Windows.

Application Wizards

Oracle Application Wizards allow developers to create database applications easily and quickly. They improve ease-of-use and reduce development time by generating much of the code for database connectivity. For information and downloads:

- http://otn.oracle.com/software/

Oracle COM/COM+ Integration Feature

Oracle COM/COM+ integration feature enables Java stored procedure developers and COM/COM+ developers to load COM+ objects from Oracle Database. For more information:

- Oracle COM Automation Feature Developer’s Guide

Oracle Objects for OLE

Oracle Objects for OLE (OO4O) provides easy access to data stored in Oracle Database servers with any programming or scripting language that supports the Microsoft COM Automation and ActiveX technology. These include Visual Basic, Visual C++, Visual Basic For Applications (VBA), IIS Active Server Pages (VBScript and JavaScript), and others. For more information:

- Oracle Objects for OLE Developer’s Guide

ODP.NET

Oracle Data Provider for .NET (ODP.NET) is an implementation of a data provider for Oracle Database. ODP.NET uses Oracle native APIs to offer fast and reliable access to Oracle data and features from any .NET application. ODP.NET also uses and inherits classes and interfaces available in the Microsoft .NET Framework Class Library. For more information:

- Oracle Data Provider for .NET Developer’s Guide

Note: Oracle Data Provider for .NET is not supported on Oracle Database 10g Release 1 (10.1) for 64-bit Windows. See Appendix G, “Oracle Database for 64-Bit Windows”.

15-2 Oracle Database Platform Guide
Oracle Services For Microsoft Transaction Server

Oracle Database for Windows permits enhanced deployment of COM/COM+ components in Microsoft Transaction Server, using Oracle Database as the resource manager. For more information:

- Oracle Services for Microsoft Transaction Server Developer’s Guide

Pro*C/C++ and Pro*COBOL Applications

- Pro*C/C++ Getting Started for Windows
- Pro*COBOL Getting Started for Windows
- Oracle Call Interface Programmer’s Guide

OLE DB

- Oracle Provider for OLE DB Developer’s Guide

Note: Oracle ODBC Driver is updated on a regular basis. The newest release available is included on your CD-ROM. To download the latest release, visit: [http://otn.oracle.com/software/](http://otn.oracle.com/software/)

Select Oracle ODBC Drivers from the Select a Utility or Driver list.

Developing Windows Applications

Oracle Database provides a comprehensive set of APIs for Windows application developers and is well suited for both Java and COM/COM+ development. Oracle Database is integrated with Microsoft’s development and deployment components, known as Windows Distributed InterNet Applications Architecture (DNA). Performance and data access on Windows is enhanced in the following areas:

- Wide variety of data access methods for Windows and internet applications
- Wizards and assistants to speed application development
- COM/COM+/DCOM integration through two APIs: Oracle Objects for OLE or Oracle Provider for OLE DB
- Microsoft Transaction Server integration: Oracle Services for Microsoft Transaction Server
- Platform extensions for internet application development

Developers are able to deploy their database applications more quickly by using the data access method with which they are familiar, rather than having to learn a new one. An Oracle Database server can communicate with Windows clients in a variety of methods, as described in Table 15–1.
By using Oracle Database data access interfaces, developers can take advantage of specific Oracle Database features. These interfaces also offer flexibility and adherence to open standards.

Oracle COM/COM+ interfaces include the following features:

- OO4O can be used from any programming environment that supports Microsoft COM/COM+ technology, such as Visual Basic, Visual C++, VBA in Excel, Active Server Pages, PowerBuilder, Delphi, Internet Information Server (IIS), and Microsoft Transaction Server. OO4O is developed specifically for use with Oracle Database servers.

- Oracle Provider for OLE DB gives ActiveX Data Objects (ADO) developers high performance and efficient access to Oracle Database. A native OLE DB provider, it offers data access optimizations and access to Oracle-specific database features.

- COM/COM+ Automation Feature APIs make it easy for PL/SQL developers to incorporate COM/COM+ objects into their routines. An extension of this feature, Oracle COM/COM+ Integration, enables Java stored procedures and COM/COM+ developers to load COM/COM+ objects through OLE Automation or custom COM/COM+ interfaces in Oracle Database.

### Developing Internet Applications

Oracle Database provides Windows extensions for internet development, enabling access from any client, such as:

- Any browser
- Windows or Macintosh client
- FTP client
- Database client
- COM/COM+ client
- E-mail client

Oracle Database data access interfaces and development tools, along with Microsoft Transaction Server integration, can be used to build internet applications, as illustrated in Figure 15–1, “Microsoft Transaction Server and Oracle Database Integration”.

<table>
<thead>
<tr>
<th>Development Environment</th>
<th>Data Access Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java</td>
<td>JDBC, SQLJ</td>
</tr>
<tr>
<td>COM/COM+</td>
<td>Oracle Objects for OLE (OO4O)</td>
</tr>
<tr>
<td></td>
<td>Oracle Provider for OLE DB</td>
</tr>
<tr>
<td></td>
<td>COM/COM+ Automation Feature</td>
</tr>
</tbody>
</table>
Building External Procedures

This section describes how to create and use external procedures on Windows. The following files are located in `ORACLE_BASE\ORACLE_HOME\rdbms\extproc`:

- `extern.c` is the code example shown in "Writing an External Procedure"
- `make.bat` is the batch file that builds the dynamic link library
- `extern.sql` automates the instructions described in "Registering an External Procedure" and "Executing an External Procedure"

External Procedures Overview

External procedures are functions written in a third-generation language (C, for example) and callable from within PL/SQL or SQL as if they were a PL/SQL routine or function. External procedures let you take advantage of strengths and capabilities of a third-generation programming language in a PL/SQL environment.

Note: Oracle Database also provides a special purpose interface, the call specification, that lets you call external procedures from other languages, as long as they are callable by C.

The main advantages of external procedures are:

- Performance, because some tasks are performed more efficiently in a third-generation language than in PL/SQL, which is better suited for SQL transaction processing
- Code re-usability, because dynamic link libraries (DLLs) can be called directly from PL/SQL programs on the server or in client tools such as Oracle Forms
You can use external procedures to perform specific processes:

- Solving scientific and engineering problems
- Analyzing data
- Controlling real-time devices and processes

Caution: Special security precautions are warranted when configuring a listener to handle external procedures. See “Modifying Configuration of External Procedures for Higher Security” on page C-3 and Oracle Net Services Administrator’s Guide for more information.

To create and use an external procedure, perform the following sequential steps:

- Installing and Configuring
- Writing an External Procedure
- Building a DLL
- Registering an External Procedure
- Executing an External Procedure

Note: You must have a C compiler and linker installed on your system to build DLLs.

Note: You can combine the instructions described in the fourth and fifth tasks into one SQL script that automates the task of registering and executing your external procedure. See ORACLE_BASE/ORACLE_HOME/rdbms/extproc/extern.sql for an example of a SQL script that combines these steps.

Installing and Configuring

This section describes installation and configuration of Oracle Database and Oracle Net.

Installing Oracle Database

Follow the steps in Oracle Database Installation Guide for Windows to install these products on your Windows server:

- Oracle Net Services
- Oracle Protocol Support

Configuring Oracle Net Services

During database server installation, Oracle Net Configuration Assistant configures listener.ora and tnsnames.ora files for external procedure calls.
When an application calls an external procedure, Oracle Net Listener starts an external procedure agent called EXTPROC. Using a network connection established by the listener, the application passes the following information to EXTPROC:

- DLL name
- External procedure name
- Parameters (if necessary)

EXTPROC then loads the DLL, runs the external procedure, and passes back any values returned by the external procedure.

If you overwrite default listener.ora and tnsnames.ora files, then you must manually configure the following files for the external procedure behavior described previously to occur:

- `ORACLE_BASE\ORACLE_HOME\network\admin\listener.ora`
- `ORACLE_BASE\ORACLE_HOME\network\admin\tnsnames.ora`

---

**Caution:** Additional security may be required for the listener in a production environment. See *Oracle Net Services Administrator's Guide* for more information.

---

**Writing an External Procedure**

Using a third-generation programming language, you can write functions to be built into DLLs and started by EXTPROC. The following is a simple Microsoft Visual C++ example of an external procedure:

```c
#include <windows.h>
#define NullValue -1

/*
This function tests if x is at least as big as y.
*/
long __declspec(dllexport) find_max(long x,
        short x_indicator,
        long y,
        short y_indicator,
        short *ret_indicator)
{
        /* It can be tricky to debug DLL's that are being called by a process
that is spawned only when needed, as in this case.
Therefore try using the DebugBreak(); command.
This will start your debugger. Uncomment the line with DebugBreak();
in it and you can step right into your code.
*/
    /* DebugBreak();  */

    /* First check to see if you have any nulls. */
    /* Just return a null if either x or y is null. */

    if ( x_indicator==NullValue || y_indicator==NullValue) {
        *ret_indicator = NullValue;
    }
```

---

**Note:** Because external procedures are built into DLLs, they must be explicitly exported. In this example, the `DLLEXPORT` storage class modifier exports the function `FIND_MAX` from a dynamic link library.
Building External Procedures

return(0);
} else {
    *ret_indicator = 0;      /* Signify that return value is not null. */
    if (x >= y) return x;
    else return y;
}

Building a DLL

After writing your external procedure(s) in a third-generation programming language, use the appropriate compiler and linker to build a DLL, making sure to export the external procedures as noted previously. See your compiler and linker documentation for instructions on building a DLL and exporting its functions.

For the example in Task 2, you can build the external procedure find_max into a DLL called extern.dll by going to ORACLE_BASE\ORACLE_HOME\rdbms\extproc and typing make. After building the DLL, you can move it to any directory on your system.

Starting with Oracle9i release 2, however, the default behavior of EXTPROC is to load DLLs only from ORACLE_HOME\bin or ORACLE_HOME\lib. To load DLLs from other directories, you must set environment variable EXTPROC_DLLS to a colon (:) separated list of DLL names qualified with their complete paths. The preferred way to set this environment variable is through the ENVS parameter in listener.ora.

See Also: Oracle Database Application Developer’s Guide - Fundamentals for more information on EXTPROC

Registering an External Procedure

Once you have built a DLL containing your external procedure(s), you must register your external procedure(s) with Oracle Database:

To create a PL/SQL library to map to the DLL:

1. Start SQL*Plus:
   C:\> sqlplus

2. Connect to the database with appropriate username and password.

3. Create the PL/SQL library using the CREATE LIBRARY command:

   SQL> CREATE LIBRARY externProcedures AS 'C:\oracle\product\10.1.0\db_1\rdbms\ extproc\extern.dll';

   where externProcedures is an alias library (essentially a schema object in the database), and
   C:\oracle\product\10.1.0\db_1\rdbms\ extproc\extern.dll

   is the path to the Windows operating system dll\extern.dll. This example uses C:\oracle\product\10.1.0 as your Oracle base and db_1 as your Oracle home.

   Note: The DBA must grant the EXECUTE privilege on the PL/SQL library to users who want to call the library's external procedure from PL/SQL or SQL.
4. Create a PL/SQL program unit specification.

Do this by writing a PL/SQL subprogram that uses the EXTERNAL clause instead of declarations and a BEGIN...END block. The EXTERNAL clause is the interface between PL/SQL and the external procedure. The EXTERNAL clause identifies the following information about the external procedure:

- Name
- DLL alias
- Programming language in which it was written
- Calling standard (defaults to C if omitted)

In the following example, externProcedures is a DLL alias. You need the EXECUTE privilege for this library. The external procedure to call is find_max. If enclosed in double quotation marks, it becomes case-sensitive. The LANGUAGE term specifies the language in which the external procedure was written.

```
CREATE OR REPLACE FUNCTION PLS_MAX(
  x BINARY_INTEGER,
  y BINARY_INTEGER)
RETURN BINARY_INTEGER AS
  EXTERNAL LIBRARY externProcedures
  NAME "find_max"
  LANGUAGE C
  PARAMETERS (
    x long,                  -- stores value of x
    x_INDICATOR short,       -- used to determine if x is a NULL value
    y long,                  -- stores value of y
    y_INDICATOR short        -- used to determine if y is a NULL value
  )
RETURN INDICATOR short );  -- need to pass pointer to return value's
                           -- indicator variable to determine if NULL

-- This means that my function will be defined as:
-- long max(long x, short x_indicator,
-- long y, short y_indicator, short * ret_indicator)
```

### Executing an External Procedure

To run an external procedure, you must call the PL/SQL program unit (that is, the alias for the external function) that registered the external procedure. These calls can appear in any of the following:

- Anonymous blocks
- Standalone and packaged subprograms
- Methods of an object type
- Database triggers
- SQL statements (calls to packaged functions only)

In "Registering an External Procedure", PL/SQL function PLS_MAX registered external procedure find_max. Follow these steps to run find_max:

1. Call PL/SQL function PLS_MAX from a PL/SQL routine named UseIt:

```
SET SERVER OUTPUT ON
CREATE OR REPLACE PROCEDURE UseIt AS
  a integer;
  b integer;
  c integer;
BEGIN
```
Debugging External Procedures

Usually, when an external procedure fails, its C prototype is faulty. That is, the prototype does not match the one generated internally by PL/SQL. This can happen if you specify an incompatible C datatype. For example, to pass an OUT parameter of type REAL, you must specify float *. Specifying float, double *, or any other C datatype will result in a mismatch.

In such cases, you might get a lost RPC connection to external procedure agent error, which means that agent extproc terminated abnormally because the external procedure caused a core dump. To avoid errors when declaring C prototype parameters, refer to Oracle Data Cartridge Developer’s Guide.

Using Package DEBUG_EXTPROC

To help you debug external procedures, PL/SQL provides utility package DEBUG_EXTPROC. To install the package, run script dbgextp.sql, which you can find in the PL/SQL demo directory.

To use the package, follow instructions in dbgextp.sql. Your Oracle Database account must have EXECUTE privileges on the package and CREATE LIBRARY privileges.

To debug external procedures:

2. Right click, and select Debug.
3. Click OK in the message window.
   - If you have built your DLL in a debug fashion with Microsoft Visual C++, then Visual C++ is activated.
4. In the Visual C++ window, select Edit > Breakpoints.
   - Use the breakpoint identified in dbgextp.sql in the PL/SQL demo directory.

See Also:

- ORACLE_BASE\ORACLE_HOME\rdbms\extproc\readme.doc (explains how to run the sample and provides debugging advice)
- PL/SQL User’s Guide and Reference
- Oracle Database Java Developer’s Guide
- "Calling External Procedures" in Oracle Database Application Developer’s Guide - Fundamentals
- Oracle Data Cartridge Developer’s Guide
Accessing Text Files with UTL_FILE

Package UTL_FILE allows your PL/SQL programs to read and write operating system text files. It provides a restricted version of standard operating system stream file I/O, including open, put, get, and close operations. When you want to read or write a text file, you call the function fopen, which returns a file handle for use in subsequent procedure calls. For example, the procedure put_line writes a text string and line terminator to an open file, and the procedure get_line reads a line of text from an open file into an output buffer.

See Also: PL/SQL Packages and Types Reference for more information on UTL_FILE

FSEEK, a UTL_FILE subprogram, adjusts the file pointer forward or backward within the file by the number of bytes specified. In order for UTL_FILE.FSEEK to work correctly, the lines in the file must have platform-specific line terminator characters. On Windows platforms the correct line terminator characters are <CR><LF>.

Accessing Web Data with Intercartridge Exchange

This section discusses the following topics:

- Configuring Intercartridge Exchange
- Using Intercartridge Exchange
- UTL_HTTP Exception Conditions
- Exception Conditions and Error Messages

Configuring Intercartridge Exchange

You must add a parameter to the registry before using Intercartridge Exchange.

1. Start Registry Editor from the command prompt:

   C:\> regedt32

   The Registry Editor window appears.

   Note: For another way to configure your registry, see “Modifying a Registry Value with regedt32” on page 14-9

2. Add HTTP_PROXY to the registry subkey of the Oracle home directory that you are using. The location of this parameter is determined by how many Oracle home directories are on your computer. If you have only one home directory, add HTTP_PROXY to

   HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME0.

   If you have more than one home directory, add it to

   HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_HOME_NAME

3. Choose Add Value from the Edit menu.

   The Add Value dialog appears.
4. Type `HTTP_PROXY` in the **Value Name** field and `REG_SZ` in the **Data Type** field.

5. Click **OK**.

6. Type `www-proxy.your-site` in the **String** field.

In this example, the Web site is `marketing.com`. You will enter the domain name of your actual Web site.

**Using Intercartridge Exchange**

Intercartridge Exchange enables you to use a stored package called `UTL_HTTP` to make Hypertext Transfer Protocol (HTTP) calls from PL/SQL, SQL, and SQL*Plus statements.

`UTL_HTTP` can do both of the following:

- Access data on the Internet
- Call Oracle Web Application Server cartridges

`UTL_HTTP` contains two similar entry points, known as packaged functions, that turn PL/SQL and SQL statements into HTTP callouts:

- `UTL_HTTP.REQUEST`
- `UTL_HTTP.REQUEST_PIECES`

Both packaged functions perform the following tasks:

- Take a string universal resource locator (URL) of a site
- Contact that site
- Return data (typically HTML) obtained from that site

Declarations to use with both packaged functions are described in the following subsections.
Packaged Function UTL_HTTP.REQUEST

UTL_HTTP.REQUEST uses a URL as its argument and returns up to the first 2000 bytes of data retrieved from that URL. Specify UTL_HTTP.REQUEST as follows:

```sql
FUNCTION REQUEST (URL IN VARCHAR2) RETURN VARCHAR2;
```

To use UTL_HTTP.REQUEST from SQL*Plus, enter:

```sql
SQL> SELECT UTL_HTTP.REQUEST('HTTP://WWW.ORACLE.COM/') FROM DUAL;
```

which returns:

```sql
UTL_HTTP.REQUEST('HTTP://WWW.ORACLE.COM/')
```

Packaged Function UTL_HTTP.REQUEST_PIECES

UTL_HTTP.REQUEST_PIECES uses a URL as its argument and returns a PL/SQL table of 2000 bytes of data retrieved from the given URL. The final element can be shorter than 2000 characters. The UTL_HTTP.REQUEST_PIECES return type is a PL/SQL table of type UTL_HTTP.HTML_PIECES.

UTL_HTTP.REQUEST_PIECES, which uses type UTL_HTTP.HTML_PIECES, is specified as:

```sql
type html_pieces is table of varchar2(2000) index by binary_integer;
function request_pieces (url in varchar2, max_pieces natural default 32767)
return html_pieces;
```

A call to REQUEST_PIECES can look like this example. Note the use of PL/SQL table method COUNT to discover the number of pieces returned; it can be zero or more:

```sql
declare pieces utl_http.html_pieces;
begin
    pieces := utl_http.request_pieces('http://www.oracle.com/');
    for i in 1 .. pieces.count loop
        .... -- process each piece
    end loop;
end;
```

The second argument to UTL_HTTP.REQUEST_PIECES (MAX_PIECES) is optional. MAX_PIECES is the maximum number of pieces (each 2000 characters in length, except for the last, which can be shorter) that UTL_HTTP.REQUEST_PIECES returns. If provided, that argument is usually a positive integer.

For example, the following block retrieves up to 100 pieces of data (each 2000 bytes, except perhaps the last) from the URL. The block prints the number of pieces retrieved and the total length, in bytes, of the data retrieved.

```sql
set serveroutput on

declare
    x utl_http.html_pieces;
begin
    x := utl_http.request_pieces('http://www.oracle.com/', 100);
    dbms_output.put_line(x.count || ' pieces were retrieved.');
    dbms_output.put_line('with total length ');
if x.count < 1
  then dbms_output.put_line('0');
  else dbms_output.put_line
    ((2000 * (x.count - 1)) + length(x(x.count)));
  end if;
end;

which displays:
Statement processed.
4 pieces were retrieved.
with total length
7687

Elements of the PL/SQL table returned by `UTL_HTTP.REQUEST_PIECES` are successive pieces of data obtained from the HTTP request to that URL.

### UTL_HTTP Exception Conditions

This subsection describes exceptions (errors) that can be raised by packaged functions `UTL_HTTP.REQUEST` and `UTL_HTTP.REQUEST_PIECES`.

#### UTL_HTTP.REQUEST

`PRAGMA RESTRICT_REFERENCES` enables display of exceptions:

```sql
create or replace package utl_http is
  function request (url in varchar2) return varchar2;
  pragma restrict_references (request, wnds, rnds, wnps, rnps);
end;
```

#### UTL_HTTP.REQUEST_PIECES

`PRAGMA RESTRICT_REFERENCES` enables display of exceptions:

```sql
create or replace package utl_http is
  type html_pieces is table of varchar2(2000) index by binary_integer;
  function request_pieces (url in varchar2, max_pieces natural default 32767) return html_pieces;
  pragma restrict_references (request_pieces, wnds, rnds, wnps, rnps);
end;
```

### Exception Conditions and Error Messages

If initialization of the HTTP callout subsystem fails for environmental reasons (such as lack of available memory), then exception `UTL_HTTP.INIT_FAILED` is raised:

```
init_failed exception;
```

If the HTTP call fails due to failure of the HTTP daemon or because the argument to `REQUEST` or `REQUEST_PIECES` cannot be interpreted as a URL (because it is `NULL` or has non-HTTP syntax), then exception `UTL_HTTP.REQUEST_FAILED` is raised:

```
request_failed exception;
```

Unless explicitly caught by an exception handler, these first two exceptions are reported by a generic message that shows them as “user-defined” exceptions, even though they are defined in this system package:

```
ORA-06510: PL/SQL: unhandled user-defined exception
```
If any other exception is raised during processing of the HTTP request (for example, an out-of-memory error), then function `UTL_HTTP.REQUEST` or `UTL_HTTP.REQUEST_PIECES` reraises that exception.

If no response is received from a request to the given URL, because the function made no contact with a site corresponding to that URL, then a formatted HTML error message may be returned:

```html
<HTML>
<HEAD>
<TITLE>Error Message</TITLE>
</HEAD>
<BODY>
<H1>Fatal Error 500</H1>
<P>
<B>Reason:</B> Can't locate remote host: home.nothing.comm.
<P>
</BODY>
</HTML>
```

If `UTL_HTTP.REQUEST` or `UTL_HTTP.REQUEST_PIECES` raises an exception or returns an HTML-formatted error message, yet you believe that the URL argument is correct, try contacting that same URL with a browser to verify network availability from your computer.
Getting Started with Your Documentation

Your Oracle Database documentation set is provided in both HTML and PDF formats on a CD included in your CD Pack. Use this CD to browse the library from the CD or copy files directly to a local system.

The library includes a Web-based search tool that enables you to search for information about a particular product, parameter, file name, procedure, error message, or other area of interest. The search tool also makes it possible to construct a "virtual book" drawn from the complete documentation library, but consisting only of topics and procedures relevant to your needs. The library also includes a comprehensive Master Index, as well as lists of SQL and PL/SQL keywords, initialization parameters, catalog views, and data dictionary views.

Instructions for installing the library and viewing its contents are in three README files at the root level of the documentation CD-ROMs:

- README.htm
- README.pdf
- README.txt

**Note:** The readme.txt file contains UNIX line breaks. If you simply double-click it, it will open in Notepad by default, and Notepad does not recognize UNIX line breaks. Use write.exe or edit.com instead.

The contents of the three files are identical; only the format differs.

**Note:** The Online Documentation Library CD is not shipped with Oracle Database for 64-bit Windows. For information on how to access Oracle Database documentation, see "Oracle Database for 64-bit Windows Documentation" on page G-8.
The following guides are not included on the Oracle Database Online Documentation Library CD-ROM for Windows:

- *Oracle Database Installation Guide for Windows* and *Oracle Database Release Notes for Windows*

  To access these documents before installation, open `welcome.htm` in the `\doc` directory on the component CD-ROM. To access these documents after installation, choose **Start > Programs > Oracle - HOME_NAME > Release Documentation** or open `index.htm` in the `ORACLE_BASE\ORACLE_HOME\doc` directory on your hard drive.

- Oracle Migration Workbench documentation

  **Note:** Oracle Migration Workbench is available only at OTN. See [http://otn.oracle.com/tech/migration/content.html](http://otn.oracle.com/tech/migration/content.html)

- Oracle Fail Safe documentation

  This document is on the Oracle Fail Safe product CD-ROM.

  **Note:** Oracle Fail Safe is not supported on Windows XP.
Storing Tablespaces on Raw Partitions

This appendix describes how to configure your system to store datafiles for a 
tablespace on raw partitions.

This appendix contains these topics:

- Raw Partition Overview
- Creating a Tablespace in a Raw Partition

---

Note: Oracle Real Application Clusters require additional configuration tools. See Oracle Real Application Clusters Installation and Configuration Guide for information on creating logical partitions and assigning symbolic links. Do not use this appendix to create partitions for Oracle Real Application Clusters.

---

Raw Partition Overview

Datafiles for tablespaces can be stored on a file system or on raw partitions. A raw partition is a portion of a physical disk that is accessed at the lowest possible level. Input/output (I/O) to a raw partition offers approximately a 5% to 10% performance improvement over I/O to a partition with a file system on it.

To create a raw partition, you must first generate an extended partition and a logical partition. An extended partition points to raw space on the disk that can be assigned multiple logical partitions for database files. An extended partition also avoids the four-partition limit by letting you define large numbers of logical partitions to accommodate applications using the Oracle Database server. Logical partitions can then be given symbolic link names to free up drive letters.

Physical Disk

A physical disk represents the entire disk and points to the following:

\Device\Harddiskx\Partition0

Symbolic link name `\\.\PhysicalDrive\` is automatically defined by Windows for every hard disk in the computer. For example, a computer with three hard disks will have the following symbolic links:

\\.\PhysicalDrive0
\\.\PhysicalDrive1
\\.\PhysicalDrive2
Internally, these names expand to the following:

```plaintext
\\.\PhysicalDrive0 = \Device\Harddisk0\Partition0
\\.\PhysicalDrive1 = \Device\Harddisk1\Partition0
\\.\PhysicalDrive2 = \Device\Harddisk2\Partition0
```

Partition0 is special, because it represents the entire physical disk regardless of any partitioning scheme on that disk. Windows writes a signature on the first block of all disks it recognizes. To avoid overwriting that block, Oracle Database skips the first block of a physical raw partition that is used for an Oracle Database datafile.

---

**Note:** Although you can use physical disks, Oracle recommends that you use logical partitions.

---

### Logical Partition

Logical partitions point to drives other than `\Device\Harddisk\Partition0`. They are initially assigned names with drive letters (`\\\drive_letter`) and typically re-assigned symbolic link names (`\\\symbolic link name`). For example, `\\\D:` may be assigned a symbolic link name of `\\\ACCOUNTING_1`. Regardless of whether a drive letter or symbolic link name is used, logical partitions are defined to represent a specific partition in a disk rather than the entire disk. Internally, these names can expand to:

```plaintext
\\.\D:= \Device\Harddisk2\Partition1
\\.\ACCOUNTING_1= \Device\Harddisk3\Partition2
```

---

**Note:** Oracle Database does not skip the first block of a logical raw partition used for an Oracle Database datafile.

---

### Physical Disk and Logical Partition Considerations

Consider the following when deciding which raw partition to use:

- Physical disks are automatically defined by Windows to represent the entire disk, and should never be defined by the user.
- Logical partitions must be defined by the user to represent a specific partition in a disk. These partitions should be logical partitions or drives contained in an extended partition. They should never be defined as `Partition0`.
- Using an entire disk (`Partition0`) for an Oracle Database datafile and using a partition that occupies the entire disk for an Oracle Database datafile are not the same thing. Even when a partition occupies the entire disk, there is still a small space on the disk that is not part of the partition.
- If you are using an entire disk for an Oracle Database datafile (`Partition0`), then use the pre-defined physical raw names that Windows provides.
- If you are using a specific partition and it occupies the entire disk, then use a logical partition.
- If you are using a specific partition created with Windows disk-management tools, then define and use a symbolic link name rather than a logical partition number (even if it occupies the entire disk).
Compatibility Issues

You can create logical partitions, but define physical disk convention names for them. For example:

```
\\PhysicalDriveACCOUNTING_1 = \Device\Harddisk2\Partition1
\\PhysicalDriveACCOUNTING_2 = \Device\Harddisk3\Partition1
```

Oracle Database then handles datafiles using the physical disk convention even though it really is a logical partition. This will not cause any data corruption or loss as long as you continue to use physical disk naming conventions. Oracle recommends that you convert to the logical partition at your earliest convenience.

You can also create logical names representing Partition0, but this is definitely not recommended. For example:

```
\\ACCOUNTING_1 = \Device\Harddisk1\Partition0
```

This poses severe problems, because Disk Management typically writes a signature into the first block of every disk, and consequently may overwrite a portion of the datafile header. It can also cause data loss. Never use Partition0 with the logical partition convention.

Physical and logical partition conventions are not compatible with one another because of the extra block that is skipped for physical raw conventions. This also means you cannot simply use OCOPY to copy from a physical disk to a logical partition, because contents of these partitions are incompatible.

To convert from a physical convention to a logical convention, you must:

1. Perform a full database export to a (local) file system.
2. Create logical partitions and define logical names for these partitions.
3. Recreate the database by using the new logical partitions.
4. Perform the full database import to the newly-created database.

If your database installation uses physical disk conventions with logical partitions, Oracle recommends converting to the logical partition conventions at your earliest convenience, using the preceding steps.

See Also: Your operating system documentation for information on creating extended and logical partitions.

Creating a Tablespace in a Raw Partition

To create a tablespace using a datafile located in a raw partition:

1. Start SQL*Plus:
   
   C:\> sqlplus

2. Connect to the Oracle Database repository database:

   Enter user-name: SYSTEM/password
where `password` for user account `SYSTEM` is `MANAGER` by default. If you have changed this password, substitute the correct password for `MANAGER`.

3. Create the tablespace:

   ```sql
   SQL> CREATE TABLESPACE tablespace DATAFILE '\.\datafile' SIZE xM;
   
   where:
   
   ■ `tablespace` is the tablespace name
   ■ `\.\` is the drive letter or symbolic link name assigned to the raw partition
   ■ `x` is the tablespace size in megabytes (Twenty megabytes is a good starting place.)
   
   For example, to create a tablespace named `accounting_1` that was assigned a symbolic link name of `accounting_1`, enter the following:
   
   ```sql
   SQL> CREATE TABLESPACE accounting_1 DATAFILE '\.\accounting_1' SIZE 502M;
   ```

   __Note:__ If you are creating a database with the SQL script, modify datafiles that are stored on raw partitions with a naming convention of `\.\drive_letter:` or `\.\symbolic link name`.  

---
Oracle Net Services Configuration on Windows

This appendix describes Oracle Net Services configuration for Windows. For more generic information on Oracle Net Services configuration, see Oracle Net Services Administrator's Guide.

This appendix contains these topics:

■ Understanding Oracle Net Services Registry Parameters and Subkeys
■ Listener Requirements
■ Understanding Optional Configuration Parameters
■ Advanced Network Configuration

Understanding Oracle Net Services Registry Parameters and Subkeys

The registry contains entries for Oracle Net Services parameters and subkeys. To successfully add or modify Oracle Net Services configuration parameters, you must understand where they are located and the rules that apply to them.

Oracle Net Service Subkeys

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services contains subkeys that correspond to services. Depending on what is installed, your Oracle Net Services consist of all or a subset of the following:

■ OracleHOME_NAME\ClientCache
■ OracleHOME_NAME\CMAdmin
■ OracleHOME_NAME\CMan
■ OracleHOME_NAME\TNSListener

Each service subkey contains the parameters shown in Table C–1.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DisplayName</td>
<td>Specifies service name.</td>
</tr>
<tr>
<td>ImagePath</td>
<td>Specifies fully qualified path name of executable invoked by service and any command line arguments passed to executable at runtime.</td>
</tr>
<tr>
<td>ObjectName</td>
<td>Specifies logon user account and computer to which service should log on.</td>
</tr>
</tbody>
</table>
Listener Requirements

In Oracle Database 10g Release 1 (10.1), the listener is set to start automatically at system restart. If you intend to use only the listener for all of your databases, ensure that only the Windows service for the listener, as listed in the Control Panel, is set to start automatically.

Oracle usually recommends that you only have a single net listener service running on a Windows computer at any one time. This single listener can support multiple databases. If you need to have two different net listener services running on a Windows computer at the same time, make sure that they are configured to listen on different TCP/IP port numbers.

If the same IP address and port are used for different listeners, you might expect that the second and subsequent listeners would fail to bind. Instead, Windows allows them all to listen on the same IP address and port, resulting in unexpected behavior of the listeners. This is a suspected Windows operating system problem with TCP/IP and has been reported to Microsoft.

Understanding Optional Configuration Parameters

You can use the following parameters on Windows:

- LOCAL
- TNS_ADMIN
- USE_SHARED_SOCKET

Oracle Net Service first checks for the parameters as environment variables, and uses the values defined. If environment variables are not defined, it searches for these parameters in the registry.

LOCAL

You can use parameter LOCAL to connect to Oracle Database without specifying a connect identifier in the connect string. The value of parameter LOCAL is any connect identifier, such as a net service name. For example, if parameter LOCAL is specified as finance, you can connect to a database from SQL*Plus with:

```
SQL> CONNECT scott/tiger
```

rather than

```
SQL> CONNECT scott/tiger@finance
```

Oracle Net checks if LOCAL is defined as an environment variable or as a parameter in the registry, and uses finance as the service name. If it exists, Oracle Net connects.

TNS_ADMIN

You can add parameter TNS_ADMIN to change the directory path of Oracle Net Services configuration files from the default location of ORACLE_HOME\network\admin. For example, if you set TNS_ADMIN to ORACLE_BASE\ORACLE_HOME\test\admin, the configuration files are used from ORACLE_BASE\ORACLE_HOME\test\admin.
USE_SHARED_SOCKET

You can set parameter USE_SHARED_SOCKET to true to enable use of shared sockets. If this parameter is set to true, the network listener passes the socket descriptor for client connections to the database thread. As a result, the client does not need to establish a new connection to the database thread and database connection time improves. Also, all database connections share the port number used by the network listener, which can be useful if you are setting up third-party proxy servers.

This parameter only works in dedicated server mode in a TCP/IP environment. If this parameter is set, you cannot use the 9.0 listener to spawn Oracle7 release 7.x databases. To spawn a dedicated server for an instance of Oracle Database not associated with the same Oracle home as the listener and have shared socket enabled, you must also set parameter USE_SHARED_SOCKET for both Oracle homes.

Advanced Network Configuration

The following sections describe advanced configuration procedures specifically for Oracle Net Services on Windows operating systems.

Configuring Authentication Method

Oracle Net Services provides authentication methods for Windows operating systems using Windows Native Authentication.

Configuring Security for Named Pipes Protocol

The network listener service may be unable to open the Named Pipe created by Oracle Names unless service OracleHOME_NAME\TNSListener has a valid user ID and password associated with it.

See Also: Your operating system documentation for instructions on setting up network listener permissions

Modifying Configuration of External Procedures for Higher Security

This section supplements generic information provided in Oracle Net Services Administrator’s Guide to configure a listener on Windows operating systems to exclusively handle external procedures. For a higher level of security, you are instructed to start the listener for external procedures from a user account with lower privileges than the oracle user. For Windows operating systems, this requires that you change the user account from LocalSystem to a local, unprivileged user for the OracleHOME_NAME\TNSListener\extproc_listener_name service.

Note: The following instructions assume that you have performed steps 1 through 5 in the section "Modifying Configuration of External Procedures for Higher Security" in Oracle Net Services Administrator’s Guide.
To change the listener account:

1. Create a new user account and grant it Log on as a Service privilege.

   **Note:** Ensure that this user account does not have general access to files owned by oracle. Specifically, this user should not have permission to read or write to database files or to the Oracle Database server address space. In addition, this user should have read access to the listener.ora file, but must not have write access to it.

2. Stop service OracleHOME_NAME|NS\Listenerextproc\listener_name.

   **See Also:** Your operating system documentation for instructions on accessing the Services dialog and stopping services

   **Note:** If the OracleHOME_NAME|NS\Listenerextproc\listener_name service does not exist, issue the following command from the command prompt:

   `lsnrctl start extproc_listener_name`

   This creates the OracleHOME_NAME|NS\Listenerextproc\listener_name service. When you return to the list of services, stop this service before proceeding to the next step of this procedure.

3. Select OracleHOME_NAME|NS\Listenerextproc\listener_name service in the Services dialog and then display the properties of the service.

4. Select This Account and enter the username and password.

5. Start the listener by clicking Start. You must start the listener in this way because you cannot use the Listener Control utility to start the listener running as an unprivileged local user.

   **Note:** You can also use `NET START OracleHOME_\NAME\Listenerextproc\listener_name` to start the listener from the command prompt. Running the listener with lower privileges prevents you from using Listener Control utility SET commands to alter the configuration of this listener in file listener.ora. You can perform other administrative tasks on this listener with the Listener Control utility, including stopping the listener. Oracle recommends that you complete listener.ora file configuration prior to running the listener.
This appendix lists error messages, causes, and corrective actions that are specific to operation of Oracle Database for Windows. This appendix also includes database connection issues.

This appendix contains these topics:

- **ORA-09275: CONNECT INTERNAL No Longer Supported**
- **OSD-04000 to OSD-04599: Windows-Specific Oracle Database Messages**
- **DIM-00000 to DIM-00039: ORADIM Command Syntax Errors**
- **Database Connection Issues**

---

**ORA-09275: CONNECT INTERNAL No Longer Supported**

**ORA-09275**

*Connect internal is not a valid DBA connection*

**Cause:** CONNECT INTERNAL is no longer supported.

**Action:** If NTS is enabled, you can connect to the database as `CONNECT / AS SYSDBA`. If NTS is not enabled, you can connect as `CONNECT SYS/password AS SYSDBA`. You can also connect as an existing user with the appropriate password.

---

**OSD-04000 to OSD-04599: Windows-Specific Oracle Database Messages**

Error messages in this section are Oracle Database operating system-dependent (OSD) messages displayed in response to an error condition in Windows. Each message in this section triggers an Oracle Database error message.

Error messages appear first in summary tables consisting of error numbers and the corresponding error message. Following the tables is a more detailed discussion of errors, including causes and corrective actions.

- **File I/O Errors: OSD-04000 to OSD-04099**
- **Memory Errors: OSD-04100 to OSD-04199**
- **Process Errors: OSD-04200 to OSD-04299**
- **Loader Errors: OSD-04300 to OSD-04399**
### Semaphore Errors: OSD-04400 to OSD-04499

- 4400 Logical block size mismatch
- 4401 Invalid logical block size
- 4402 Unable to open file
- 4403 Unable to read file header block
- 4404 Invalid file header
- 4405 SetFilePointer() failure, unable to read from file
- 4406 ReadFile() failure, unable to read from file
- 4407 Truncated read
- 4408 WriteFile() failure, unable to write to file
- 4409 Truncated write
- 4410 <create> option specified, file already exists
- 4411 GetFileInformationByHandle() failure, unable to obtain file info
- 4412 File size mismatch
- 4413 Unable to read line from file
- 4414 Unable to close file
- 4415 An asynchronous I/O request returned an error
- 4416 Error queuing an asynchronous I/O request
- 4417 Unable to open the specified RAW device
- 4418 Unable to access the specified directory or device
- 4419 Unable to set file pointer
- 4420 Unable to set eof file marker
- 4421 Unable to read file
- 4422 Unable to write file
- 4423 SleepEx() failure, unable to Sleep
- 4424 Unable to delete file
- 4425 Invalid question asked
- 4426 Invalid parameter passed

### Miscellaneous Errors: OSD-04500 to OSD-04599

- 4500 Logical block size mismatch
- 4501 Invalid logical block size
- 4502 Unable to open file
- 4503 Unable to read file header block
- 4504 Invalid file header
- 4505 SetFilePointer() failure, unable to read from file
- 4506 ReadFile() failure, unable to read from file
- 4507 Truncated read
- 4508 WriteFile() failure, unable to write to file
- 4509 Truncated write
- 4510 <create> option specified, file already exists
- 4511 GetFileInformationByHandle() failure, unable to obtain file info
- 4512 File size mismatch
- 4513 Unable to read line from file
- 4514 Unable to close file
- 4515 An asynchronous I/O request returned an error
- 4516 Error queuing an asynchronous I/O request
- 4517 Unable to open the specified RAW device
- 4518 Unable to access the specified directory or device
- 4519 Unable to set file pointer
- 4520 Unable to set eof file marker
- 4521 Unable to read file
- 4522 Unable to write file
- 4523 SleepEx() failure, unable to Sleep
- 4524 Unable to delete file
- 4525 Invalid question asked
- 4526 Invalid parameter passed

### Memory Errors: OSD-04100 to OSD-04199

- 4100 malloc() failure, unable to allocate memory
- 4101 Invalid SGA: SGA not initialized
- 4102 Unable to open/create file for shared memory object
- 4103 Unable to attach to SGA: SGA does not exist
- 4104 Unable to map shared memory (SGA) into the address space
- 4105 Shared memory (SGA) mapped to wrong address
- 4106 Unable to allocate memory with VirtualAlloc
- 4107 Unable to deallocate memory with VirtualFree
- 4108 Unable to protect memory with VirtualProtect
<table>
<thead>
<tr>
<th>Process Errors:</th>
<th>OSD-04200 to OSD-04299</th>
</tr>
</thead>
<tbody>
<tr>
<td>4200</td>
<td>Unable to begin another thread</td>
</tr>
<tr>
<td>4201</td>
<td>No pid structure supplied to spdcr()</td>
</tr>
<tr>
<td>4202</td>
<td>DosSetPriority() failure, unable to set process priority</td>
</tr>
<tr>
<td>4203</td>
<td>DosKillProcess() failure, unable to kill process</td>
</tr>
<tr>
<td>4204</td>
<td>Invalid pid</td>
</tr>
<tr>
<td>4205</td>
<td>CreateProcess() failure, unable to spawn process</td>
</tr>
<tr>
<td>4207</td>
<td>Invalid priority specified in CONFIG parameter ORACLE_PRIORITY</td>
</tr>
<tr>
<td>4208</td>
<td>OpenProcess() failure, unable to open process handle</td>
</tr>
<tr>
<td>4209</td>
<td>Incorrect or unknown background image name given to spdcr()</td>
</tr>
<tr>
<td>4210</td>
<td>Timeout waiting for thread semaphore</td>
</tr>
<tr>
<td>4211</td>
<td>Thread information not found</td>
</tr>
<tr>
<td>4212</td>
<td>Maximum number of ORACLE threads reached</td>
</tr>
<tr>
<td>4213</td>
<td>ORACLE thread unable to DuplicateHandle()</td>
</tr>
<tr>
<td>4214</td>
<td>ORACLE thread unable to CreateEvent()</td>
</tr>
<tr>
<td>4215</td>
<td>Bad function code supplied to ssthreadop</td>
</tr>
<tr>
<td>4216</td>
<td>Unable to find file handle for that thread</td>
</tr>
<tr>
<td>4217</td>
<td>Unable to retrieve system username for current user</td>
</tr>
<tr>
<td>4218</td>
<td>Cannot post thread</td>
</tr>
<tr>
<td>4219</td>
<td>Bad thread list semaphore</td>
</tr>
<tr>
<td>4221</td>
<td>Target thread is currently busy</td>
</tr>
<tr>
<td>4222</td>
<td>Unable to get the threads context</td>
</tr>
<tr>
<td>4223</td>
<td>Unable to set the threads context</td>
</tr>
<tr>
<td>4224</td>
<td>Unable to suspend the target thread</td>
</tr>
<tr>
<td>4225</td>
<td>Unable to resume the target thread</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Loader Errors:</th>
<th>OSD-04300 to OSD-04399</th>
</tr>
</thead>
<tbody>
<tr>
<td>4300</td>
<td>Unable to read complete record from datafile</td>
</tr>
<tr>
<td>4301</td>
<td>Record size too large</td>
</tr>
<tr>
<td>4302</td>
<td>Invalid record type, load options, or both</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Semaphore Errors:</th>
<th>OSD-04400 to OSD-04499</th>
</tr>
</thead>
<tbody>
<tr>
<td>4400</td>
<td>Unable to acquire internal semaphore for process</td>
</tr>
<tr>
<td>4401</td>
<td>WaitForSingleObject() failure, unable to obtain semaphore</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Miscellaneous Errors:</th>
<th>OSD-04500 to OSD-04599</th>
</tr>
</thead>
<tbody>
<tr>
<td>4500</td>
<td>Illegal option specified</td>
</tr>
<tr>
<td>4501</td>
<td>Internal buffer overflow</td>
</tr>
<tr>
<td>4502</td>
<td>Translations nested too deep</td>
</tr>
<tr>
<td>4503</td>
<td>Text contains no translatable elements</td>
</tr>
<tr>
<td>4505</td>
<td>stdin not responding</td>
</tr>
<tr>
<td>4506</td>
<td>Unable to spawn process via system()</td>
</tr>
<tr>
<td>4510</td>
<td>Operating system roles are not supported</td>
</tr>
</tbody>
</table>
OSD-04000 to OSD-04599: Windows-Specific Oracle Database Messages

File I/O Errors: OSD-04000 to OSD-04099

OSD-04000
Logical block size mismatch
Cause: Database block size specified in initialization parameter file does not match block size of actual database files.
Action: Use matching logical block sizes.

OSD-04001
Invalid logical block size
Cause: Logical block size is not a multiple of 512 bytes, or it is too large.
Action: Change the value of DB_BLOCK_SIZE in the initialization parameter file.

OSD-04002
Unable to open file
Cause: Specified path or filename is invalid, or destination device is full. This error can also be caused by insufficient Windows file handles.
Action: Make sure path and file exist, and device has free space. If this fails, then increase number of Windows file handles.

OSD-04003
Unable to read file header block
Cause: Media has been damaged.
Action: Recover file, if necessary, and verify that Windows is functioning correctly.

OSD-04004
Invalid file header
Cause: File is damaged.
Action: Recover file.

OSD-04005
SetFilePointer() failure, unable to read from file
Cause: Unexpected return from Windows system service SetFilePointer().
Action: Check operating system error code and operating system documentation.

OSD-04006
ReadFile() failure, unable to read from file
Cause: Unexpected return from Windows system service ReadFile().
Action: Check operating system error code and operating system documentation.

Miscellaneous Errors: OSD-04500 to OSD-04599

4511 Unable to get date and time from the operating system
4512 Unable to translate the ‘USERNAME’ config.ora variable on server
4513 'remote_os_authent' init.ora variable not set to true
4514 The Windows Group name is too long for internal buffer
4515 This command is not implemented at this time
OSD-04007

Truncated read

**Cause:** System encountered an unexpected end-of-file, which is due to damaged media.

**Action:** Verify that file is not damaged.

OSD-04008

WriteFile() failure, unable to write to file

**Cause:** Unexpected return from Windows system service WriteFile().

**Action:** Check operating system error code and operating system documentation.

OSD-04009

Truncated write

**Cause:** Destination device is full, or media is damaged.

**Action:** Verify that device has free space and that file is not damaged.

OSD-04010

<create> option specified, file already exists

**Cause:** File you attempted to create already exists.

**Action:** Delete existing file or use REUSE option in SQL statement.

OSD-04011

GetFileInformationByHandle() failure, unable to obtain file info

**Cause:** Unexpected return from Windows system service GetFileInformationByHandle().

**Action:** Check operating system error code and operating system documentation.

OSD-04012

File size mismatch

**Cause:** File to be re-used is either too large or too small.

**Action:** Specify correct file size or delete existing file.

OSD-04013

Unable to read line from file

**Cause:** This error is caused by an operating system error or by damaged media.

**Action:** Check operating system error code (if available) and operating system documentation. If no operating system error code is presented, then verify that media is not damaged.

OSD-04014

Unable to close file

**Cause:** Media has been damaged.

**Action:** Recover file, if necessary, and verify that Windows is functioning correctly.

OSD-04015

Asynchronous I/O request returned an error

**Cause:** Unexpected return from Windows system service.

**Action:** Check operating system error code and operating system documentation.
OSD-04016
Error queuing an asynchronous I/O request
Cause: Unexpected return from Windows system service.
Action: Check operating system error code and operating system documentation.

OSD-04017
Unable to open the specified RAW device
Cause: An invalid path or filename was specified, or device is full.
Action: Make sure file exists and device is not full; verify that operating system is functioning correctly.

OSD-04018
Unable to access the specified directory or device
Cause: An invalid path name was specified.
Action: Make sure directory or device exists and is accessible.

OSD-04019
Unable to set file pointer
Cause: This error is caused by an operating system error or by damaged media.
Action: Check operating system error code (if available) and operating system documentation. If no operating system error code is presented, then verify that media is not damaged.

OSD-04020
Unable to set eof file marker
Cause: This error is caused by an operating system error or by damaged media.
Action: Check operating system error code (if available) and operating system documentation. If no operating system error code is presented, then verify that media is not damaged.

OSD-04021
Unable to read file
Cause: This error is caused by an operating system error or by damaged media.
Action: Check operating system error code (if available) and operating system documentation. If no operating system error code is presented, then verify that media is not damaged.

OSD-04022
Unable to write file
Cause: This error is caused by an operating system error or by damaged media.
Action: Check operating system error code (if available) and operating system documentation. If no operating system error code is presented, then verify that media is not damaged.

OSD-04023
SleepEx() failure, unable to Sleep
Cause: Unexpected return from Windows system service.
Action: Check operating system error code and operating system documentation.
OSD-04024
Unable to delete file
Cause: This error is caused by an operating system error or by damaged media.
Action: Check operating system error code (if available) and operating system documentation. If no operating system error code is presented, then verify that media is not damaged.

OSD-04025
Invalid question asked
Cause: This is an internal error, not normally expected to occur.
Action: Contact Oracle Support Services.

OSD-04026
Invalid parameter passed
Cause: This is an internal error, not normally expected to occur.
Action: Contact Oracle Support Services.

Memory Errors: OSD-04100 to OSD-04199

OSD-04100
Malloc() failure, unable to allocate memory
Cause: Program is out of memory.
Action: Shut down all unnecessary processes or install more memory in the computer.

OSD-04101
Invalid SGA: SGA not initialized
Cause: System Global Area (SGA) has been allocated but not initialized.
Action: Wait until STARTUP has completed before attempting to connect.

OSD-04102
Unable to open/create file for shared memory object
Cause: Unexpected return from Windows system service CreateFile().
Action: Check operating system error code and operating system documentation.

OSD-04103
Unable to attach to SGA: SGA does not exist
Cause: SGA does not exist.
Action: Start up an Oracle Database instance.

OSD-04104
Unable to map shared memory (SGA) into the address space
Cause: Unexpected return from Windows system service MapViewOfFileEx().
Action: Check operating system error code and operating system documentation.

OSD-04105
Shared memory (SGA) mapped to wrong address
Cause: Unexpected return from Windows system service MapViewOfFileEx().
Action: Check operating system error code and operating system documentation.
OSD-04106
Unable to allocate memory with VirtualAlloc
Cause: Program is out of memory.
Action: Shut down all unnecessary processes or install more memory in the computer.

OSD-04107
Unable to deallocate memory with VirtualFree
Cause: Unexpected return from Windows system service VirtualFree().
Action: Check operating system error code and operating system documentation.

OSD-04108
Unable to protect memory with VirtualProtect
Cause: Unexpected return from Windows system service VirtualProtect().
Action: Check operating system error code and operating system documentation.

OSD-04200
Unable to begin another thread
Cause: Program has run out of system resources.
Action: Shut down all unnecessary processes; install more memory in the computer.

OSD-04201
No pid structure supplied to spdcr()
Cause: This is an internal error, not normally expected to occur.
Action: Contact Oracle Support Services.

OSD-04202
DosSetPriority() failure, unable to set process priority
Cause: Unexpected return from Windows system service DosSetPriority().
Action: Check operating system error code and operating system documentation.

OSD-04203
DosKillProcess() failure, unable to kill process
Cause: Unexpected return from Windows system service DosKillProcess().
Action: Check operating system error code and operating system documentation.

OSD-04204
Invalid pid
Cause: Process ID not recognized by system; process previously terminated.
Action: Verify that process ID is correct and that process is active.

OSD-04205
CreateProcess() failure, unable to spawn process
Cause: Unexpected return from Windows system service CreateProcess().
Action: Check operating system error code and operating system documentation.
OSD-04207
Invalid priority specified in CONFIG parameter `ORACLE_PRIORITY`
Cause: Priority specified is invalid or out of range.
Action: Specify a valid setting for `ORACLE_PRIORITY`.

OSD-04208
OpenProcess() failure, unable to open process handle
Cause: Unexpected return from Windows system service OpenProcess().
Action: Check operating system error code and operating system documentation.

OSD-04209
Incorrect or unknown background image name given to spdcr()
Cause: Unexpected background name given to spdcr().
Action: Contact Oracle Support Services.

OSD-04210
Timeout waiting for thread semaphore
Cause: An Oracle Database thread died holding the semaphore.
Action: Restart Oracle Database instance.

OSD-04211
Thread information not found
Cause: An Oracle Database thread died without deleting its information.
Action: Restart Oracle Database instance.

OSD-04212
Maximum number of Oracle threads reached
Cause: Maximum number of Oracle Database threads for the instance is reached.
Action: Wait until some connections exit before trying again.

OSD-04213
Oracle thread unable to DuplicateHandle()
Cause: This is an internal error, not normally expected to occur.
Action: Contact Oracle Support Services.

OSD-04214
Oracle thread unable to CreateEvent()
Cause: This is an internal error, not normally expected to occur.
Action: Contact Oracle Support Services.

OSD-04215
Bad function code supplied to ssthreadop
Cause: This is an internal error, not normally expected to occur.
Action: Contact Oracle Support Services.

OSD-04216
Unable to find file handle for that thread
Cause: This is an internal error, not normally expected to occur.
Action: Contact Oracle Support Services.
OSD-04217
Unable to retrieve system username for current user
Cause: This is an internal error, not normally expected to occur.
Action: Contact Oracle Support Services.

OSD-04218
Cannot post thread
Cause: This is an internal error, not normally expected to occur.
Action: Contact Oracle Support Services.

OSD-04219
Bad thread list semaphore
Cause: This is an internal error, not normally expected to occur.
Action: Contact Oracle Support Services.

OSD-04221
Target thread is currently busy
Cause: Target thread is processing an Oracle Database utility command.
Action: Wait and resend command.

OSD-04222
Unable to get the threads context
Cause: Check operating system error code.
Action: Remedy operating system error.

OSD-04223
Unable to set the threads context
Cause: Check operating system error code.
Action: Remedy operating system error.

OSD-04224
Unable to suspend the target thread
Cause: Check operating system error code.
Action: Remedy operating system error.

OSD-04225
Unable to resume the target thread
Cause: Check operating system error code.
Action: Remedy operating system error.

Loader Errors: OSD-04300 to OSD-04399

OSD-04300
Unable to read complete record from datafile
Cause: Datafile ended in the middle of a record. This error occurs when loading files with a fixed record length.
Action: Verify that datafile is of correct length and contains complete records.
OSD-04301
*Record size too large*
**Cause:** Specified record size is too large to load.
**Action:** Reduce record size and reload data.

OSD-04302
*Invalid record type, load options, or both*
**Cause:** Control file's Windows file processing options string contains an invalid option or keyword.
**Action:** Set Windows file processing options string to an acceptable value.

**Semaphore Errors: OSD-04400 to OSD-04499**

OSD-04400
*Unable to acquire internal semaphore for process*
**Cause:** Oracle Database has exceeded the maximum number of connections.
**Action:** Delete any unused connections and try again.

OSD-04401
*WaitForSingleObject() failure, unable to obtain semaphore*
**Cause:** Unexpected return from Windows system service WaitForSingleObject().
**Action:** Check operating system error code and operating system documentation.

**Miscellaneous Errors: OSD-04500 to OSD-04599**

OSD-04500
*Illegal option specified*
**Cause:** This is an internal error, not normally expected to occur.
**Action:** Contact Oracle Support Services.

OSD-04501
*Internal buffer overflow*
**Cause:** This is an internal error, not normally expected to occur.
**Action:** Contact Oracle Support Services.

OSD-04502
*Translations nested too deep*
**Cause:** Program encountered too many intermediate translations while attempting to translate a configuration variable.
**Action:** Simplify values of configuration parameters to include fewer intermediate translations.

OSD-04503
*Text contains no translatable elements*
**Cause:** Program cannot recognize variables in text to be translated.
**Action:** Check and, if necessary, correct text to be translated.
OSD-04505

stdin not responding

Cause: System is unable to receive input from standard input stream.
Action: Verify that process has access to an input device.

OSD-04506

Unable to spawn process via system()

Cause: System is out of memory or executable is invalid.
Action: Shut down unnecessary processes; install more memory in the computer.
Verify name of executable.

OSD-04510

Operating system roles are not supported

Cause: An attempt was made to use an operating system role.
Action: Only use roles that were created 'IDENTIFIED BY PASSWORD' as opposed to 'IDENTIFIED EXTERNALLY'.

OSD-04511

Unable to get date and time from the operating system

Cause: Unexpected return from GetLocalTime() call.
Action: Verify that system time is correct on the computer.

OSD-04512

Unable to translate the 'USERNAME' config.ora variable on server

Cause: 'USERNAME' configuration parameter variable on host is not properly set.
Action: Verify 'USERNAME' variable is set.

OSD-04513

'remote_os_authent' init.ora variable not set to TRUE

Cause: For remote operating system logon to function, 'REMOTE_OS_AUTHENT' parameter must be set to TRUE.
Action: Shut down and start up instance with 'REMOTE_OS_AUTHENT = TRUE' in initialization parameter file.

OSD-04514

The Windows Group name is too long for internal buffer

Cause: Windows Group name is too long.
Action: Use a shorter Windows group name.

DIM-00000 to DIM-00039: ORADIM Command Syntax Errors

ORADIM is a command-line tool for starting and stopping database instances that is only available on Oracle Database for Windows. It is not available on any other platform.

<table>
<thead>
<tr>
<th>Oradim Errors</th>
<th>DIM-0000 to DIM-00039</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000</td>
<td>ORADIM completed with no errors</td>
</tr>
<tr>
<td>00001</td>
<td>ORADIM: &lt;command&gt; [options]. Refer to manual.</td>
</tr>
<tr>
<td>00002</td>
<td>The specified command was invalid.</td>
</tr>
<tr>
<td>00003</td>
<td>An argument is missing for the parameter</td>
</tr>
</tbody>
</table>
Oradim Errors | DIM-0000 to DIM-0039
--- | ---
00004 | SID or service name was not specified.
00005 | SID with more than 64 characters specified.
00006 | Missing SID
00007 | Missing or invalid -STARTMODE parameter. Valid -STARTMODE parameter is AUTO or MANUAL.
00008 | A valid service name is OracleService appended with a SID
00009 | SID name is mandatory.
00010 | SYSTEM\CurrentControlSet\Services\OracleService key does not exist.
00011 | The specified service does not exist.
00012 | A PFILE is necessary for AUTOSTART option.
00013 | Service start mode could not be set in the registry.
00014 | Cannot open the Windows NT Service Control Manager.
00015 | Cannot start already-running ORACLE - shut it down first.
00016 | Missing or invalid -SHUTTYPE parameter. A valid -SHUTTYPE parameter is SRVC or INST.
00017 | Instance shutdown mode must be one of the following: a for abort, i for immediate or n for normal.
00018 | Failed to stop Oracle Service.
00019 | Create Service Error.
00020 | A service for this name exists.
00021 | Registry open failed.
00022 | Create an instance by specifying the following options:
00023 | -NEW -SID sid | -SRVC srcv | -ASMSID sid | -ASMSRVC srcv [-SYSPWD pass]
00024 | [-STARTMODE auto | manual] [-SRVCSTART system | demand] [-PFILE file | -SPFILE]
00025 | [-SHUTMODE normal | immediate | abort] [-TIMEOUT secs] [-RUNAS osusr/ospass]
00026 | Edit an instance by specifying the following options:
00027 | -EDIT -SID sid | -ASMSID sid [-SYSPWD pass]
00028 | [-STARTMODE auto | manual] [-SRVCSTART system | demand] [-PFILE file | -SPFILE]
00029 | [-SHUTMODE normal | immediate | abort] [-SHUTTYPE srcv | inst] [-RUNAS osusr/ospass]
00030 | Delete instances by specifying the following options:
00031 | -DELETE -SID sid | -ASMSID sid | -SRVC srcv | -ASMSRVC srcv
00032 | Startup services and instance by specifying the following options:
00033 | -STARTUP -SID sid | -ASMSID sid [-SYSPWD pass]
00034 | [-STARTTYPE srcv | inst | srvc,inst] [-PFILE filename | -SPFILE]
00035 | Shutdown services and instance by specifying the following options:
00036 | -SHUTDOWN -SID sid | -ASMSID sid [-SYSPWD pass]
00037 | [-SHUTTYPE srcv | inst | srvc,inst] [-SHUTMODE normal | immediate | abort]
00038 | Query for help by specifying the following parameters: -? | -h | -help
00039 | Invalid option for the -NEW command.
00040 | Invalid option for the -EDIT command.
00041 | Invalid option for the -DELETE command.
00042 | Invalid option for the -STARTUP command.
00043 | Invalid option for the -SHUTDOWN command.
00044 | Internal error in ORADIM.
00045 | Invalid Pfile.
Oradim Errors | DIM-0000 to DIM-0039
---|---
00050 | Instance deleted.
00051 | Instance created.
00075 | Failed to control service.
00076 | Failed to delete service.
00077 | Failed to change service configuration.
00078 | Failed to start service.

**DIM-0000**

*ORADIM completed with no errors.*

**Cause:** The specified operation completed successfully.

**Action:** None.

**DIM-00001**

*ORADIM: <command> [options]. Refer to manual.*

**Cause:** The specified options were invalid or no arguments were supplied.

**Action:** Usage: ORADIM <command> [options]

**DIM-00002**

The specified command was invalid.

**Cause:** Valid commands are: -DELETE, -EDIT, -NEW, -STARTUP, and -SHUTDOWN.

**Action:** Use valid command.

**DIM-00003**

An argument is missing for the parameter.

**Cause:** Missing or invalid argument.

**Action:** Use a valid argument and invoke the program again.

**DIM-00004**

*SID or service name was not specified.*

**Cause:** Either a SID or service name is mandatory.

**Action:** Enter a valid *SID* of 64 characters and retry.

**DIM-00005**

*SID with more than 64 characters specified.*

**Cause:** SID with more than 64 characters specified.

**Action:** Change SID to 64 unique characters and make sure that there is no other service with this name.

**DIM-00006**

*Missing SID.*

**Cause:** SID was not specified in the arguments.

**Action:** Specify a SID.
DIM-00007

Missing or invalid -STARTMODE parameter. Valid -STARTMODE parameter is AUTO or MANUAL.

Cause: An argument for STARTMODE is missing.
Action: Enter a valid start mode and retry.

DIM-00008

A valid service name is OracleService appended with a SID

Cause: The Oracle service name specified is invalid.
Action: Correct the name of service and retry.

DIM-00009

SID name is mandatory.

Cause: SID was not specified.
Action: Enter the SID and retry.

DIM-00010

SYSTEM\CurrentControlSet\Services\OracleService key does not exist.

Cause: Specified registry key was not found.
Action: Try reinstalling. If the problem persists, contact Oracle Support Services.

DIM-00011

The specified service does not exist.

Cause: An attempt to edit a service failed.
Action: Make sure the service exists or user has enough privileges.

DIM-00012

A PFILE is necessary for AUTOSTART option.

Cause: A parameter file [PFILE] was not specified.
Action: Specify a parameter file.

DIM-00013

Service start mode could not be set in the registry.

Cause: The start mode entry in the registry for the service could not be set.
Action: Check if the user has privileges to modify registry.

DIM-00014

Cannot open the Windows NT Service Control Manager.

Cause: The Service Control Manager could not be opened.
Action: Check for user privileges.

DIM-00015

Cannot start already-running ORACLE - shut it down first.

Cause: The instance is already started.
Action: Stop the database before restarting.
DIM-00016
Missing or invalid -SHUTTYPE parameter. A valid -SHUTTYPE parameter is SRVC or INST.
Cause: An option for SHUTTYPE was missing or invalid.
Action: Enter parameter to shut down the instance or the service and retry.

DIM-00017
Instance shutdown mode must be one of the following: a for abort, i for immediate or n for normal.
Cause: Invalid option to shut down the instance was specified.
Action: Enter the correct mode and retry.

DIM-00018
Failed to stop Oracle Service.
Cause: An attempt to stop the service failed.
Action: Retry, check for user privileges.

DIM-00019
Create service error.
Cause: Service could not be created.
Action: Check for user privileges and retry.

DIM-00020
A service for this name exists.
Cause: An attempt was made to create a service name when it already existed.
Action: Retry with a different service name or SID.

DIM-00021
Registry open failed
Cause: An attempt to open the registry failed.
Action: Check for user privileges and retry the operation.

DIM-00023
Create an instance by specifying the following options:
Cause: n/a
Action: n/a

DIM-00024
-NEW -SID sid | -SRVC srcv | -ASMSID sid | -ASMSRVC srcv [-SYSPWD pass]
Cause: n/a
Action: n/a

DIM-00025
[-STARTMODE auto | manual] [-SRVCSTART system | demand] [-PFILE file | -SPFILE]
Cause: n/a
Action: n/a
DIM-00026
[-SHUTMODE normal | immediate | abort] [-TIMEOUT secs] [-RUNAS osusr/ospass]
Cause: n/a
Action: n/a

DIM-00027
Edit an instance by specifying the following options:
Cause: n/a
Action: n/a

DIM-00028
-EDIT -SID sid | -ASMSID sid [-SYSPWD pass]
Cause: n/a
Action: n/a

DIM-00029
[-STARTMODE auto | manual] [-SRVCSTART system | demand] [-PFILE file | -SPFILE]
Cause: n/a
Action: n/a

DIM-00030
[-SHUTMODE normal | immediate | abort] [-SHUTTYPE srvc | inst] [-RUNAS osusr/ospass]
Cause: n/a
Action: n/a

DIM-00031
Delete instances by specifying the following options:
Cause: n/a
Action: n/a

DIM-00032
-DELETE -SID sid | -ASMSID sid | -SRVC srvc | -ASMSRVC srvc
Cause: n/a
Action: n/a

DIM-00033
Start up services and instance by specifying the following options:
Cause: n/a
Action: n/a

DIM-00034
-STARTUP -SID sid | -ASMSID sid [-SYSPWD pass]
Cause: n/a
Action: n/a
**DIM-00035**

```
[-STARTTYPE srvc | inst | srvc,inst][-PFILE filename | -SPFILE]
```

*Cause:* n/a

*Action:* n/a

**DIM-00036**

*Shut down services and instance by specifying the following options:*

*Cause:* n/a

*Action:* n/a

**DIM-00037**

```
-SHUTDOWN -SID sid | -ASMSID sid [-SYSPWD pass]
```

*Cause:* n/a

*Action:* n/a

**DIM-00038**

```
[-SHUTTYPE srvc | inst | srvc,inst] [-SHUTMODE normal | immediate | abort]
```

*Cause:* n/a

*Action:* n/a

**DIM-00039**

*Query for help by specifying the following parameters: -*? | -h | -help

*Cause:* n/a

*Action:* n/a

**DIM-00040**

*Invalid option for the -NEW command.*

*Cause:* One or more arguments for creating new service is invalid.

*Action:* Specify required option and retry.

**DIM-00041**

*Invalid option for the -EDIT command.*

*Cause:* One or more arguments for editing existing service is invalid.

*Action:* Specify required option and retry.

**DIM-00042**

*Invalid option for the -DELETE command.*

*Cause:* One or more arguments for deleting service is invalid.

*Action:* Specify required option and retry.

**DIM-00043**

*Invalid option for the -STARTUP command.*

*Cause:* One or more arguments for starting the instance is invalid.

*Action:* Specify required option and retry.

**DIM-00044**

*Invalid option for the -SHUTDOWN command.*

*Cause:* One or more arguments for shutting down the instance is invalid.

*Action:* Specify required option and retry.
Database Connection Issues

The following are common Oracle Database connection error codes, their causes, and suggested remedies.

**TNS-12203**

*TNS: unable to connect to destination*

**Cause:** OracleServiceSID service, OracleHOME_NAME.TNSListener service, or both are not running.

**Action:** Ensure that both services are started.
ORA-12560

*TNS: lost contact*

**Cause:** OracleServiceSID service, OracleHOME_NAME TNSListener service, or both are not running. You receive this error if you attempt to use any Oracle Database utilities, such as SQL*Plus. This error is analogous to the following Oracle7 error: ORA-09352: Windows 32-bit Two-Task driver unable to spawn new ORACLE task.

**Action:** Ensure that both services are started.

ORA-28575

*unable to open RPC connection to external procedure agent*

**Cause:** tnsnames.ora and listener.ora files have not been correctly configured to use external procedures.

**Action:** Reconfigure services.

ORA-06512

*at "APPLICATIONS.OSEXEC", line 0*

**Cause:** tnsnames.ora and listener.ora files have not been correctly configured to use external procedures.

**Action:** Reconfigure services.

ORA-06512

*at "APPLICATIONS.TEST", line 4*

**Cause:** tnsnames.ora and listener.ora files have not been correctly configured to use external procedures.

**Action:** Reconfigure services.

ORA-06512

*at line 2*

**Cause:** tnsnames.ora and listener.ora files have not been correctly configured to use external procedures.

**Action:** Reconfigure services.

ORA-01031 and LCC-00161

*Both codes appear at startup*

**Cause:** Parameter file (init.ora) or Windows services are damaged. These errors usually appear when the parameter file cannot be read by Oracle Database at database startup.

**Action:** Delete and re-create the SID and services. Make sure you are logged on as the user Administrator, or a user within the Windows Administrator's Group with full administrative rights. At the command prompt, enter: `oradim -delete -sid sid` where `sid` is the name of your database (for example, `orcl`). Re-create the SID and services by entering: `oradim -new -sid sid -startmode auto -pfile full_path_to_init.ora`
Using Oracle Database on Windows 2000

This chapter highlights differences between Windows 2000 and Windows NT, with emphasis on procedures for common database tasks.

This chapter contains these topics:

- How to Perform Common Tasks in Windows NT and Windows 2000
- Other Differences Between Windows NT and Windows 2000

How to Perform Common Tasks in Windows NT and Windows 2000

Table E–1 lists common database administration tasks and tools required to accomplish those tasks in Windows NT and Windows 2000.

<table>
<thead>
<tr>
<th>Task</th>
<th>Windows NT</th>
<th>Windows 2000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install a domain controller</td>
<td>Windows setup</td>
<td>Active Directory installation wizard from Configure Your Server</td>
</tr>
<tr>
<td>Manage user accounts</td>
<td>User Manager</td>
<td>Active Directory Users &amp; Computers</td>
</tr>
<tr>
<td></td>
<td>Choose Start &gt; Programs &gt; Administrative Tools &gt; User Manager</td>
<td>Choose Programs &gt; Administrative Tools &gt; Active Directory</td>
</tr>
<tr>
<td>Manage groups</td>
<td>User Manager</td>
<td>Active Directory Users &amp; Computers</td>
</tr>
<tr>
<td>Manage computer accounts</td>
<td>Server Manager</td>
<td>Active Directory Users &amp; Computers</td>
</tr>
<tr>
<td></td>
<td>Choose Start &gt; Programs &gt; Administrative Tools &gt; Server Manager</td>
<td></td>
</tr>
<tr>
<td>Add a computer to a domain</td>
<td>Server Manager</td>
<td>Active Directory Users &amp; Computers</td>
</tr>
<tr>
<td>Create or manage trust relationships</td>
<td>User Manager</td>
<td>Active Directory Domains &amp; Trusts</td>
</tr>
<tr>
<td>Manage account policy</td>
<td>User Manager</td>
<td>Active Directory Users &amp; Computers</td>
</tr>
<tr>
<td>Manage user rights</td>
<td>User Manager</td>
<td>Active Directory Users &amp; Computers: Edit the Group Policy object for the domain or organizational unit containing the computers to which the users rights apply.</td>
</tr>
<tr>
<td>Manage audit policy</td>
<td>User Manager</td>
<td>Active Directory Users &amp; Computers: Edit the Group Policy object assigned to the Domain Controllers organizational unit.</td>
</tr>
</tbody>
</table>
Other Differences Between Windows NT and Windows 2000

This section discusses differences between Windows NT and Windows 2000 that are not related to common tasks.

No DNS Domain Name for Windows 2000 Computer

If a Windows 2000 computer is not identified with a DNS domain name, then you will receive the following error message:

Calling query w32RegQueries1.7.0.17.0 RegGetValue
Key = HKEY_LOCAL_MACHINE
SubKey = SYSTEM\CurrentControlSet\Services\Tcpip\Parameters
Value = Domain

Query Exception: GetValueKeyNotFoundException
Query Exception Class: class oracle.sysman.oii.oiil.OiilQueryException
...

Perform the following steps:

1. Choose Start > Control Panel > System > Network Identification > Property > More > Primary DNS.
2. Enter a domain name, for example, us.oracle.com.

Microsoft Management Console Included in Windows 2000

Microsoft Management Console, available in Windows NT as a separate item from Microsoft, is included in Windows 2000.

---

Table E–1 (Cont.) How to Perform Common Tasks in Windows NT and Windows 2000

<table>
<thead>
<tr>
<th>Task</th>
<th>Windows NT</th>
<th>Windows 2000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set policies on users and computers in a site</td>
<td>System Policy Editor</td>
<td>Group Policy, accessed through Active Directory Sites &amp; Services</td>
</tr>
<tr>
<td></td>
<td>Choose Start &gt; Programs &gt; Administrative Tools &gt; System Policy Editor</td>
<td></td>
</tr>
<tr>
<td>Set policies on users and computers in a domain</td>
<td>System Policy Editor</td>
<td>Group Policy, accessed through Active Directory Users &amp; Computers</td>
</tr>
<tr>
<td>Set policies on users and computers in an organizational unit</td>
<td>Not applicable</td>
<td>Group Policy, accessed through Active Directory Users &amp; Computers</td>
</tr>
<tr>
<td>Use Security Groups to filter the scope of policy</td>
<td>Not applicable</td>
<td>Edit the permissions entry for Apply Group Policy on the security tab of the Group Policy Object properties sheet</td>
</tr>
<tr>
<td>Access services dialog</td>
<td>Choose Start &gt; Settings &gt; Control Panel &gt; Services</td>
<td>Choose Start &gt; Settings &gt; Control Panel &gt; Administrative Tools &gt; Services</td>
</tr>
</tbody>
</table>

---
Raw Partitions

In Windows NT, use Disk Administrator to create raw partitions required for Oracle Real Application Clusters.

In Windows 2000, use Computer Management to create basic disks (compatible with raw partitions on Windows NT). Choose Start > Programs > Administrative Tools > Computer Management.

Services Autostart

Oracle services autostart on Windows NT 4.0. After upgrading to Windows 2000, you may find that services start but the database does not start.

The solution is to use ORADIM to delete and re-create the services.

To delete an instance using ORADIM, enter:

```
ORADIM -DELETE -SID SIDA, SIDB, SIDC, ...
ORADIM -DELETE -SRVC SRVCA, SRVCB, SRVC, ...
```

where:

- **SIDA, SIDB, SIDC** are values of the SIDs to delete.
- **SRVCA, SRVCB, SRVC** are values of the services to delete.

During upgrading, the disk is converted to NTFS 5, and a different access authorization is used. The new services autostart under the same account, but they no longer hold the same Windows permissions as before.
This chapter lists major differences between Oracle Database on Windows and UNIX. For Oracle Database developers and database administrators moving from a UNIX platform to Windows, this information can be helpful in understanding Windows features that are relevant to Oracle Database.

This chapter contains these topics:
- Automatic Startup and Shutdown
- Background Processing and Batch Jobs
- Diagnostic and Tuning Utilities
- Direct Writes to Disk
- Dynamic Link Libraries (DLLs)
- Hot Backups
- Initialization Parameters: Multiple Database Writers
- Install Accounts and Groups
- Installation
- Memory Resources
- Microsoft Transaction Server
- Multiple Oracle Homes and OFA
- Processes and Threads
- Raw Partitions
- Services

**Automatic Startup and Shutdown**

On UNIX, several files and scripts in different directories are used to start an instance automatically. Other scripts are run on computer shutdown, allowing applications such as Oracle Database to shut down cleanly.

For automatic startup on Windows, set registry parameter `ORA_SID_AUTOSTART` to `true` using an Oracle Database tool such as ORADIM. Enter the following with parameters at the command prompt:

```
C:\> oradim options
```

To start the listener automatically, set `services` startup type to automatic.
For automatic shutdown on Windows, set registry parameters `ORA_SHUTDOWN` and `ORA_SID_SHUTDOWN` to stop the relevant OracleService `SID` and shut down. Set registry parameter `ORA_SID_SHUTDOWNTYPE` to control shutdown mode (default is `i`, or `immediate`).

**See Also:**
- Chapter 5, "Administering a Database on Windows"
- *Oracle Database 2 Day DBA*

### Background Processing and Batch Jobs

UNIX provides sophisticated control mechanisms for background processing and batch jobs.

For similar functionality on Windows, use the AT command or a GUI version in the Microsoft Resource Kit.

### Diagnostic and Tuning Utilities

On UNIX, utilities such as `sar` and `vmstat` are used to monitor Oracle Database background and shadow processes. These utilities are not integrated with Oracle Database.

Performance utilities available on Windows include Oracle Counters for Windows Performance Monitor, Task Manager, Control Panel, Event Viewer, User Manager, and *Microsoft Management Console* (included only with Windows 2000).

Oracle Database is integrated with several of these tools. For example:

- Oracle Counters for Windows Performance Monitor displays key Oracle Database information. This tool is the same in appearance and operation as Windows Performance Monitor, except it has been preloaded with Oracle Database performance elements.

- Event Viewer displays system alert messages, including Oracle Database startup/shutdown messages and audit trail.

- Task Manager on Windows displays currently running processes and their resource usage, similar to the UNIX `ps -ef` command or HP OpenVMS `SHOW SYSTEM`. But Task Manager is easier to interpret and the columns can be customized.

**See Also:**
- Chapter 2, "Database Tools on Windows"
- Chapter 6, "Monitoring a Database on Windows"

### Direct Writes to Disk

On both UNIX and Windows platforms, bypassing the file system buffer cache ensures data is written to disk.

On UNIX, Oracle Database uses the `O_SYNC` flag to bypass the file system buffer cache. The flag name depends on the UNIX port.

On Windows, Oracle Database bypasses the file system buffer cache completely.
Dynamic Link Libraries (DLLs)

Shared libraries on UNIX are similar to shared DLLs on Windows. Object files and archive libraries are linked to generate Oracle Database executables. Relinking is necessary after certain operations, such as installation of a patch.

On Windows, Oracle Database DLLs form part of the executable at run time and are therefore smaller. DLLs can be shared between multiple executables. Relinking by the user is not supported, but executable images can be modified using ORASTACK.

Modifying executable images on Windows reduces the chances of running out of virtual memory when using a large SGA or when supporting thousands of connections. However, Oracle recommends doing this only under the guidance of Oracle Support Services.

Hot Backups

A (manual) hot backup is equivalent to backing up a tablespace that is in offline backup mode.

Backup strategy on UNIX is as follows: put the tablespace into backup mode, copy the files to the backup location, and bring the tablespace out of backup mode.

Windows supports the same backup strategy, but you cannot copy files in use with normal Windows utilities. Use OCOPY to copy open database files to another disk location. Then use a utility to copy the files to tape.

Initialization Parameters: Multiple Database Writers

On UNIX, you can specify more than one database writer process with initialization parameter DB_WRITERS. Multiple database writers can help, for example, when a UNIX port does not support asynchronous I/O.

DB_WRITERS is supported but typically unnecessary on Windows, which has its own asynchronous I/O capabilities.

See Also: Chapter 13, "Oracle Database Specifications for Windows"

Install Accounts and Groups

UNIX uses the concept of a DBA group. The root account cannot be used to install Oracle Database. A separate Oracle Database account must be created manually.

On Windows, Oracle Database must be installed by a Windows username in the Administrators group. The username is automatically added to the Windows local group ORA_DBA, which receives the SYSDBA privilege. This allows the user to log in to the database using CONNECT / AS SYSDBA and not be prompted for a password.

Password files are located in the ORACLE_BASE\ORACLE_HOME\database directory and are named pwdSID.ora, where SID identifies the Oracle Database instance.

See Also: Chapter 5, "Administering a Database on Windows"
Installation

The following manual setup tasks, all required on UNIX, are not required on Windows:

- Set environment variables
- Create a DBA group for database administrators
- Create a group for users running Oracle Universal Installer
- Create an account dedicated to installing and upgrading Oracle Database components

See Also: Oracle Database Installation Guide for Windows

Memory Resources

The resources provided by the UNIX default kernels are often inadequate for a medium or large instance of Oracle Database. The maximum size of a shared memory segment (SHMMAX) and maximum number of semaphores available (SEMMNS) may be too low for Oracle Database recommendations.

On Windows, fewer resources are needed for interprocess communication (IPC), because the Oracle Database relational database management system is thread-based and not process-based. These resources, including shared memory and semaphores, are not adjustable by the user.

Microsoft Transaction Server

UNIX does not support Microsoft Transaction Server.


See Also: Oracle Services for Microsoft Transaction Server Developer’s Guide

Multiple Oracle Homes and OFA

The goal of OFA is to place all Oracle Database software under one ORACLE_HOME directory and to spread database files across different physical drives as databases increase in size. OFA is implemented on Windows and UNIX in the same way, and main subdirectory and filenames are the same on both operating systems. Windows and UNIX differ, however, in their OFA directory tree top-level names and in the way variables are set.

On UNIX, ORACLE_BASE is associated with a user’s environment. ORACLE_HOME and ORACLE_SID must be set in system or user login scripts. Symbolic links are supported. Although everything seems to be in one directory on the same hard drive, files may be on different hard drives if they are symbolically linked or have that directory as a mount point.

On Windows, ORACLE_BASE is defined in the registry (for example, in HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME0). ORACLE_HOME and ORACLE_SID are variables defined in the registry. Symbolic links like those on UNIX are not supported, although Microsoft has announced the intention to support them in a future release.
Processes and Threads

On UNIX, Oracle Database uses a process to implement each of such background tasks as database writer (DBW0), log writer (LGWR), shared server process dispatchers, and shared servers. Each dedicated connection made to the database causes another operating system process to be spawned on behalf of that session.

On Windows, each background process is implemented as a thread inside a single, large process. For each Oracle Database instance or system identifier, there is one corresponding process for Oracle Database. For example, 100 Oracle Database processes for a database instance on UNIX are handled by 100 threads inside one process on Windows.

All Oracle Database background, dedicated server, and client processes are threads of the master Oracle Database Windows process, and all threads of the Oracle Database process share resources. This multithreaded architecture is highly efficient, allowing fast context switches with low overhead.

To view processes or end individual threads, use Oracle Administration Assistant for Windows. Choose Start > Programs > Oracle - HOME_NAME > Configuration and Migration Tools > Administration Assistant for Windows. Right-click the SID and choose Process Information.

**Note:** Microsoft Management Console (MMC) is started when Oracle Administration Assistant for Windows is started. Oracle Database has integrated several database administration snap-ins into MMC.

**See Also:**
- Oracle Administration Assistant for Windows online help
- Chapter 1, "Oracle Database Architecture on Windows"

Raw Partitions

Datafiles for tablespaces may be stored on a file system or on raw partitions. A raw partition is a portion of a physical disk that is accessed at the lowest possible level.

UNIX supports raw partitions (logical drives). There is no limitation on the number of disk drives.

Windows is limited to using drive letters A-Z, but creating raw partitions lets you bypass the disk drive limitation and divide disks into smaller sections.

Use Windows disk management tools to create an extended partition on a physical drive. An extended partition points to raw space on the disk that can be assigned multiple logical partitions for database files.

An extended partition avoids the four-partition limit on Windows by allowing you to define large numbers of logical partitions to accommodate applications using Oracle Database. Logical partitions can then be given symbolic link names to free up drive letters.
Windows services are similar to UNIX daemons.

Oracle Database registers a database instance as a service (OracleServiceSID). Services start background processes.

To connect to and use an Oracle Database instance, an Oracle Database service is created during database creation and associated with Oracle Database. Once a service is created with Oracle Database, the service can run even while no user is logged on.

By default, services run under the SYSTEM account. Choose Start > Settings > Control Panel > Services to access the Services dialog.

See Also: Chapter 5, "Administering a Database on Windows"
Oracle Database 10g Release 1 (10.1) for 64-bit Windows supports 64-bit processing in the following operating systems:

- Windows Server 2003 for 64-bit Itanium 2 Systems

This appendix contains:

- Unsupported Features
- Oracle Database Architecture on 64-Bit Windows
- Database Tools for 64-Bit Windows
- Backing Up and Recovering 64-Bit Database Files
- Users and Roles for 64-Bit Windows
- Large Page Support for 64-bit Windows
- Database Migration from a 32-bit Windows Computer
- Application Migration
- Oracle Database for 64-bit Windows Documentation

Unsupported Features

The following features of Oracle Database, documented elsewhere in this guide, are not currently supported in the 64-bit version:

- Oracle Enterprise Manager Grid Control CD
- Oracle Enterprise Manager Console (Java-based)
- Oracle Migration Workbench
- Oracle Objects for OLE
- Oracle Data Provider for .NET (ODP.NET)
- Oracle Open Gateways
- Oracle Transparent Gateways
Oracle Database Architecture on 64-Bit Windows

Oracle Database for 64-bit Windows does not support Very Large Memory (VLM) configurations. VLM enables the address space for 32-bit computers to expand beyond its default value of 2 to the power 32 bytes. But the default address space for 64-bit computers is already 2 to the power 64 bytes. So a 64-bit computer does not need VLM.

Neither Windows XP 64-bit Edition Version 2003 nor Windows Server 2003 for 64-bit Itanium 2 Systems support 4 GB RAM Tuning, so it is not available in Oracle Database for 64-bit Windows.

Database Tools for 64-Bit Windows

Pro*C OBOL, Oracle Portal, and Oracle Migration Workbench are not supported in Oracle Database for 64-bit Windows.

Backing Up and Recovering 64-Bit Database Files

Legato Networker is supported in this release of Oracle Database for 64-bit Windows.

Users and Roles for 64-Bit Windows

Oracle Database for 64-bit Windows supports enterprise users and roles stored in Oracle Internet Directory, but administration tools must be run from a 32-bit computer.

Large Page Support for 64-bit Windows

To enable large page support, the system administrator must grant the "Lock pages in memory" privilege to the oracle user. This privilege is not enabled by default when Windows is installed. To grant this privilege:

1. Choose Start > Settings > Control Panel.
   The Control Panel window opens.
2. Double-click Administrative Tools.
   The Administrative Tools window opens.
   The Local Security Settings window opens.
4. In the left pane of the Local Security Settings window, expand Local Policies and select User Rights Assignment.

Note: A 64-bit version of Oracle Enterprise Manager Grid Control is not available in this release. Use Oracle Enterprise Manager Grid Control from your 64-bit Solaris system to manage the 64-bit computer nodes remotely.

See Also: Oracle Database Release Notes for Windows for a complete list of unsupported features in Oracle Database for 64-bit Windows.
5. In the right pane of the Local Security Settings window, select **Lock pages in memory** and choose **Action > Security...**

The Local Security Policy Setting dialog opens.

6. Click **Add...**

The Select Users or Groups dialog opens.

7. Select the oracle user from the **Name** list.

8. Click **Add**.

9. Click **OK** to close the Select Users or Groups dialog.

10. Click **OK** to close the Local Security Policy Setting dialog.

To take advantage of large pages on Windows Server 2003, the amount of physical memory must be greater than the amount of System Global Area (SGA) specified in the parameter file.

Large pages may not be allocated at all times during instance startup; either all of the SGA is allocated using large pages or all of SGA is allocated using regular pages.

---

**Note:** Large page usage locks the entire SGA into physical memory. Physical memory is not released during a shrink operation.

---

**See Also:** Your operating system documentation for restrictions on allocating large pages.

To enable large page support:

1. Go to `ORACLE_BASE\ORACLE_HOME\bin\oracle.key`.

2. Open `oracle.key` in a text editor and record the value found. It is set by Oracle Universal Installer. The default is:

   \[SOFTWARE\ORACLE\KEY_HOME_NAME\]

3. Start Registry Editor at the command prompt:

   \[C:\> regedit\]

---

**Note:** Although Registry Editor lets you view and modify registry keys and parameter values, you normally are not required to do so. In fact, you can render your system useless if you make incorrect changes. Therefore, only advanced users should edit the registry! Back up your system before making any changes in the registry.

---

4. Go to `HKEY_LOCAL_MACHINE`.

Find the key corresponding to the value found in `oracle.key`. In the default case, for example, you would look for:

   \[HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_HOME_NAME\]

---

Oracle Database for 64-Bit Windows   G-3
5. Create one of the following, depending on where you want to enable large page support:
   - `ORA_LPENABLE=1` to enable large page support on all instances
   - `ORA_SID_LPENABLE=1` to enable large page support on a specific instance

6. Exit Registry Editor.

By default Oracle allocates the minimum available large page size when using large pages. The minimum available large page size, 16 MB, is obtained by using the `GetLargePageMinimum` function.

---

**Caution:** Do not set initialization parameter `lock_sga` when large pages are enabled. Large page usage locks the entire SGA into physical memory. When used with parameter `lock_sga`, database startup fails with an error because the operating system automatically locks. That is, it prevents memory from being paged to disk when large pages are requested. Physical memory is not released during a shrink operation.

---

### Database Migration from a 32-bit Windows Computer

This section contains these topics:

- Backing Up a 32-Bit Oracle Database
- Migrating an Oracle Database 10g Release 1 (10.1) Database
- Migrating an Oracle9i or Older Database

**See Also:** [Oracle Database Upgrade Guide](#)

#### Backing Up a 32-Bit Oracle Database

To back up a 32-bit Oracle home database:

1. Start SQL*Plus:
   ```
   C:\> sqlplus /NOLOG
   ```

2. Connect to the database instance as `SYSDBA`:
   ```
   SQL> CONNECT / AS SYSDBA;
   ```

3. Create a `.trc` file to use as a template to re-create the control files on the 64-bit computer:
   ```
   SQL> ALTER DATABASE BACKUP CONTROLFILE TO TRACE;
   ```

4. Shut down the database:
   ```
   SQL> SHUTDOWN IMMEDIATE;
   ```

5. Perform a full offline backup of the database.

**See Also:** [Oracle Database Recovery Manager Quick Start Guide](#)
Migrating an Oracle Database 10g Release 1 (10.1) Database

To migrate an Oracle Database 10g Release 1 (10.1) database for 32-bit Windows to an Oracle Database 10g Release 1 (10.1) database for 64-bit Windows:

1. Install Oracle Database 10g Release 1 (10.1) for 64-bit Windows.

   **See Also:** *Oracle Database Installation Guide for Windows*

2. Create the new Oracle Database 10g Release 1 (10.1) service at the command prompt:

   ```
   C:\> ORADIM -NEW -SID SID [-INTPWD PASSWORD ]-MAXUSERS USERS
          -STARTMODE AUTO -PFILE ORACLE_HOME\DATABASE\INITSID.ORA
   ```

   The following table provides more information on the values you must supply.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SID</strong></td>
<td>SID of the database you are upgrading</td>
</tr>
<tr>
<td><strong>PASSWORD</strong></td>
<td>Password for the new Oracle Database 10g Release 1 (10.1) for 64-bit Windows database. This is the password for the user connected with SYSDBA privileges. The -INTPWD option is not required. If you do not specify it, then operating system authentication is used, and no password is required.</td>
</tr>
<tr>
<td><strong>USERS</strong></td>
<td>Maximum number of users who can be granted SYSDBA and SYSOPER privileges</td>
</tr>
<tr>
<td><strong>ORACLE_HOME</strong></td>
<td>Oracle home directory. Ensure that you specify the full path name with the -PFILE option, including drive letter of the Oracle home directory.</td>
</tr>
</tbody>
</table>

3. Copy the 32-bit datafiles to the new 64-bit Oracle home.

4. Copy the 32-bit configuration files to the 64-bit Oracle home.

   a. If your 32-bit initialization parameter file has an IFILE (include file) entry, then copy the file specified by the IFILE entry to the 64-bit Oracle home and edit the IFILE entry in the initialization parameter file to point to its new location.

   b. If you have a password file that resides in the 32-bit Oracle home, then copy the password file to the 64-bit Oracle home. The default 32-bit password file is located in `ORACLE_BASE\ORACLE_HOME\database\pwdSID.ora`, where `SID` is your Oracle instance ID.

5. In the 64-bit Oracle home, add the `_SYSTEM_TRIG_ENABLED = false` parameter to the `ORACLE_HOME\database\ORACLE_SID\init.ora` file before changing the word size.

6. Remove this parameter from the initialization file after the word size change is complete.

   **See Also:** *Oracle Database Upgrade Guide* for more information on changing word size

7. Go to the 64-bit `ORACLE_HOME\rdbms\admin` directory from the command prompt.

8. Start SQL*Plus:

   ```
   C:\> sqlplus /Nolog
   ```
9. Connect to the database instance as SYSDBA:

SQL> CONNECT / AS SYSDBA;

10. Re-create the 64-bit control files using the `CREATE CONTROLFILE` command. Edit the trace file created in "Backing Up a 32-Bit Oracle Database" on page G-4 to change the paths to the datafiles, log files and control files to point to the Oracle home on the 64-bit computer. This creates the new control file in `ORACLE_HOME\database`.

Here is an example of a database named "orcl32" on a 32-bit computer migrating to "orcl64" on a 64-bit computer:

```sql
CREATE CONTROLFILE REUSE DATABASE "T1" NORESELOGS NOARCHIVELOG
MAXLOGFILES 32
MAXLOGMEMBERS 2
MAXDATAFILES 32
MAXINSTANCES 16
MAXLOGHISTORY 1815

LOGFILE
GROUP 1 'C:\oracle\product\10.1.0\oradata\orcl64\REDO03.LOG' SIZE 1M,
    # was 'C:\oracle\product\10.1.0\oradata\orcl32\...LOG'
    # on the 32-bit computer
GROUP 2 'C:\oracle\product\10.1.0\oradata\orcl64\REDO02.LOG' SIZE 1M,
GROUP 3 'C:\oracle\product\10.1.0\oradata\orcl64\REDO01.LOG' SIZE 1M

DATAFILE
'C:\oracle\product\10.1.0\oradata\orcl64\SYSTEM01.DBF',
    # was 'C:\oracle\product\10.1.0\oradata\orcl32\...DBF'
    # on the 32-bit computer
'C:\oracle\product\10.1.0\oradata\orcl64\RBS01.DBF',
'C:\oracle\product\10.1.0\oradata\orcl64\USERS01.DBF',
'C:\oracle\product\10.1.0\oradata\orcl64\TEMP01.DBF',
'C:\oracle\product\10.1.0\oradata\orcl64\TOOLS01.DBF',
'C:\oracle\product\10.1.0\oradata\orcl64\INDX01.DBF',
'C:\oracle\product\10.1.0\oradata\orcl64\DR01.DBF'

CHARACTER SET WE8ISO8859P1;
```

11. Alter the `init` file from the 32-bit computer to include the new control file generated in the preceding step.

12. Start the database in `RESTRICT` mode:

```sql
SQL> STARTUP RESTRICT;
```

You might need to use the `PFILE` option to specify the location of your initialization parameter file.

13. Set the system to spool results to a log file for later verification of success. For example:

```sql
SQL> SPOOL catoutw.log
```

14. Enter the following command to view the output of the script on-screen:

```sql
SQL> SET ECHO ON;
```

15. Recompile existing PL/SQL modules in the format required by the 64-bit Oracle9i database:

```sql
SQL> @utlirp.sql;
```
16. Turn off the spooling of script results to the log file:

   SQL> SPOOL OFF;

17. Check the spool file and verify that the packages and procedures compiled successfully. Correct any problems you find in this file.

18. If you were viewing the output of catoutw.log on-screen, disable viewing now:

   SQL> SET ECHO OFF;

19. Exit the RESTRICT database mode:

   SQL> ALTER SYSTEM DISABLE RESTRICTED SESSION;

20. The word size of the 64-bit Oracle Database 10g Release 1 (10.1) database is changed. You can open the database for normal use.

**Migrating an Oracle9i or Older Database**

To migrate an Oracle9i or older database to an Oracle Database 10g Release 1 (10.1) database for 64-bit Windows:

1. Perform steps 1 - 11 in "Migrating an Oracle Database 10g Release 1 (10.1) Database" on page G-5.

2. Shut down the database on the 64-bit computer:

   SQL> SHUTDOWN IMMEDIATE;

3. Start the database migration:

   SQL> STARTUP MIGRATE;

4. Migrate the database as described in Chapter 3, "Upgrading a Database to the New Oracle Database 10g Release" in *Oracle Database Upgrade Guide*.

5. Shut down the database:

   SQL> SHUTDOWN IMMEDIATE;

6. Restart the database:

   SQL> STARTUP MOUNT;

**Application Migration**


---

**Note:** NCHAR columns in user tables are not changed during the migration. To change NCHAR columns in user tables, refer to "Upgrade User NCHAR Columns" in *Oracle Database Upgrade Guide*. 

---
The Oracle Database Online Documentation Library CD-ROM for Windows is not shipped with Oracle Database for 64-bit Windows. Everything in the library is available for download from the Oracle Technology Network (OTN) at http://otn.oracle.com/documentation/

You must register online before using OTN; registration is free and can be done at http://otn.oracle.com/membership/.
alert file
A file that contains important information and error messages that are generated during database operations.

authenticate
To verify the identity of a user, device, or other entity in a computer system, often as a prerequisite for allowing access to resources in a system.

authentication
Identification of a user, device, or other entity in a computer system, often as a prerequisite for allowing access to resources in a system.

authorization
Permission given to a user, program, or process to access an object or set of objects. In Oracle Database, authorization is done through the role mechanism. A single person or a group of people can be granted a role or a group of roles. A role, in turn, can be granted other roles.

backup
A representative copy of data. This copy includes important parts of your database such as control files, redo log files, and datafiles.
A backup is a safeguard against unexpected data loss; if you lose your original data, then you can use the backup to make the data available again. A backup is also a safeguard against an application error; if an application makes incorrect changes, then you can restore the backup.

certificate authority
A certificate authority (CA) is a trusted third party that certifies the identity of other entities such as users, databases, administrators, clients, and servers. The certificate authority verifies the user's identity and grants a certificate, signing it with one of the certificate authority's private keys.

COM/COM+
Microsoft's Component Object Model is an object-oriented programming architecture and a set of operating system services. These services notify running application components of significant events and ensure that they are authorized to run. COM/COM+ is intended to make it relatively easy to create business applications that work well with Microsoft Transaction Server in Windows NT and Windows 2000.
connect descriptor
A specially formatted description of the destination for a network connection. A connect descriptor contains destination services and network route information. The destination service is indicated by using its service name for Oracle9i or Oracle8i databases or its Oracle system identifier for Oracle8 release 8.0 databases. The network route provides, at a minimum, the location of the listener through use of a network address.

connect identifier
A net service name or service name, that maps to a connect descriptor. Users initiate a connect request by passing a username and password along with a connect identifier in a connect string for the services to which they wish to connect, for example:

CONNECT username/password@connect_identifier

connect string
See net service name.

control files
Files that record the physical structure of a database and contain the database name, the names and locations of associated databases and online redo log files, the time stamp of the database creation, the current log sequence number, and checkpoint information.

credentials
A username, password, or certificate used to gain access to the database.

data dictionary
A set of read-only tables that provide information about a database.

database alias
See net service name.

decryption
Process of converting contents of a message that has gone through encryption (ciphertext) back into its original readable format (plaintext).

digital certificates
ITU X.509 v3 standard data structures that securely bind an identity to a public key. A certificate is created when an entity’s public key is signed by a trusted identity, a certificate authority. The certificate ensures that the entity’s information is correct and that the public key actually belongs to that entity.

digital signature
Digital signatures are created when a public key algorithm is used to sign messages with senders’ private keys. A digital signature assures that a document is authentic, has not been forged by another entity, has not been altered, and cannot be repudiated by the sender.

DLL
See dynamic link library.
downgrade
To convert the data in Oracle Database to an earlier Oracle release. See upgrade and migrate.

dynamic link library
An executable file that a Windows application can load when needed.

encryption
Process of disguising a message, rendering it unreadable to any but the intended recipient.

enterprise domains
Directory constructs consisting of Oracle Database and enterprise users and roles. Enterprise domains are different from Windows 2000 domains, which are collections of computers that share a common directory database.

enterprise role
A directory structure which contains global roles on multiple databases, and which can be granted to an enterprise user.

enterprise user
A user that has a unique identity across an enterprise. An enterprise user connects to individual databases through a schema and is assigned an enterprise role that determines the user's access privileges on databases.

external procedures
Functions written in a third-generation language (C, for example) and callable from within PL/SQL or SQL as if they were PL/SQL functions or procedures.

external role
Roles created and managed by Windows NT and Windows 20000 operating systems. Once an external role is created, you can grant or revoke that role to a database user. You must set init.ora parameter OS_ROLES to true and restart Oracle Database before you can create an external role. You cannot use both Windows operating systems and Oracle Database to grant roles concurrently.

external routine
A function written in a third-generation language (3GL), such as C, and callable from within PL/SQL or SQL as if it were a PL/SQL function or procedure.

external user
A user authenticated by the Windows 2000 or Windows NT operating system who can access Oracle Database without being prompted for a password. External users are typically regular database users (non-database administrators) to which you assign standard database roles (such as CONNECT and RESOURCE), but do not want to assign SYSDBA (database administrator) or SYSOPER (database operator) privilege.

eexternal user
The Windows operating system can authenticate a user, who can then access Oracle Database without being prompted for a password. External users are typically regular database users (non-database administrators) to whom you assign standard database roles (such as CONNECT and RESOURCE), but do not want to assign the SYSDBA (database administrator) or SYSOPER (database operator) privilege.
global groups
See Windows global groups.

global role
A role whose privileges are contained within a single database, but which is managed in a directory.

Globalization Support
The Oracle Database architecture that ensures that database utilities, error messages, sort order, date, time, monetary, numeric, and calendar conventions automatically adapt to the native language and locale.

HOME_NAME
Represents the name of an Oracle home. In Oracle Database 10g Release 1 (10.1), all Oracle homes have a unique HOME_NAME.

init.ora
See initialization parameter file.

initialization parameter file
An ASCII text file that contains information needed to initialize a database and instance.

instance
Every running Oracle Database is associated with an Oracle Database instance. When a database is started on a database server (regardless of the type of computer), Oracle Database allocates a memory area called the System Global Area and starts one or more Oracle Database processes. This combination of the System Global Area and Oracle Database processes is called an instance. The memory and processes of an instance manage the associated database's data efficiently and serve the users of the database.

instantiate
Produce a more defined version of some object by replacing variables with values (or other variables).

latch
A simple, low-level serialization mechanism to protect shared data structures in the System Global Area.

LDAP

Lightweight Directory Access Protocol (LDAP)
A standard, extensible directory access protocol. It is a common language that LDAP clients and servers use to communicate. LDAP is a framework of design conventions supporting industry-standard directory products, such as Oracle Internet Directory.

listener
The Oracle Database server process that listens for and accepts incoming connection requests from client applications. The listener process starts up Oracle Database processes to handle subsequent communications with the client; then it goes back to listening for new connection requests.
**listener.ora**
A configuration file that describes one or more Transparent Network Substrate (TNS) listeners on a server.

**local groups**
See *Windows local groups*.

**local roles**
Roles created and managed by the database. Once a local role is created, you can grant or revoke that role to a database user. You cannot use Windows NT (for external role management) and Oracle Database (for local role management) concurrently.

**Microsoft Management Console**
An application that serves as a host for administrative tools called *snap-ins*. By itself, Microsoft Management Console does not provide any functionality.

**Microsoft Transaction Server**
A transaction processing system based on COM/COM+ that runs on an Internet or network server.

**migrate**
To *upgrade* or *downgrade* an Oracle Database or convert the data in a non-Oracle database into an Oracle Database.

**mount**
To associate a database with an *instance* that has been started.

**MTS**
See *Microsoft Transaction Server*.

**multiple Oracle homes**
The capability of having more than one Oracle home on a computer.

**net service name**
The name used by clients to identify an Oracle Net server and the specific *system identifier* or database for the Oracle Net connection. A net service name is mapped to a port number and protocol. Also known as a connect string, database alias, host string, or service name.

This also identifies the specific SID or database to which the connection is attaching, not just the Oracle Net server.

**network listener**
A listener on a server that listens for connection requests for one or more databases on one or more protocols. See *listener*.

**network service**
In an Oracle application network, a service performs tasks for its service consumers. For example, a Names Server provides name resolution services for clients.

**obfuscated**
Protected by a process often used by companies for intellectual property written in the form of Java programs. The obfuscation process mixes up Java symbols found in the
code. It leaves the original program structure intact, allowing the program to run correctly, while changing the names of the classes, methods, and variables in order to hide the intended behavior. Although it is possible to decompile and read non-obfuscated Java code, obfuscated Java code is sufficiently difficult to decompile to satisfy U.S. government export controls.

OCI
See Oracle Call Interface.

OFA
See Optimal Flexible Architecture.

Optimal Flexible Architecture
A set of file naming and placement guidelines for Oracle Database software and databases.

ORACLE_BASE
ORACLE_BASE is the root of the Oracle Database directory tree. If you install an OFA-compliant database using Oracle Universal Installer defaults, then ORACLE_BASE is X:\oracle\product\10.1.0 where X is any hard drive.

Oracle Call Interface
An application programming interface that enables you to manipulate data and schema in an Oracle Database. You compile and link an Oracle Call Interface application in the same way that you compile and link a non-database application. There is no need for a separate preprocessing or precompilation step.

ORACLE_HOME
Corresponds to the environment in which Oracle Database products run. This environment includes the location of installed product files, the PATH variable pointing to the binary files of installed products, registry entries, net service names, and program groups.

If you install an OFA-compliant database, using Oracle Universal Installer defaults, then Oracle home (known as ORACLE_HOME in this guide) is located beneath ORACLE_BASE. It contains subdirectories for Oracle Database software executables and network files.

Oracle Internet Directory
An Oracle Database-based LDAP V3 directory server, used for centralizing database user, Oracle Net network connector, and database listener parameters.

Oracle Net
A component of Oracle Net Services that enables a network session from a client application to an Oracle Database server. Once a network session is established, Oracle Net acts as a data courier for the client application and the database server. It is responsible for establishing and maintaining the connection between the client application and database server, as well as exchanging messages between them. Oracle Net is able to perform these jobs because it is located on each computer in the network.

Oracle Net Services
A suite of networking components that provide enterprise-wide connectivity solutions in distributed, heterogeneous computing environments. Oracle Net Services are
comprised of **Oracle Net**, **listener**, Oracle Connection Manager, Oracle Net Configuration Assistant, and Oracle Net Manager.

**Oracle PKI**
Oracle Advanced Security includes Oracle PKI (public key infrastructure) integration for authentication and single sign-on. Oracle-based applications are integrated with the PKI authentication and encryption framework, using Oracle Wallet Manager.

**Oracle Protocol Support**
A product that maps the functions of a given network protocol into Oracle Transparent Network Substrate (TNS) architecture. This process translates TNS function calls into requests to the underlying network protocol. This allows TNS to act as an interface among all protocols. **Oracle Net** requires Oracle Protocol Support.

**Oracle services**
Windows services that are associated with particular Oracle Database components.

**PL/SQL**
Procedural language extension to SQL that is part of Oracle Database.
PL/SQL enables you to mix SQL statements with procedural constructs. You can define and run PL/SQL program units such as procedures, functions, and packages.

**precompiler**
A programming tool that enables you to embed SQL statements in a high-level source program.

**private keys**
In **public key cryptography**, these are the secret keys. They are used primarily for **decryption** but also for **encryption** with a **digital signature**.

**privilege**
A right to run a particular type of SQL statement or to access another user's object.

**process**
A mechanism in an operating system that can run an executable. (Some operating systems use the terms job or task.) A process normally has its own private memory area in which it runs. On Windows a process is created when an application runs (such as Oracle Database or Microsoft Word). In addition to an executable program, all processes consist of at least one **thread**. The Oracle Database master process contains hundreds of threads.

**public key**
In **public key cryptography**, this key is made public to all. It is primarily used for **encryption** but can also be used for verifying signatures.

**public key cryptography**
Public key cryptography involves information **encryption** and **decryption** using a shared **public key** paired with **private keys**. Provides for secure, private communications within a public network.
quota
A limit on a resource, such as a limit on the amount of database storage used by a database user. A database administrator can set **tablespace** quotas for each Oracle Database **username**.

**raw partitions**
Portions of a physical disk that are accessed at the lowest possible disk (block) level.

**recovery**
To restore a physical **backup** is to reconstruct it and make it available to the Oracle Database server. To recover a restored backup is to update it using redo records (that is, records of changes made to the database after the backup was taken). Recovering a backup involves two distinct operations: rolling forward the backup to a more current time by applying redo data, and rolling back all changes made in uncommitted transactions to their original state.

**redo log buffer**
A circular buffer in the **System Global Area** that contains information about changes made to the database.

**redo log files**
Files that contain a record of all changes made to data in the database buffer cache. If an instance failure occurs, then the redo log files are used to recover the modified data that was in memory.

**registry**
A Windows repository that stores configuration information for a computer.

**remote computer**
A computer on a network other than the local computer.

**remote database**
A database on a computer other than the local database.

**replication**
The process of copying and maintaining database objects in multiple databases that make up a distributed database system.

**role**
A named groups of related privileges. You can grant a role to users or to another role.

**schema**
A named collection of objects, such as tables, views, clusters, procedures, and packages, associated with one or more particular users.

**services**
Executable processes installed in the Windows **registry** and administered by Windows. Once services are created and started, they can run even when no user is logged on to the computer.

**service name**
See **net service name**.
SGA
See System Global Area.

Shared Server Process
A server configuration which allows many user processes to share very few server processes. The user processes connect to a dispatcher background process, which routes client requests to the next available shared server process.

SID
See system identifier.

snap-ins
Administrative tools that run within Microsoft Management Console.

snapshot
(1) Information stored in rollback segments to provide transaction recovery and read consistency. Rollback segment information can be used to re-create a snapshot of a row before an update.

(2) A point-in-time copy of a master table located on a remote site. Read-only snapshots can be queried, but not updated. Updateable snapshots can be queried and updated. They are periodically refreshed to reflect changes made to the master table, and at the snapshot site.

starter database
A preconfigured, ready-to-use database that requires minimal user input to create.

SYSDBA
A special database administration role that contains all system privileges with the ADMIN OPTION, and the SYSOPER system privilege. SYSDBA also permits CREATE DATABASE actions and time-based recovery.

SYSOPER
A special database administration role that permits a database administrator to perform STARTUP, SHUTDOWN, ALTER DATABASE OPEN/MOUNT, ALTER DATABASE BACKUP, ARCHIVE LOG, and RECOVER, and includes the RESTRICTED SESSION privilege.

System Global Area
A group of shared memory structures that contain data and control information for an Oracle Database instance.

system identifier
A unique name for an Oracle Database instance. To switch between instances of Oracle Database, users must specify the desired system identifier. The system identifier is included in the CONNECT DATA parts of the connect descriptors in a tnsnames.ora file, and in the definition of the network listener in a tnsnames.ora file.

SYSTEM
One of two standard database administrator usernames automatically created with each database. (The other username is SYS.) The SYSTEM username is the preferred username for database administrators to use for database maintenance.
**tablespace**
A database is divided into one or more logical storage units called tablespaces. Tablespaces are divided into logical units of storage called segments, which are further divided into extents.

**thread**
An individual path of execution within a **process**. Threads are objects within a process that run program instructions. Threads allow concurrent operations within a process so that a process can run different parts of its program simultaneously on different processors. A thread is the most fundamental component that can be scheduled on Windows.

**tnsnames.ora**
A file that contains connect descriptors mapped to net service names. The file can be maintained centrally or locally, for use by all or individual clients.

**trace file**
Each server and background **process** can write to an associated trace file. When a process detects an internal error, it dumps information about the error to its trace file. Some of the information written to a trace file is intended for the database administrator, while other information is intended for Oracle Support Services. Trace file information is also used to tune applications and instances.

**trust points**
Trust points or trusted certificates are third party identities that are qualified with a level of trust. A trusted certificate is used when an identity is being validated as the entity it claims to be. Certificate authorities you trust are called trusted certificates. If there are several levels of trusted certificates, a trusted certificate at a lower level in the certificate chain does not need to have all its higher level certificates reverified.

**universal groups**
Universal groups are available in Windows 2000, but not in Windows NT. They can contain other groups, including other universal groups, **local groups**, and **global groups**.

**upgrade**
To convert the data in an Oracle Database into a later release. See **downgrade** and **migrate**.

**username**
A name that can connect to and access objects in a database.

**view**
A selective presentation of the structure and data of one or more tables. Views can also be based on other views.

**Windows global groups**
Groups that can be granted permissions and rights in their own domain, member servers and workstations of their domain, and in trusted domains. They can also become members of **Windows local groups** in all these places. But global groups can contain user accounts only from their own domains.
**Windows local groups**

Groups that can be granted permissions and rights only for its own computer or, if part of a domain, to the domain controllers of that domain. Local groups can, however, contain user accounts and **Windows global groups** from both their own domain and from trusted domains.
A

Access Control Lists
  adding and deleting members, 1-12
  available security groups, 1-11
Active Directory
  adding and deleting security group members, 1-12
  automatic discovery of directory servers, 1-3
  connecting to a database, 1-8
  how Oracle directory objects appear, 1-4
  integration with directory servers, 1-8
  managing Access Control Lists, 1-11
  managing security groups, 1-11
  requirements for using Oracle, 1-8
  testing connectivity from SQL*Plus, 1-8
  testing database connectivity, 1-3
  user interface extensions, 1-3
Active Directory Users and Computers
  integration with Oracle objects in Active Directory, 1-3
Advanced Replication support
  data dictionary tables, 4-12
  initialization parameter requirements, 4-12
  tablespace requirements, 4-11, 4-12
alert files
  monitoring a database, 6-1
  using, 6-8
ALTER DATABASE ARCHIVELOG command, 5-13
application development
  and data access, 4-3
  finding information, 4-1
architecture
  thread-based, 1-1
ARCHIVELOG mode, 5-13
archiving mode
  controlling, 5-12
  custom database, 5-12
  starter database, 5-12
archiving procedures, 5-14
  for redo log files, 5-12
  specifying an archive destination, 5-14
  UNC not allowed, 5-12
audit trail
  managing, 6-8

B

background processes
  querying, 1-3
BACKGROUND_DUMP_DEST, 6-8
backup
  control files, 3-6
  databases, 3-11
Backup Wizard
  preferred tools, 2-2
bad file
  specifying, 2-10
block size
  maximum, 2-5
  blocks for each file, maximum, 2-5

C

commands
  ALTER DATABASE ARCHIVELOG, 5-13
  ARCHIVE LOG LIST, 5-13
  CREATE DATABASE, 3-8
NET START, 3-8
REGEDT32, 3-10
configuration parameters
defined, 3-1
LOCAL, C-2
registry, defined, 3-1
TNS_ADMIN, C-2
USE_SHARED_SOCKET, C-3
configuring
Named Pipes Protocol Adapter, C-3
Oracle Spatial, 4-10
Oracle Text, 4-8
CONNECT /AS SYSDBA
correcting without a password, 8-4
using, 5-5
CONNECT INTERNAL
replacement, 2-1
connecting
LOCAL parameter, C-2
to a database, 5-5
control files
maximum size, 2-5
CREATE DATABASE command, 3-8
CREATE LIBRARY command, 4-8
custom database
archiving mode, 5-12
D
data dictionary
Advanced Replication tables, 4-12
Data Pump Export
starting, 2-7
Data Pump Import
starting, 2-7
database administrator privileges
for a single database on a computer, 9-19
for all databases on a computer, 9-4
Database Configuration Assistant
preferred tools, 2-2
registering a database object in a directory
server, 1-4
starting, 2-5
database connection
error messages, D-19
database files
deleting, 3-5
database monitoring
using Oracle Counters for Windows Performance
Monitor, 6-2
with alert files, 6-8
with Event Viewer, 6-6
with trace files, 6-8
database operator privileges
for a single database on a computer, 9-20
for all databases on a computer, 9-5
database privileges
in Windows local groups, 9-29
database tools
operating system compatibility, 2-2
starting from the command line, 2-6
starting from the Start Menu, 2-5
starting in multiple Oracle Homes, 2-4
databases
backing up, 3-11
connecting to, 5-5
creating manually, 3-3
deleting, 3-5
exporting, 3-4
importing, 3-9
monitoring, 6-1
naming conventions, 3-1
password encryption, 5-12
shutting down, 5-5, 5-6
starting, 5-5
DBVERIFY
starting, 2-7
displaying external procedures, 4-10
devolving applications
for Windows, 4-1
diagnostic and tuning utilities
for Windows, 2-14
directory servers
automatic discovery of directory servers, 1-3
features integrated with Oracle10g, 1-2
how Oracle directory objects display in Active
Directory, 1-4
integration with Active Directory, 1-8
managing Access Control Lists, 1-11
requirements for using Oracle with Active
Directory, 1-8
user interface extensions, 1-3
DisplayName parameter, C-1
DLLs
compared to UNIX shared libraries, F-3
displaying with Task List, 2-14
external procedures, 4-8
Oracle Counters for Windows Performance
Monitor, 3-7
Oracle Real Application Clusters, 3-8
DNS-style naming convention, 1-8
E
encrypting, database passwords, 5-12
enhanced security, 4-2 to 4-4
everse roles
environments in which to use, 8-3
everse users
environments in which to use, 8-3
error messages
DIM-00000 to DIM-00039, D-12
Intercartridge Exchange, 4-14
ORA-00256, 3-2, 5-12
ORA-01102, 3-1
ORA-09275, D-1
ORA-09291, 3-2, 5-12
ORA-12560, D-20
OSD-04000 to OSD-04099, D-4
OSD-04018, 3-2, 5-12
Event Viewer
blue (informational) icon, 6-6
defined, 2-11
for monitoring a database, 6-1
integration with Oracle Database, 2-11
logging operating system audit trail, 2-11
managing, 6-8
reading, 6-7
red (stop sign) icon, 6-6
starting, 2-8
using, 6-6
yellow (exclamation point) icon, 6-6
exception conditions, Intercartridge Exchange, 4-14
executable images
modifying, 1-3
EXECUTE privileges, on a PL/SQL library, 4-8
Export
databases, 3-4
interactive mode, 3-4
parameter mode, 3-4, 3-5
preferred tools, 2-2
starting, 2-7
Export Wizard
preferred tools, 2-2
extended partition
defined, B-1
EXTERNAL clause, 4-9
external operating system users
administering, 9-1, 9-21
creating, 9-9, 9-22
environments in which to use, 8-3
external procedures
building a DLL, 4-8
creating a PL/SQL library, 4-8
debugging, 4-10
EXTERNAL clause, 4-9
granting EXECUTE privileges, 4-8
registering with Oracle Database, 4-8
using EXTPROC, 4-7
writing, 4-7
external roles
administering, 9-1, 9-21
creating, 9-16
environments in which to use, 8-3
external users
administering, 9-1, 9-21
creating, 9-9, 9-22
environments in which to use, 8-3
EXTPROC
eample, 4-7
explained, 4-6
responsibilities, 4-7
features
4GT tuning, 1-6
large user populations, 1-7
Oracle PKI, 1-7
file I/O enhancements, 1-3
file permissions, 4-2 to 4-4
files
alert, 6-8
maximum number for each database, 2-5
maximum size possible, 2-5
sample init.ora, 2-2
size limitations, 1-3
trace, 6-8
FSEEK
line terminators, 4-11
Hostname parameter, 6-2
ICX. See Intercartridge Exchange
ImagePath parameter, C-1
Import
databases, 3-9
parameter mode, 3-9, 3-10
preferred tools, 2-2
Import Wizard
preferred tools, 2-2
initialization parameter file
defined, 2-1
editing, 2-2
location, 2-2
initialization parameter requirements
Advanced Replication Support, 4-12
initialization parameters
OS_ROLES, 8-3
path in registry, 3-3
instances
modifying, 3-15
Oracle Database, 1-2
running multiple instances, 5-9
integration with Windows
4GT tuning, 1-6
Oracle Fail Safe, 1-8
Oracle PKI, 1-7
Oracle Services for MTS, 1-7
Intercartridge Exchange
accessing Web data, 4-11
configuring, 4-11
error messages, 4-14
exception conditions, 4-14
packaged functions, 4-12
stored packages, 4-12
using, 4-12
internet applications
developing, 4-4
K
Kerberos
  default use of, 8-2
  features, 8-2
keys
  defined, 3-1

L
Load Wizard
  preferred tools, 2-2
local database role
  creating, 9-14
local groups
  with database privileges, 9-29
LOCAL networking parameter, C-2
LOG_ARCHIVE_DEST_n, 3-2, 5-12, 5-14
LOG_ARCHIVE_FORMAT parameter, 5-14
LOG_ARCHIVE_START, 5-14

M
mapped drives, 3-2, 5-12
MAXDATAFILES, 3-7
memory usage, 7-3
Microsoft Certificate Services, 11-2
Microsoft Certificate Stores, 11-2
Microsoft Management Console
  defined, 2-12
  integration with Oracle Database, 2-12
  requirements, 9-2
  starting, 2-8
Microsoft ODBC Administration
  starting, 2-5
Migration Utility
  preferred tools, 2-2
MMC. See Microsoft Management Console
monitoring
  alert files, 6-1
  Event Viewer, 6-1
  Management Pack, 6-1
  Oracle Counters for Windows Performance Monitor, 6-1
  Oracle Database events, 2-12
  trace files, 6-1
multiple instances, running, 5-9
multiple Oracle homes
  service naming conventions, 5-2

N
Named Pipes Protocol Adapter
  with an Oracle Names Server, C-3
naming conventions for multiple Oracle homes, 5-2
NET START command, 3-8
networking parameters
  LOCAL, C-2
  TNS_ADMIN, C-2
  USE_SHARED_SOCKET, C-3
NOARCHIVELOG mode, 5-13
NTFS
  file system permission setting, 4-1
NTLM
  default use of, 8-2
  features, 8-2
NTS. See Windows native authentication

O
ObjectName parameter, C-1
OCOPY
  and raw files, 1-3
  preferred tools, 2-2
operating system authentication
  automatically enabling during installation, 8-4
  connecting as SYSDBA without a password, 8-4
  OSAUTH_PREFIX_DOMAIN parameter, 9-23
operating systems
  audit trail, 2-11
  authentication overview, 8-1, 1-7
opercfsg
  starting, 2-7
  syntax examples, 3-14
ORA_DBA local group
  adding users to, 8-4
ORA-00256 error, 3-2
Oracle Administration Assistant for Windows
  adding a computer to the navigation tree, 9-3
  connecting to a database, 9-5
  creating a local database role, 9-14
  creating an external operating system user, 9-9
  creating an external role, 9-16
  database connection issues, 9-7
  defined, 2-12
  granting administrator privileges, 9-19
  granting operator privileges, 9-20
  integration with Oracle Database, 2-12
  managing remote computers, 9-2
  saving a navigation tree configuration, 9-3
  setting OS_AUTHENT_PREFIX, 9-8
  starting, 2-5
  using, 9-1, 3-10, 3-15
  using the Oracle Counters for Windows Performance Monitor snap-in, 3-15
  using the Oracle Home Configuration snap-in, 3-10
  viewing authentication settings, 9-8
Oracle Counters for Windows Performance Monitor
  accessing, 6-3
  for monitoring a database, 6-1
  Hostname parameter, 6-2
  integration with Windows, F-2
  parameters, 3-7
  Password parameter, 6-2
  registry information, 6-2
  starting, 2-6, 2-8, E-2
  troubleshooting information, 6-6
User Name parameter, 6-2
  using, 2-12, 6-2, 3-15
Oracle Database
Index-5

connecting to, 5-5
password encryption, 5-12
shutting down, 5-5, 5-6
specifications, 2-5
starting, 5-5
Oracle Database services
auto-starting, 5-4
naming conventions for multiple Oracle homes, 5-2
shutting down a database, 5-6
starting, 5-2
stopping, 5-3
Oracle Database Upgrade Assistant
preferred tools, 2-2
starting, 2-5
Oracle Directory Manager
starting, 2-6
Oracle Enterprise Manager
Management Pack, 6-1
Oracle Enterprise Manager Console
preferred tools, 2-2
starting, 2-5, 2-7
Oracle Home Configuration snap-in
using, 3-10
Oracle Locale Builder
starting, 2-5
Oracle Managed Files, 3-8
Oracle Migration Workbench
starting, 2-5
Oracle Names
Named Pipes Protocol Adapter, C-3
Oracle Net
configuring for external procedures, 4-6
Oracle Net Configuration Assistant
configuring Oracle software with a directory server, 1-3, 1-4
creating the Oracle schema, 1-5
starting, 2-6
Oracle Net directory naming
connecting to a database through a directory server, 1-8
Oracle Net Manager
starting, 2-6
Oracle public key infrastructure, 11-1
Oracle Real Application Clusters
registry values, 3-8
Oracle schema
creating with Oracle Net Configuration Assistant, 1-5
Oracle Spatial
configuring, 4-10
Oracle Text
configuring, 4-8
Oracle Wallet Manager, 10-2
starting, 2-6
Oracle Wallets, 10-1
storing in the registry, 10-1
storing private keys and trust points, 10-1
ORACLE_SID, 3-10, 5-9
OracleDBCreator security group
defined, 1-11
OracleHOME_NAMEClientCache, C-1
OracleHOME_NAMECMAdmin, C-1
OracleHOME_NAMEMan, C-1
OracleHOME_NAMEMTNSListener, C-1
OracleHOME_NAMEMTNSListener service, C-3
OracleNetAdmns security group
defined, 1-11
ORADIM
command syntax errors, D-12
modifying an instance, 3-15
moving or copying password files, 5-10
preferred tools, 2-2
starting, 2-7
ORAPWD
creating password files, 5-9
starting, 2-7
OS_AUTHEN_PREFIX parameter
case insensitivity, 9-22
defined, 9-8
using, 9-22
OS_ROLES parameter
defined, 9-8
using with external roles, 8-3
OSAUTH_PREFIX_DOMAIN, 9-2, 9-23
OSAUTH_PREFIX_DOMAIN parameter, 9-23

P

packaged functions
Intercartridge Exchange, 4-12
UTL_HTTP_REQUEST, 4-13
UTL_HTTP_REQUEST_PIECES, 4-13

parameter mode
Export, 3-4, 3-5
Import, 3-9, 3-10

parameters
AUDIT_FILE_DEST, 6-8
BACKGROUND_DUMP_DEST, 6-8
DisplayName, 3-8, C-1
Hostname, 6-2, 3-7
ImagePath, 3-8, C-1
INST_LOC, 3-6
LOCAL, C-2
LOG_ARCHIVE_DEST_n, 3-2, 5-12, 5-14
LOG_ARCHIVE_FORMAT, 5-14
LOG_ARCHIVE_START, 5-14
LOGFILE, 3-8
MSHELP_TOOLS, 3-3
NLS_LANG, 3-3
ObjectName, 3-8, C-1
OO4O, 3-6
ORA_AFFINITY, 3-4
ORA_CWD, 3-3
ORA_SID_AUTOSTART, 3-3
ORA_SID_PFILE, 3-3
ORA_SID_SHUTDOWN, 3-3
ORA_SID_SHUTDOWN_TIMEOUT, 3-3
ORA_SID_SHUTDOWNTYPE, 3-3
Oracle Counters for Windows Performance
Monitor, 3-14
ORACLE_BASE, 3-5
ORACLE_GROUP_NAME, 3-5
ORACLE_HOME, 3-5
ORACLE_HOME_KEY, 3-5
ORACLE_HOME_NAME, 3-5
ORACLE_PRIORITY, 3-5
ORACLE_SID, 3-10, 5-9, 3-5
OS_AUTHENT_PREFIX, 9-8
OS_ROLES, 9-8
OSAUTH_PREFIX_DOMAIN, 9-2, 9-23, 3-6
OSAUTH_X509_NAME, 3-6
Password, 6-2
PERF_FILE_NAME, 3-8
RDBMS_ARCHIVE, 3-6
RDBMS_CONTROL, 3-6
REMOTE_LOGIN_PASSWORDFILE, 5-9
SQLPATH, 3-6
TNS_ADMIN, C-2
USE_SHARED_SOCKET, C-3
Username, 6-2, 3-7
password
encryption, 5-12
not needed with SYSDBA, 8-4
utility, 5-9
password file
authenticating database administrators, 5-9
creating, 5-9
hiding, 5-9
viewing, 5-10
Password parameter, 6-2, 3-7
PERFORMANCE key, 3-7
Performance Monitor
See Oracle Counters for Windows Performance Monitor
Performance Pack, monitoring a database, 6-1
PhysicalDrive, B-1
PL/SQL Embedded Gateway, 4-2
postinstallation
setting NTFS file system permissions, 4-1
setting Windows registry security, 4-4
PRAGMA RESTRICT_REFERENCES, with
Intercartridge Exchange, 4-14
privileges
in Windows local groups, 9-29
Process Explode, 2-14
Process Viewer, 2-14
PWDSID.ORA file, 5-9

Q
QuickSlice, 2-14

R
raw files
using, 1-3
raw partition
defined, B-1
logical partition, B-2
overview, B-1
physical disk, B-1
Recovery Manager
preferred tools, 2-2
starting, 2-7
Recovery Wizard
preferred tools, 2-2
redo log files
archiving, 5-12
REGEDT32 command, 3-10
registering an external procedure, 4-8
registry
adding parameters, 3-9
and Oracle Real Application Clusters, 3-8
configuration parameters, defined, 3-1
DisplayName, 3-8, C-1
editor, 3-1
editor, starting, 2-8
Hostname, 6-2, 3-7
ImagePath, 3-8, C-1
INST_LOC, 3-6
keys, defined, 3-1
LOGFILE, 3-8
modifying values, 3-9
MSHELP_TOOLS, 3-3
NLS_LANG, 3-3
ObjectName, 3-8, C-1
OO4O, 3-6
ORA_AFFINITY, 3-4
ORA_CWD, 3-3
ORA_SID_AUTOSTART, 3-3
ORA_SID_PFILE, 3-3
ORA_SID_SHUTDOWN, 3-3
ORA_SID_SHUTDOWN_TIMEOUT, 3-3
ORA_SID_SHUTDOWNTYPE, 3-3
ORACLE_BASE, 3-5
ORACLE_GROUP_NAME, 3-5
ORACLE_HOME, 3-5
ORACLE_HOME_KEY, 3-5
ORACLE_HOME_NAME, 3-5
ORACLE_PRIORITY, 3-5
ORACLE_SID, 3-5
Oracle_HOME_NAMEClientCache, C-1
Oracle_HOME_NAMECAdmin, C-1
Oracle_HOME_NAMECMan, C-1
Oracle_HOME_NAMETNSListener, C-1
OSAUTH_PREFIX_DOMAIN, 9-23, 3-6
OSAUTH_X509_NAME, 3-6
Password, 6-2, 3-7
PERF_FILE_NAME, 3-8
PERFORMANCE key, 3-7
RDBMS_ARCHIVE, 3-6
RDBMS_CONTROL, 3-6
REG_DWORD, 3-2, 3-10
REG_EXPAND_SZ, 3-2, 3-10
REG_MULTI_SZ, 3-2, 3-10
REG_SZ, 3-2, 3-10
REGEDIT32, 3-9
setting security, 4-4
SQLPATH, 3-6
update ORACLE_SID, 3-10
Username, 6-2, 3-7
using operfcfg, 3-14
remote computers
accessing database files, 5-12
managing with Oracle Administration Assistant for Windows, 9-2
REMOTE_LOGIN_PASSWORDFILE, 5-9
requirements
for using Oracle with Active Directory, 1-8
role authorization
description, 8-2
method enhancements, 8-2
roles
creating, 9-16
creating a local database role, 9-14
when to use enterprise roles, 8-3
when to use external roles, 8-3
security groups
adding and deleting members, 1-12
Server Manager
replacement, 2-1
services, 5-2
auto-starting, 5-4
shutting down a database, 5-6
starting, 3-7, 5-2
stopping, 5-3
SET INSTANCE command, 9-27, 9-29
SET ORACLE_SID=SID, 5-9
Shared Server Process, 1-7
shutting down
databases, 5-5, 5-6
snap-ins
Oracle Counters for Windows Performance Monitor, 3-15
Oracle Home Configuration, 3-10
specifying an archiving file format, 5-14
SQL*Loader
default file conventions, 2-10
direct path option, 2-10
preferred tools, 2-2
starting, 2-8
SQL*Plus
connecting to a database through Active Directory, 1-3
preferred tools, 2-2
shutting down the database, 5-5
starting, 2-6, 2-7, 5-5
starting the database, 5-5
SQL*Plus Worksheet
preferred tools, 2-2
starting, 2-6
sqlnet.ora file
and Windows native authentication, 9-27, 9-28
location of, 9-27, 9-28
starter database
archiving mode, 5-12
starting
databases, 5-5
Oracle Counters for Windows Performance Monitor, 6-3
Oracle Database services, 5-2
SQL*Plus, 5-5
stopping, Oracle Database services, 5-3
stored packages, Intercatridge Exchange, 4-12
storing private keys and trust points
Oracle Wallets, 10-1
symbolic links
creating, B-3
SYSDBA privileges
connecting without a password, 8-4
for a single database on a computer, 9-19
for all databases on a computer, 9-4
SYSOPER privileges
for a single database on a computer, 9-20
for all databases on a computer, 9-5
tablespace
Advanced Replication support, 4-11, 4-12
Task List, 2-14
Task Manager
starting, 2-9
using, 2-13
threads
and Microsoft Management Console, 2-12
and multiple Oracle Database instances, 1-2
and ORASTACK, 1-3
and shared server process, 1-7
and UNIX processes, F-5
defined, 1-1
optional and required, 1-2
process errors, D-3
processor affinity, 3-4
scheduler priority, 3-5
TKPROF
starting, 2-8
TNS_ADMIN networking parameter, C-2
tools, starting
Data Pump Export, 2-7
Data Pump Import, 2-7
Database Configuration Assistant, 2-5
DBVERIFY, 2-7
Event Viewer, 2-8
Export, 2-7
Microsoft Management Console, 2-8
Microsoft ODBC Administration, 2-5
operfcfg, 2-7
Oracle Administration Assistant for Windows, 2-5
Oracle Counters for Windows Performance Monitor, 2-6, 2-8
Oracle Database Upgrade Assistant, 2-5
Oracle Directory Manager, 2-6
Oracle Enterprise Manager Console, 2-5, 2-7
Oracle Locale Builder, 2-5
Oracle Migration Workbench, 2-5
Oracle Net Configuration Assistant, 2-6
Oracle Net Manager, 2-6
Oracle Wallet Manager, 2-6
ORADIM, 2-7
ORAPWD, 2-7
Recovery Manager, 2-7
Registry Editor, 2-8
SQL*Loader, 2-8
SQL*Plus, 2-6, 2-7
SQL*Plus Worksheet, 2-6
Task Manager, 2-9
TKPROF, 2-8
User Manager, 2-9
trace files
   for monitoring a database, 6-1
   using, 6-8
troubleshooting
   ORA-12560 error, D-20
   ORA-28575 error, D-20
   TNS-12203 error, D-20
tuning Windows Server operating system, 7-1

U
UNC, 3-2, 5-12
Universal Naming Convention, 3-2, 5-12
UNIX
   and Windows, Oracle Database differences, F-1
USE_SHARED_SOCKET networking parameter, C-3
user authentication
description, 8-2
   enhancement methods, 8-2
   when to use enterprise users, 8-3
   when to use external users, 8-3
User Manager
defined, 2-13
   integration with Oracle Database, 2-13
starting, 2-9
Username parameter, 6-2
UTL_FILE
   using, 4-11
UTL_HTTP.REQUEST, Intercartridge Exchange, 4-13
UTL_HTTP.REQUEST_PIECES, Intercartridge Exchange, 4-13

V
viewing
   password file, 5-10

W
Wallet Resource Locator, 11-2
Web data, Intercartridge Exchange, 4-11
Windows
   and UNIX, Oracle Database differences, F-1
diagnostic and tuning utilities, 2-14
   extensions for internet development, 4-4
Windows 2000 domains
   administering external users and roles, 9-1
Windows authentication protocols
default protocol used, 8-2
   with Windows 2000, 8-2
   with Windows NT 4.0, 8-2
Windows domains
   administering external users and roles, 9-21
   basic features, 8-3
Windows local groups
   with database privileges, 8-4, 9-29
Windows native authentication
   benefits, 8-1, 1-7
   enhancements, 8-2
   installation of, 8-1, 1-7
   methods and use of, 8-1, 1-7
   overview, 8-1, 1-7
   role authorization enhancements, 8-2
   setting the sqlnet.ora file, 9-27, 9-28
   user and role requirements, 8-2
   user authentication enhancements, 8-2
Windows tuning
   applying latest service packs, 7-5
   closing unnecessary foreground applications, 7-7
   configuring server to be an application server, 7-3
   disable unnecessary services, 7-3
   foreground applications, 7-2
   multiple striped volumes for sequential and random access, 7-6
   overview, 7-1
   removing unused network protocols, 7-4
   resetting the network protocol bind order, 7-4
   using hardware and operating system striping, 7-5
Windows-specific
   archiving procedures, 5-14
   audit trail, 6-7
   automatic database startup after restart, 5-4
   initialization parameter file, 2-1
   parameter file location, 2-2
   parameter filename and location, 2-1
   password filename and location, 5-9
   role syntax, 9-29
trace file names, 6-8

X
X.500 naming convention, 1-8